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1 Introduction

The Fujitsu Server BS2000 SE series with its innovative HW and SW features forms the proven mainframe line
from Fujitsu. Designed as hybrid systems, the SE servers create a new quality of openness and integration
capability of different server and peripheral systems with simultaneous comprehensive and cross-system
manageability.

Under the umbrella of the SE infrastructure, multiple application scenarios are possible in various combinations for
both mainframe applications and applications of the open world. The server architecture offers comprehensive
performance scalability (scale-up and scale-out), and ensures that users can manage their application workloads
securely, quickly and efficiently across technological boundaries with maximum availability.

One major aim of the SE servers is to provide a uniform management strategy which offers customers significant
added value through maximum integration, and guarantees extremely cost-effective operation of their IT.

The heart of the SE series is formed by the /390-based Server Units, the x86-based Server Units, the Net Unit (NU)
and the Management Unit (MU).

All components are integrated into a standard 19" rack and are supplied to customers ready to use.

In addition to their high system performance, the servers of the SE series offer enhanced configuration options,
maximum availability and, not least of all, significantly reduced power consumption compared with predecessors.

Depending on requirements, the SE server contains all the system components needed for operation as an overall
application:

® Server Unit /390 for BS2000 guest systems

® Server Unit x86 for BS2000 guest systems

® Application Units x86 for operating Native or hypervisor systems (e.g. Linux, Windows, VMware, etc.)

® Net Unit as a high-speed, server-internal infrastructure to connect the components with each other and with the
customer's IP networks.

® Shareable tape and disk periphery

® Infrastructure to connect the components with the customer's FC networks.

Main features of an SE server are:

® Cross-system administration with state-of-the-art, browser-based GUI (SE Manager) as a single point of
operation

® Centralized system monitoring of all components

® End-to-end redundancy concept

® Joint service process for all units

® Various options for consolidation through virtualization

® SE components and infrastructure are preconfigured and supplied to customers ready to use.

Regarding customer's requirements, SE servers enable a flexible and application-specific implementation which
fulfills high SLAs (Service Level Agreements) through the use of high-end components and an end-to-end
redundancy concept. This permits cost-effective operation of the overall system with few resources thanks to its
uniformity.

Intel x86-based Application Units with their systems also profit from the concepts for stable system operation tested
on the mainframe:

® Selection of high-quality server components

10
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Redundant hardware components

® Prepared operating concepts which also include high availability

High level of proven quality through extensive testing before release

® Comprehensive service concept.

The uniform management interface, the SE Manager, permits a simultaneous view of all the system components of
the SE servers involved and, from this higher-level perspective, enables the resources to be optimized through
efficient distribution of the application to the systems which are currently utilized least.

It is possible to combine up to eight SE servers in a Management Cluster to one management entity and therefore
utilize the advantages of the central administration with the SE Manager for several SE servers at the same time.
Every Management Unit can be used to control all components of the cluster, thus enhancing protection against
failure.

Two Server Units can be combined in an SU Cluster. Thus, live migration (LM) allows to relocate BS2000 systems
between the units without interruption.

SE servers consequently permit very stable system operation which includes not only the mainframe platforms
which have to date been known to be particularly failsafe, but also the other units and the infrastructure and
peripherals employed by the SE server. This can be achieved with fewer resources for administration and system
operation than for separate operation of different IT systems.

In this manual, abbreviations are used to describe the SE server models and their components. These are
explained in the introduction to the Basic Operating Manual [1] in the section "Models, Names, Abbreviations".

You will find information on these topics in the following sections:

® Documentation for the Fujitsu Server BS2000 SE Series
® Obijective and concept of this manual
® Changes since the last edition of the manual

® Notational conventions

11
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1.1 Documentation for the Fujitsu Server BS2000 SE Series

A wide range of documentation is available for the SE servers on the manual server at https://bs2manuals.ts.fujitsu.

com.

The manuals on BS2000 OS DX, which provide the basic literature.

The manuals for the system-related software products also apply.

Any additions to the manuals are described in the Readme files for the various product versions. These Readme
files are also available on the manual server with the BS2000 documentation under the various products.

Current information, version and hardware dependencies and instructions for installing and using a product version
are contained in the associated Release Notice. Release Notices, in particular those relating to BS2000 OS DX,
M2000, X2000, and HNC, are available on the manual server.

The documentation for the SE servers consists of the following parts:

Operating manual (consisting of a number of modules):
© Basic Operating Manual [1]

© Server Unit /390 [2]

© Server Unit x86 [3]

© Additive Components [4]

Operation and Administration [5] (this manual)

Quick Guide [6]

Security Manual [7]

Cluster Solutions for SE Servers (Whitepaper) [8]

12
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1.2 Objective and concept of this manual
The chapter "Architecture and strategies” contains fundamental information regarding the SE server which is
relevant for all readers (e.g. architecture, fundamental operating functions).

The chapter "Operating the SE Manager" contains fundamental information on the SE Manager, the central user
interface of the SE server.

The subsequent chapters describe the tasks on the SE server and the user interface of the SE Manager. They are
based on the tree structure of the SE Manager.

Detailed information on the data displayed, the dialog boxes, and operation of the SE Manager is provided in the
online help of the SE Manager.

Additional product information

Current information, version and hardware dependencies and instructions for installing and using a product version
are contained in the associated Release Notice. These Release Notices are available online on the manual server
with the BS2000 documentation (https://bs2manuals.ts.fujitsu.com).

Target groups of this manual
This manual is intended for people who operate an SE server:

® Administrator

© As administrator you manage the entire SE server with all its components and the operating systems which
run on it. You need a good knowledge of the BS2000, Linux and Windows operating systems and of the
network and peripherals.

© As administrator you can manage the integration of the optional Application Units on which an open operating
system (by default Linux) runs in Native mode or in a virtualized manner (e.g. under VMware® vSphere).

© As administrator you can manage by default all add-on packs.

® For other users, roles are provided with a customized (reduced) selection of functions (e.g. BS2000 operator, AU
administrator, etc.) to permit the assigned tasks to be performed.

13
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1.3 Changes since the last edition of the manual

This manual describes the functionality of the SE Manager with the use of the basic software M2000/X2000/HNC
V6.6A.

Functional extensions

The basic software M2000/X2000/HNC V6.6A provides the functional extensions described below.
Changes that only occurred with SP1 (Service Pack 1) are marked as such.

BS2000-supporting functions

® SU /390

© Support for the new SU740 model.
New SU740-specific functions are:

® Display of the change of the active IORSF file in SEM.
® Display of the configured maximum transmission speed of the individual channels.
© With SP1: Possibility to create BS2000 disks based on EMDISC files on the MUs.
® SU x86
© Use of internal SSD disks for virtual BS2000 disks of the new EMDISC type.
© Possibility to restart all tape devices configured on an SU.
® General
© With SP1: The SERVICE-PACK and the SYSID of the single BS2000 systems are displayed.

Security

® Service account service
© The password and its management must comply with today's generally applicable security requirements.

© This applies to the length and complexity, as well as to the validity time and warning time.
The specific values for the validity time and warning time are defined by mutual agreement between the
customer and Customer Support.

© The password for the service account is managed by Customer Support in accordance with the mutual
agreement.

* SNMPv3

© Support of SNMPv3 for the configuration of trap receivers.

© With SP1: For every single MU its specific persistent SNMP Engine ID is displayed.
® Display of Teleservice messages

© Display of all Teleservice messages sent to the Support Center as events.
®* New role

© A new role called Remote service administrator has been introduced.

© With SP1: The new auxiliary basic role Shell access has been introduced.
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® Entering passwords

© In the SE Manager, entered passwords are usually hidden for security reasons.
During input, an eye icon is displayed in front of the input field, with which the password can be made visible
and hidden again.

© With SP1: The password rules have been tightened to improve security.

© With SP1: The passwords of the accounts are monitored. In case given, events with the component PwMon
are created.

SEM graphical user interface

* AU PY
© Extended display and reboot functionality
® Comfort

© Optimization of some SEM windows and tables (new columns, switching between compact and detailed view,
extended descriptions, ...)

® General

© With SP1: The user-defined links are assigned to categories and are displayed in the navigation menu
ordered according to these categories.

Maintainability

® Alarm management

© The automatic forwarding of events as a mail or trap can be deactivated and reactivated for each receiver.
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1.4 Notational conventions

The following notational conventions are used in this manual:

italics
nonospace
<abc>

Key
symbols

[]

Texts from the SE Manager (e.g. menu name, tab)
System inputs and outputs
Variables which are replaced by values.

Keys are displayed as they appear on the keyboard. When uppercase letters
need to be entered, the Shift key is specified, e.g. SHIFT - A for A. If two
keys need to be pressed at the same time, this is indicated by a hyphen
between the key symbols.

An action which you must perform is indicated by this symbol.

This symbol indicates information and notes that you should observe.

This symbol indicates further instructions for action and tips that you should observe.

This symbol indicates particularly important notes and instructions for action which you should
observe.

This symbol and the word "ATTENTION!" or "CAUTION!" precede warning information.
In the interests of system and operating security you should always observe this information.

The titles of related publications in the text are generally abbreviated.
The complete title of each publication which is referred to by a number is listed in the Related
Publications chapter after the associated number.
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2 Architecture and strategies

The description is divided into the following sections:

® Architecture

® Software of the SE server

© Structure of the software

© Versions and updates of the basic software

© Add-on packs

® Networks

© Services

IPv6 autoconfiguration
Domain Name System (DNS)
Managing the "senet" domain
ACL functionality

NTP server

© Integration of BS2000 into the SE Manager
© |ntegration of BS2000 into the LAN

© Qverview of the possible LAN connections of the VMs

© Important information about IP configuration
¢ External CRD disks

® Cluster

© Management Cluster
© SU Cluster

® Management Unit and SE Manager

© Role and user strategy

© IP-based access to the Management Unit

© Redundant Management Units

© Central logging

® Virtualization

© Implementation of VM2000

© Virtualization on Server Unit x86

® Time synchronization

® Customer Support and maintenance

© Tasks of Customer Support

© Tasks of the customer

© Handling updates
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2.1 Architecture

A Fujitsu Server BS2000 of the SE Series (SE server for short) can consist of the following components:

®* Management Unit (MU) with SE Manager
The operation of the SE server with a single Management Unit is called a "single-MU configuration”. The
Management Unit can be redundant in design. An SE server configuration with more than one Management Unit
(MU redundancy on the SE server or Management Cluster with two SE servers) is called "multi-MU
configuration”. MU redundancy ensures that the components of the SE server can still be operated if one MU
fails. In particular this means that the SKP functionality is then still available for operating an SU /390.

® Server Unit (SU)
An SU enables operation of BS2000 (Native BS2000 or VM2000). Depending on the model family, the following
combinations are possible:

O SE servers SE7xx are equipped with an SU /390
© SE servers SE3xx each contain an SU x86
® Application Unit (AU)
Multiple AUs can be operated on the SE server. An AU enables operation of applications under Linux, Windows

or hypervisor-based systems.
A distinction is made between AUs depending on the hardware base:

© Application Unit PY (AU PY) refers to all PRIMERGY-based AUs (e.g. hardware model AU25 or AU47).

©  Application Unit PQ (AU PQ) refers to all PRIMEQUEST-based AUs (e.g. hardware model AUQ38E or
DBUSS8E).

® Net Unit (NU)
The Net Unit offers maximum performance and security for internal communication in an SE server and for a
connection to customer networks (IP networks). For an SU /390, HNC is an additional component of the Net
Unit.
In the case of SE server with an SU /390 the Net Unit is always redundant in design. In the case of SE server
with SU x86 only redundancy of the Net Unit is optional.
The Net Unit is supplied preconfigured, is autonomous with respect to SE server management, and can easily be
connected to the customer network.

® Rack console and KVM switch

® Optional hardware components / peripherals integrated into the rack:
Disk storage systems (for SU x86, AU), tape library systems (for SU x86), FC switches

All components of the SE server are integrated into a joint rack or multiple racks. Information on the current
hardware configuration of your SE server is displayed by the SE Manager in the Hardware -> HW inventory menu
(see section "HW inventory").
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Figure 1: Architecture of SE servers

The SE Manager (also called SEM for short) enables you to operate and manage all components of the SE server
centrally from the Management Unit. The SE Manager offers a user-friendly, web-based user interface for this
purpose.
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2.2 Software of the SE server

The description is divided into the following sections:

® Structure of the software
® Versions and updates of the basic software

® Add-on packs
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2.2.1 Structure of the software

M2000

M2000 is the basic software of the Management Unit. It provides, among other things, the following main functions
for accessing SE servers:
® SE Manager as Single Point of Administration (central operation and administration of the SE servers)

© Operation and administration of the BS2000 systems on SU /390 and SU x86 (BS2000 console, BS2000
dialog, SVP console on SU /390)

© Operation and administration of VMs on AUs

© Realizes the data collection and storage necessary for managing and operating the SE server.
Receives events from all instances of the SE server for displaying, editing and forwarding.
In the case of a multi-MU configuration, these internal functions are coordinated between the MUs.

® Role and user strategy
® Net Unit functions for integration of the SE server into the customer network
® SE Desktop for operation on the local console of the Management Unit

® |ntegration into the Remote Service of Fujitsu

X2000
X2000 is the basic software of the SU x86. It provides, among other things, the following functions:

® Execution system for BS2000 systems (including 1/0O system)

® Management functions for administering the BS2000 VMs in the SE Manager

® Management functions for administering the BS2000 devices in the SE Manager
® Configuration of the Net-Storage for the BS2000 systems of the SU x86

HNC
HNC is the basic software of the HNC. It provides, among other things, the following functions:

® Network connection for the BS2000 systems of the SU /390
® Configuration of the Net-Storage for the BS2000 systems of the SU /390

Add-on packs

In addition to the standard software M2000, X2000, and HNC, the SE server offers enhancements by means of add-
on packs.

See also section "Add-on packs".
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2.2.2 Versions and updates of the basic software

In addition to the system version, the software status also includes the updates which are installed on the unit.
Software updates can only be installed if they are available on the local system.

Under SW version in the system information the SE Manager displays on the MU, SU x86, and HNC the version of
the basic software M2000, X2000 or HNC, including the update status.

On the SU /390, the SE Manager displays the HCP (Hardware Control Program) software (e.g. in the SU /390
information on "Name, system information and interfaces of the SU /390"), but in this case does not support update
management.

The software status consequently has the following components:

Component = Example Description
Version 6. 5A

Revision REV=0305 Update status
Update 6. 5A, No. 020

® Updates are assigned to a version and update status.

® Updates have a sequence number for each version status and each
update status (020 in the example)

In contrast to the other updates, add-on packs are autonomous software products which Fujitsu provides for

installation on the Management Units. An add-on pack is either a software product which is installed by default (e.g.

StorMan on the Management Unit) or one which is optional.
Add-on packs are managed like updates to the basic software, but the software status displayed consists of the
product name and a product-specific version designation.

Updates to the basic software

You can transfer updates to the basic software as well as add-on packs to the Management Unit, the SU x86 and
the HNC and manage them there.

An update to the basic software contains a patch with which an urgent problem in your system can be rectified as
quickly as possible.

An update can only be installed by Customer Support. Installation can only be performed using a CLI command
under the Customer Support account.

Updates are supplied as files of the following types:

® i so. gz for files which can be downloaded from the download server

® | so for files which are supplied on CD/DVD

Naming conventions

The following naming conventions apply for the files containing the updates:
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Update e.g. W6. 5A0305U020. i sof . gz]
The update with number 020 is assigned to the version and update status 6. 5A REV=0305.

Add-on pack | e.g. W. STORVAN- 10. 3. 1-0.0.i so
This add-on pack contains STORMAN V10.3.

The first letter in the file name indicates the basic software of the associated unit:

¢ X for X2000 on the Server Unit
®* M for M2000 on the Management Unit
* H for HNC on the High-speed Net Connect
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2.2.3 Add-on packs

Add-on packs are software components on a unit which generally have their own web interfaces that are integrated
into the SE Manager. The type and location of the integration into the SE Manager depends on the category to
which the add-on pack is to be assigned, e.g. Application, Monitoring, Hardware Management.

Add-on packs have their own version schema and can be replaced independently of the basic software.
Add-on packs are also distinguished by whether they are chargeable or included in the price and preinstalled.
The fact that the web interfaces of the add-on packs are integrated into the SE Manager means the following:

® The add-on packs are visible as links in the SE Manager's menu.
®* When such a link is clicked, the add-on pack's web interface is opened in the same browser window.

® You log into the add-on pack's web interface implicitly using the account with which you are working in the SE
Manager and in the same session. The same setting therefore applies for the session timeout in the event of
inactivity. Logging off in the add-on also leads to logging off in the SE Manager and thus to the login window of
the SE Manager.

®* From the add-on pack's web interface there is a link back to the last valid main window in the SE Manager.

Add-on packs have their own online help systems and, when necessary, are described in separate product
manuals. These online helps are integrated into that of the SE Manager, but can also be called separately.

If there is more than one MU (MU redundancy or Management Cluster):

® Every add-on pack can be installed on any MU or on all MUs.
The recommended use and configuration for multi-installation can be found in the documentation for the add-on.

® Allinstalled add-on packs are integrated into the SE Manager with an MU-specific link.

An exception applies to the Storage Manager: It is fully integrated into the SE Manager. The STORMAN user
interface is accessible immediately below the Hardware -> Storage menu.
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Example with the add-on packs OPENUTM and ROBAR:

G Applications v

-1 SE management
BS2000 Backup Monitor
openUTM WebAdmin (wald)
openUTM WebAdmin (geneve)
openUTM WebAdmin (lugano)
ROBAR (lugano)

+ User-defined links

Overview of the add-on packs with own GUI in the SE Manager on the MU:

Add-on (product Chargeab @ Preinstalled | Integration into the SE Manager
name) le ex works
OPENSM2 Yes Optional Category: Performance

openSM2 Manager
(op ger) -> Performance

OPENUTM No *) No Category: Applications

(openUTM o
-> Applications -> SE management -> openUTM

WebAdmin) ,
WebAdmin (<mu>)
ROBAR Yes Optional Category: Applications
(ROBAR-SV > Applications -> SE t -> ROBAR (<mu>
Manager) -> Applications - management - (<mu>)
STORMAN No Yes Category: Hardware
(Storage
-> Hardware -> Storage
Management)

Table 1: Add-on packs (with own GUI) in the SE Manager on the MU
*) The add-on OPENUTM is not chargeable, but the basic product openUTM is.

Add-on pack SEFW

The SEFW add-on pack is used to update firmware components on x86 servers. It does not have a graphical user
interface and is therefore not integrated into the SE Manager.

Add-on pack NUX
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The add-on pack NUX occupies a special position. NUX stands for Net Unit eXtension and the add-on serves to
connect the SE server to the customer networks via Cisco switches.

If a suitable Cisco infrastructure is available, the NUX add-on is installed and configured as part of a service.

In the SE Manager, the NUX-specific menus extend the Hardware -> IP Networks menu.

The online help for NUX is included in the online help of the SE Manager.

For more details on NUX, please contact customer support or service.

SE management applications

SE management applications run on the Management Units and are integrated as described above into the SE
Manager. These include the above-mentioned add-on packs OPENSM2, OPENUTM, ROBAR and STORMAN, the
latter being fully integrated.

As a further SE Management application, which in contrast to the add-on packs is implemented as a permanent part
of the SE Manager, also the BS2000 Backup Monitor is currently available. It can be found in the SE Manager
under the Applications category: -> Applications -> BS2000 Backup Monitor.
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2.3 Networks

The Net Unit supplies the central link of all the SE server's IP network connections. It concentrates the network
connections of the various units to the outside into the customer network (public networks) and, internally,
establishes the network connections between the various units (private networks).

The hardware of the Net Unit is supplied preconfigured. All the cable connections to the units are implemented

professionally in the cabinet in the factory. Connections to the customer networks (data networks, management
networks) only need to be established to the reserved connection ports of the Net Unit (uplinks). In terms of the
software, the Net Unit is fully installed and immediately ready to operate.

Up to two uplinks are possible per public network to provide the connection to the customer's LAN structure. The
uplinks are provided without vendor dependencies and can be connected to any switch (managed or unmanaged).
The uplinks are operated without a VLAN ID (i.e. untagged), and no switch protocol (e.g. spanning tree) is used.

Only the relevant configuration measures need to be implemented in the operating systems to use the networks. It
is not necessary to involve network administrators of the customer network.

Private networks have been configured for the units to communicate with each other. These separate the network
communication within the SEs totally from the customer network. The private networks are protected from each
other and can be configured flexibly according to customer requirements. Network security is automatically
enhanced because of this protection and the flexibility to configure and operate private networks independently of
the customer infrastructure.

The private networks can be operated with high performance, do not influence the customer network, and cannot
be influenced by it (e.g. they continue to function even when the customer infrastructure fails).

The Net Unit can be designed with redundancy in the interest of protection against failure. By default, SE servers
with an SU /390 incorporate a redundant Net Unit. Redundancy can be ordered as an option for SE x86.

The BS2000 systems communicate with the MU over a private network, see section "Integration of BS2000 into the
SE Manager".

The following logical networks are supported:

® Data Network Public

© Data Network Public (DANPU): when required, up to 8 additive networks DANPU<n> (where <n>= 01..08)
can be configured for connecting applications to the public customer network.

® Data Network Private

© Data Network Private (DANPR): when required, up to 99 networks DANPR<n> (where <n>= 01..99) can be
configured for internal private customer networks for SE servers.

® Public management networks
© Management Admin Network Public (MANPU) for administrative access to the MU, BS2000 systems and AUs

© Management Optional Network Public (MONPU): the additive administration network can be configured when
required (e.g. when AIS Connect is not to be operated via MANPU but over a separate network).
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® Management Network Private
© Management Control Network Local (MCNLO) for the local SE server communication
© Management Control Network Private (MCNPR) for SE server communication

© Management Optional Network Private (MONPR): when required, up to 8 additive networks MONPR<n>
(where <n>= 01..08) can be configured for SE server communication.

© Management SVP Network Private (MSNPR) enables SVP communication to the SU /390 on SE server with
an SU /390.

In addition to the connections of the units to the switches of the Net Unit, direct cabling from the units to the
customer network can also be used.

The SE Manager provides a graphical display of the network topology with all the network components and
connections of the SE server in the Topology tab of the Hardware - > IP networks menu. See section "Graphical
display of the internal IP network topology".

I sYs I ISYS I PCl

Management Network Pn'vateie.i. MCNPR, MONPRO1

I HIiEIIN i1l d
Data Network Private (DANPRO1)

R EEEEE L ==

Management Network Public

[ ] AT sy [ (e ey
Data Network Public

Net Unit I

Management Network Data Network Public
Public (e.g. MANPU) (e.g. DANPUO1)

SE Server tlnierconnad

Figure 2: Block diagram of the Net Unit

i This description refers to the internal Net Unit and the internal networks and connection possibilities of the
SE Server to the public customer network realized with it.
If the optional add-on NUX (Net Unit eXtension) is installed on the Management Unit, there are further
connection possibilities to the public customer network.
For further details on NUX, please contact customer service.
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2.3.1 Services

The description is divided into the following sections:

IPv6 autoconfiguration
Domain Name System (DNS)
Managing the "senet" domain
ACL functionality

NTP server

29



SE Server - Administration and Operation - User Guide

2.3.1.1 IPv6 autoconfiguration

IPv6 autoconfiguration based on the "radvd" (Router Advertisement Daemon) which runs on the MU is provided for
communication in the MCNPR network segment. Optionally IPv6 autoconfiguration is also provided for the private
network segments MONPR and DANPR.

The prefix "fd5e:5e5e:<vlan-id>:0::/64" (for MCNPR where vlan-id 600 = fd5e:5e5e:600:0::/64) is preconfigured.
When conflicts occur on the customer side, Customer Support can set a different prefix (change the first 32 bits of
the prefix).

Connected units (with enabled IPv6 autoconfiguration) are then assigned an IPv6 address based on the MAC
address (e.g. fd5e:5e5e:600:0:219:99ff:fee2:79d/64).

IPv6 autoconfiguration is automatically enabled for MCNPR by means of the installation and is required for the
management functions for the units. IPv6 autoconfiguration can optionally be activated for private network
segments.

Each MU is assigned its own static IPv6 address during configuration in MCNPR (e.g. fd5e:5e5e:600::101/64 =
<IPv6 prefix>::<mu-id>0<se-id>) with which the MU in the network segment can be addressed.
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2.3.1.2 Domain Name System (DNS)

A DNS server for the "senet” domain which provides name resolution for communication runs on the MU. The DNS
server is configured in such a manner that it performs name resolutions for "senet" itself and forwards other name
resolutions to external DNS servers which must be configured manually.

The static IPv6 address of the local MU is the first name server in the DNS configuration of the MU. Two further
external DNS servers and the external domain search list can be configured.

The IPv6 addresses of the two possible MUs are preconfigured on an SU x86 or HNC. No further configuration is
required.

DNS queries are thus directed to the MU via the network segment MCNPR. The MU then either resolves the
address itself for the "senet" domain or forwards the request to the customer's external DNS servers.

Name resolutions can also be used for the other network segments MONPR and DANPR. For this purpose the
relevant network segments must be configured on the MU in the SE Manager, and IPv6 autoconfiguration must be
enabled (see section "Managing the IP configuration™).

31



SE Server - Administration and Operation - User Guide

2.3.1.3 Managing the "senet" domain

You manage the names and aliases of the "senet" domain in the SE Manager. You can add, modify or delete DNS
entries (see section "Configuring SENET").

The management of the "senet" domain is global for the SE server resp. SE cluster. Changes to SE server
configurations with more than one MU are automatically aligned in the DNS.

The aliases are assigned according to the following schema:

Component MCNPR SE alias Description
(x=1..n; y=1..8; z=01..99)

MU mu<x>-se<y>.senet M2000
SU /390 suObs2-se<y>.senet BS2000 (Native/monitor VM)
suOvm<z>-se<y>.senet BS2000 VMs

SU x86 su<x>-se<y>.senet X2000
su<x>irmc-se<y>.senet SU x86 iRMC
su<x>bs2-se<y>.senet BS2000 (Native/monitor VM)

su<x>vm<z>-se<y>.senet BS2000 VMs

Net Unit nswa<x>-se<y>.senet 1 Gbit NU switch
(Managed switch)

HNC hnc<x>-se<y>.senet HNC

hnc<x>irmc-se<y>.senet = HNC iRMC

AU PY au<i>-se<y>.senet System (e.g. VMware)
(i=1..9999)
AU PQ auc<z>-se<y>.senet Management Board of a PRIMEQUEST

auc<z>p<nr>se<y>.senet  Partition of a PRIMEQUEST

RAID system prd<z>-se<y>.senet e.g. ETERNUS DX (prd=periphery raid)
Tape library ptl<z>-se<y>.senet e.g. LT140 S2 (ptl=periphery tape library)
Other periphery pot<z>-se<y>.senet (pot=periphery other)

Table 2: Name schema of the SE aliases
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2.3.1.4 ACL functionality

You can lock or release individual TCP/UDP ports (services) for the DANPU<xx>, MANPU, MONPU, DANPR<xx>,
and MONPR<xx> networks in an ACL (Access Control List):

® Either the administrator defines an ACL list of the type "permit" in which all released services (ports) are explicitly
entered.

i After the ACL of the type "permit" has been configured, the list is initially empty. Access to the network
is thus locked for all services (ports).

® Or the administrator defines an ACL list of the type "deny" in which all the locked services (ports) are explicitly
entered.

One ACL list each can be defined for IPv4 and IPv6.
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2.3.1.5 NTP server

The MU of the SE server is configured as an NTP server and is used as the central NTP server for the SE server.

The units SU x86 and HNC are configured in such a manner that time synchronization takes place from the local
SE server's MU.

In the case of MU redundancy, both MUs of the local SE server are configured as timers.

If external timers are used in a multi-MU configuration, the same external NTP servers must be configured on each
MU, so that the time remains accurate even if one MU is switched off.

The static IPv6 address of the MU can be used for time synchronization of an AU with the local SE server's MU.

For further details, see section "Time synchronization".
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2.3.2 Integration of BS2000 into the SE Manager

The VM Management for SU /390 in VM2000 operation mode requires communication between the monitor system
and the MU.

For SU /390 as well as for SU x86, communication is required between the MU and the BS2000 systems concerned
in the following cases:

" For the BS2000 Backup Monitor to communicate with the BS2000 systems on which the backup requests take
place

® For the display of pending BS2000 messages in SEM

® For the display of C2H data of BS2000 systems in SEM

" For the display of BCAM networks in SEM

The communication uses the internal network MCNPR (see Figure 2 in section "Networks") and must be configured
as follows:

" |n the BS2000 systems mentioned a suitable BCAM configuration must be configured by means of the templates
provided. See also the BCAM manual [13].

® The REWAS subsystem must be active (default).
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2.3.3 Integration of BS2000 into the LAN

From the viewpoint of BS2000 devices, the ZASLAN and LOCLAN are devices which are used for the LAN
connection to the external physical network or for internal communication in the Server Unit. They can be created in
the SE Manager (see section "Managing LAN devices") and must, in the case of VM2000, then be assigned to the
BS2000 VM concerned.

BS2000 ZASLAN

In the case of a ZASLAN connection, BS2000 uses a LAN interface of its own (Ethernet controller) independently of
other LAN interfaces. Only via such a connection does BS2000 obtain a direct view of the physical network.

In VM2000 mode a LAN interface can be used jointly by all connected BS2000 guest systems. To permit this, a
separate ZASLAN connection is configured for each BS2000 VM. The associated devices are connected to their
particular VM (using the /ADD-VM-DEVICES command).

The ZASLAN interfaces are displayed or modified in the SE Manager using Devices -> [<se server> (SE<model>) ->
] <unit> (SU<model>) on the LAN tab.

i All PCI ports can be used for the ZASLAN connections.

LOCLAN

The local LAN is a network implemented by software in the Linux-based basic system concerned (X2000/M2000
/HNC). The local LAN connections are consequently not included in the figure illustrating the LAN structure (see
Figure 2 in section "Networks"). The connection of BS2000 to the local LAN is implemented on an SU x86 system
with connections implemented by software (MANLO: Management Network LOCLAN), and on an SU /390 by FC
connections between SU /390 and MU (MANLO) or HNC.

The following addresses are preconfigured for BS2000 and the basic system (X2000/M2000):

System IP address
Basic system 192.168.138.12
BS2000 (Native or monitor system) 192.168.138.21

BS2000 guest systems on other VMs = 192.168.138.22 etc.

A second MU (in case of SU /390) is automatically assigned the addresses 192.168.139.x. If address conflicts
occur, Customer Support can configure other address ranges.
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2.3.4 Overview of the possible LAN connections of the VMs

The figures below provide an overview of the possible internal and external LAN connections of the BS2000 VMs
running on the Server Unit. Physical network integration is shown in Figure 2 in section "Networks".
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Figure 3: Overview of possible internal and external LAN connections (Server Unit /390)
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2.3.5 Important information about IP configuration

After your SE server has been installed, the IPv6 protocol is enabled throughout the system.

Use of IPv6 for all networks of the SE server is enabled by default. You can perform the following configuration
measures separately on a network-specific basis:

You can enable or disable the use of IPv6 for specific networks.
IPv6 is permanently set for the internal network (MCNPR).

Enable/disable Autoconf (Stateless Address Autoconfiguration)

This setting is evaluated only when IPv6 is enabled:

Autoconf is a user-friendly automatic procedure which enables the system to specify its own LAN addresses on
the basis of information which is provided both locally and remotely. Autoconf requires a router which is
responsible in the network that, when requested by the system, assigns the so-called IPv6 prefixes (one prefix
per available network).

The system supplements these prefixes for each LAN interface to make them unambiguous addresses, the
supplement being based by default on the MAC address of the LAN interface concerned.

A LAN interface configured in this way is automatically linked to all available networks. In contrast to Autoconf, in
the case of DHCP IPv6 address assignment (stateful) is performed by an instance in the network which also
manages the current state of the address assignment.

Enable/disable DHCPv6
DHCPv6 requires a DHCP server in the network which distributes IPv6 addresses.

Enable/disable DHCPv4
DHCPv4 requires a DHCP server in the network which distributes IPv4 addresses.

In all cases of dynamic address distribution, the addresses assigned are provided with validity times by the
Autoconf router or the DHCP server.

Any number of IPv6 addresses (and also IPv4 addresses) can be allocated explicitly.

When IPV6 is used, IPv6 routes can also be configured.
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2.4 External CRD disks

On a CRD disk (configuration disk) of a unit (MU, SU x86, HNC), the following data of the SE server configuration
are stored:
® General data of the SE server:

© Model, name and location

© Cross-unit data

® Unit-specific data with contents that should remain available even after the unit fails or is powered off (not for
HNC):

© Model, SW version and host name

© IP configuration

© FC configuration

© VM data for BS2000 (on SU x86 also for Linux and Windows)

® Current configuration of the Net Unit switches

By default, the data are locally stored on an internally mirrored disk of the unit (MU, SU x86, HNC).

In addition to the internal configuration disk, up to two external CRD disks can be configured on external FC RAID
systems, to which all MUs and SU x86 have access via a redundant connection.

This ensures consistency: Every MU and SU x86 reads the data of the SE server in the same way and the actions
on these units can be coordinated.

The SE Manager displays information about the CRD disks, e.g. of an MU, in the Hardware -> Units -> [<se
server> (SE<model>) ->] <unit> (MU) -> Information menu (see "Displaying CRD disks of the MU"):
System IP interfaces ’ FC interfaces Multipath disks | CRD disks EMDISC files

= Management Unit abgse7mui: CRD disks @ f

Ej Update storage data

Index~ Device Storage name Storage serial number  Volume number  Stafus Description
Filter  Filter Filter Filter Fiiter Al ~ | Filter
1 [devi/diskiby-partuuid/fi5c7ed-bffd. . - - - L NORMAL intern
2 DX0D0E31025C-Disk1E8 DX900-55-1 4652005001 485 & NORMAL SE_CRD_Server?
3 DXO0D0E31025C-Disk1ES DX800-55-1 4652005001 488 o4 NORMAL SE_CRD_Serverd

5 & Total: 3

Figure 5: MU with external CRD disks
External CRD disks are required in the following cases:

® MU redundancy

® Cluster
For the SE Cluster (Management Cluster), external CRD disks are sufficient on the MUs. For SU Clusters,
external CRD disks are also required on SU x86.
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2.5 Cluster

Two types of clusters are possible in an SE server configuration:

® Management Cluster
® SU Cluster
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2.5.1 Management Cluster

If two or more SE servers (up to eight) are combined into one management entity, this is called a "Management
Cluster"” (or "SE Cluster").

A Management Cluster is configured by Customer Support based on the customer's requirements and is used to
operate und administrate the involved SE servers together.

A Net Unit connection between the SE servers (ISL-E) and one or two external configuration disks for managing the
global data are required to establish a Management Cluster. See also section "External CRD disks".

External CRD disk (optionally redundant)

SE Server 1 ' SE Server 2

~3 0 Q3Cc 00D
~3J DO 3C Q0D

S
sl

Figure 6: Management Cluster with two SE servers

Regarding administration and operation, all MUs of the Management Cluster are equally ranking. This means you
can centrally administer and operate all objects of the whole SE server configuration (in this case: two SE servers)
from each MU.

The SE servers can be operated as long as one MU functions. However, an MU of the local SE server is required
for the SVP operation of an SU /390 and its correct HW display.

Figure 6 shows a Management Cluster with two SE /390 and additional SU x86 in each SE server. A Management
Cluster can also be formed with two SE x86.
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2.5.2 SU Cluster

Two Server Units of the same type (SU /390 or SU x86) can be combined into a logical unit, a so-called "SU
Cluster".

An SU Cluster is configured by Customer Support based on the customer's wishes and provides the Live Migration
(LM) function for the BS2000 systems of the two Server Units.

Live Migration is used to migrate a BS2000 system from the source SU to another SU (target SU) of the same type
and operating mode. This means that a running system can be migrated to a target SU without interruption. A
planned operational interruption, e.g. for hardware maintenance, is therefore no longer required. LM can also be
used for manual load balancing, e.g. in the event of recurring high-load phases.

External CRD disk (optionally redundant)

SE Server 1 =% SE Server 2
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Figure 7: SU Cluster in a Management Cluster with two SE servers

Figure 7 shows a Management Cluster with two SE /390 and additional SU x86 in each SE server. A Management
Cluster can also be formed with two SE x86.

The Live Migration action can be called from the Operation main window of the respective BS2000 system. It is only
available on SUs that are part of an SU Cluster. Whether or not an LM is possible depends on the current cluster
status. The current status is displayed by the SE Manager in the Cluster -> <cluster-name> -> SU Cluster menu,
see section "Managing an SU Cluster".

LM requires both SUs to have the same operating mode. In case of an SU /390, LM is only possible if the current
operating mode is set to VM2000 mode.

In order to avoid unwanted fault indications and events over long periods when maintenance takes place (e.g. SU
switched off or in error status), the SU Cluster can be temporarily deactivated in the Cluster -> <cluster-name> ->
SU Cluster menu. LM is not possible in this state as well.

Details on the use of clusters are described in the Whitepaper ,Cluster Solutions for SE Servers* [8].
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2.6 Management Unit and SE Manager

The Management Unit together with the SE Manager enables central monitoring, administration and operation of all
units of the SE server and the systems running on it. Additional cross-unit functions are also available, e.g. for
displaying the components of the SE server, together with the operating status or performance monitoring.

These topics are described below:

® Role and user strategy
® |P-based access to the Management Unit
® Redundant Management Units

® Central logging
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2.6.1 Role and user strategy

Depending on how the system is viewed, different tasks must be performed to administer and operate the SE
server which are categorized in multiple task areas. The task areas correspond to predefined basic roles. In
addition, basic roles (except Administrator and Service) can be combined to user-defined roles. See also the
chapter ,Roles".

In addition to the SEM functionality described below, each basic role also has access to some further SEM windows
like the main windows Dashboard and Certificates and may change its own password on main window Password
management, download the CA certificate of the MU and access the event logging.

The roles are tied to an account. In other words, users take over a role when they log in on the SE Manager with an
account which is assigned to this role. A user who takes over a task area (i.e. a role) must be authorized to execute
all the functions which are required to perform these tasks.

When the system is delivered, there are predefined accounts for the Administrator and Service roles, see
"Predefined accounts".

All roles except the Service role can be assigned to additional accounts, see "Further accounts with role
assignment".

All accounts to which the same role is assigned are equivalent. The only exception in this respect is for accounts
with the BS2000 operator role. These are also initially equivalent. However, an administrator or security
administrator can additionally assign them individual rights for access to BS2000 or the individual BS2000 VMs.

The task areas of the various roles are described in detail below. For further information, see the online help.

Administrator

This task area comprises management of all units on the SE server and management and operation of the systems
which run on Server Units and Application Units of the SE server.

® BS2000 systems: For BS2000 on a Server Unit, the task area comprises operation of the BS2000 system or,
under VM2000, operation and partial management of the BS2000 guest systems.

® Application Units: For the optional Application Units the task area comprises the configuration and management
of the Application Units and the systems running on these.

In the SE server configuration, the administrator performs, among others, the following tasks:

® Managing all user accounts

® Managing individual authorizations
® LDAP configuration

® Managing the networks

® Monitoring audit and event logging

® The administrator can configure the automatic messaging (via SNMP trap or E-Mail) that is triggered for events
with certain attributes (e.g. component and weight).

® Additional general configurations like installing add-on packs, etc.

The administrator can also open a Linux shell on the Management Unit and can use this to call CLI commands. The
cli _i nf o command lists the M2000-specific commands which are available. You can obtain a detailed description
of the commands in the online help.
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BS2000 administrator

Comprises (largely) the subset of the Administrator task area which refers to BS2000 systems (BS2000 systems,
BS2000 devices, Backup Monitor, Net-Storage, Cluster, ...).

General access to the Linux shell is not possible. A BS2000 administrator can, however, access the BS2000
console, the BS2000 dialog and the SVP console outside the SE Manager by means of ssh client PUTTY. To do
this, they can execute the bs2Console, bs2Dialog and svpConsole commands as remote commands by means of
PUuTTY.

BS2000 operator

This task area is a subset of the administrator tasks and largely consists of operating the BS2000 systems for
ongoing operation or, under VM2000, operation and partial management of the BS2000 guest systems.

General access to the Linux shell is not possible. A BS2000 operator can, however, access the BS2000 console,
the BS2000 dialog and the SVP console outside the SE Manager by means of ssh client PUTTY. To do this, they
can - depending on the individual rights - execute the bs2Console, bs2Dialog and svpConsole commands as
remote commands by means of PUTTY. The individual rights (dialog access, console access, SVP access) must
first be defined by an administrator. See also the section "Accesses to BS2000" below.

AU administrator

An AU administrator has the authorization for functions of the SE Manager which are necessary to operate the
systems on AUs. In addition, they also have some administrator authorizations: switching the AUs on/off, read
access to the hardware inventory, and configuration of scheduled power on/off of the AUs.

Access to the Linux shell is not possible.

Read-only administrator

A Read-only administrator has the right to view all windows of the SE Manager, however modifying actions are not
allowed.

Security administrator

A Security administrator has full authorization for the windows and functions of the SE Manager under the
categories Authorizations and Logging.

Hardware administrator

A Hardware administrator has full authorization for the windows and functions of the SE Manager under the
categories Hardware -> Units, Hardware -> HW inventory, Hardware -> Energy and Service -> Units.

Storage administrator

A Storage administrator has full authorization for the windows and functions of the SE Manager under the categories
Devices -> ... -> IORSF files | Disks | Tape devices, Hardware -> Units -> ... -> FC interfaces | Multipath disks |
CRD disks as well as Hardware -> Storage (without STORMAN!).
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Power operator

A Power operator has authorization for the main window Units under the category Hardware and the functions for
powering units on and off.

IP networks administrator

An IP network administrator has full authorization for the windows and functions of the SE Manager under the
categories Hardware -> Units -> ... -> IP interfaces, Hardware -> Management -> ... -> [P configuration | Routing &
DNS as well as Hardware -> IP networks.

FC networks administrator

An FC network administrator has full authorization for the windows and functions of the SE Manager under the
categories Hardware -> FC networks and Devices -> BS2000 paths.

Shadow terminal operator

A Shadow terminal operator has authorization for access to the main window Service -> Units -> <MU> -> Remote
Service, wherefrom a shadow terminal can be opened.

Remote service administrator

A Remote service administrator has full authorization for the windows and functions of the Service menu, relevant
with regard to remote service: Service -> Information (only Customer ID) | Remote service access | Remote service
sessions und Service -> Units -> ... -> Remote service.

Shell access

Users with this basic role are given shell access.
This role is an auxiliary role which can be used only in combination with another basic role.

Add-on-specific roles

® OPENSM2

© OPENSMZ2 administrator
An OPENSMZ2 administrator has authorization for access to the add-on OPENSM2 and to its administration
on all Management Units.

© OPENSM?2 information
A user with role OPENSM2 information has authorization for access to the add-on OPENSM2. The
administration of the add-on is not allowed.
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® OPENUTM

© OPENUTM administrator
An OPENUTM administrator has authorization for access to the add-on OPENUTM and to its administration
on all Management Units (Master and Administration Write privileges).

© OPENUTM operator
An OPENUTM operator has authorization for access to the add-on OPENUTM including administration
(Administration Write privilege).

© OPENUTM information
A user with role OPENUTM information has authorization for read access to the add-on OPENUTM
(Administration Read privilege).

* ROBAR

© ROBAR administrator
A ROBAR administrator has authorization for access to the add-on ROBAR and to its administration on all
Management Units.

© ROBAR operator
A ROBAR operator has authorization for access to the add-on ROBAR. The administration of the add-on is
not allowed.

¢ STORMAN

© STORMAN administrator
A STORMAN administrator has authorization for access to the add-on STORMAN and to its administration on
all Management Units.

© STORMAN information
A user with role STORMAN information has full authorization for the SE Manager windows and functions
under Hardware -> Storage (STORMAN pages). The administration of the add-on is not allowed.

i The above description of the add-on-specific roles refers to the SE Manager.
The role description within the individual add-ons can be found in the add-on-specific manuals.

Service

This role includes all tasks of Customer Support, such as maintenance and configuration of the SE server and
registration of Application Units.

When special basic roles are mentioned below, such as BS2000 administrator or Security administrator, this also
refers to those user-defined roles which contain these basic roles.

Predefined accounts

As supplied, the following local accounts are predefined on the SE server for the existing roles:

® admin (administrator role)

® service (Customer Support role)
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The predefined account admin is protected by an initial password. The administrator can configure further accounts.
Further details are provided in the section "Managing accounts" and in the Security Manual [6].

The predefined account service is available solely to Customer Support. A service account cannot be administered
in the SE Manager.

Accounts of the add-ons are internal function accounts, do not correspond to a role in the SE Manager and are
therefore not displayed in the SE Manager.

Further accounts with role assignment

An administrator or security administrator can configure further accounts for all basic roles except Service and for
user-defined roles. They assign the role during creation of an account. The use of person-related accounts is
therefore also possible.

i The accounts are MU-global, i.e. in SE server configurations with more than one MU, all accounts that are
added, changed or removed by the administrator are implicitly added, changed or removed on all existing
MUs.

An account (locally or centrally managed) must always be unique. If an account is to be added that
corresponds to a pre-defined account (e.g. admin, service or account of an add-on), the SE Manager
rejects the action and shows an error message.

Centrally managed accounts

In addition to local accounts, an administrator or security administrator can also permit LDAP accounts for the
various roles. These accounts are managed centrally on an LDAP server (in particular also the password).

In order to use LDAP accounts, the access to an LDAP server must be configured. In the Management Cluster,
access to the LDAP server can be configured specifically for one SE server. See section "Access to an LDAP
server". When this requirement is satisfied, the administrator resp. security administrator, when creating an account,
can release an LDAP account by means of the account type for the desired role. If the central account is the same
as the existing local account, no LDAP account can be released. When an LDAP account is removed, it is also
locked again.

Accesses to BS2000

All administrator and BS2000 administrator accounts have access authorization to the BS2000 console and
BS2000 dialog of all BS2000 systems. An administrator or security administrator can assign these authorizations
individually also to a BS2000 operator account, in VM2000 mode specifically for particular guest systems.

For information on accesses to BS2000 for BS2000 operator accounts, see section "Managing individual rights".

Accesses to the operating system on Application Units

The customer is responsible for configuring accounts in the operating systems on Application Units, possibly linked
to a strategy for particular roles or authorizations. This depends on the options of the operating system concerned.
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2.6.2 IP-based access to the Management Unit

By default, access to the MUs of the SE server is unrestricted for all IP addresses and networks. However, the
administrator can configure access to the MU (applies for the SE Manager and CLI) in such a manner that it is
possible only for explicitly entered IP addresses or for IP addresses from explicitly entered IP networks.

In a Management Cluster, the configuration is server-specific.

The current configuration of the access to the MUs is displayed in the IP-based access rights tab of the
Authorizations - > Configuration menu (see section "IP-based access restriction to the MUs").
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2.6.3 Redundant Management Units

Central operation and administration of the SE server is continued after an MU has failed if there is MU redundancy,
i.e. if the SE server has a second MU. The two MUs are equivalent in this case and each of them can be used for
administration.

Redundancy of the SKP functionality

On an SE server with SU /390, two MUs mean that the SKP functionality is also provided with redundancy. As a
result, when one MU fails the SU /390 can still be operated via the SVP.

With respect to the SKP functionality, one MU is always "active" and the other is "passive". Only the active MU can
access the SVP of the SU /390. SVP accesses of the passive MU take place by means of automatic redirection via
the active MU.

On the SVP console tab of the SU /390 you see the current status of the MUs with respect to the SKP functionality.
There you can also switch over the passive MU, i.e. the two MUs change status (see Systems - > [<se server>
(SE<model>) - >] <unit> (SU</390>), "Switching active Management Unit").

The SE Manager displays the current status of the SVP network and of the MU connections in the IP configuration
of the SU /390 (see Hardware - > Units - > [<se server> (SE<model>) - >] <unit> (SU</390>) - > Management,
"Managing the IP configuration").

Operating redundant MUs

When two MUs are available, in other words MU redundancy exists, you can log into the SE Manager on either of
the two MUs. Operation and administration of the SE server is possible without restriction on either of the two MUs.

In the title bar, the SE Manager displays the existing MUs and permits a "change" to the SE Manager of the other
MU via a link. You do not need to log in again, because, in the default case, a session on the SE Manager is global.
For this, the following requirements must be met:

® The MUs are registered at an external DNS domain.

®* The connection to the SE Manager was made via the DNS name of the MU (entering the DNS name of the MU
as address in the browser).

The MU on whose SE Manager the user is currently logged in is the local MU in this session, and the redundant MU
is the remote MU.
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2.6.4 Central logging

The SE server configuration provides centralized access to the Audit logging and Event logging functions as well as
to the Alarm management.

Audit logging logs every action that is executed on a Unit (MU, SU, HNC) of the SE server configuration via the SE
Manager, an add-on or a CLI command. Thus, every administrator can always see who performed which action
with which result and when.

The SE Manager displays all occurring events in the event logging with a timestamp, weight, name of the reporting
unit, name of the reporting component and message text. The most recent events are displayed first. To provide a
better overview, the recent events that you have not yet seen are also displayed in the Current events tab. The
Dashboard displays a summary of this overview in a separate tile.

The SE Manager displays the audit and event logging entries in the Logging - > Audit logging and Logging - > Event
logging menu (see "Displaying audit logging" and "Displaying event logging").

With the alarm management you can configure automatic SNMP trap or e-mail messages for events with certain
weights; this enables you to recognize important events like error situations earlier and to react quickly if necessary,
even in large SE server configurations.

The SE Manager displays the alarm management configuration in the Logging - > Alarm management menu (see
"Alarm management").
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2.7 Virtualization

The description is divided into the following sections:

®* |mplementation of VM2000

® Virtualization on Server Unit x86
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2.7.1 Implementation of VM2000

Depending on the architecture of the Server Unit there are two fundamentally different technical implementations of
VM2000.

Implementation principle for SU /390

On SU /390 VM2000 controls the hardware of the Server Unit.

The VM2000 monitor manages all VMs and provides its functions via the VM2000 interface.

The VM2000 hypervisor controls execution of all guest systems on the VMs. Differentiated scheduling mechanisms
ensure optimum execution of the guest systems.

Monitor VM VMm VMn
Monitor system
: Guest system Guestsystem
VM2000 e ¥
monitor
r r
b
Virtual HSI Virtual HSI Virtual HSI
for monitor VM for VMm saia for VMn
Y “ 4
v Y v
VM2000 hypervisor
r
h 4
VM2000 HSI
HS| offered VM2000 extensions

Figure 8: Structure of VM2000 on SU /390

In this case, HSI stands for "Hardware Software Interface".

Further information is provided in the "VM2000" manual [12].
Implementation principle for SU x86

On SU x86 the X2000 basic system controls the hardware of the Server Unit.

The VM2000 monitor manages the VMs with the guest system BS2000 (BS2000 VM) and provides its functions via
the VM2000 user interface.

The Xen hypervisor virtualizes the global resources CPU and main memory, controls the execution of all VMs
(scheduling), and ensures load balancing for CPU usage.
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Figure 9: VM2000 on SU x86

Further information is provided in the "VM2000" manual [12].

Roles
Actions for the BS2000 VMs can be initiated from different roles:

® Fundamental functions for VM management (including configuring BS2000 VMs), operating the BS2000 VMs,
and device management are available to the administrator in the SE Manager.

® The full VM2000 functional scope is available to the VM2000 and VM administrators via the interface of VM2000.
The VM2000 commands operate and manage all BS2000 VMs. A detailed description of the VM2000 functional
scope is contained in the "VM2000" manual [12].
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2.7.2 Virtualization on Server Unit x86

Virtualization permits parallel execution of BS2000 systems with their applications on a Server Unit x86. The basic
software X2000 together with Xen and if necessary VM2000 permits other systems to execute.

BS2000 operation

BS2000 operation is possible in either Native or VM2000 mode:

® In Native mode, precisely one Native BS2000 system is available.
® |n VM2000 mode, a BS2000 system, the monitor system, is started under VM2000. Additional BS2000 VMs can

be created in the SE Manager or with VM2000.
Main memory management

32 GB of the existing main memory is reserved for the X2000 carrier system. In addition, memory for the firmware
of the individual BS2000 systems is heeded.

BS2000 can use the remaining main memory on the Native system or on the BS2000 VMs.

The main memory is always allocated to the respective guest system only when a virtual machine is started (or

when a BS2000 VM is created/activated), provided that free main memory is still available in the requested amount.

CPU pool management

The real CPUs of the Server Unit x86 are allocated to groups, which are known as CPU pools. Each real CPU can
be assigned to at most one CPU pool.

One main objective of this distribution to different CPU pools is to seal off the carrier system X2000 from the other
systems. For the operation of BS2000 this ensures a stable performance in accordance with the SE server model.

A virtual machine (VM) is assigned permanently to a CPU pool when it is generated. It can use only the CPUs from
this CPU pool, even if CPUs in parallel CPU pools are unused. The scheduling of CPU performance always relates
only to the CPUs of a particular CPU pool. The weightings between individual VMs (via limitation and weight) in a
CPU pool can thus not influence the weightings among the VMs in another CPU pool.

The distribution of the real CPUs to CPU pools is implemented automatically on the basis of the installed hardware
and the installed licenses when the Server Unit x86 is started up and cannot be changed by the user. The CPU
pools can be extended by integrating further hardware or by installing further licenses.

The BS2000 CPUs, i.e. those CPUs which are used by the BS2000 systems in accordance with the server model,
can be split into further CPU pools using VM2000 means.

The hardware and licenses are installed by Customer Support, and this requires a maintenance window.
In normal operation the CPU pools are configured and managed as follows:

® Pool 0
This pool is reserved exclusively for the X2000 basic system. It contains a quarter of the existing real CPUs, but
at least 2 CPUs.
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® BS2000 pools
The standard pool is used exclusively by the Native BS2000 system or by the BS2000 VMs. Provided no further
BS2000 CPU pools are configured, this pool contains all the BS2000 CPUs.
When further CPU pools are configured with VM2000 means, the BS2000 CPUs can be displayed in other
BS2000 CPU pools. The standard pool is retained in this case, but may possibly no longer contain CPUs.
BS2000 VMs are assigned to one of these CPU pools when they are created. In ongoing operation, VM2000
means can be used to switch them dynamically between these pools.

® Depending on the hardware and licenses which are installed, further unused real CPUs can exist in the Server
Unit outside the pools, the so-called free CPUs.

The CPU pools are also visible under VM2000, but the naming of static pools is retained in VM2000 for
compatibility reasons. The table below shows the names of the CPU pools in the X2000 basic system and the
names in VM2000.

CPU pool Users Name in X2000 Name in VM2000
Pool 0 X2000 | Pool0O *POOLO
Standard BS2000 pool BS2000 | bs2_pool *STDPOOL

co_bs2_pool 1

Pool configured in VM2000 BS2000 <name 1..8> <name 1..8>
co_<name 1..8>1

Free CPUs (not a pool)
Table 3: Overview of the CPU pools (X2000 and VM2000 views)
1For CPUs which are not attached. These are as a rule the CoD CPUs (which are called extra CPUs in VM2000)

In normal operation enough CPUs are available for every pool. A lack of CPUs can occur in the following
exceptional situations:
®* Reduced operation: a hardware failure means that fewer CPUs are operational at system startup.

® Abnormal operation: a change of license means that more CPUs are required.

In the case of reduced or abnormal operation the basic system automatically reacts with the following step-by-step
measures to rectify the lack of CPUs:

The (free) CPUs not used so far are used

The BS2000 CoD CPUs are omitted (CoD means Capacity on Demand)

Alternating omission of one CPU of the BS2000 pool down to 2 CPUs

Pool 0 is reduced to 1 CPU

The last but one CPU of the BS2000 pool is omitted

o~ 0w NP

The SE Manager displays an overview over the available BS2000 CPU pools (including empty pools) and an
overview over the BS2000 VMs to which a CPU pool is currently allocated as well as their current assignment to the
defined CPU pools under Systems -> [<se server> (SE<model>) ->] <su-name> (model) -> VM resources.

For information on BS2000 and BS2000 VMs, see also section "Working in Native BS2000 mode" and section
"Working in VM2000 mode".
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BS2000 devices

The real devices of the periphery are not directly visible to BS2000 (Native BS2000 and BS2000 VMs). Only the
devices emulated in the X2000 basic system are visible. See also section "Managing devices".
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2.8 Time synchronization

Basic state without external time synchronization
In the SE server the MU, SU x86, HNC and the optional AUs each have their own time management.

When the SE server is installed, Customer Support sets the exact time in the BIOS setup of each Unit. By default,
the MU is configured as the NTP server for SU x86 and HNC via the MCNPR. By default MU and AU use the time
set locally in the respective basic system. If differences occur on the MU, SU x86 or HNC, the administrator can
correct the local time on the MU manually in the SE Manager (under Hardware - > Units [- > <se server>
(SE<model>) ] - > <mu> - > Management - > System time).

On an AU the time is corrected with the resources of the operating system used (by default Linux).

The SVP time (on SU /390) and the Linux time of the SU x86 (on SU x86) are important as a time base for the
BS2000 systems (see "Time synchronization in BS2000"). Consequently, only time synchronization of the SU is
examined below.

Time synchronization of an Application Unit is possible with the resources of the operating system used.

SU x86 MU
BS2000 i Linux |
Linux System time |
System time
? AU
X2000 SVP clock, Linux (default)
TODR I TabA Linux System time
Linux System time
3
v
MCNPR

MANPU

Figure 12: SE server with SU x86 only without external time synchronization (synchronized internally via the MU)

Time synchronization of the SU with an NTP server

If a server with a more accurate system time can be reached over the network MANPU/MONPU, the local system
time can be synchronized with this server using NTP (Network Time Protocol). As soon as the administrator has
entered this server as the MUs NTP server, an NTP process starts which periodically adjusts the local time to the
NTP server’s time:

® |f at startup time a deviation of more than 0.1 seconds exists, the process sets the time absolutely precisely
(accurate to the millisecond).

* |n the subsequent time comparison, any time differences are adjusted relatively precisely. The local time thus
remains accurate to within a few milliseconds.

This process is restarted if the NTP configuration or the accessibility of the NTP server changes (e.g. reachable
again after a connection failure).
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By and large it is sufficient to configure one (external) NTP server on the MU.

SU x86 MU
BS2000 Linux |

||' Linux System time | -

E AU |
X2000 SVP clock, Linux (default)

I U Linux System time
Linux System time
MCNPR
MANPU NTP
server
P —

Figure 13: SE server with SU x86 only with external time synchronization

The SE Manager displays the current NTP configuration, see section "Setting the system time (time synchronization
or local)". In addition to the status and the current time difference, the accuracy of the NTP server's time is also
displayed. The accuracy of the NTP server’s time, the NTP server quality stratum, is specified in quality levels from
1to 15. The best NTP server quality level 1 has a radio clock.

The administrator can also enter more than one NTP server. In this case the NTP process selects a server which is
currently accessible and has the most accurate time.

NTP configuration in the Management Cluster

An external time server should be configured in the MUs of the Management Cluster.

® |f no external time server is configured or if it cannot be reached, the time of all units is synchronized with the
local time of the MUL1 of the local SE server.

® |f an external time server is configured (MU1 and MU2) and can be reached, all units (HNC and SU x86) are
synchronized with the MU1 of the local SE Server. If the MU1 cannot be reached, all units are synchronized with
the MU2 of the local SE server.

In all units, the MUs of the local SE server and the MU1 of the first SE server are entered as NTP server.

® The IPv6 address in the network MCNPR is entered.
® The MU1 in the first SE server receives the stratum value 7.
® Every additional MU1 receives the stratum value 8.

® Every MU2 receives the stratum value 9.

Time synchronization in BS2000

On SU x86, the basic software X2000 is initially responsible for the time synchronization. X2000 emulates the
clocks used on /390 architecture, namely the Time of Day Register TODR and the SVP clock, for BS2000, the SVP
clock always supplying the current Linux time.
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On SU /390, the MU communicating with the SVP of the SU /390 is responsible for the time synchronization in
BS2000. The SVP clock of the SU /390 always receives the current Linux time from this MU.

BS2000 is automatically synchronized with the SVP clock, and thus with the Linux time. As the command for
reading the SVP time ignores the milliseconds, the time can be inaccurate by as much as one second. If this
inaccuracy is too great, an NTP connection within BS2000 can also make sense.

If the Linux time is synchronized using an NTP server, this automatically also applies for BS2000. If the NTP server
has an NTP server quality with a stratum <= 4 and the current time difference is less than one second, BS2000 is
shown that the Linux time available is as accurate as the radio clock (see SYNCHRONIZATION in the output of the
SHOW-SYSTEM-INFORMATION INFORMATION=*SYSTEM-TIME-PARAMETER command).

If the Linux time is not synchronized using an NTP server, all the other synchronization instances in BS2000 (NTP
or XCS) can apply.

An NTP instance in BS2000 with a stratum <= 4 is always higher ranking than an SVP time with a radio clock
(which is equivalent to a Linux time with a stratum <= 4).

Repercussions of changing the system time on the Server Unit

When changes are made in the Server Unit's time management, greater or lesser leaps in time can occur in the
following cases:

®* When the local time is set manually (if no NTP server is configured).

®* When an NTP server is entered for the first time (possibly also when modifying the NTP configuration).

In the current BS2000 session, leaps in time have the following effects:

® The modified time is forwarded to BS2000. Every 15 minutes BS2000 compares its time with the SVP clock. If a
time difference is detected during synchronization, the time is adjusted over a period which is approx. 4 times as
large as the time difference (i.e. an adjustment of 2 minutes takes 8 minutes). As a result, time changes on the
Server Unit arrive in BS2000 with a corresponding delay.

® BS2000 accepts a time change of at most 15 minutes.
If a leap in time is <= 15 minutes, the time adjustment is made without issuing any messages. If the leap in time
is greater, the time is not adjusted. A console message indicates that from this point the BS2000 session will run
only using its own time from the TODR. At intervals of 15 minutes, BS2000 repeatedly compares the times, and
synchronizes them only if the time difference is less than 15 minutes.

Details on configuring the system time on the MU are provided in the section "Setting the system time (time
synchronization or local)".

Further details on system time management in BS2000 can be found in the manual "Introduction to System
Administration” [10].
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2.9 Customer Support and maintenance

The SE server is normally connected to remote service. The connection to the Support Center is established via the
Management Unit using an internet connection (AIS Connect).

Customer Support configures the remote service in accordance with customer wishes when system installation is
performed or when the SE server is placed in service.

In the SE Manager, the pages under the Service category serve as an interface between customers and Customer
Support. You can also find more details on this under Managing service-related functions.

These topics are dealt with below:

® Tasks of Customer Support
® Tasks of the customer

® Handling updates
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2.9.1 Tasks of Customer Support

Customer Support has the following tasks:

® Diagnostics and debugging

® Software/hardware maintenance work
© Installation of updates
© Software/firmware upgrades
© Model upgrades

® Hardware upgrades

The contractually agreed annual maintenance
© Updating the software/firmware

© Changing batteries

© Customer-specific measures

© Configuration data backup at the end of the maintenance work

i Maintenance state

During maintenance work, you or the service team set the maintenance status (SE operating state
Maintenance) to make all users aware of the special situation.
See also the "Information” section in the "Managing service-related functions" chapter.
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2.9.2 Tasks of the customer

In some cases Customer Support sometimes needs your assistance on site to perform maintenance activities. As a
customer, you have the following tasks in the maintenance strategy:
® Permitting access to the SE server

© Opening remote service access if required (requirement for the service and maintenance strategy)

© Permitting access to the rack (e.g. to the local console)

® Assisting Customer Support when there are software/firmware updates for the units. In agreement with
Customer Support, the following tasks may need to be performed:

© Transferring the updates from CD/DVD to disk

© Uploading the updates

© Uploading, installing and uninstalling add-on packs
© Deleting update files which are not installed

® Generating and supplying diagnostic documentation
For the standard generation of diagnostic documents, see the chapter Generating diagnostic data.
Other diagnostic documents available on the Management Unit in file form can be made available to the service
with the command ai sTr ansf er . Its description can be found in the online help.
Other diagnostic documents such as screenshots can be sent directly to the service by mail.

® Scheduled provision of an annual maintenance window of approximately 5 hours

® If necessary, also unscheduled provision of a maintenance window

The following also applies when Application Units are operated:

® As customer you are responsible for operating the software on the Application Units.This includes tasks such as
software installation, configuration, updates and importing patches. You obtain updates and patches yourself as
part of your license agreement.

® [f required, you install a new operating system or modify the SE server’'s LAN configuration and ensure the
connection to status monitoring and remote service.

* When maintenance is performed, you grant Customer Support at least temporary access to the Application Unit
s IRMC and root access to the operating system level of the Application Unit. The procedure and the type of
access are agreed on individually between you and Customer Support.

Customer ID and serial numbers

When communicating with Customer Support, always specify the customer ID of your SE server that allows the
service to identify your server configuration unambiguously. Determine the customer ID as follows:

> |n the tree structure select Service -> Information.

The Information tab shows the customer ID for the SE server.

In addition specify where appropriate the serial numbers of the system components. Determine the serial numbers
as follows:

> In the tree structure select Hardware -> HW inventory [-> <se server> (SE<model>) ] and open the Units tab.
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> Then click the Details (“® ) icon by the desired unit. The Show details dialog box informs among other things
about the unit's serial number.

Alternatively you can also inquire this information as follows:

> In the tree structure select Hardware -> Units -> [<se server> (SE<model>) ->] <unit> -> Information.

The System tab shows system information for the selected unit.

Maintenance windows of the SE server

The SE server is designed to operate without interruption. To guarantee interrupt-free operation over lengthy
periods, Customer Support performs certain maintenance work roughly once a year. This maintenance work (e.qg.

the installation of corrections) is performed within planned maintenance windows agreed on with the customer (e.g.

in periods when there is a minimum load on the server).

i Maintenance state

During maintenance work, you or the service team set the maintenance status (SE operating state
Maintenance) to make all users aware of the special situation.
See also the "Information” section in the "Managing service-related functions" chapter.
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2.9.3 Handling updates

Providing updates

Updates of the basic system you can receive by email, on CD/DVD or by means of remote service.

Tasks and responsibilities when installing updates

The table below shows the tasks of the administrator and of Customer Support and also the sequence when
installing and managing updates.

Update type = Administrator Service

Update

Provide maintenance window | ® Clarify requirements
(if necessary) * Procure update
® Transfer update to system (via remote service or on site)

® Install update (via remote service or on site)

Add-on pack

Clarify requirements1 ® Clarify requirements1
® Procure software
® Transfer software to system

® |nstall/uninstall software

1 with respect to optional add-on packs or new versions of the add-on packs installed by default
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3 Operating the SE Manager
This chapter describes how you operate an SE server using the SE Manager.

Requirement:

To enable you to access the SE Manager GUI and operate the SE server(s), one of the following web browsers
must be installed on your computer.

The web browsers currently supported are:

® Mozilla Firefox Version 128.5.1 (ESR) and higher
® Microsoft Edge

® Google Chrome

Restrictions can apply when other browsers are used (e.g. for uploads, downloads, display of certain pages like
Hardware inventory).

The chapter is subdivided as follows:

® Calling the SE Manager, logging in and logging out
® Session management
© Session timeout
© Automatic update
© Restricted operation mode
® SE Manager interface
© Window types
© Main window
© Terminal windows
© Dialogs
© Wizards
© Web Uls of Application Units
® Working with the SE Manager
© Calling an object or function in the SE Manager
© Navigation
© Filtering, sorting and exporting a table
© Executing an action
© Calling the online help

© Error handling
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3.1 Calling the SE Manager, logging in and logging out
> As address, enter the FQDN (Fully Qualified Domain Name) of an MU of the SE server into the address bar of

the browser.

> Press the ENTER key.

i If the browser now displays a warning about the security certificate, click Continue to this website.
The procedure for confirming or importing a certificate is described in more detail in Section
"Confirming/importing a certificate in the web browser".

The connection is set up. The login window is opened. The login window provides access to the web
application. It has a different format from the other windows:

SE Manager RSy
Mapagesuarg Unlt DE | Help

Logm

Sysfem shgsemul.example net
Please iog in willh your user accounl and password

Account i
Passwond

Login

Access to the SE Manager is protected. You must log in with your account and the associated password.
Exception: The SE Manager help is unprotected.

> Enter your account in the login window.

> Enter your password.

i When the SE server is supplied, an initial password is set for standard account admin, which can be
requested at the service. Change the password immediately after you have logged in for the first time
(see section "Managing passwords").

The login window is also displayed to permit you to log in again if you have logged out or the session was
terminated owing to inactivity (see the section "Session management").
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> Click Log in.
To increase security, multi-factor authentication (MFA) can be configured for accounts. In this case, a one-
time password has to be entered additionally in a second step. This password is generated using an
authentication app. For more details, please refer to section Managing multi-factor authentication and to the
SE Manager help.
The Dashboard tab opens as the welcome page. It provides a quick overview of the systems, BS2000
messages, units/partitions, IP networks, FC networks, storage, users of the SE server and occurred events. If
at least one cluster exists, the tab also contains the status of the existing clusters.
The information displayed is described in the SE Manager help.
.
__ Management Uik (Basel) - 1. Pleass be aware of e cutent inicrmation]
47} Status ovarview E =
¥ Dashboard
I Systems 3 1 Systems L/ 2 BS2000 messages 24 Units/Partitions 1/
(=] speieaton G ] RUNNING W3 ouUESTION 7] NORMAL
{7} Pertcrmance B sNACTIVE D sTOFFED
L} NOT_ACCESSIBLE ] UNCONFIGURED
a Devices
: g™ ; 22 IP networks 2 FC networks 6 Storage !
L‘.E i . 1 NORMAL 2§02 ERROR B oK
Y Authorizations B erROR ¥ 1 WARNING
D Logging
@ Service
75 Events 24 Users 2 Cluster
- NOTICE 51 ACTIVE SESSIONS E NORMAL
| WARNING P WARNING
Logging out
> In the header area of the SE Manager main window click Log out to terminate the session. See section "Main

window".

The login window opens.
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3.2 Session management

When you log in on the SE Manager, a session with a unique session ID is set up. The server regards all requests
with the same session ID as connected and they are assigned to your account. The SE Manager displays an
overview over the active sessions under Authorizations -> Users -> Sessions (see section "Displaying sessions").

This means in particular that a session which has not yet timed out is regarded as still valid when, in the browser,
you close the tab via which you are logged in on the SE Manager (without logging out explicitly). When you connect
to the SE Manager again before the session timeout has expired, you are redirected again to the main window
opened most recently without having to log in once more.

Local and global sessions
SE Manager sessions are global under the following conditions:
® The MUs are integrated into an external DNS in the same network domain.

® The SE Manager is called via the DNS name of the MU (entering the FQDN) and not via the IP address.

A global session is a cross-MU session. This means that in SE server configurations with more than one MU (MU
redundancy or Management Cluster), you only have to log in at the SE Manager of one MU. After that, you can
switch from the SE Manager of the local MU to the SE Manager of another MU without having to log in again.

The same is true for add-on applications, i.e. you can operate the add-on applications on a different MU from the
local SE Manager.

A local session is MU local. It is only created if you address an MU via the IP address during login. The name of the
MU for which the session is valid, is displayed. You must log in again when you switch to another MU.
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3.2.1 Session timeout

You click Log out in the header area of the main window to terminate the current session explicitly. The session
expires without explicit logout if you are inactive for a longer period of time, i.e. if the SE Manager does not register
any action within a certain period of time. The default setting for this time is 20 minutes after creating an account.

Users can change this setting for themselves in the range from 5 through 60 minutes or disable the session timeout
at all:

> Click in the login information in the header area. A list containing the menu item Individual settings opens.

> Click Individual settings. The Change individual settings dialog box opens in which you can enable/disable the
session timeout and set the timeout in the range from 5 to 60 minutes.

The individual setting is stored in the SE Manager on a user-specific basis.

If you click in the main window after the session has terminated, the login window opens and you must log in again.
When you start an action in a dialog box after a session has timed out, the following message appears:

The action could not be executed. Your session has expired. Please log in again.

The login window appears after the dialog closes. See section "The dialog"”.
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3.2.2 Automatic update

Automatic update ensures that the data displayed in the main window is up to date. All the data displayed is
updated in each cycle, in particular:

® the object lists and their statuses in the working area

® the object lists and their statuses in the tree structure
For information on "working area" and "tree structure", see section "Main window".

Main windows with automatic updates are identified by the Update icon (wheel =+#) in the right upper corner of the
main page. If there is currently an update in progress, the wheel is rotating. If there is currently no update in
progress, the wheel is greyed out. If you drag the mouse cursor over the icon, the "Automatic update follows" tool
tip is displayed. All main windows for which an up-to-date status display is important, support automatic updates.
You can find the current list of these main windows in the online help.

By default the automatic update is switched off for each user. Each user can change this setting for themself so that
an automatic update takes place every 10 to 120 seconds or switch off the automatic update again. The setting is
specified in the Change individual settings dialog box (see section "Session timeout"). The individual setting is
stored on an account-specific basis.

The automatic update is suspended as soon as an action is selected in the main window (e.g. when an action is
selected in the Actions group in the Operation main window for a BS2000 system). In this case, the Continue with

o
automatic update icon (*) is displayed instead of the update icon. Clicking this icon continues the suspended
automatic update.
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3.2.3 Restricted operation mode

There may be situations in which the SE Manager does not have full access to all its resources. This may be the
case if an MU is shut down or if time is needed for the reconfiguration of the Management Cluster.

In these situations, the operation mode for the active sessions is restricted for a short period of time and no actions
are possible. Access to BS2000 consoles, BS2000 dialogs and the SVP is still possible.

The SE Manager indicates the restricted operation mode in the header of the main window as follows:

E SE Manager Aftention: Restricted operation mode! No actions available! _

Management Unit (abgse2mu1) {Location 1] ~

In dialog boxes, the restricted operation mode is reported with the following message:
The functionality of the SE Manager is currently restricted! No actions possible!

As soon as the SE Manager has regained access to all its resources, the restricted operation mode terminates
automatically.
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3.3 SE Manager interface

The sections below describe the interface of the SE Manager and introduce terms which are used in the manual.

®* Window types

® Main window

® Terminal windows
® Dialogs

® Wizards

®* Web Uls of Application Units
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3.3.1 Window types

Various window types are used in the SE Manager:

Login window: a window in which you log in using your account and password. See section "Calling the SE
Manager, logging in and logging out".

Main window: a window which is always visible between logging in and logging out on the SE Manager; it
contains the navigation elements and the workarea in which information is output and actions are initiated.
See section "Main window".

Terminal window: a window which is opened from the SE Manager and enables access to the BS2000 console,
BS2000 dialog, SVP console or the shell of the MU. A terminal window can only be opened when there is an
active session and subsequently remains open irrespective of the SE Manager's session.

See section "Terminal window".

Dialog box: a window which opens when an action starts and closes again after the action has been completed.
It is also used to output error messages concerning the action being performed.
See section "The dialog".

Wizard: a utility which guides you step by step through a sequence of windows (dialogs) to perform a task.
See section "The wizard".

Help window: Window which opens in a separate tab or window of the browser when you call the online help.
See section "Calling the online help".
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3.3.2 Main window

The main window of the SE Manager opens as soon as you have logged in on the SE Manager. The next two
figures provide an example to name the areas in the main window and the principle controls.

SE Manager: areas in the main window

a 2 3 c d
1 1 b [ &
E SE Manager
___Management Unit (ugano) [Svizzera]| » L Please be aware of the current information! DE_ | Help
Dashboard
8 i (@)
% Dashboard s gy 2
Syst 3 ;i
£ Sysioms £ 42 Systems 1) 9 BS2000 messages 3 1 Units 1
ED Applications > = X
5] RUNNING I} QUESTION JF1-] NORMAL
€7} Performance 3 ) INACTIVE KN STOPPED
NOT_ACCESSIBLE 1) NOT_ACCESSIBLE
a Devices
. Hardware 3
2 6 IP networks & switches 4 FC networks & switches 7 Storage
@ Cluster 3
¥ |77 NORMAL "7 NORMAL BE) ox
As Authorizations > ] WARNING UNKNOWN
D Logging 3 " WARNING
@ Service >
1 25 Events 1 8 1 Users 2 Cluster
A NoTIcE 1/l ACTIVE SESSIONS (Il NORMAL
[ WARNING {1l WARNING
4

1: Tree structure
Main menus for selecting objects which are displayed in the working area
2: Tabs

Tabs for selecting objects which are displayed in the working area.

If the main window supports automatic updates (see "Automatic update"), the Update icon (wheel #s#) is
displayed on the right-hand edge. During an update, the wheel is rotating. Otherwise it is greyed out. When the

u
automatic update is suspended, the icon Continue with automatic update (=) is displayed instead.
3: Header area

Contains general information and settings for the SE Manager:

a Click the icon to hide or display the tree structure again.

b ' Management Unit (<unit>) [location] provides information about the Management Unit via which you are
currently operating the SE Manager.

<unit> is the name of the Management Unit.

If a location is configured with SYSLOCATION, <location> displays the entry. For the configuration of
the local system data see section "Managing SNMP".
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c Displays the login information: user account or, if defined, the person-related name of the user account.
When you click the field, a selection menu with the following entries opens:

® Individual settings
Opens a dialog box in which you can set the cycle of the automatic updates and the session timeout
for your user account.

® Reset tables
Resets all tables of the SE manager back to standard view after confirmation. Changing and resetting
the table settings is always MU specific.

A tool tip for login information displays the values currently set.
d Click Log out to end the session.
e Clicking the language option displayed (DE or EN) switches the web interface to the language selected.

f  Click Help to open the SE Manager help in a new tab.

g This hint is displayed regardless of the currently called main page, if an information has been
configured (see "Information™).

4: Working area

Displays data and enables dialog boxes and wizards to be opened to execute actions.

SE Manager: elements of the main window

- ¥
= seAdministrator

Update | CSR | Diagnostics | Remote Senice
o~ v Management Unit mainz: SW version V6.6A0107 (7)) =—— 3
™ Dashboard
_-:I'ran's-f'er update from CO/DVD to system | [—1— 4a
{j’ Systems be
+ Management Unit mainz: Add-on packs Q)
B Applications 5
. Upload add-on pack | —r—14b
. Hardware b = S : —
6 Authorizations b3 Fitter All v Al v A1l &
OPENSM2-21.0.7-0.0 Online Not installed ® O M 9 ——5
Logging 3 OPENUTM-7.0427-5.0 Online Mot installed ® O 98 9
ROBAR-7.7C00-1.0 Online Installed P RUNNING ® 0O “;m b
@ Service v STORMAN-10.3.0-1 Partial Installed P RUNNING ® O "E |
Information (%] : Total: 4 «——— 6
| Configuration T g
Remote senice | * Management Unit mainz: Updates No update available 0.(0) (7)
= Units —
' mainz (MU)

1 Active main menu of the tree structure
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2

4a,
4b,

4c

Active tab
Help icon for calling the SE Manager help on a context-sensitive basis (see "Calling the online help")

The information may be subdivided into groups (in the example above, 4a, 4b, 4c). If the groups can be
expanded, the arrow icon in the group header indicates the current status (expanded or collapsed). If
collapsed, the group header also contains the number of contained objects: Total <n> (see 4c in the above
example).

Each group contains one or more tables with properties of the objects displayed.

Icons for triggering actions. Depending on the situation, icons may be deactivated (greyed out); in such
situations the corresponding action cannot be triggered.

Number of entries in the table Total: <n> or Total <objects>: <n>
The Export of table icon allows to export or print the table data.

As soon as the settings of a table (e.g. filter or sorting) have been changed, the reset icon is displayed
below the table. If you click the icon, the SE Manager again displays the table with the default settings.

77



SE Server - Administration and Operation - User Guide

3.3.3 Terminal windows

BS2000 console window, BS2000 dialog window, SVP console window, AlS Connect shadow terminal, and shell
terminal (CLI) on an MU are opened in a separate terminal window (SE Manager's Virtual terminal, SEMVT) after
they are called in the SE Manager. Subsequently the terminal window remains open irrespective of the SE
Manager's session. The following example shows a terminal window with a BS2000 dialog:

................................................................................ ~
CNe4 CONNECTED WITH MANLO1$DIALOG; IND=C':: -ccseraencnnsnnnnasnanasnncsasnannns
% JMS@15@ INSTALLATION '39@SU- 700-70', BS2000 VERSION 'v21@', HOST 'ABGSE211’
: PLEASE ENTER '/SET—LOGON—PARAMETERS' OR '"?' s setnssanstsssasssansssnssssasnnsns
] - E
LTG TAST
v
| Display keyboard | | Display settings | Connected

The terminal window and its embedding in the SE Manager have the following properties, among others:

® No further login is required when the terminal window is called.
® The size of the window can be changed flexibly.

® A virtual keyboard (matching the functionality) can be displayed or hidden as needed: The virtual keyboard
enables all required characters and function keys to be entered irrespective of the real keyboard's layout.

® Several properties of the terminal window are configurable.

® You can transfer text between Windows and SEMVT via Copy & Paste. In SEMVT this functionality is available
from the context menu (right mouse button).

® The current status of the connection is displayed in the lower right corner of the terminal window:
During initialization of the terminal window, a yellow status icon and the text Initializing... is displayed.
A green status icon and the text Connected indicates that a connection exists. The terminal window can be used
normally.

A red status icon and the text Disconnected indicates that the connection has been terminated or is broken. In
this case, a message describing the reason for the loss of connection is displayed. In addition, in front of the icon
the button Reconnect is offered to restore the connection (a prerequisite for this is that the SE Manager session
in which the terminal window was opened is still active), and another button Hide message resp. Show
message allows for hiding or showing the message. The terminal window is closed by pressing the Enter key.
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If you want more than one terminal window to remain open in parallel (e.g. with BS2000 console
windows), this must be supported on the client side by the number of possible connections to a server. To
achieve this, you must configure your browser to support the desired number of parallel connections, if
necessary.

Firefox for example by default supports six simultaneous connections to a server. A higher number can be
configured as shown in the figure below.

@ sboutcanfig - Mazills Firefoy e & =]
e Edir Higtery Hooliman fanls Wk — =
about:config % |\ +
€ L) Fieine | abouticonfig C || Q Search wTE D AR =
Search: R
Freference Name - Status Type Value m
network,http.max-persistent-connections-per-proxy  default integer Er ~
rienwvork. it max-persistent-connectons-per-server  default Integer
network. http.network-changed timeout default integer §
network.http.pacing requests.burst default integer 32 = i
network. httppacing requests.enabled default boolean trug ffﬁ"—-‘"&m"w}]’!— ; @
netwaork hittp.pacing.requests.hz default nteger 100 . -
\ ) ) ; _ 0 nebwork http.max-persistent-connections-per-server
network http.pacing.requests.min-parallelism default integer fi :
netwark, http.pipelining default boolean false 18
network.http.pipelining.abtest default boolean false [ oK ] l Cancel [
network.http.pipelining.aggressive default boolean false
network.http.pipelining.max-optimistic-requests default integer 4
nehunrk. htronmelininaomacee aue s default intener 7 -
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3.3.4 Dialogs

A dialog opens as soon as you start an action. Example:

& SEManager :: Action — Mozilla Firefox = m} X
O E} httpsy/ /sem/fauth/user/accounts/create him w ﬁ =
Add account @
Add a new account.
Type of account (O Local (@) LDAP
Role @ Administrator (7) Other role
Account i
7] Check account in the LDAP directory tree
Comment i) optional

A dialog comprises:
® Title bar with the following information:
SE Manager :: Action

® Header area
Information on the action

Help icon (@, optional) for calling the help on a context-sensitive basis

® Parameter area (optional): fields for entering or selecting parameter values. The syntax check takes place

immediately when a value is entered in a field. An info icon (Ri:') is displayed next to entry fields. When you drag
the mouse over the info icon, possible values or the syntax to be used are displayed.

® Area with the labeled buttons, e.g. Add and Cancel.

After opening the dialog you have the following options:

® You can use options to control and confirm the action.

® Oryou can confirm the action (dialog box with empty parameter area)
Alternatively you can also cancel the action.

You start an action using an icon or button. By pressing only the enter key you activate the default action
(highlighted button). Following confirmation the action is executed and the dialog box remains open. Each action
displays feedback in the associated dialog box. You can then terminate the dialog box with Close and thus refresh
the working area of the main window. If you close the dialog box in another way, the working area is not refreshed.
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i No types of lock are provided when actions are executed. This means that, for example, multiple dialog
boxes can create, select or delete the same object in parallel. When devices are configured, the same
unit IDs or MNs can, for example, be selected simultaneously. All actions are executed for this object, but
only the first action is successful and the other actions fail and lead to an error message.

When an action has failed, in addition to the error messages the original message of the command called
can also be displayed. Irrespective of the language setting in the SE Manager, such original messages
are always displayed in English.

You can press function key F5 to update the SE Manager manually. Not every action modifies the table contents.

i Do not close the dialog using the close function in the browser window because the working area is then
not updated immediately. The browser functionality should never be used in dialogs.

The section "Executing an action" describes what you must take into account when executing an action.
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3.3.5 Wizards

A wizard is a utility which takes you through a task step by step.

As a rule a wizard consists of several steps (dialogs) which you must complete. The humber of steps in a wizard
depends on

® the number of parameters which are required for the action

® the grouping of the parameters

You control execution of the wizard using the buttons at the bottom right in each step.
Next > Opens the next step in the wizard.
< Back Opens the previous step in the wizard.
Cancel Cancels the wizard without saving your changes.

<action> Closes the task and executes the wizard with your settings.
<action> on the button means the action to be executed, e.g. Add or Create.

Feedback from the system is displayed in the wizard's last dialog box.
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3.3.6 Web Uls of Application Units

On Application Units, web applications such as a VMware ESXi Server can run, which are operated using a
browser window of their own.

Example:
A VMware ESXi Server runs on the AU.

Systems - > [<se server> (SE<model>) - >] <unit> (AU <model>) - > <vm-name> leads to the Operation tab.

Operation
Application Unit abgsqs09 VM SLES12-5P4: Status (7
VM name SLES12-5P4
Status RUMNMNING
Operating system SUSE Linux Enterprise 12 (64-bit)
Humber CPUs 3
Main memory 4043 MB
Description System administrator John Doe, phone 089-12345 ,f
Application Unit abgsqs09 VM SLES512-5P4: Operation @
VMware vSphere Web Client | open [
VMware Host Client | Open [
Application Unit abgsqs09 VM SLES12-5P4: Actions @
Action | Restart VM~ ~ | Execute

The Open action opens a separate browser window to execute the required actions. This window remains open
irrespective of the session.
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3.4 Working with the SE Manager

The following sections describe aspects of working with the SE Manager.

® Calling an object or function in the SE Manager
® Navigation

® Filtering, sorting and exporting a table

® Executing an action

® Calling the online help

® Error handling
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3.4.1 Calling an object or function in the SE Manager

Proceed as follows to call a function area in the SE Manager:

> Select an object or function in the primary navigation by clicking it.

A tab opens in the working area which enables you to manage or operate the object or function. Some
functions are distributed over more than one tab, and these are displayed at the top of the working area.

In the working area the content which belongs to the function area of the first tab is displayed in one or more
tables. Buttons or icons may also be available to execute actions.

If required, select another tab by clicking it.
Alternatively, you can also switch directly between the associated tabs in the tree structure using an object's

or function's tool tip.

The content of the working area changes if you select another tab.

The selected menu item and the selected tab are highlighted by being displayed in bold black print against a blue or
gray background.

Example

Service -> Units -> [<se server> (SE<model>) ->] <unit> (MU), Update tab

Service -> Units -> [<se server> (SE<model>) ->] <unit> (MU) corresponds to a selection in the tree structure,

Update to a selection in the secondary navigation, also called tab.

& seAdministrator =

E SE Manager

Management Unit (mainz) [MchE C1B]
CSR | Diagnostics | Remote Senice
o~ = Management Unit mainz: SW version V6.6A0107 @
A Dashboard
| Transfer update from CO/DVD to system |
= systems >
s e = Management Unit mainz: Add-on packs @
E Applications >
" | Upload add-on pack |
M Hardware S
Add-on pack = Inetan tion type | .. = on = 1
& Authorizations s Filter Al - [Lai - Al =
OPENSM2-21.07-0.0 Online Notinstalled @ O %\ ¢
Logging 5 OPENUTI7 0A27-5.0 Online Notinstalled ® & 9 9
ROBAR-7.7C00-1.0 Online Installed B RUNNING @ O ""FE ¥
{ service v STORMAN-10.3.0-1 Partial Installed BRUNNNG @ O Sg 9
1 Information o8 Total: 4

) Configuration

) Remote semvice sessions

» Management Unit mainz: Updates

Mo update available 0 (0) (2)

The objects and functions which are displayed in the tree structure depend on the server component and

the configuration.
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3.4.2 Navigation

The navigation in the SE Manager is distributed over the main menus Dashboard, Systems, Applications,
Performance, Devices, Hardware, Cluster, Authorizations, Logging, and Service. With the exception of Dashboard,
all main menus can be expanded (the Performance main menu only in a multi-MU configuration).

When you click a main menu, the tree structure beneath it expands. Below this you see objects and functions as
links. Navigation using the main menus is also referred to as the primary navigation.

When you click a link, a tab opens in the working area which enables you to manage or operate the object or
function. Some functions are distributed over more than one tab, and these are displayed at the top of the working
area. These tabs are also referred to as secondary navigation.

A main menu collapses in the following cases:

® When you click the main menu again.

® When you click a link in another main menu.

Dynamic extensions of the navigation
New links are created in the tree structure for the following functions:

® Systems main menu:

© when creating a BS2000 VM

© after a virtual machine has been created on an AU
® |P networks main menu:

© when creating a new network
* when installing an add-on - see the text below

® when creating a SU cluster or a management cluster - see for this also the text below

Links to add-on software

After add-on packs have been installed, the SE Manager can also contain links to the GUI of the software
concerned. When you click such a link, the GUI is displayed in the SE Manager. You use the SE Manager entry in
the GUI's main menu to exit the GUI and return to the SE Manager.

The Performance main menu is a link to openSM2. It is only available when the add-on pack is installed.

The link to the Storage Manager (STORMAN) is available under the Hardware main menu. It is displayed in the tree
structure with Storage. For STORMAN versions V10.3 and higher on the local MU, the Storage Manager is directly
integrated into the SE Manager. The STORMAN user interface is accessible immediately below the Storage menu.

The links to the add-ons ROBAR and openUTM are available under the Applications main menu.

Authorizations
The scope and thus the visibility of the functions depends on the role which is assigned to your account.

In the SE Manager, each user sees only those functions to which the role assigned to their account entitles them.

Expanded navigation in case of MU redundancy or Management Cluster

In a multi-MU configuration, the tree structure of the SE Manager contains the following additional elements:
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® |n the Applications menu, the openUTM WebAdmin and ROBAR add-ons are displayed MU-specifically in the

application overview.
The MU-specific link <add-on> (<mu-name>) links to the add-on on the respective MU.

Example:
G Applications v

= 5E management
BS2000 Backup Monitor
openUTM WebAdmin (wald)
openUTM WebAdmin (geneve)
openUTM WebAdmin (lugano)
ROBAR (lugano)

+ User-defined links

® In the Performance -> Performance (<mu-name>) menu, the MU-specific link always links to the add-on
openSM2 on the respective MU.

* |n the Hardware -> Storage menu, the Overview tab displays a total overview over the storage systems and
management software that the Storage Manager manages on all MUs. Storage systems that are configured on
multiple MUs are only displayed once, with the worst status. A tool tip lists the status for each MU.

The Hardware -> Storage -> Storage (<mu-name>) menu displays an MU-specific overview over the storage
systems and management software that the Storage Manager manages on this MU. Additionally, the menu
contains the link to the Storage Manager on this MU.

® |n the Hardware -> HW inventory menu, the Units tab displays in case of a Management Cluster a total overview

of all units of the participating SE servers.
The Hardware -> HW inventory -> <se server> (SE<model>) menu in this case displays the SE server-specific

tabs Rack view, Units, Components, and Administration.

® |n the Authorizations -> Certificates -> <mu-name> (MU) menu, you manage certificates of the respective MU.

Expanded navigation in case of installed add-on NUX

If the add-on pack NUX is installed on at least one MU, the structure of the primary navigation beneath the main
menus Systems and Hardware -> Units is extended: Both main menus receive rack-specific substructures SE<se-
index> AU<rack-index>xx corresponding to the name scheme of the AUs, under which the links to the individual
AUs of the rack (with a corresponding submenu if necessary) can be found.
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3.4.3 Filtering, sorting and exporting a table

On the tabs, the properties of the objects are listed in one or more tables. When a tab is called for the first time, all
the data available for the function selected is displayed in a default sort (sorting column and sorting direction). The
table column according to which the table is sorted is highlighted.

i In some cases, the default sorting is neither ascending nor descending but by some other criterium. For
example, the units in the unit table may be listed in the same order as in the navigation.

You can change the sorting criteria for the tables (columns) and, by filtering, the volume of displayed data.

The following properties are persistent, i.e. they are retained even when the window is changed and in the case of
automatic update.

® Filter and sort
® Scroll position
® Page if scrolling pages is possible

® Status (expanded or collapsed) if expandable elements are contained

As soon as a table is being sorted or filtered, the Reset table to default view icon ("EB') appears beneath it. Click the
icon to obtain the table in the default sort and without filters. To obtain all tables in the default sort and without
filters, click on Login information and select Reset tables.

i For automatic updates see section "Automatic update".

As soon as a table contains more objects than are set in Per page, a control bar appears above the table containing
the functions for scrolling and for paginating the objects to be displayed. Details for controlling the table view are
provided in the SE Manager help.

Filtering a table

Filters reduce the number of data displayed in a table based on certain criteria and make handling large tables
easier. You can use free text filters and filter lists to filter the data used to build up a table.
The filters for different table columns can be combined.

If a filter is set, the filter's field is highlighted.
With a free-text filter, hits are searched for at every position of a cell without differentiating between upper and lower

case. Otherwise, the rules for the so-called regular expressions apply when searching.

i Detailed information on filtering tables is provided in the SE Manager help. Here, the different filter options
are described at the places where they can be used.

Sorting a table
A table is sorted according to the values of a selected column.
> Drag the mouse cursor over the column headings in the table.

When the mouse cursor turns into a symbolic hand, you can sort the table according to the values of this
column.
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> Click the column heading.
The table is newly sorted. The selected column is highlighted.

If you click on the same column heading again, the sort order changes from ascending to descending or vice versa.

Sorting according to a different column cancels the previous sort order.

Export of table data

You can either print the data of a table or export it in XLSX format. To do this, choose the icon = pelow the table
to call up the Export of table dialog. Details can be found in the online help.
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3.4.4 Executing an action

This section describes how an action is typically executed.
You start an action in the SE Manager‘s working area. Two options are available after you have selected a tab:
> Click a button.

> Click anicon in a table (e.g. Change, Delete).
Icons always belong to a particular record (of a table row) and are therefore contained in this table row. Each
icon stands for a particular task which you can execute. Detailed information on the SE Manager's icons is
provided in the SE Manager help.

After you have started the action, a dialog opens. See the section "The dialog" for the layout.
Within the dialog proceed as follows:

> If required, control the action with options.

> Confirm the action.

Following confirmation the action is executed and the dialog box remains open. Each action displays feedback in
the associated dialog box. You can then terminate the dialog box with Close and thus refresh the working area of
the main window. If you close the dialog box in another way, the working area is not refreshed.

Example of how an action is executed

» Management Unit bern: Trap receiver 2

| Add new frap receiver |

'Trap receiver « SNMP version Trapcommunity User

Filter All ~ Filfer Filter

1T 18 SNMPv2Zc Sesenver = y ¢ >
ak = net SMNMPv3 - SEMmuUser F $ >
B & Total: 2

> Log in to the SE Manager.

> Select Hardware -> Units -> [<se server> (SE<model>) ->] <unit> (MU) -> Management, SNMP tab.

> In the SNMP trap receivers group click Add new trap receiver.
A dialog box with a parameter area opens.
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Add trap receiver

Add a new trap receiver on Management Unit bern.

Trap receiver ho1-trap.example.net
SNMP version SNMPvZ2c

Trap community community-10

> Enter an IP address or an FQDN as trap receiver.

> Select an SNMP version.
> Enter a trap community.

> Click Add.

[ cancel |

After execution of the action, the message that the trap receiver has been successfully added appears.

> Click Close.

» Management Unit bern: Trap receiver

| Add newirap receiver |

Trap receiver ~ SNMP version  Trap community  User

Filter All v | Fiffer Filter

17 18 SNMPv2c seserver = P e

ab = net SNMPv3 = semuser sy 9 2

ho1-trap.example net SNMPv2c commmunity-10 - ¥y 9 >
Total: 3

-.E.f‘:lj L:-:'

The table displays the added trap receiver.
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3.4.5 Calling the online help

The SE Manager incorporates an integrated, context-sensitive online help, the SE Manager help.
The SE Manager help contains information on all groups of the SE Manager.

There are two ways to call the SE Manager help:

Pending BS2000 messages | G2H data
~ Systams EE] %)
ﬁ Dashboard - 2
£ systems Fiter Filter AT v Filler Fiter Fitter Fller A -
- MONTOR ABGSE  WM2000 BS2000 V21 0A sig0sed E20N ABGSE111, Home Pubset E20N (1 I RUNMING

ABGSE11A ABGSE11A VM2000 BS2000 V20 0B 1390-se4 one > RUNNING
= 50390 se4 (SUT0) it z Zeus
i0s (SLU310) ABGSES ABGSENE VM0 BS2000 V21 0A sul0-sed 1225 I RUNNING

MONITOR ABGSE4D!  VM2000 BS2000 V21,04 sul0sed E24N ABGSEA01; Home Pubset E24N{ . B+ RUNNING
[*] Appications y ABGSE4DS - V2000 BS2000 V2008 sudtosed QN % DEFNED_ONLY

Figure 14: Calling the SE Manager help

1 Using Help in the SE Manager header area:
The homepage of the SE Manager help is called in a new tab of the browser window.

2 | Using the Help icon (@') in the selected group:
Information on the functionality of the group is displayed on a new tab in the browser window.

The figure below shows the homepage of the SE Manager help:

SE Manager
Inirugian
SE Manager
Dhashiosmd ———— e
Syeloms v The SE Manager is the web-based, easy-to-operate user intedace for Fujitsu BS2000 servers of the SE serfes (SE servers for short), The SE Manager rurs on the Management
Unit and permits central operation and administration of Server Units (280 and x85), Application Linis (xB6), Met Uinit (including HNG), and the storage.
Apptications A browser Is used for Ihe purpose of operation, which is pessitle both on workstations which are remote from he server and also lecally on the Management Unit of the SE
Server.
Prrformance
Far the Serves Linits of the: SE server the funcional scope incorporates operation of BS2000 will acoess to the BS2000 console and to the BS2000 dialog, plus functions for
Dewces » configuring BS2000 devices and adminisiration of the Server Units,
Nariae Management of the Application Unlts which are opfionatly avallable and of the applications which run on these Is also Integrated into the SE Manager.
=rdwe
The funclions of the user terface are described In detall in ihe sections below, Information on the SE Manager s pravided
Cietar
n the chapters of this onling help )
Authorizatians = o a comtexi-sensitive basis in ihe online help when you click on the 7 jcon In the SE Manager
= of the online server for Fujitsu Te i suliors manuals at imansiils b ujisu ceom. In the “Fujiteu Server BS20007 section there you will Tind the cument
i manuals and Release Nolices for the servers of the 5E seres.
Logging
Fanice

Contact
Sanaral infarmation
I you woulr Iike 1o make any suggestions or corrections relaling to the SE Manager anfine heip or the SE Manager, please notily us at

£2000 docui@ls, sy, com

Thank you for your neipl

Figure 15: Homepage of the SE Manager help

The area on the left contains the table of contents, which is structured in a similar way to the tree structure of the
SE Manager.

The content selected is displayed on the right. The size of the content area can be adjusted to a certain extent by
drawing the dividing line between the two areas.

92



SE Server - Administration and Operation - User Guide

The contents of the SE Manager help are also supplied as PDF file. You will find the PDF file under General
information in the SE Manager help.

Add-on packs of the SE Manager each have their own online help which can be called directly from the add-on's
GUL.
Searching the help

You can navigate and search in the entire SE Manager help irrespective of how it was called. The search field for
searches is on the right above the work area.

> Enter the term you wish to search for.

> Click the Search icon. In the working area the Search results page lists all topics in which the term appears.
The path name of the topic and an excerpt of the content with the search term are displayed. The hit(s) are
highlighted.

> Click a topic header in the table. The topic is displayed on the right in the work area. All places which contain

the search term are highlighted. By clicking the icon & you can hide the highlighting or display it again.
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3.4.6 Error handling

This section provides information on handling errors and problems.The following problems can occur:

® You cannot establish a connection.
® You cannot start an action.
® Errors occur when an action is started.

® The connection is interrupted.

Measures

> |If you cannot establish a connection, check the address entered, and also the availability and, if necessary,
the system status of the SE server’s system components.
If IP-based access rights are configured: Make sure that access is allowed for the IP address of your
computer.

> |If execution of an action fails, the cause is specified in the parameter area of the dialog.

> With some actions, e.g. a reboot of the MU, in which you operate the SE Manager, the connection is
interrupted. Log in again after such an action.

> Search for the relevant topic in the SE Manager help if you require further information (see the section
"Calling the online help").

> If you still cannot solve the problem, contact Customer Support.
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4 Dashboard

The Dashboard menu contains the Dashboard tab, which provides a quick overview of the Systems, BS2000
messages, Units, IP networks & switches, FC networks & switches, Storage, Cluster, Users and Events of the SE
server configuration. The Dashboard is displayed after you have logged in on the SE Manager.

If at least one AU PQ is available, Units/Partitions is displayed instead of Units. With AU PQ, the chassis
of the AU and the partitions are each counted as individual units.

Cluster is displayed only if at least one cluster exists in the SE server configuration.

Up to three status classes are displayed per object type. If more than three status classes are currently assigned,
the last line displays the status class with the highest priority level. The totals display also contains the less urgent
problematical statuses which cannot be displayed separately.

The tab offers the following functionality for this purpose:

® Displaying the status overview in the tile view

® Displaying the status overview in the list view

® Displaying the overview page associated with a component
® Filtering the overview page according to an object type

® Displaying the overview for a component / object type filtered according to status

Detailed information on the Dashboard tab is provided in the SE Manager help.

Displaying the status overview in the tile view

> In the tree structure select Dashboard.
The Dashboard tab with the Status overview group opens. This enables you to see at a glance whether any
problem exists.

> If the tile view is not displayed, click the Tiles icon in the group header.

The tile view opens.
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erview:. .

42Sysﬁems ®

9 BS2000 messages 31 Units .1

[IF5] RUNNING 7] QUESTION. NORMAL

20 P networks s switches 4] Fc networks s switches 7 storage
NORMAL 1 NORMAL g ok

1 WARNING

1 25 Events 1 ; 1 Users 2 Cluster

[ NoTICE ACTIVE SESSIONS [ 1l NORMAL

[0 WARNING WARNING

Displaying the status overview in the list view

> In the tree structure select Dashboard.

The Dashboard tab with the Status overview group opens. This enables you to see at a glance whether any

problem exists.

> If the list view is not displayed, click the List icon in the group header.

The list view opens.

Dashboard

——— I ——— e S

| Systems © 9 RUNNING 8 | INACTIVE

14 |NOT_ACCESSIBLE

. BS2000 messages 2 QUESTION

Units/Partitions © 20 NORMAL 1 |STOPPED

3 |UNCONFIGURED

"' IP networks & switches 17 NORMAL 5 WARNING

FC networks & switches 2 NORMAL

o) Storage ‘i 2 OK 4 WARNING
[ Events 72 INOTICE 3 WARNING

Users 4 ACTIVE SESSIONS

¢ Cluster 1 NORMAL 1 WARNING
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> Click the arrow at the start of a component row.

The list for the selected component expands. In the expanded status the information is subdivided further,
and displayed in a line for each object type.

Displaying the overview page associated with a component

> In the tree structure select Dashboard.
> When the Dashboard tab in the tile view opens, click the tile for the required component, e.g. Systems.

> When the Dashboard tab opens in the list view, click the component name in the list header of the required
component, e.g. Systems.

The corresponding overview page opens, in this case the Systems main menu with the Overview tab.

Filtering the overview page according to an object type
> In the tree structure select Dashboard.
> |If the list view is not displayed, click the List icon in the group header.
> Click the arrow at the start of a component row to which the required object belongs, e.g. Units.
The list for the selected component expands.

> In the expanded list, click the required object type, e.g. Management Unit.

The associated overview page opens with the corresponding filter, in this example the Hardware main menu with
the Units tab. Only Management Units are displayed.

Displaying the overview for a component / object type filtered according to status

Up to three status classes are displayed. If more than three status classes are currently assigned, the last line
displays the status class with the highest priority level. The sum display also contains the less urgent problematical
states that cannot be displayed separately.

> In the tree structure select Dashboard.

> If the list view is not displayed, click the List icon in the group header.
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> Select one of the following procedures:

>

In order to display the overview for a component filtered according to status, in the list header click the
status of the required component according to which you wish to filter the overview, e.g. for the
component Systems the status INACTIVE.

The associated overview page opens with the corresponding filter, in this example the Systems main
menu with the Overview tab. Only the systems with the status INACTIVE are displayed.

In order to display the overview for an object type filtered according to status, in the line with the
required object type click the status according to which you wish to filter the overview, e.g. for the object
type VM2000 the status INACTIVE.

The associated overview page opens with the corresponding filter, in this example the Systems main
menu with the Overview tab. Only the VM2000 systems with the status INACTIVE are displayed.
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5 Operating and managing systems on Server Units

The systems referred to here are the Native and virtual operating systems which run on the various units of the SE
server.

You operate and manage the systems using the Systems menu in the tree structure. See the following example:

Managing a single SE server Managing two SE servers
(with SU x86 and AU) in a Management Cluster

& systems . £ Systems v

Overview
= abgse? (SET740)

+ EM2 (5U740)

# sul-se2 (SU340)
+ abgsed (SET30B)

Overview

su330Bse6 (SU330B)
suZ2-sef (SU340)
abgsqs01 (AU25)

|

L3

-

In the tree structure displayed, those units are shown on which the so-called "productive systems" with their
applications run. These are Server Units with BS2000 systems as well as Application Units with Unix, Linux or
Windows systems. In each case, the name is followed by the type of unit in parentheses:

® In the example, SU740 refers to a Server Unit of the type /390.
® In the example, SU330B and SU340 refer to Server Units of the type x86.

* In the example, AU25 refers to an Application Unit based on an x86-based server.

i The operation and administration of the systems on AUs are described in the chapter "Operating and
managing systems on Application Units".

If you manage a configuration of two or more SE servers in a Management Cluster, underneath Systems, a
submenu <se server> (SE<model>) will be displayed for each SE server, containing the SUs and AUs of the
respective SE server.

Also, if the add-on pack NUX is installed on at least one MU, the structure of the primary navigation underneath
Systems is extended: The main menu receives rack-specific substructures SE<se-index> AU<rack-index>xx
corresponding to the name scheme of the AUs, under which the links to the individual AUs of the rack (with a
corresponding submenu if necessary) can be found:
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Ii:_JJ Systems

Overview
= SE1-Suisse (SE330)

# gold (SU330)

# SE1 Alhox

- SE1 AlMxx
au102-sa1 (AU25)
aul103-sel (AU25)
aulld-set (ALI2S)
aul07-sel (AL2S)
au108-se1 (AUZ5)
au109-set (ALUZ25)
aulll-sel (ALI2S)

+ SE1 All2nx

Overview of all systems of the SE server configuration

> Select Systems -> Overview, Overview tab.

The Overview tab displays information on all systems present on the managed SE server configuration. See the

Desenigtion Sraua
i e LA

LLMOT =]

> When you click on a system in the Name column, the Operation tab of the selected system opens.

The Server column is only displayed if two or more SE servers are managed together in a Management Cluster. It
contains the name of the SE server to which the system belongs.

Under the category Systems -> Overview, the Pending BS2000 messages and C2H data tabs also display
messages waiting for a response of all BS2000 systems of the SE administration area and output data of the
BS2000 tool C2H (C2H reports and global C2H tables).
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Overview over the systems of a Server Unit

> Select Systems -> [<se server> (SE<model>) ->] <unit> (SU<model>), Overview tab.
The Overview tab displays information on the systems present on the SU. See the following example for SU /391

Ovarview SVP console BE000 operabon mode VM arninectrabion | VA resources VM optioie

= Server Link SU390-5E5-5viz: Main memory (120 GB) 7

Used ma mesmory, 72 GB Free man memery 4 6 GB (40 GB)

B0 %

400%
+ Server Unis SUI90-3EE-Sviz: License dependent CPU usage 0
Harmal CPUs. Exira CPUs ‘Spars CPUs
1 1 '
= Sarver Unis SU90-SEE-Sviz’ Systema EG
Fier Fiter Futer e Farr Fiber it AN -
DAR0ZED 1 BE2000 V2108.5P 242 175 anF 512 Monkor system DOROZEOT (V210 # RUNNNG
DOROZED? 2ANY)  BS2000 V21 08 g M8 Reserved for ASTE and REWAS I RUNNING
DOZEDS JCANY)  BE2000 V2008 178 e Fiad b FUNNING
DOZOZEDH 4 (PANY)  ES2000 V2108 SP 242 183 ano BB HTSH VM, feserved for SR B RUNNNG
v DOROZEDS 5 E52000 V2008 - Ay 512 P RUNNING
Totat &

> When you click on a system in the Name column, the Operation tab of the selected system opens.
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5.1 Setting BS2000 operation mode

You set BS2000 operation mode on a unit-specific basis. The procedure differs depending on the type of the Server
Unit.

® Server Unit /390

® Server Unit x86
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5.1.1 Server Unit /390
> Select Systems -> [<se server> (SE<model>) ->] <unit> (SU</390>), BS2000 operation mode tab.

Overview SVP console B52000 operation mode VM administration VM resources VM options

w Server Unit SU730-SE6: Status

(<)

Status RUNNING (since 2023-02-17 17:34:36)
Current operation mode V2000 mode
Active and planned IORSF file 2 (VMAXV21 UNIFIED LM CONFIGURATION (BS2000 V21.0))

a Management of IORSF files

= Server Unit SU730-SE6: Actions

(=)

The BS2000 operation mode tab in the Status group displays the operation mode set (Native BS2000 mode or
VM2000 mode) and permits this setting to be changed in the Actions group:

Reload IORSF file / Change BS2000 operation mode

You can change the operation mode only when no BS2000 system is active.

> In the Actions group click Reload IORSF file / Change BS2000 operation mode. In the subsequent dialog box,
enter the IPL parameters for the IMPL. Optionally, you can change the operating mode.

i After the execution of the IMPL, a BS2000 IPL is always initiated. Depending on the set operation
mode, either the native BS2000 or the monitor system is started.
If you set a different IORSF file, you have to explicitly update the IORSF file list in the Devices menu
after the IMPL has been executed.
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5.1.2 Server Unit x86

> Select Systems -> [<se server> (SE<model>) ->] <unit> (SU<x86>), BS2000 operation mode tab.

Overview | BS2000 operation mode | VM administration | VM resources | WM options

= Server Unit sudilse4: Status

Status

Current operation mode

4

Server Unit su310s=4: Startup settings: Native BS2000 system

Hip eatitnns | Change main memory seftings |

= RUNNING (since 2023-02-08 09:02:22)
WVM2000 mode

=)

Current
BS2000 main memory - configured [ME] 54272 (53800)
BS$2000 main memory - possible [MB] 211062
Total memory [ME] 261632
Server Unit sud10sed; Startup settings: Monitor VM 7)
ale S s | Change startup settings |
Current
Name MONITOR
Number of virtual CPUs 2
Main memory - maximum [ME] 4096 (4024)
Main memory - minimum [MB] 1024 (852)
Main memaory [MB] 2048 (1976)
Exclusive devices 1236 1237 1242 1243 CC20 CC21 CC40 CC41 CCao cce
Shared devices 122F
Passwerd (VM2000 administrator) No

The BS2000 operation mode tab in the BS2000 operation mode group displays the operation mode set (Native

BS2000 mode or VM2000 mode) and permits this setting to be changed:

Changing the operation mode

You can change the operation mode only when BS2000 is not active. In VM2000 mode this applies for all BS2000

VMs.

> Click Change operation mode and confirm the switch to the other operation mode.

i When you switch mode, the Automatic IPL option is implicitly set to Not planned. This setting can be
changed again after the operation mode has been changed successfully (Options or VM options tab).
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i If you change the device configuration of the monitor VM, please note the following:

® If the devices of the monitor VM are assigned or removed using the VM specific tabs Disks, KVP, LAN,
Tape devices or All devices, the changes only remain active until the BS2000 operation mode is reset
or until the SU is restarted. The same applies for changes of the device configuration done via VM2000
commands that refer to the monitor VM.

® |f changes to the device configuration are to remain active after a change of the BS2000 operation
mode or restart of the SU, they have to be entered and activated in the startup configuration of the
monitor VM as well (see group Startup settings: Monitor VM of the BS2000 operation mode tab).

® Changes to the startup configuration of the monitor VM have no immediate effect on the running
monitor VM.

The groups below show the current startup settings for the operation mode concerned.

> To change the main memory size for the Native BS2000 system, in the Startup settings: Native BS2000
system group, click Change main memory settings.

> To change the name of the monitor VM, the number of virtual CPUs, the main memory settings, the device
lists or the access password for the monitor VM, in the Startup settings: Monitor VM group, click Change
startup settings.

> To activate the startup settings of the respective operation mode, click Activate startup settings in the
corresponding group. The function is only available if BS2000 is not active.

Changes will take effect only after the setting has been activated by clicking the Activate icon in the group
concerned or after you have switched the operation mode.
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5.2 Opening the BS2000 console and dialog window

The BS2000 console and dialog window is opened using the Operation tab.

> Open the Operation tab. Depending on the mode in which BS2000 is running (Native/VVM2000), you reach the
tab as follows:

> Native BS2000:
Select Systems -> [<se server> (SE<model>) ->] <unit> (SU<model>) -> BS2000, Operation tab.

> VM2000 on SU /390:
Select Systems -> [<se server> (SE<model>) ->] <unit> (SU<model>) -> <bs2000-vm>, Operation tab.

> In the Console and dialog group, click Open by the required function (BS2000 console or BS2000 dialog).

The BS2000 console window or BS2000 dialog window opens.

Alternatively, you can open a BS2000 console or a BS2000 dialog via PuTTY, by using the CLI commands
bs2Consol e and bs2Di al og. A detailed description is provided in chapter "Operating BS2000 with PuTTY".
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5.2.1 Messages on the BS2000 console

The base system M2000 or X2000 issues messages on the BS2000 console. On an SU /390 these messages are
issued by the M2000 of the MU, and on an SU x86 by the X2000 of the SU. With the exception of the messages for
write operations to CDROM/DVD, these messages are not issued via the BS2000 system component MIP
(Message Improvement Processing) and are therefore not stored in a BS2000 message file.

Specifically, M2000/X2000 issues messages of the following message classes on the BS2000 console:

Message @ Meaning

class

KVP Messages of the console distribution program (KVP)

SVR Messages of the SVP emulation (on SU x86 only)

10D Messages of the 1/0 handler for bus devices (on SU x86 only)

HAL Messages of the Hardware Abstraction Layer (on SU x86 only)

SNX Messages for write operations to CDROM/DVD (SNXCDxx) or messages relating to a fault in a

peripheral component which cannot be reported via an 1/0 to BS2000.

You can inquire response and any meaning texts for messages of M2000/X2000 using the HTML application
"System messages". It is available online at https://bs2manuals.ts.fujitsu.com or on the "BS2000 SoftBooks" DVD.

In BS2000 you can inquire the message text, meaning and response text for a message code with the
/HELP-MSG-INFORMATION command only if the message is stored in a BS2000 message file.
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5.2.2 Working with EMDS

If you open an operation instance BS2000 terminal in the SE Manager or via PuTTY, after successful authentication
the EMDS application will start automatically and provide the "terminal” functionality. The dialog with BS2000 is
started and you are prompted to login with BS2000 command /SET-LOGON-PARAMETERS.

The following sections describe shortcuts and programmable keys:

® Using shortcuts for special characters

® Using programmable keys (pfkeys)
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5.2.2.1 Using shortcuts for special characters

When you work with EMDS, special characters are available which you can access by means of shortcuts. The
table below shows the most important shortcuts:

Keys F1 F2 F3 F4 F5 F6 |F7 F8 F9 F10 F11 F12
NIL LZF LVD K1 K2 | K3 MAR ED EM DUE1

Shift EFZ AFZ LZE LSP F1 F2 F3 RS |WAZ SY AM DUE2

Esc P1L P2 P3 P4 PS5 P6 P7 P8 P9 P10 LAl HC

Esc Shift P11 P12 | P13 P14 P15 P16 P17 P18 P19 P20 PP | SC

Table 4: EMDS - Shortcuts for special characters

Hold down the Shift key when you press an Fn key. Press the Esc key once briefly before you press Fn or Shift - Fn.
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5.2.2.2 Using programmable keys (pfkeys)

You can use programmable keys (pfkeys) when you work with EMDS. Proceed as follows to assign values to the
pfkeys:

> Press Esc Shift - F11 in the EMDS window (PP in the table above).

The pfkey menu is displayed:

TTDVODV”OVUOVUDO
=
W00 s e R e

@

el
P
-

P12
P13
P14
P15
P16
P17
P18
P19
P28

> Press the pfkey to which you want to assign a value twice. To do this, use the key shortcuts from the table on
page "Using shortcuts for special characters”, for example Esc F7, Esc F7 for P7, P7.

> Now assign a value to the selected pfkey, e.g. a frequently used command.
> Terminate the entry by pressing the selected pfkey again, for example Esc F7 for P7.

> Press Esc Shift - F11 (PP in the table above) to return to the EMDS window.

Proceed as follows if you want to change an existing pfkey assignment:

> Press the pfkey to which you want to change once. To do this, use the shortcuts from the table on "Using
shortcuts for special characters", for example Esc F7 for P7.

> Position the cursor with the arrow keys on a character in the existing assignment.

> Press the Del key to delete the character.

> Press the pfkey again (in the example Esc F7 for P7) and enter a character which will overwrite
the existing character. Press the pfkey once again to terminate assignment.

> Press the Enter key and then the pfkey again (in the example Esc F7 for P7) and enter a character
which will overwrite the existing one. Press the pfkey once again to terminate assignment.
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5.3 SVP console on Server Unit /390

A Server Unit /390 is operated via the SVP (service processor). Some important SVP functions, for instance for IPL

or IORSF, are also available directly on the SE Manager.

Alternatively, SVP functions can be called under menu control on an SVP console via SVP frames. The SVP

console is accessed via the SE Manager:

> Select Systems -> [<se server> (SE<model>) ->] <unit> (SU</390>), SVP console tab.

> In the SVP console group click Open.

The SVP console window opens.

FFFFFFF U u J3331 III TTITTTTT 555S8s u u
F u u 3 I T s 5 u u
F u u 3 I T s u u
FFFFFFF U u J I T 55585 u u
F u u J I T 5 u u
F u u 3 J I T 5 5 u u
F uuuuu 333313 III T 55585 uuuuvu
cccc 0000 N N 5555 0000 L EEEEE
c o 0 NN N 5 o 0o L E
c o 0 NN N 5555 o 0o L EEEE
c o 0O N NN s 0 0o L E
cccc 0000 N NN 5558 0000 LLLLL EEEEE
5555 v V PPPPP
s v v P P
5888 v v PPPPP
s v v P
5888 v P

Bitte ENTER druecken/Please press ENTERD

LTG TAST

Display keyboard | [ Display seftings

Connected

You can operate the SVP console in the familiar manner. A detailed description of how to operate the SVP is

provided in the "Server Unit /390" Operating Manual [2].

SVP console via PUuTTY

Alternatively, you can open the SVP console via PuTTY, by using the CLI command svpConsol e. A detailed
description is provided in chapter "Appendix”, section "SVP console on MU or SU /390".

SVP connection in case of redundant Management Units

If an SE server has redundant Management Units, they are displayed in the SVP connection group: One MU is

always Active with respect to SVP operating, and the other is Passive.
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Switching active Management Unit

> Click on the Change icon for the passive MU to make it the active MU with respect to SVP operating.

i This action may be advisable if the active MU has to be shut down for maintenance reasons and the
SVP console has to be available without interruption.

See also "Redundant Management Units".
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5.4 Working in Native BS2000 mode

You can perform the following actions in Native BS2000 mode:

® Starting (IPL) and shutting down a BS2000 system, executing an IPL dump and migrating
® Setting the options (only SU x86)
® Evaluating KVP logging
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5.4.1 Start/shut down a BS2000 system, execute an IPL dump and migrate
You perform these actions from the Operation tab of the BS2000 system:

> Select Systems -> [<se server> (SE<model>) ->] <unit> (SU<model>) -> BS2000, Operation tab.
In the Actions group you can select one of the following actions:

® BS2000 shutdown (only for SU x86)
* BS2000 IPL
®* BS2000 dump IPL

The following actions are only available for SU x86. The SU x86 also has to form an SU Cluster with another
SU x86 of the SE server configuration. Whether or not an LM (Live Migration) is possible, depends on the
cluster status. The second SU must also be in the Native BS2000 mode operating mode. See also section
"SU Cluster". Further details are provided in the "Cluster Solutions for SE Servers" whitepaper [8].

® Delete BS2000
This action prepares the SU as target SU for a migration.

® Restore BS2000
This action restores the SU after a failback (BS2000 was deleted).

® Migrate BS2000
Starts the wizard for the migration of the BS2000.
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5.4.2 Setting the options (only SU x86)

For SU x86, you manage the options using the Options tab of the BS2000 system. You can change the settings for
the shutdown, the startup and the Auto IPL.

> Select Systems -> [<se server> (SE<model>) ->] <unit> (SU<model>) , Options tab.

Overview | BS2000 operation mode | Options
Server Unit sul-se7: General options @
Remaining runtime for shutdown 00:30 (hh:mm}) 7
Server Unit sul-se7: BS§2000 options @
System Auto IPL Boot disk  Console device Startup mode  System name
BS2000 Not planned - - AUTOMATIC - 4
D Total: 1

The Options tab displays the groups General options and BS2000 options. The tab provides the following functions:

Defining the remaining runtime for shutdown

The remaining runtime is the time which is available to BS2000 to terminate itself when the Server Unit is shut
down. The remaining runtime is only of any significance when the SU x86 is shut down or restarted. BS2000
receives a shutdown request which is handled in accordance with the setting in the system parameter SHUTPROC
(see the “System Administration” manual [10]). The configured remaining runtime is then available for the BS2000
shutdown. You define the remaining runtime for BS2000 in Native mode or in VM2000 mode for the monitor
system. In VM2000 mode the remaining runtime defined then applies for all BS2000 guest systems (see section
"Setting VM options").

If you enter the value 00:00, there is no defined remaining runtime, i.e. when the SU is powered off or restarted, the
system always waits for BS2000 to shut down.

> In the General options group click the Change icon and set the required remaining runtime.

Setting BS2000 options (startup and auto IPL)

> In the BS2000 options group click the Change icon and set the required values.
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5.4.3 Evaluating KVP logging

You manage KVP logging using the KVP logging tab of the BS2000 system. You can select and display logging
entries specifically using a subsequent dialog.
> Select Systems -> [<se server> (SE<model>) ->] <unit> (SU<model>) -> BS2000, KVP logging tab.

Operation KVP logging Networks

Server Unit suise8 BS52000: KVP logging files

(=)

Number File name File size [Bytes]
1 KVPLOG.HV0.200820.035401 % @ 9
2 KVPLOG.HV0.200819.120325 bz2 32,151 ® 9
3 KVPLOG.HV0.200818.125642.bz2 40,708 @ )
4 KVPLOG.HV0.200814.071013.bz2 347 @ )
5§ KVPLOG.HV0.200813.093043.bz2 13,33 @ 9

§ Total: &

The KVP logging tab displays the list of KVP logging files and offers the following options:

Displaying a KVP logging file

> In the KVP logging files group select the required KVP from the KVP list.

The KVP logging files which exist for this KVP are listed. The Display icon (“# ) opens the Display KVP
logging file dialog box in which the logging records of the selected file are displayed. You can limit the time
range for the logging records to be displayed and filter the output.

Downloading a KVP logging file

> In the KVP logging files group select the required KVP from the KVP list. Click the Download icon (J-WI ) by the
required KVP logging file. Enter the path and file names in the system-specific Explorer window and save the
file.
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5.5 Working in VM2000 mode

You manage the BS2000 VMs of a Server Unit using the menu item Systems -> [<se server> (SE<model>) ->]
<unit> (SU<model>).

i For an SU /390, the VM2000 management by SE Manager is only possible when REWAS is active in the
monitor system, see also section "Integration of BS2000 into the SE Manager".

Working in VM2000 mode is described in the following sections:

® VM administration
® Managing VM resources
® Setting VM options
® QOperating a VM
© BS2000 guest system - Information and Operation

© Managing devices of the VM
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5.5.1 VM administration
You manage the BS2000 VMs using the VM administration tab. You can create and delete BS2000 VMs.

> In the tree structure select

Systems -> [<se server> (SE<model>) ->] <unit> (SU<model>) , VM administration tab

Overview . BS2000 operation mode

VM administration

Server Unit abgpuma: VM administration (BS2000)

[ Create new B32000 VM |

- VM resources

| VM options

Free main memory: 10.8 GB

VM name Host name VM index Main memory [MB] Status

Filter Fiiter Fiiter Filter All

MONITOR ABGPUMAL 1 2048 (1976) ' RUNNING

ABGPUMAS ABGPUMAS 2 ("ANY) 8102 (7984) = RUNNING »
ABGPUMASE ABGPUMAG 3 (“ANY) 8192 (8024) RUNNING 4
ABGPUMATY ABGPUMAT 4 ("ANY) 16384 (15898) = RUNNING ¥
ABGPUMAS ABGPUMAS 5 ("ANY) 1024 (964) = RUNNING 4
VMX1 - (*ANY) 512 (442) DEFINED_ONLY b 4
VMX2 - (FANY) 512 (466) DEFINED_ONLY b 4

¥ p:: Total” 7

The VM administration tab displays the list of all the unit's BS2000 VMs.

The following functions are available:

Creating a BS2000 VM

> On the VM administration tab click Create new BS2000 VM.

In the Create new BS2000 VM wizard you can specify the required properties of the BS2000 VM step by step.

Deleting a BS2000 VM

> By the required VM click the Delete icon ( # ) and confirm the action.

BS2000 VMs can only be deleted if they are in DEFINED_ONLY status.
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5.5.2 Managing VM resources

You manage the VM resources of the BS2000 VMs using the VM resources tab. You can change the resources of a

BS2000 VM.

> In the tree structure select

Systems -> [<se server> (SE<model>) ->] <unit> (SU<model>) , VM resources tab

Overview SVP console BS2000 operation mode WM administration VM resources VM options
» Server Unit SU390-SE5; Update VM2000 resources @)
‘ Update WVM2000 resources |
- Server Unit SU300-SE5: CPU pools (BS2000} Q)
CPU pool ~ Attached CPUs Detached CPUs Number of VMs
Filter Filter Filter Filter
*STDPOOL 1 a 4
USRCPOOL 1 0 1
Total: 2
+ Server Unit SU390-SE5: VM resources (BS2000) @
VM name VMindex  vCPUs CPU pool CPUquota  Max. CPU util. Status
Filter Filter Filter Filter Filter Filter All -
M4IVE 1 Z(My *STDPOOL 20.00 100.00 b RUMMING e
G4V 2 (FANY) 1 *STDPOOL 10.00 1250 P RUNNING y
G4IVL 3 1 *STDPOOL 10.00 100.00 B RUNNING 7
G4V 4 (*ANY) 2({My  *BY_VM_GROUP 1.00 100.00 B RUNNING 7
G4NT 15 1 *BY_VM_GROUP 20.00 100.00 [ RUNMIMNG &+
o3 Total: 5

The VM resources tab provides information on the use of the CPU pools and displays the list of BS2000 VMs with

the VM resources. The following functions are available:

Update VM2000 resources (for SU /390 only)

> You should use this action if you have carried out preparatory measures in VM2000 and want to continue
work in the SE Manager. This ensures that the VM resource data such as main memory and CPU pools

displayed in the SE Manager are up-to-date.

Change resources of a BS2000 VM

> By the required BS2000 VM click the Change icon and make the requisite changes in the Change resources

dialog box.
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5.5.3 Setting VM options

You manage the VM resources of the various BS2000 VMs using the VM options tab. You can change VM-specific
options, and you can also change the settings for the automatic IPL for the monitor VM (only SU x86) and persistent
BS2000 VMs. For a non-persistent BS2000 VM (except the monitor VM), you can set the persistence attribute. On
an SU x86 you can also set the remaining runtime for the shutdown.

> |n the tree structure select

Systems -> [<se server> (SE<model>) ->] <unit> (SU<model>) , VM options tab

Overview | BS2000 operationmode | WM administration | VM resources | VM options
Server Unit abgpuma: General options @)
Remaining runtime for shutdown 00:30 (hh:mm) ¥ 4

Server Unit abgpuma: VM-specific options @)
VM name Persistence Auto IPL Boot disk  Console device  Startup mode System name
Filter All w || All ~ | Filter Filter All ~ | ABG
MONITOR No Not planned 4C21 Z0_Z1 (KVP HV0)  FAST ABGPUMA1 #
ABGPUMAS Yes Planned 4C43 Z8 78 (KVP VM5)  FAST ABGPUMAS Y
ABGPUMAG Yes Planned 4C44 ZA_7B (KVP VMB) FAST ABGPUMAG Ed
ABGPUMAT Yes Planned 4C45 ZC_ZD (KVP VMT) FAST ABGPUMAT F 4
ABGPUMAS Yes Planned 4C46 ZE 7F (KVP VM8) FAST ABGPUMAS k4

.Ea e Total: 5 of 7

The VM options tab displays the settings of the VMs in the VM-specific options group. For an SU x86 (see figure)
the General options group with the remaining runtime for the shutdown is displayed above.

The following functions are available:

Setting the VM-specific options (persistence, Auto IPL and startup parameters)

> In the VM-specific options group click the Change icon by the required VM and make the requisite changes in
the Change VM-specific options dialog box.

If you deactivate automatic IPL of a persistent VM, the preset IPL parameters are retained and are
available for an explicit IPL in the Initiate BS2000 IPL dialog box.

Defining the remaining runtime for the shutdown (only for Server Unit x86)

The remaining runtime is the time which is available to BS2000 to terminate itself when the Server Unit is shut
down. The remaining runtime is only of any significance when the SU is shut down or restarted. BS2000 receives a
shutdown request which is handled in accordance with the setting in the system parameter SHUTPROC (see the
“System Administration” manual [10]). In VM2000 mode first the guest systems receive the termination signal.
When all guest systems have shut down or half the remaining runtime has elapsed, the monitor system receives the
termination signal. If guest systems have not yet shut down, they are now subjected to hard termination by the
monitor system. If the monitor system has shut down or at the latest at the end of the remaining runtime, X2000 is
terminated.

For the setting of the remaining runtime for Native mode, see section "Setting the options (only SUx86)".
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If you enter the value 00:00, there is no defined remaining runtime, i.e. when the SU is powered off or restarted, the
system always waits for the monitor system to shut down.

> In the General options group click the Change icon and set the required remaining runtime in the Change
remaining runtime for shutdown dialog box.
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5.5.4 Operating a VM

As soon as a BS2000 VM has been created, the tree structure is extended by a VM-specific menu <bs2000-vm>:
Systems -> [<se server> (SE<model>) ->] <unit> (SU<model>) -> <bs2000-vm>

In the menu the functions are assigned to tabs according to topics.

The following functions are available to you, depending on the situation:

® BS2000 guest system - Information and Operation

® Managing devices of the VM
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5.5.4.1 BS2000 guest system - Information and Operation

> Select: Systems -> [<se server> (SE<model>) ->] <unit> (SU<model>) -> <bs2000-vm>, Operation tab
Operation Disks KNP LAN Metworks Tape devices All devices

= Server Unit gold B52000-VM GOLD0: Status

(-2}

Host name GOLDO1
Status B RUNNING {since 2025-01-17 18;44:58)
Operating system BS2000 W21.0B 5P 23.2 {Last update: 2025-01-28 12:59:09) =
5Y 51D 178
Home pubset 2IVG
Humber of vCPUs 2
Main memory 2048 (1978) MB
Description System administrator John Doe, phone 088-12345 #
» Server Unit gold B52000 VM GOLD01: Pending B52000 messages E L7
Last update: 2025-01-28 12.04:48 2
Type Target Message text
QUESTION L P1LKP-000. 184842 HE L G A : INFUT REQUEST
Total: 1
= Server Unit gold B52000 WM GOLDOY: Console and dialog Z
BS2000 conscle with KVP | HVD ~ | and console mnemenic |0 | Open |
B52000 dislog with connection | MANLO1 ~ | Gpen |
= Server Unit gold BS2000 VW GOLDO4: TPL settings 3
Current IPL parameters Presetting / Auto IPL
Mot planned
Boot disk 4008 4C08
Console device Z0_Z1 [KWP HWD) Z0_Z1 {KWP HWVD)
System name GOLDO01 GOLD01
Jia
= Server Umit gold B52000 VM GOLD01: Actions ‘_"
Action | BS2000 [PL w Execute

The Operation tab displays the status of the VM, enables you to enter or change a description of the VM, displays
pending BS2000 messages, offers access to the BS2000 console and BS2000 dialog, and allows the following
actions, depending on the situation:

® BS2000 IPL

® BS2000 dump IPL

* BS2000 shutdown

® Activate BS2000 VM (persistent VMs only)

® Deactivate BS2000 VM (persistent VMs only)

® Deactivate and delete BS2000 VM (only non-persistent VMs except the monitor VM)

* Migrate BS2000 VM (except monitor VM)
Starts the wizard for the migration of the BS2000 VM.
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i The action Migrate BS2000 VM is only available if the SU is a member of an SU Cluster and Live
Migration is possible. The second SU must also be in the VM2000 mode operating mode. See also
section "SU Cluster". Further details are provided in the "Cluster Solutions for SE Servers" whitepaper [8].

The description of the BS2000 console window and dialog is provided in section "Opening the BS2000 console and
dialog window".
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5.5.4.2 Managing devices of the VM

> Select: Systems -> [<se server> (SE<model>) ->] <unit> (SU<model>) -> <bs2000-vm>, tabs Disks, KVP,

LAN, Networks, Tape devices or All devices

Disks tab

This tab enables you to assign disks to or remove disks from a BS2000 VM or to change its usage.

The Disks tab displays all disks which are assigned to the BS2000 VM.

Operation Disks ' KVP LAN E Metworks Tape devices All devices

= Server Unit EM2 BS2000 VM VM11SEGC: Assigned disks

=)

| Assign disk | E' Management of IORSF files 9 Management of BS2000 disks E] Update storage data

Perpage |32 v
MN Code Usage PRV Storage system Volume number
267 All - Al ~ Al ~ Filter Filter
2678 A5 Shared - DX8700-53-01 120 *, 9
2679 A5 Shared - DX8700-33-01 121 sy 3
267A A5 Shared - DX8700-53-01 122 S
267B A5 Shared - DX8700-53-01 123 5 9
267C A5 Shared - DX8700-53-01 124 A,
267D A5 Shared - DX8700-53-01 125 7 9
267E A5 Shared - DX8700-53-01 126 7 9
267F Ab Shared - DX8700-53-01 127 s 3
:;‘9 = Total: 8 from 258

i The link to IORSF file management and the PAV column are displayed for SU /390 only.

> Click Assign disk to assign another disk individually to the VM.

> Click Management of BS2000 disks to branch to the device management, see section "Managing disks".

> Click the Change icon by a disk to change the usage of this disk (Shared/Exclusive).

> Click the Remove icon by a disk to remove this disk from the VM.

For further information on displaying BS2000 disks, see section "Displaying generated disks on Server Unit /390"

and section "Managing disks on Server Unit x86" .

KVP tab
This tab enables you to assign further KVPs to the BS2000 VM or to display KVP logging files.

The KVP tab lists all assigned KVPs and all KVP logging files.
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Operation Disks KVP LAN MNetworks Tape devices All devices

©)

+ Server Unit su380-se4 B52000 VM ABGSE11A: Assigned KVPs

| Assign KVP | 8 Management of IORSF files 5 Management of KVPs
MN v KVP name Unit
Filter Fifter All h
CN_CO VMA abgsedmu1-1 9
DN B - %
Do = = 9
D B Total: 3
* Server Unit su390-sed B52000 VM ABGSE11A: KVP logging files ;;-5‘_.
KVP | WVMA (abgsedmul-1, 5 files) v
Number File name File size [Bytes]
1 KVPLOG.VMA.230208.021037 810 @ ;"l
2  KVPLOG.VMA. 230207.105126.bz2 4,256 w ﬁ
3 KVPLOG.VMA 230206.130010.bz2 6,004 @ ;"l
4  KVPLOG.VMA. 230203.124040.bz2 212 @ ﬁ
5 KVPLOG.VMA 230203.121343 bz2 275 @ ;"l
Total: 5

The link to IORSF file management and the Unit column in the Assigned KVPs group and the MU of the
selected KVP in the KVP logging files group are displayed for SU /390 only.

Assigning a KVP

> In the Assigned KVPs group click Assign KVP and select a KVP in the subsequent dialog box.
Removing a KVP

> In the Assigned KVPs group click the Remove icon by a KVP and confirm the action.
Branching to the hardware device management

> Click Management of KVPs to branch to the hardware device management, see section "Managing KVP
devices"

Displaying KVP logging file

> In the KVP logging files group select the required KVP from the KVP list.

The KVP logging files which exist for this KVP are listed. The Display icon opens the Display KVP logging file
window for the chosen logging file. You can restrict the time period of the logging records to be displayed and
filter the output.

Downloading the KVP logging file
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> In the KVP logging files group select the required KVP from the KVP list. Click the Download icon by the
required KVP logging file, enter the path name and file name in the system-specific Explorer window, and

save the file.

Further details on KVPs are contained in the section "Managing KVP devices".

LAN tab

This tab enables you to assign further LAN devices (as a device pair) to the BS2000 VM or to remove LAN devices

from it.

The LAN tab lists all LAN devices which are assigned to the BS2000 VM.

Operation | Disks

KVP

LAN

Networks

Tape devices

Server Unit $175-20C BS2000 VM G4IVQ: Assigned LAN devices

|"A§sign LAN device |

All devices

L '_? 1

&3] Management of IORSF files 5] Management of LAN devices

MN ~ Type BS2 IP address BS2 MAC address Unit

Fitter All ~ | Filter Filter All hd

CC42 CC43 ZASLAN - 00:19: el abgviolet 9

CCB82_CC83 LOCLAN 192. 22 0A00: 16 locarno 9

ch42 cD42 ZASLAN - 0019 t51 abgpurple 4

cDgz _cDse3 LOCLAN 192 1.22 DA0O: 116 lugano b
Total: 4

i The link to IORSF file management and the Unit column are displayed for SU /390 only.

> Click Assign LAN device to assign another LAN device pair to the VM.

> Click the Remove icon by a LAN device to remove the LAN device from the VM.

> Click Management of LAN devices to branch to the hardware device management, see section "Managing

LAN devices".

Networks tab

This tab gives you an overview of the BS2000 VM's BCAM data and allows you to update the displayed BCAM data.
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Operation Diiskes VP LAN Hetworks Tape devices | All devices
Berver Unit SU380-se4 BE2000 VI BR2000 systen SESOOVIMA @)
Lipnchisdi BOAR dita BCAM version: V2504 Last update of the BCAM data: 2020-08-26 1532 11

» Berver Unit sulsi-ses BE7000 VM SESIOVMA ES2000 systam SESOOVMA: BCAM linas

5] LAN device assignment

Name Addrasses Node  Linkaggregation Davice 1 Status
= |P addresses MAC Name MName VLAN name Write Read ADMstatus ADM TRANE
Filier Fater Fiter Fliter Filter Fier Fiter  Fiter Al =t A | Al
LELAGZTU 100 6723 S1BOEE4AIDZ HELAGZIY LAG21U - = = = OACTNE B WORKING
LeLAG2ZIY 11 67123 - NELAGZTY LAG2TY - = s 2 S MCLUDED @INONE
L#MANLDY 182 13630 CATO1410101E HEMANLOT - - cCcez coey - OACTNE b WORKING
LEMANLOZ | 182 130.30 0ACD1410201E HEMANLOZ - - chez CDEy - QACTI\!E B WORKING
LIgMANPU 172 16123 S01BOEEAAID HEMANPU = D#H152P0  CCS2  CCS3 OM:TI\-'E DACTI\-'E B WORIGNG
k] e
LIWMMCNPR  FLGE & =FF FEE4 AdD1/B4 BOEEAALL NEMCNPR DRHISZPOD COH2 053 ON STVE OM: TVE B WORKING
FEBOL E4A4DM0
L2HMANFL HRAMANELI DNHZE2P0.  COS2 COL3 UIM{}HN]PB él"ﬂl LDED UN[]NE'
LINMENPR REMOCNPR DRHZEZP0 CDGZ CD63 é'lﬂ:( UDED GF.‘K:[ LED g‘”[]NF
Tolal, 8
» Berver Unit sulsi-sed BEI000 VM SESO0VAMA BEE2000 systam BCAM link agg
» Server Unil sulsl-sed B32000 VM ES2000 system SESD0VMA: BCAM nodes

» Berver Unit sulsi-sad BEI000 VM SESI0VAMA ES2000 system SESD0VMA: BCAM roulérs

i The Link aggregation column of the BCAM lines table and the BCAM link aggregations group are

displayed only if at least one link aggregation exists.

> Click Update BCAM data to retrieve the BCAM data again.

Tape devices tab

Tatal 2 (%)

Total & (7]

Tatal 1 (7)

This tab enables you to assign further tape devices individually to the BS2000 VM or to remove tape devices from it.

The Tape devices tab lists all tape devices which are assigned to the BS2000 VM.

Operaton | Disks | KVP | LAN | MNetworks | Tapedevices [ Alldevices

Server Unit 5175-20C BS2000 VM G4IVP: Assigned tape devices O]
| Assign tape device | &) Management of IORSF files 5] Management of tape devices
MN Type Unit
T2 EMFILE locarno ]
©F Total: 1

i The link to IORSF file management and the Unit column are displayed for SU /390 only.

> Click Assign tape device to assign another tape device individually to the BS2000 VM.

> Click the Remove icon by a tape device to remove the tape device from the BS2000 VM.

> Click Management of tape devices to branch to the hardware device management, see section "Managing

tape devices".
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All devices tab

This tab enables you to assign or remove further BS2000 devices to or from the BS2000 VM on a cross-type basis.
In other words the assignment or removal applies for sets of devices which are defined via MN lists, MN areas or

MNs with wildcards.

The All devices tab lists all BS2000 devices which are currently assigned to the BS2000 VM.

@)

Operaton | Disks | KvP | LAN | Networks | All devices
Server Unit abgpuma BS2000 VM ABGPUMAS: All assigned devices
Assign devices Remove devices
BS§2000 mnemonic ~ Device type Usage
Filter All All e
4C43 Disk Exclusive
CC48 LAN Exclusive
CC49 LAN Exclusive
CCes LAN Exclusive
CCcs9 LAN Exclusive
78 K\VP Exclusive
79 KVP Exclusive

Total: 7

The device mnemonic, device type and device usage are displayed for each assigned BS2000 device (Exclusive

only for one BS2000 VM or Shared for more than one BS2000 VMs usable).

> Click Assign devices to start the Assign BS2000 devices wizard. The wizard enables you to assign multiple
BS2000 devices to the BS2000 VM on a cross-type basis.

> Click Remove devices to open the Remove BS2000 devices dialog box. There you can remove devices from

the VM on a cross-type basis.

Wildcards and range specifications are possible when you specify the devices.

129



SE Server - Administration and Operation - User Guide

6 Operating and managing systems on Application Units

An operating system from another vendor (Windows, Linux or Unix systems) usually runs on an Application Unit.
The scope of the setting and display options thus depends on the operating system concerned. An Application Unit
can be operated with a Native operating system or a hypervisor system. A hypervisor system permits the operation
of VMs. These are displayed in the SE Manager and can be operated with it.

The following hypervisor systems can be configured: VMware vSphere ESXi or HyperV Windows Server.
Application Units are displayed in the tree structure as <unit> (AU...) or <unit> (DBU...).

For deployment scenarios with many Application Units, the standard view of the systems in the SE Manager can
become confusing. For such cases, the AU optimized view, which can be selected in the user's individual settings,
is suitable. In the navigation, the AU optimized view displays only one System AU menu in the Systems main menu
for all AUs of an SE server, which provides access to the Operation main page of the AUs.

If the add-on pack NUX is installed on at least one MU, the structure of the primary navigation underneath
Hardware - > Units is extended: The main menu receives rack-specific substructures SE<se-index> AU<rack-
index>xx corresponding to the name scheme of the AUs, under which the links to the individual AUs of the rack
(with a corresponding submenu if necessary) can be found.

i If an AU is only integrated at hardware level, its VMs are not enquired and are therefore not displayed.
For such an AU, only the basic system resp. Native-AU system is displayed.

The following description is divided into these sections:

® QOperating a Native system
® QOperating virtual machines

® |nstalling an operating system on an Application Unit
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6.1 Operating a Native system
You operate a Native system via the Operation tab.

> In the tree structure select Systems -> [<se server> (SE<model>) -> ] <unit> (AU<model>), Operation tab.

The Operation tab opens (example for a VMware system).

Operation
Application Unit abgse1au1-0: Status @
Host name abgselaul-0
Status RUNNING
Serial number YLTS002204
Operating system VMware ESXi 5.5.0 build-2143827
Description System administrator John Doe, phone 089-12345 ,;9’
Application Unit abgse1au1-0: Operation @
iRMC Open
Application Unit abgse1au1-0: Actions @
Action: Shutdown Execute
Operation

> In the Operation tab click Open in the Operation group.

® In this way you open the web interface of the iRMC for an AU PY (e.g. AU25 or AU47).
® |n this way you open the web interface of the Management Board for an AU PQ (e.g. AUQ38E or DBU38E).

Booting or shutting down the system

The possible actions depend on the particular status of the system: If the system is running, the Operation tab in the
Actions group displays the text Shutdown. If the system is not running, the text Boot is displayed.

> In the Actions group click Execute to shut down or boot the system.

i For AUs that are only embedded at hardware level, only the Native System is displayed, as follows:

® The SENET name is displayed as the host name (e.g. aul-sel).
®* NOT_MONITORED is displayed as the status.

® There is no shutdown action available.

For more information, refer to the online help.
Please contact Customer Support for further details.
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6.2 Operating virtual machines

When an AU is operated with a hypervisor system, VMs can be configured (via this hypervisor system).
As soon as a VM has been configured, the tree structure below Systems -> [<se server>(SE<model>) ->] <unit>
(AU<model>) is expanded by a VM-specific menu <VM-Name>.

In the case of AU PQ, systems run on the individual partitions of the AU. As soon as a VM has been
configured, the tree structure below Systems -> [<se server> (SE<model>) ->] <unit> (<AU PQ model>) -
> <unit> (<partition>) is expanded by a VM-specific menu <VM-Name>. You can operate the VM in this
window.

Information on VMs

The VM overview tab provides information on the virtual machines which run on the AU under a hypervisor
(VMware vSphere ESXi or HyperV Windows Server).

>

Select Systems -> [<se server> (SE<model>) ->] <unit> (AU<model>), VM overview tab.

On AU PQ select Systems -> [<se server> (SE<model>) ->] <unit> (<AU PQ model>) -> <unit> (<partition>),
VM overview tab.

The VM overview tab displays the configured VMs.

Operating a VM

In the VM-specific menu you receive detailed information on the VM. Depending on the situation, you can also
execute an action directly for the VM (e.g. start the VM).

>

In the tree structure select Systems -> [<se server> (SE<model>) ->] <unit> (AU<model>) -> <VM-name>.

On AU PQ select Systems -> [<se server> (SE<model>) ->] <unit> (<AU PQ model>) -> <unit> (<partition>) ->
<VM-name>.

The Operation tab opens and in the Status group displays the properties and current status of the VM.

For the hypervisor VMware vSphere ESXi, the Operation group is also displayed provided the associated
hypervisor is active and can be reached by the Management Unit. That means a VM with vCenter Server
must be running on the Application Unit.

Some actions for the VM can also be called directly in the SE Manager:

>

Click Open for VMware vSphere Web Client in the Operation group.
The VM Manager opens in a new window. After logging in successfully, you obtain access there to manage
the VMware hosts/systems.

Additionally, the group also offers the Open action for VMware Host Client.

In the Actions group click an action which is to be executed directly for the VM.

Depending on the situation, the actions Start VM, Restart VM, Power off VM, Pause VM, Resume VM and
Stop VM are available for selection.

These actions are also available for VMs with the hypervisor Microsoft HyperV.
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6.3 Installing an operating system on an Application Unit

As administrator you manage the applications and the operating system on AUs.

When requested by the customer, an AU is configured on the vendor side and provided with an operating system.
In this case it is supplied preinstalled and the steps described below are not required. It is also possible for the
customer to reinstall the operating system in this case.

Configuring the SAS/SATA Controller Card

The AU has a SAS/SATA RAID Controller with “MegaRAID functionality”. You can configure the SAS/SATA RAID
Controller either before installation with the LSI WebBIOS or during installation with the ServerView Installation
Manager. For basic RAID configurations the ServerView Installation Manager can be used in the context of
operating system installation.

i The controller provides a separate utility for configuring the MegaRAID. Detailed information on this
subject is provided in the “LSI MegaRAID SAS Software” manual [19].

Further information on modular RAID Controllers is provided in the “LSI Controllers Modular RAID
Controller” Installation Guide [20].

Descriptions of operating systems which are not contained in the controller manual are provided in the
corresponding Readme files on the driver CDs.

Configuring the integrated Remote Management Controller (iRMC)

The iIRMC-LAN interface is already preconfigured for your administration LAN by the vendor. This enables you to
utilize all functions of the iRMC such as Advanced Video Redirection (AVR) and Remote Storage for operating
system installation.

If you want to use a configuration other than the preconfigured network configuration, adjust the iRMC’s
configuration accordingly.

You configure important server parameters such as the ASR&R settings (Automatic Server Reconfiguration and
Restart) and watchdog settings in the web interface of the Application Unit’'s iRMC.

Further information is provided in the “IRMC S<n> - integrated Remote Management Controller” manual [16].

Configuration and operating system installation with the ServerView Installation Manager

The ServerView Installation Manager which is contained on the enclosed ServerView Suite DVD1 enables you to
perform operating system installation and also to configure hardwarespecific parameters of the AU. This includes
configuring settings with the ServerView Configuration Manager and configuring the RAID Controller with the
ServerView RAID Manager.

You can read how you operate the ServerView Installation Manager and further information in the associated
manual [17].

Configuration and operating system installation without the ServerView Installation
Manager

In the case of manual installation without the ServerView Installation Manager you can configure all aspects of
server, RAID and operating system installation in accordance with your requirements.
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Configuring a RAID Controller

The SAS/SATA RAID Controller is configured with “MegaRAID functionality” using the controller’s WebBIOS tool
(see "Configuring the SAS/SATA Controller Card").

Installing the operating system:

> Insert the CD/DVD/BD of the operating system which is to be installed.
> Restart the AU.

> Follow the instructions on the screen and those in the manual for the operating system.

Installing ServerView agents and the ServerView RAID Manager

AUs are permanently monitored as part of the maintenance concept for SE servers; hardware problems are
reported to the Support Center.

ServerView agents and the ServerView RAID Manager must be installed in the Application Unit's operating system
to permit hardware monitoring.

> Install the ServerView agents and the ServerView RAID Manager. Use one of the following options for this
purpose:

® You can download the software from the internet by specifying the Application Unit’'s serial number:
http://support.ts.fujitsu.com , section Driver & Downloads. You will find the two software packages under
Server Management Software.

® You can install the software from the ServerStart DVD1, which is supplied with the Application Unit.

® You can install the software when the operating system is installed if you install the operating system with
the ServerView Installation Manager.

The associated installation instructions are provided in the Installation Guides for the ServerView Operation
Manager [17] and [18].

Configuring the network for the administration LAN

For the connection to the MU, AUs must be configured at the administration network. Configure this network when
you install the operating system.

Configuring LAN interfaces

The connection can either be made to the public MANPU administration network or to the private MONPRO1
administration network.

® For connection to MANPU:
Use Linux resources to configure the IP address, subnetwork and gateway.

® For connection to MONPRO1:

Activate Linux for the selected eth interface DHCP for IPv6. The MU then assigns an automatic IPv6 address in
the MONPRO1 network.
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In case your Linux does not support IPv6, you can connect the AU to MONPRO1 via a static IPv4 address. To do
so, please contact your service technician.

You configure the management network using Linux resources with the appropriate IP addresses, subnetwork
masks, and gateways.

You configure the IP address in the administration network in accordance with your administration network, as
defined with Customer Support in the installation checklist.

There is also an option of connecting an AU to private data networks (DANPRnNnN) or public data networks
(DANPUNN). Ask your Customer Support staff for details.
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7 Managing applications

You manage applications using the Applications menu in the tree structure. A distinction is made between SE
management applications and user-defined links.

In the tree structure, the user-defined links are subdivided according to the category assigned to them.

D Applications

= SE management
BS2000 Backup Monitor
openUTM WebAdmin (basel)
= User-defined links
= BS2000
B52000 manuals
BS2000 messages

+

IP networks
FC networks

¥

+ Slorage
General

+

You get an overview over all SE management applications of the SE administration area and you can manage user-
defined links:

® SE management applications are fully integrated into the SE Manager.

® User-defined links are opened in a new window or tab in the browser.

Overview of all SE management applications of the SE administration area

> In the tree structure select Applications -> SE management. The Overview tab opens.

Overview

~ SE management applications

)

Name ~ Description Management Unit
Filter Filter Filter

BS2000 Backup Monitor Backup Monitor for HSMS and FDDRL in BS2000 - (global)

openUTM WebAdmin openUTM server administration basel

ROBAR ROBAR-SV Server bern
o & Total: 3
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7.1 SE management applications

SE Management applications execute on the Management Units and are fully integrated into the SE Manager. For
details, see under "Management applications" in section "Add-on packs".

The following SE management applications currently exist:

® BS2000 Backup Monitor is a permanent part of the SE Manager.

® Storage Manager is a preinstalled add-on pack (in the Hardware -> Storage menu, see section "Managing
storage systems").

The following optional SE management applications can be installed as add-on packs:

® openUTM WebAdmin (see "openUTM WebAdmin®)
®* ROBAR (see "ROBAR")

® openSM2 (see chapter "Monitoring performance")

If the administered SE server configuration has more than one MU (SE server with redundant MU or two SE servers
in a Management Cluster), every installation of these SE management applications is listed in the tree structure,
with the exception of the BS2000 backup monitor. The name of the MU on which the application is installed is given
in brackets after the name of the application. In the table of SE management applications, the name of the
respective MU is listed in the Management Unit column.

ROBAR and openSM2 are chargeable products, each with its own online help, which are realized as add-on packs.
openUTM WebAdmin also is a product with its own online help and realized as add-on pack, but it is not
chargeable. The basic product openUTM, however, is chargeable.
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7.1.1 BS2000 Backup Monitor

The BS2000 Backup Monitor monitors backup requests which have been submitted in the BS2000 systems of the
SE server configuration using the software products HSMS and FDDRL. Whether or which information of a BS2000
system is transferred to the BS2000 Backup Monitor is controlled by an HSMS or FDDRL parameter.

> Select Applications -> BS2000 Backup Monitor -> Overview, Overview tab.

Overdew | Reguests
» BS000 backip requests olarview

Gl requests

HSME Request Statn FDDRL Request Sute
- System ServerUnit ACCEPTED STARTED INTERRUPTED OK ERRORS  ACCEPTED STARTED OK ERRORS
Fiter Filter Al - - A - A - A - - A Al Al

ABGSESDT  MONTOR sutsed
S ABGSEYD
ABGSESIA VMO0V

sulsed

il %S e 1<

In the Overview tab you can retrieve requests (via the Get requests button above the table or for a specific syste

-,
the = icon) as well as delete requests.

> The Requests tab provides you with detailed information on the various requests and, when necessary, enables

to display the report file.

The display of the backup requests for each SE Manager is only possible when REWAS is active, see section

"Integration of BS2000 into the SE Manager".
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7.1.2 openUTM WebAdmin

openUTM WebAdmin enables you to manage openUTM applications on the SE server. openUTM WebAdmin has
its own online help.

> Select Applications -> openUTM WebAdmin.

The Home tab displays the homepage of openUTM WebAdmin.

Home

=)

fﬂf]ﬁ Collections

Reiresh Data
Name Group UTM Applications Remark
Fiter Alf x| an =] an =l
® g =2 LT Application <all» Containg all UTM applications from the
® i oeo-bs2000 michael GEGUTMD / DO  GTESTHAAT DU
- ﬁ aEg-uniy michael GEGOT /M . GEGOY ! MCHOOL

Mumber of Collections: 3

The menus of openUTM WebAdmin are displayed in the tree structure.

> Clicking SE Manager in the tree structure returns you to the SE Manager.
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7.1.3 ROBAR

You use the ROBAR-SV Manager to manage ROBAR-SV instances on the SE server. The ROBAR-SV Manager
has its own online help.

> Select Applications -> ROBAR.

The Overview tab displays all ROBAR-SV instances.

Overview

ROBAR-SV Instances (7)

Uplosd configurstion fie

Create new instance |

Name | Interface Connection L Status  Connection Status Action

Fiter Al | Fitter Al =] an =|

stl meiss conf  ABBA 174 1".37.75,3058 RUNNING  J» = y W

=cl meiseu conf ABBA 173 1°.37.75,3059 STOPPED y ®
ABBA 192 537 75,9058 STOPPED » ®
ABBA 1172, /7.37.75,3058 DEFINED ’ ®
ABBA 152,90 .36.133,9058 DEFINED o I
ABBA 17.5.).38.128,9058 DEFINED $
ABBA 122.4..35.57,3000 DEFINED $ @
scs! 3500308c001415800 DEFINED »
scs 1ADIC_ADCO245803_LLD DEFINED $ ™
scsl 1ADIC_ADC0245B03_LLB DEFINED y ™

Mumber of Instances, 10

In this tab you can upload a configuration file, select and edit the configuration file of an instance, generate a
new ROBAR-SV instance or delete ROBAR-SV instances.

The menus of the ROBAR-SV instances and of the ROBAR-SV management are displayed in the tree
structure.

> Clicking SE Manager in the tree structure returns you to the SE Manager.
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7.2 Administering user-defined links

> Select Applications -> User-defined links, Administration tab.

In the User-defined links group the Administration tab displays the list of the user-defined links which are embed

Administration
User-cafined links B
Embed usor-ooined ink
S = Phsorel Canegory URL. Unit System
HE2000 Ftnr A - | Fiter Ftey Fater
2 BS000 manua serer BS2000 haps Phe2manuals 15 fugdtsu cam LA

BE2000 sysiem messages (Gerwn) hisp (s rmaniis 15 hgtsy CoMBSImessages ¥

> The Change and Remove icons enable you to change application properties (e.g. a URL) or remove the link to &
SE Manager.

> Embed user-defined link enables you to integrate further external links into the SE Manager and assign them to
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8 Monitoring performance

The openSM2 Performance Monitor can be integrated into the SE Manager as add-on pack OPENSM2. This

enables the performance of the Server Units and the systems running on them to be monitored centrally using the
SE Manager. openSM2 is optional and chargeable.

> If you have a single-MU configuration and click on Performance in the tree structure, the welcome page of the o}

Manager opens. The layout is the same as the layout of the SE Manager.

S opsenae

(€] SEManime Systams | yslemproperies | Alem messages

Surver sysiams i,
£, View
L il ot i CrupH, Mampa) Beapon)
ntvivns : A « From o From 1o From 0
Reptan views
Expont joos sut-set o ay 118
Anabysis ABGEETIE EEEN 103 a0
AT L a2 145 19675
AhgeTrn? L 42 7B 5087
DOT5ZE04 BS2000 13 =] 22
L Sollegs 5 Storage systems
o Administniion y L bsinid — ___ Datapuare] L . Timajmsa0]
& -y : Fite From w From o From w
4572437001 TTERNLS FIXES0 56 253 102813 a1
4562412001 ETEANLIS DNEO0 55 23 105003 a1
4852005001 ETERMNLIS CINSE0 25
ABEZ214004 ETERNLIS CIXES0 54
1511951002 ETERNLIE D500 55
Snp systems
Systen
i From 1o From L]
dumviper Neshivorks, (1. 3400481 Efernet Suilch,
7 K JUNCES 23 7R T, Poskd dale 30230616 o .
i 015 LITC Copyiion! (5 1996-2023 Junges iz 158
Metworks, Inc
st NX-CAS{Im) Nessno Cansivc-Fis,
AT Software (NXCS 64-0f). Version 10,4(4), RELEASE

SOFTWARE Copynghl (i) 2002 2024 by Cisea

If you have an SE server configuration with multiple MUs (MU redundancy or Management Cluster), the tree strt

contains a submenu below Performance, which contains an entry Performance (<mu-name>) for each MU of the
configuration on which openSM2 is installed.

(;) Performance

! Performance (abgse1mu1l)
Performance (abgseimu2)
I Performance (abgse2mul)

Click on an entry to open the welcome page of the openSM2 Manager of the respective MU.
> You use the tree structure and tabs of openSM2 to call the functions of openSM2.

> SE Manager in the tree structure returns you to the SE Manager.

Further details on openSM2 are contained in the openSM2 User Guide [14].
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9 Managing devices

You manage the devices of the SE server using the Devices menu in the tree structure.

If you manage an SE server configuration with two or more SE servers in a Management Cluster, underneath
Devices there will be a submenu <se server> (SE<model>) for each SE server, containing the devices of the
respective SE server.

The devices are managed on an SU-specific basis.

For an SU x86 you manage BS2000 devices via the SU itself. Detailed information is provided in the sections on
disks, LAN devices, KVP, and tape devices.

A few special aspects apply for an SU /390, see Device management on Server Unit /390.

Emergency system

A new SE server is prepared by the manufacturer so that it is ready for use by the customer. The Server Units are
delivered with a pregenerated and preinstalled emergency system. The emergency system is IPL-capable. It is
intended for installation and maintenance only, should not be used for everyday operation, and should not be newly
installed by the customer. The pubset with the emergency system can be kept as a stand-by pubset or for
diagnosis. You can find more information in the "System Installation (SE Server)" [9] user guide.

The description is divided into the following sections:

¢ Device addresses

® Device management on Server Unit /390
© Predefined BS2000 devices
© Device connection via Management Unit and HNC
© Configuration in IORSF files

® Device management on Server Unit x86
© Predefined BS2000 devices
© Connection of peripheral devices

® Managing disks
© Managing disks on Server Unit /390
© Managing disks on Server Unit x86

® BS2000 paths

® Managing KVP devices

® Managing LAN devices

® Managing tape devices
© Emulated tape devices

© Emulated tape devices from the BS2000 viewpoint
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9.1 Device addresses

Mnemonic and unit ID

In BS2000 devices are identified and addressed by means of their mnemonic name. The mnemonic name is known
as mnemonic for short and abbreviated to MN (in BS2000 output sometimes also abbreviated with MNEM).

Example

On the BS2000 console an emulated tape drive with the mnemonic AF is addressed in the /SHOW-DEVICE-
STATUS and /ATTACH-DEVICE commands:

/ SHOWM DEVI CE- STATUS AF
% MNEM DEV- TYPE CONF- STATE POOL VSN  DEV-A PHASE ACTI ON

% AF BML662FS DETACHED SW FREE NO ACTI ON

/ ATTACH- DEVI CE AF

% MSG- 000. 165608 % NKRO042 ' DEVI CE =AF': ATTACH ACCEPTED
9XAAE- 000. 165608 % NKR0116 ASSI GN FOR ' DEVI CE=AF' | N PROCESS

% M5G- 000. 165608 % NKR0110 ' DEVI CE =AF'" ATTACHED AND ASSI GNED

I UCO 000. 165608 % NBRO740 COMVAND COVPLETED ' ATTACH- DEVI CE' ; ( RESULT:
SC2=000, SC1=000, MC=CMD0001); DATE: 2017-01-09

/ SHOW DEVI CE- STATUS AF

+XAAD MNEM DEV- TYPE CONF- STATE POCL VSN  DEV-A PHASE ACTI ON
+XAAD AF  BML662FS ATTACHED SW FREE NO ACTI ON

Tape drive AF is initially in the DETACHED status (CONF-STATE); it is then successfully attached using the
/ATTACH-DEVICE command. The second command, /[SHOW-DEVICE-STATUS, shows the new status.

With the exception of "normal” disks and real tape devices, the devices visible to BS2000 on an SU /390 are
emulated devices and not directly the real devices. The disks for the emergency system are emulated at the MU.
On SU x86, all devices visible for BS2000 are emulated. The following designation is more precise than "emulated
devices": BS2000 emulations of the real devices.

The device address must be specified when an emulated device is configured for BS2000. The names in X2000
/M2000 for the channel path identifier and logical unit number (LUN) are Host Connector and Unit ID, with Unit ID
corresponding to the host LUN.

BS2000 Device address @ Device address Device address
X2000/M2000 @ SU /390 (IORSF) Periphery

Channel path identifier = Host Connector = Channel path identifier | -

Logical unit number Unit ID Logical unit number Host LUN or LUN

For information on device addresses in BS2000, please also refer to the “System Installation (SE Server)” manual [9

1

When a device is generated for BS2000, the following details are required in addition to the type-specific data:
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® Unit ID on SU x86 or LUN on SU /390
Possible values:

© Unit ID: hexadecimal, two digits in the range 00 through FF
© LUN: 0000 through FFFF
All values are functionally equivalent.

® Mnemonic
Possible values:

© alphanumeric, two characters (character set: digits and letters)
© hexadecimal, four characters (character set: numbers from 1000 through FFFF)

The mnemonics can be selected in such a way that every customer-specific naming schema is supported. On an
MU no check is made to see whether the specification matches the mnemonic configured in BS2000. To prevent
misunderstandings, they should be identical.

Every combination of the possible values is permitted.
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9.2 Device management on Server Unit /390

On the SU /390, all the devices which are used must be generated in the IORSF. One or more IORSF files are
stored in the SVP. One IORSF file is used for the IPL. This is the "current" IORSF file.

KVP devices, LAN devices, and emulated tape devices of the SU /390 are emulated on the MU. In addition, up to
two disks of the type EMDISC are emulated for the emergency system of the SU /390 on the MU. ZASLAN devices
of the SU /390 are emulated on the HNC. However, the relevant devices must always also be generated in the
current IORSF. In the device overviews, the Unit and Unit type columns indicate the unit on which the device is
emulated.

Apart from the devices which are emulated on the MU or HNC, further devices, namely disks and real tape devices,
exist in BS2000.

For devices which are emulated on the MU, the Host Connector is always 00. For devices which are emulated on
the HNC, the Host Connector is 00 or 01.

FC-SCSI channels have a Channel Path ID (CHPID) >= 02.

There are no device licenses. LUNs 0000 through FFFF can be used without restriction for configuring devices
irrespective of the type.

Information on the generated BS2000 devices of the SU /390 is displayed when the data of the current IORSF file is
available.

® Predefined BS2000 devices
® Device connection via Management Unit and HNC

® Configuration in IORSF files
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9.2.1 Predefined BS2000 devices

The following BS2000 devices are predefined for the SU /390:

Type
EMDISC

KVP

LOCLAN

CDROM

EMFILE

MN HC
CCFO0, CCF1 00
c2 C3 00

Cccso_ccs1 00

TO 00

T1 00

LUN
30, 31
c3 c4

80_81

60

61

Details
2 emulated disks (e.g. for BS2000 emergency system)
Name: HVO

Name: MANLO1
IP address: 192.168.138.21
Address space: 192.168.138.xx

Real CD-ROM drive

emfile0061

In the case of MU redundancy on MU2 (MU index 2):

EMDISC

KVP

LOCLAN

CDROM

EMFILE

CDFO, CDF1 00
C4_C5 00

CD80_CcD81 00

TA 00

B 00

30, 31
C3_C4

80_81

60

61

2 emulated disks (e.g. for BS2000 emergency system)
Name: HVO

Name: MANLO1
IP address: 192.168.139.21
Address space: 192.168.139.xx

Real CD-ROM drive

emfile0061

Table 5: Predefined BS2000 devices on SU /390 (MU)

On the HNC the following BS2000 devices are predefined for the SU /390:

Type

LOCLAN

ZASLAN

MN HC

CC40_CC41 00

LUN

Details

Address space: 192.168.151.xx

40_41 | Name: MCNPR

Slot: s2 p0 pci

In the case of HNC redundancy on HNC2:

LOCLAN

ZASLAN

CD40_CD41 00

Address space: 192.168.152.xx

40_41 | Name: MCNPR

Slot: s2 p0 pci

Table 6: Predefined BS2000 devices on SU /390 (HNC)

147



SE Server - Administration and Operation - User Guide

i In case of a Management Cluster, these BS2000 devices are predefined on MU and HNC for the SU /390
on both SE servers as described above.
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9.2.2 Device connection via Management Unit and HNC

You manage the devices of an SU /390 via the Management Unit. The devices are emulated on the MU or, in the
case of LAN devices, alternatively on the HNC. When adding a device, the first step is to specify the MU or HNC
where the device will be emulated. LAN devices of type ZASLAN or LOCLAN can be emulated on an HNC, only

those of type LOCLAN can be emulated on an MU.

You can manage (add, change, remove) KVP devices, LAN devices and emulated tape devices via the
Management Unit. Disks and real tape devices are only displayed.

Details are provided in the sections below:

® Managing KVP devices
® Managing LAN devices

® Managing tape devices
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9.2.3 Configuration in IORSF files
Creating the current device lists for SU /390

> Select Devices -> [<se server> (SE<model>) ->] <unit> (SU</390>), IORSF files tab.

IORSF files Disks | BS2000paths | KWP | LAN Tape devices
- Sarver Lnit EM1: IORSF flles (7
Updale IORSF Fis list Ganerale and Wranster IORST fe Last update of the IDRSF data: 02700271 130028
Level File (description) Date Active Planmed  Pr

0 SUT0DCISUTIONCI 01, 20,02 2023 2023-02-21 10:4835 3 I
1 SUT10-55EM-1 29002 55, 14.06 2022 2022-10-13 1552865
2 SUTI0-SEEM-129002 56 16112022 2022:10:21 175447 ]
3 SUMD-S5EM-1 29002 55 14.06 2072 2022121 \P5132 ﬂ
4 SUTTI043EM-1 29002 43, 13112018 2020-01-27 14:52:30
5 FSTSTARTBASECONF I0P=2. HNG=1, MU=1, VW=1 - 2021-07-21 2021-07-21 10:00:01 s
€ FSTSTARTBASECONF I0P=2, HNC=1, MU=1, WM=1 - 2021.07-21 2021-07-21 DE5LET 0
7 TYPE-1)IQINITIAL PATTERN CHEO0=FCN DATE 020CT/2013 12/00/25V10L48 A01B-03-13 O7-28:17 ] o1
i

» Server Unit EM1: Basic configurations

Basic configuration for the emengency system LW ]

Totsl 1

The IORSF files tab provides information about the IORSF files which are available on the SU /390.

> Click Update IORSF file list to update the file list and the device lists. This action is only possible if at least
one of the associated MUs is in normal operation.
The previous file list and the previous device lists are deleted and the current data are transferred from the
SVP. The active IORSF file is edited implicitly, and the device lists of the Server Unit are refreshed.

i The SE Manager always displays the devices which are contained in the current IORSF file on the SVP
(*CURRENT level). Dynamic I/O configuration changes are initially performed in the active IORSF. The
SE Manager can display these changes only if you write back the changed configuration to the relevant
file on the SVP. Use the / STOP- CONFI GURATI ON- UPDATE | ORSF- UPDATE=* YES( LEVEL=. . .)
command in the BS2000 to do this. After that you have to run the Update IORSF file list action in the SE
Manager.

If the current IORSF file has been changed but the IORSF file list has not yet been updated, a warning
icon with a corresponding tooltip is displayed in the Active column for the current IORSF file.

Creating an 1/O configuration for SU /390
In SEM, actions are available with which 10 configurations (IORSF files) can be created and transferred to the SVP:
® Generate and transfer IORSF file

® Generate and transfer the basic configuration

The actions are executed on the MU and do not require an active BS2000.
The generated configurations and log files are no longer accessible after the respective action has been completed.
The actions must be repeated completely if they fail or are not completed.
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> Click button Generate and transfer IORSF file in group IORSF files
The individual steps for generating and transferring the IORSF file on the SEM are as follows:
® Upload the file(s) with the IOGEN instructions from the PC to the MU,;

then select the start file and the configuration, if necessary.

® Generating an IORSF file (on the MU)
It is possible to download the log file to the MU. The generated log file contains the data of the IOGEN and
IOCGEN runs in the form as they are created in BS2000 with the option PROT=*SPOOL in the SYSLST file.
(The IOGEN and IOCGEN protocols are not separated.)

® Transferring the IORSF file to a selected SVP level

. . . . BT . . . . .
> Click Generate and transfer basic configuration (~3‘;‘r) icon in the Basic configurations group

Without existing IOGEN instructions the generation and transfer to the SVP of a basic I/O configuration is possible.
The basic configuration can be used for an initial installation or as an emergency system.
The basic configuration includes the following devices:
® Via the channel with CHPID 40 at the MU (first MU):

© EMDISCs CCF0, CCF1

© KVP main consoles C2, C3

© LOCLAN connection (dialog) CC80, CC81

© CDROM TO

© EMFILE T1
® Via the channel with CHPID 08 on the HNC (first HNC):

© ZASLAN (Data LAN) CCO00, CC01

© ZASLAN (Control LAN for REWAS) CC40, CC41

The corresponding IOGEN instructions can be downloaded in a file to the PC for further use.
The name in the basic configuration is "FSTSTART".

Creating an IOGEN source
From an existing IORSF file, the corresponding IOGEN source can also be created again in the SE Manager.
> Click the Create IOGEN source (I§ﬁ£|) icon by the desired IORSF file

This invokes a wizard that calls IOGEN, displays the IOGEN job messages, and offers to download the generated
IOGEN source.

Details on the 1/O configuration and the IOGEN utility can be found in the manual "System Installation (SE Server)" [
9].
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9.3 Device management on Server Unit x86

On an SU x86 all the BS2000 devices (disks, KVP, LAN devices, tape devices) are emulated in X2000.
The devices are managed on the SU x86 concerned.
When devices are added, device licenses may need to be taken into account.

® Predefined BS2000 devices

® Connection of peripheral devices
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9.3.1 Predefined BS2000 devices

The following BS2000 devices are predefined on SU x86:

Type

EMDISC

KVP

LOCLAN

ZASLAN

CDROM

EMFILE

MN

DO

Z0 71

CC80_CcCs81

CC40_cca1l

CD

EF

HC | Unit

00

00

oC

oC

00

00

ID

30

04 05

80_81

40_41

CD

EF

Table 7: Predefined BS2000 devices on SU x86

Details

Emulated disk; generated as standby pubset with the emergency
system.
The EMDISC DO is no more set up for SU models as of SU330.

Name: HVO

Name: MANLO1
Address: 192.168.138.21
Address space: 192.168.138.xx

Name: MCNPR
Slot: s1 p0 pci

Real CD-ROM drive

emfile00ef
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9.3.2 Connection of peripheral devices

When BS2000 devices which reside on peripheral devices (disks, tapes) are configured, as a rule not only the
X2000 level plays a role, but also other levels.

The various levels are explained on the basis of an example of a connected (via FibreChannel) disk storage system:

® The BS2000 disks are mapped on Linux disks.
® The Linux disks are operated via one or more FibreChannel HBAs (Host Bus Adapters).

® The SU x86 is connected to the disk storage system either directly or via a FibreChannel switch.

SU x86 Instance Level Task/explanation Configuration example

Assignment of BS2000 MM 2000 : /xemp<serial#><lun>
device to Linux device

0+ 040
&S
g

Multipath 3  path administration , [xemp<senal#<iun> —
mapping to physical device 0. wwn 50:06:04:..59
/ \ and assignment to WWPN  and
of the storage system 1:wwn 50:06:04°.. 46
0 1
| TS RS SUBN Sl T N =N R T NSNS
Switch 2 Zoning

Switch Switch
| i O . S AT i T TS ik e R0

';gt;‘sA [;;{,5: FCadapter 1 AssignmentfromLUNto  4A: lun 000 — logical volume 010
04:.59 | 0446 logical device # 5A : lun D00 — logical volume 010
e e eSS e RS Saa S Snsias s

Figure 16: Device configuration on an SU x86 taking a disk storage system as an example

FibreChannel-connected BS2000 disks on an SU x86 must be configured at Storage(1), Switch(2) and X2000(4)
levels. No special configuration is necessary at Multipath(3) level. However, it is necessary for Multipath to know the
connected devices. For this purpose Customer Support can scan the devices, if required. When an operational
interruption is acceptable, you can as an alternative reboot the Server Unit.

® Storage level
The settings in the storage system should be made by a qualified technician.

® FibreChannel switch
The zone is set in the FibreChannel switch.

® X2000
Use the SE Manager to configure the disks of the storage system as BS2000 disks of the SU x86. Customer
Support must partition disks of the type D3475-8F up front.
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9.4 Managing disks
Disks of the type A5 (D3435) or A6 (D3435-FP, for SU /390 only) are connected to an SE server. The disks are
connected either internally (within the SE server) or externally (in other storage systems or cabinets).

For the Server Units, the Disks tab offers functions for managing disks. A distinction has to be made between SU
/390 and SU x86.

® Managing disks on Server Unit /390

® Managing disks on Server Unit x86
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9.4.1 Managing disks on Server Unit /390

> Select Devices -> [<se server> (SE<model>) ->] <unit> (SU</390>), Disks tab.

HIRSE fres

= Server Unil BV Disky

Aaznaw

The devices are displayed completely only if the data of the active IORSF file are available at the MU. If
necessary, execute action Update IORSF file list on tab IORSF files for this purpose.

000 pashs | HVF

LAN

g evxes

1 %0 32 brom 58

s | -{h, S A -

Ladt update of the BE2000 data: MIS05-06 124045 3

. " Gotopage t [ Perpage 82
MN - HC  CHPID HostLUN  Sio Errage vl Tyee Coga | WWFN | P . Siza[ME]  Lisage Fomat L Vs ‘Assigned  sttus
FBCIDT Furer P Fomer Foter e omer A o w  Fikey ~ A + Fuer n - AV > AT » [l Fider ~

BODS 00 40 546 - EMDERC AL 000 CREEH D0 O 00 A Pmin THOG . Pubkst LV BODSO MOMITOR 2

BODE - A0 5% - HWSF A& 00,0000 0000 D0 OX00. - - -

BOGT 0 ar Lo =1 Al A3 001 00, 00 00 10 O 00

BODE 00 A0 sl EMOISC. MG 043,00 K100 01 €80 £6) abgsefimu i itialized ARGEETIA

BODS 00 40 58 EMOSC A5 000,00 0000001 001,00 stgeTivu 2000 Pubsat hacz BLOa0

BODA o oA TNGO0-564 LGN 5 bORSF A5 500000 EQDO-AFA4 20, L READY
BODA ca oA DXEO.S61 4BETA12001 W6 KORSF A SO 00BN D40 4435 @ READY
BODA, - ] 04 TXBO0-56-4 562412001 3db KORSF A5 SOOOOEG DA - 10 READY
BODA {21 DA OxG00-86-1 562412001 346 KORSF a5 SO0 00 ErOD 604435 ) READY
EOOA aa A XECO-SE-Y AEETH2HN 346 KBE Al SO0 EDTI A2 - 0 HEADY

otz 58 from 25603

The Disks tab provides information about the BS2000 disks configured in the active IORSF file as well as about

those emulated on MU.

Above the table the number of free licenses is displayed.

In VM2000 mode the table contains an additional column: if a device assignment exists, the column

Assigned displays the VM name.

The columns Host LUN, Storage name, Storage serial number, Volume number, Volume name and
Status are supplied only, if STORMAN is properly configured and the storage data is updated. For this,
the Update storage data dialog in the Hardware -> Storage menu must be called.

For emulated disks (type EMDISC) only, the following options are available to you:

Add new BS2000 disks

> Click Add new BS2000 disks.

In the Add BS2000 disks wizard you can specify the required properties and the desired humber of emulated
BS2000 disks step by step.

Remove BS2000 disks

> Click Remove BS2000 disks.

In the Remove BS2000 disks wizard you can specify an interval of MNs for the BS2000 disks to be removed.
The same prerequisites apply as for Remove disk (see below).

Update BS2000 data

> Click the Update BS2000 data icon ( & ) and confirm the action. This concerns only disks of type EMDISC
emulated on an MU.
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Remove disk

i The following requirements must be satisfied:

® The disk must be an emulated disk (type EMDISC).

® The disk must be out of service as a BS2000 device in order to prevent data loss (/EXPORT-PUBSET
and /DETACH-DEVICE commands).

® |n VM2000 mode the disk may not be assigned to a VM.

> By the required disk, click the Remove icon () and confirm the action.
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9.4.2 Managing disks on Server Unit x86

Displaying disks

> Select Devices -> [<se server> (SE<model>) ->] <unit> (SU<x86>), Disks tab.

The Disks tab displays the configured BS2000 disks.

Above the table the number of free licenses is displayed.

i Only in VM2000 mode the table contains the column Assigned (see the picture): if a device assignment
exists, this column displays the VM name.

The columns Host LUN, Storage name, Storage serial number, Volume number, Volume name and Status
are supplied only, if STORMAN is properly configured and the storage data is updated. For this, the
Update storage data dialog in the Hardware -> Storage menu must be called.

The following options are available to you:

Add new BS2000 disks

> Click Add new BS2000 disks.

In the Add BS2000 disks wizard you can specify the required properties and the desired number of BS2000
disks step by step.

Remove BS2000 disks

> Click Remove BS2000 disks.

In the Remove BS2000 disks wizard you can specify an interval of MNs for the BS2000 disks to be removed.
The same prerequisites apply as for Remove disk (see below).

Update BS2000 data

> Click the Update BS2000 data icon ( z ) and confirm the action.
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Remove disk

i The following requirements must be satisfied:

® The disk must be out of service as a BS2000 device in order to prevent data loss (/EXPORT-PUBSET
and /DETACH-DEVICE commands).

® In VM2000 mode the disk may not be assigned to a VM.

> By the required disk, click the Remove icon () and confirm the action.
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9.5 BS2000 paths

In the BS2000 paths tab the configured paths between server and storage are shown.

The prerequisite for this is that the FC network data and in addition also the storage systems in StorMan are
configured correctly. If necessary, these must first be updated. Information on updating the FC network
configuration can be found under Configuring settings (Administration and Operation, #213).

> Select Devices -> [<se server> (SE<model>) ->] <unit> (SU<model>), BS2000 paths tab.

Disies: BEII00 pathy L il T e
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]
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Rangs. e Port Mama of LUtk
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spl  H0P000 R i T | W
VROTE T P ADO0ON DO F 1ocT " £ HoRAL
fp0 W : [ "
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The BS2000 paths tab opens. A table displays the entries grouped according to the MN range. The icon |I| resp. El
above the table makes it possible to switch between the default view and an alternative view of the columns.
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9.6 Managing KVP devices

A KVP (console distribution program) with the name HVO is preconfigured on the MU and SU x86 (see table 5 and
table 7). You can delete the existing KVP and then define a new one with different values.

BS2000 sees a KVP as two (emulated) KVP devices (or a device pair) which are identified by their mnemonic
names.

For VM2000 mode it is necessary to define at least one KVP per VM. By default HVO is the monitor system's KVP.
Access to a BS2000 console always takes place via the KVP and the home account. An operator requires an

individual right for access. For information on this, see section "Opening the BS2000 console and dialog window".

i Recommendation:
Define precisely one KVP for each VM (in the case of SU /390 for each MU).

> Select Devices -> [<se server> (SE<model>) ->] <unit> (SU<model>), KVP tab.
IORSFfles | Disks | BS2000paths | KVP | LAN | Tapedevices

w» Server Unit su390-se4: KVP devices (IORSF file: #3, 2022-11-21 17:57:22)

(©)]

| Addnewkve | Free licenses: 240 i)
Perpage 32 v
MN « HC HostLUN CHPID Type Name Unit Unit type Assigned Status Color
Filter Filter  Filter Filter All ~ Filter Al ~ Al ~ |Filter NORMAL -
c2c3 0o C3_C4 40 KVP HVO abgse4mut-1 MU MONITOR @ NORMAL
C4 C5 00 C3 C4 08 KVP HVO abgse4mu2-1 MU MONITOR @ NORMAL
CN_CO 00 BO_B1 40 KVP VMA abgse4mui-1 MU ABGSE11A @) NORMAL
Cy . cZ 00 BA BB 40 KVP VMF abgsedmui-1 MU ABGSE11F @ NORMAL
o Total: 4 from 44
w Server Unit su390-se4: KVP logging files 0

KVP | VMA (abgse4mui-1, & files) v

MNumber File name File size [Bytes]
1 KVPLOG.VMA.230208.021037 819 ® 4
2  KVPLOG.VMA 230207.105126.bz2 4,256 ® 3
3 KVPLOG.VMA.230206.130010.bz2 6,004 ® 9
4 KVPLOG.VMA 230203.124040.bz2 272 ® 9
5 KVPLOG.VMA.230203.121343.bz2 275 ® A
8 Total: 5 from 50

The KVP tab with the KVP devices and KVP logging files groups opens. When expanded, the groups display a
table containing the current KVPs and the logging files of the selected KVP.

Above the table the number of free licenses is displayed. Only for SU /390: When you drag the mouse cursor over
the information symbol, a tool tip displays the number of licenses per MU.
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i Information on the generated KVP devices on SU /390

The devices are displayed completely only if the data of the active IORSF file are available at the MU. If
necessary, execute action Update IORSF file list on tab IORSF files for this purpose.

® Entries of the type IORSF display devices which are generated exclusively in the IORSF.

® Entries of the type KVP display the KVP devices already defined. If the KVP is also generated in the
IORSF, a valid channel path identifier is displayed under CHPID. Otherwise only a warning icon is
displayed under CHPID, and the device must still be generated (in BS2000 with /ADD-IO-UNIT).

i In VM2000 mode the table contains an additional column: if a device assignment exists, the Assigned
column displays the VM name.

The KVP tab offers the following functionality for managing KVPs:

Adding a new KVP

The KVP is created by this action.

> In the KVP devices group, click Add new KVP.

In the Add KVP wizard you can specify the required properties of the KVP step by step.

Changing the color of a KVP

With this action you define the color for the console window's frame. This enables a number of opened console
windows to be distinguished just by their frame color.

> In the KVP devices group, click on the Change icon by the required KVP and determine a new color code.

Restarting a KVP device

The restart allows you to rectify a problematical situation which affects the device. Open KVP connections (console
windows) are then terminated.

> Click the Restart icon by the required KVP.

Removing a KVP

i When the KVP is removed, the associated KVP logging files are also deleted. The history of the BS2000
systems is then no longer complete.

> In the KVP devices group, click the Remove icon by the required KVP.
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Displaying KVP logging file

>

As access is possible to all KVPs, files of a KVP whose assignment to a BS2000 guest system has
already been deleted can still be displayed. This also permits the BS2000 history of BS2000 guest
systems which have already been deleted to be traced if necessary.

Only the KVP assignment is displayed, not the VM assignment, because a different VM assignment may
have been valid in a previous session.

You can also view the log files of a KVP which is not assigned to any BS2000 system (e.g. because the
latter has already been deleted). This enables you to access all logs of all KVPs of this Unit

In the KVP logging files group select the required KVP from the KVP list.

The KVP logging files which exist for this KVP are listed. The Display icon opens the Display KVP logging file
window for the chosen logging file. You can restrict the time period of the logging records to be displayed and
filter the output.

The logging records are displayed in a separate window.

Downloading the KVP logging file

>

In the KVP logging files group select the required KVP from the KVP list. Click the Download icon by the
required KVP logging file. Enter the path and file names in the system-specific Explorer window and save the
file.
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9.7 Managing LAN devices

An SU /390's BS2000 system is integrated into a LAN via ZASLAN and LOCLAN, the MU permitting a connection
via LOCLAN and the HNC via ZASLAN and LOCLAN. On an SU x86, the BS2000 is integrated into a LAN via
ZASLAN and LOCLAN.

From the BS2000 viewpoint, a LAN device is always a device pair.

For VM2000 mode it is necessary to define at least one LAN device per VM.

> In the tree structure select Devices -> [<se server> (SE<model>) ->] <unit> (SU<model>), LAN tab.

Desks, BS2000 paths | KVP LAN | Tape dewces

= Server Unit suli0sed: LAN devices )
Add new LAN device Free beenses &7 | 100 () B8] © wertaces
1o 32 from 40 e Pagelhom3  [F][W Go t page 1 v Perpage 32 v
‘MN HC ‘UnitiD LANtpe  Detalls BS52IP address 552 MAC addrass { Status - o~
Filier Filfer Fiiter Al = | Filler Fiifer Filter Friter Al -
Coa cc  C 2021 ZASLAN &1 p1 pei 08:00 OF  MONITOR ) NORMAL B v
cce cc2r 0c 27 PASLAN &1 pi pei 08:00 42 ABGSEA0A 3 HORMAL E
CCPR 0C28 O 2828 ZASLAN s1pi pci 0800 81 ABGSEA05 £ noRMAL N oy
CCAO_CC41  OC 40 41 ZASLAN 1 pli pei 0a00 85 MONTOR £ HORMAL "
CG46_CCAT  0C 46_47  ZASLAN 51l pel oBi0o A5 ABGSEA €9 NORMAL B
CCAg_CCAN 0T 48 49 ZASLAN 51 p0 per = 5018 446  ABGSE40S D NORMAL m
Cosd coal oc 8081  LOCLAN MANLD ez 2 08, 00 15 MONTOR £ NORMAL M. e
CC85_CCET  0C 86 87 LOCLAN  MANLOW 12 1 24 0400 15 ABGSE404 &) NORMAL o,
CCog CcCes OC g2 80 LOCLAN  MANLOOS 18211 2% 0A00 19 ABGSEADS L9 NORMAL B s
CO20 CD21 0D 021 ZASIAN 5p1 pei (R 427 MONITOR D NORMAL m s
COP6 CD2T oD 2827 IASLAN  =5pi pel BEO0 A3 ABGSEAM D NORMAL "
CD2s CD29 0D 2829  ZASLAN s5pl pet - 06:00 a4 ABGSEL05 0 NORMAL o "
COA0_CD4t 0O 4041 IASLAN  sSpopel 80,18 445 MONITOR £ NORMAL B
CD46_C047 0D 4847  ZASLAN 5 pll pr - B8 827 ABGSE40Y ) NORMAL =
Co48.CD4s 0D 4849 ZASLAN 55 pll pei 0018 428 ABGSE4S &3 NORMAL . s
Ce22 6C23 00 2223 ZASLAN 511 pei 0800 ] 0 UnUsED B s
CC24_ 0025 0C 24 35 FASLAN s1p1 pei O DO )| 0 UNUSED E »
CC2A CCZH 00 2A 7R ZASLAN s1p1 pei 0800 a4 D UNUSED E 2 v
e Total 90

The LAN tab lists the configured LAN devices.
Above the table, the free licenses for LOCLAN and ZASLAN are shown. When you drag the mouse cursor over the

information icon, a tool tip displays detailed license information.

i In VM2000 mode the table contains an additional column: if a device assignment exists, the Assigned
column displays the VM name.
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i Information on the generated LAN devices on SU /390

The devices are displayed completely only if the data of the active IORSF file are available at the MU. If
necessary, execute action Update IORSF file list on tab IORSF files for this purpose.

® Entries of the type IORSF display devices which are generated exclusively in the IORSF.

® Entries of the type LOCLAN and ZASLAN display the LAN devices already defined. If the device is
also generated in the IORSF, a valid channel path identifier is displayed under CHPID. Otherwise only
a warning icon is displayed under CHPID, and the device must still be generated (in BS2000 with
/ADD-IO-UNIT).

The LAN tab offers the following functionality for managing the LAN devices:

Add new LAN device
> Click Add new LAN device.

In the Add LAN device wizard you can specify the required properties of the LAN device step by step.

Restart LAN device

The restart allows you to rectify a problematical situation which affects the device.

> By the required device click the Restart icon and confirm the action.

Removing a LAN device

> Click the Remove icon by the required LAN device and confirm the action.
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9.8 Managing tape devices
The Tape devices tab provides the following functions:

> Select Devices -> [<se server> (SE<model>) ->] <unit> (SU<model>), Tape devices tab.

Example for SU x86:

Disks | BS2000paths | KvP | LAN | Tape devices

~ Server Unit sui-se2: Tape devices )
| Addnewtape devices | | Removetapedevices | | Restartall tape devices | Free licenses: 504 / 0 i)
MN ~ HC  UnitiD  Type Code  Devicain i Size [KB]  Assign
Filter Filter Filter Al v Al w | Filter Filter Filter
TF22  TF 2 NTTAPE CE Durmmy tape device - - =
L 0 NTTAPE D2 32001901b0e222e01-Lib - ABGSE314 =
TFE4 00 E4 EMFILE E8 emfile00ed - A 9 E »
TFES 00 E5 EMFILE E8 emfile00e5 e dA D E »
AABB 77 10 NTTAPE ~ CF Dummy tape device - - o
CD 00 CD CDROM EB emfile 5o H
DC 00 [n]ed MKTAPE  C4 Dummy tape device - ABGSE315 N
DD 00 DD NTTAPE  CD Dummy tape device e o
DEOD 00 DE NTTAPE CE Dummy tape device - - .
DFO0 00 DF NTTARPE CF Dummy tape device S H >
DE Total: 16

Example for SU /390:

IORSFfles | Diks | BS?000paths | KVP | LAN | Tapa devices

= ServerUnit EME: Tape dovices (IORSF Me: 83 20720121 17631)

Add new 13 devke Freelcenses 10 )
161 10 178 from 178 4 Page & lrom & vl [FE Ga o pge B + Perpage &2 v
MN » HC  HostLUN CHPID  Type Cotle  Device . Sice [KB]  Unit Uit e "
Filter  Filter  Filter Fiter A - A0 = Filter Fiter Al - Al Filter
w00 &0 COROM  ES8 il abpzeZmul MU M 4+
T o0 &1 EMFILE E8 ermfileiE 1 3ET2028  abgsePmul MU ABGSENT A K
T2 o 62 - EMFILE Eg emfleDis2 2042645 abgseZmut Mu ABGSEXT A M E 1]
T2 o 1] - EMFILE Eg w0083 2077 abgsedrul ) Ay H »
T4 . Bd 40 1RSSR Eff 0000 00 00 00 00 00 00
] B8 an RS EH 00 00 00 G000 00 R0
Th -] a0 IDRSF ES 00 00 0000 0000 0000
Li - FF 40 IORSF E8 00.00:00:00.00.00.00.00
T8 - &0 1] IORSF E8 00: 00 00:00:00. 00, 00-00
] - 61 A 1R 3] 0000 00 00 90,00 50 00 v
imE Tatut 170

The Tape devices tab lists the configured tape devices. EMFILEs without a tape assignment are displayed with the
type DATA.

Above the table, the free licenses for real tape devices (only for SU x86) and CDROMs/EMFILEs are displayed.
When you drag the mouse cursor over the information icon, a tool tip displays detailed license information.

i In VM2000 mode the table contains an additional column: if a device assignment exists, the Assigned
column displays the VM name.
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i Information on the generated tape devices on SU /390

The devices are displayed completely only if the data of the active IORSF file are available at the MU. If
necessary, execute action Update IORSF file list on tab IORSF files for this purpose.

® Entries of the type IORSF display devices which are generated exclusively in the IORSF.

® Entries of the type EMFILE, CDROM, and DATA display the emulated tape devices already defined. If
the device is also generated in the IORSF, a valid channel path identifier is displayed under CHPID.
Otherwise only a warning icon is displayed under CHPID, and the device must still be generated (in
BS2000 with /ADD-IO-UNIT).

The Tape devices tab offers the following functionality for managing the tape devices:

Add new tape devices

> On SU /390, click Add new tape device and on SU x86, click Add new tape devices.

In the Add tape device/Add tape devices wizard you can specify the required properties step by step. In the
case of real or dummy tape devices of an SU x86, you can also enter the required number of tape devices.
Remove tape devices (SU x86 only)

> Click Remove tape devices.

In the Remove tape devices wizard you can specify an interval of MNs for the real and dummy tape devices
to be removed.

Restart all tape devices (SU x86 only)

> Click Restart all tape devices and confirm the action.

Restart tape device

The restart allows you to rectify a problematical situation which affects the device.

> By the required device click the Restart icon and confirm the action.

Remove tape device

> Click the Remove icon in the row with the required tape device and confirm the action.
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9.8.1 Emulated tape devices

The SE Manager supports the configuration of emulated tape devices. Emulation enables BS2000 tapes to be
presented either as files in the Linux file system (EMFILES) or as files on CD or DVD (CDROM files). This permits
data exchange between BS2000 systems by means of compatible EMFILEs or CDROM files. With the help of the
EMFILEsS/CDROM files, you can, for example, read in BS2000 correction packages from CD or DVD or transfer files
containing diagnostic data by means of CD, DVD or LAN. Another possible application is exporting BS2000 data
temporarily to the Linux file system.

It is also possible to write CDROM files directly to a CD/DVD medium on the SU x86's integrated DVD burner. For
the SU /390 this can be done on the MU's integrated DVD burner.

Data CDs and DVDs written in ISO9660 or UDF format and containing precisely one file with the name emfile are
supported.

You manage emulated tape devices using the Tape devices tab of the SU /390 or SU x86, see the example below
for an SU x86:

Disks | BS2000paths | KVP | LAN | Tape devices

v Server Unit su1-se7: Tape devices (2)
| Add new fape devices | | Remove tape devices | | Restart all tape devices | Free licenses: 507 / 6 (i)
MN «~ HC UnitID Type Code Device information Size [KB] Assigned
Filter Filter Filter EMFILE - | All « |Filter Filter Filter
EF 00 EF EMFILE  ES emfile00ef 4 - a3 ’
| Total: 1 from 7

i You can replace EMFILES/CDROM files with EMFILES/CDROM files of other SE servers. The data
formats of the EMFILES/CDROM files on these servers are compatible.

You can upload and download EMFILES, and remove emulated tape files.

Download

When you initiate a download, the tape device in BS2000 should not be attached, i.e. if necessary a DETACH
command should be issued first.

> Click the Download icon by the required tape device, enter the path and file names in the system-specific
Explorer window and save the file.
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Upload

When you initiate an upload, the tape drive in BS2000 should not be attached, i.e. if necessary a DETACH
command should be issued first.

A download enables EMFILESs to be stored in a different place and an upload enables them to be read in again
later. This also permits files to be exchanged with other systems. The names of files to be downloaded must comply
with the conventions for EMFILE names. Existing files of the same name are overwritten when files are uploaded.

> Click the Upload icon by the required tape device, select the file in the dialog box, and click Upload.

Remove

When you delete data, the tape drive in BS2000 should not be attached, i.e. if necessary a DETACH command
should be issued first.

> Click the Remove icon by the required tape device and confirm the action.

In the case of an emulated tape device you can select in the dialog box whether you want to remove the
device and/or whether you want to delete the EMFILE. If you only remove the device, the data is
subsequently displayed with the device type DATA.
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9.8.2 Emulated tape devices from the BS2000 viewpoint

Instead of the EMFILEs and CDROM files, BS2000 sees tape devices of the type BM1662FS which are addressed
by means of their mnemonics. In the drives tapes of the type T6250 (T9G) are visible which are addressed using
their VSNs and are handled in the same way.
EMFILEs
The following BS2000 commands are relevant for tape drives which are emulated by EMFILES:
/IATTACH-DEVICE

Attaches a tape device; mandatory before use.
/DETACH-DEVICE

Detaches a tape device. The actions uploading, downloading, deletion of the data, and removal of the
emulated device via the SE Manager only make sense in the “detached” status.

INIT utility routine
Initialization of a tape using the INIT utility routine; mandatory if a new EMFILE emulates a tape. For details,
see the "Utility Routines" manual [11]. Specify “T9G” as the volume type and define the VSN.
CDROM files
The following BS2000 commands are relevant for tape devices which are emulated by CDROM files:
/ATTACH-DEVICE

Attaches a tape device; mandatory before use. Even if the DVD drive is empty, the corresponding tape device
can be attached in BS2000. When you have inserted a DVD later, enter the /CHECK-TAPE command to make
the mounted volume known to BS2000.

/CHECK-TAPE

Makes a mounted volume (DVD) in the emulated tape drive known to BS2000. The /CHECK-TAPE command
is needed if the drive was still empty when a previous /ATTACH-DEVICE command was issued or the DVD
was changed after /UNLOAD-TAPE.

/DETACH-DEVICE

Detaches a tape device. Access to the DVD drive from Linux is forbidden while the device concerned is
attached in BS2000. After it has been detached, any DVD still contained in the drive can be ejected by
pressing the button on the drive.

/UNLOAD-TAPE
Burns a DVD, which is then ejected.
INIT utility routine

Initialization of a volume by the INIT utility routine; mandatory when a DVD straight from the factory is inserted.
For details, see the “Utility Routines” manual [11]. Specify “T9G” as the volume type and define the VSN. If the
DVD is rewritable, any existing data is overwritten.

You use the ERASE operand in the INIT statement to initiate complete deletion of a rewritable DVD.
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Procedure for burning a DVD

Proceed as follows to burn a DVD in the drive of the MU or SU x86:

> Initialize the CDROM file using the INIT utility routine and specify a VSN in the process.
> Make the DVD known to BS2000: /ATTACH-DEVICE or (if that has already been issued) /CHECK-TAPE

> Initialize the CDROM file with the INIT utility routine and assign a VSN.
All data on a rewritable medium will be deleted.

> Write the CDROM file with BS2000 means.
This file is initially buffered on hard disk. The buffered file must contain more than 5 tape blocks, and the data
must be terminated with a double tape mark (indicating the logical end of a BS2000 tape).
The buffered data is retained until it is deleted when initialization takes place again (INIT) or until a data
medium is written for this drive again.

> Burn the DVD using the /UNLOAD-TAPE command.
After the medium has been burned, it is ejected from the DVD burner (i.e. the drive opens).

> Burn another DVD or detach the device (/DETACH-DEVICE).

DVD media supported
The following media are supported for the burning functionality:

* DVD-R/DVD+R
* DVD-RW /DVD+RW
* DVDRAM

The end-of-tape processing depends on the size of the medium. The maximum net size of the CDROM file is 4200
MB and is correspondingly lower in the case of a smaller medium since the space for the table of contents and lead-
in / lead-out is deducted (DVD: up to 128 MB).

Times of different DVD media

The burning times (or initialization times) depend on the medium used and the possible speed for burning/deleting.
The table below provides some information for estimating roughly how long the procedure will take (tests with a few
different media).

Medium Time INIT | Time INIT ... ERASE | Time /UNLOAD-TAPE (burn)
DVD-R 8x 2 sec - 11 min (4200 MB)
DVD+RW 1x-4x | 30 sec 16 min 15 min (4200 MB)
DVDRAM 3x-20x | 20 sec 40 min 37 min (4200 MB)
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10 Managing hardware

You manage the hardware of the SE server configuration using the Hardware menu in the tree structure:

Managing a single SE server Managing two SE servers
(with an SU /390) in a Management Cluster
I Hardware v I Hardware v
+ Units (SET30) - Units
+ |P networks + SE-Server-2 (SE710)
FC networks + SE-Server-4 (SE730)
Storage + |P networks
HW inventory FC networks
Energy ¥ Storage
+ HW inventory
+ Energy

The menu has the same layout for all SE servers and contains the following items:
® Units: Here you manage all existing units of the SE server configuration, see section "Managing units of the SE
server".

* |P networks: Here you manage all private and public networks of the SE server configuration, see section
"Managing IP networks".

®* FC networks: Here you manage the Fibre Channel networks of the SE server configuration, see section
"Managing FC networks".

® Storage: Here you manage the storage components of the SE server configuration, see section "Managing
storage systems".

®* HW inventory: Here you can have the hardware configuration displayed on the screen in graphic or tabular form,
see section "HW inventory".

® Energy: Here you manage the energy settings of the SE server configuration, e.g. powering the units on or off
automatically, see section "Managing energy settings".
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10.1 Managing units of the SE server

You manage the units of the SE server using the menu Hardware -> Units (SE<model>). When you expand this

menu, all the existing units are listed.

If you manage a configuration of two or more SE servers in one Management Cluster, the units are listed
underneath Units in SE server-specific submenus Hardware -> Units -> <se server> (SE<model>).

If the add-on pack NUX is installed on at least one MU, the structure of the primary navigation underneath Hardware

-> Units (SE<model>) resp. Hardware -> Units -> <se server> (SE<model>) is extended: The main menu receives

rack-specific substructures SE<se-index> AU<rack-index>xx corresponding to the name scheme of the AUs, under

which the links to the individual AUs of the rack (with a corresponding submenu if necessary) can be found.

The description is divided into the following sections:

® Units - Information, powering on/off, etc.

® Qverview of the software versions of the units

® Managing the SE servers of the Management Cluster

® Managing the Server Unit /390

o

o

Name, system information and interfaces of the SU /390

Displaying the IP configuration of the SU /390

® Managing the Management Unit

o

o

o

o

o

o

o

Displaying system information and interfaces of an MU
Managing the IP configuration

Managing routing of the Management Unit

Managing the DNS configuration

Managing SNMP

Setting the system time (time synchronization or local)

Entering CLI commands

® Managing the HNC

o

o

o

o

o

Displaying system information and interfaces of the HNC
Managing the IP configuration of the HNC

Managing routing of the HNC

Managing the DNS configuration of the HNC
Configuring Net-Storage on the HNC

® Managing the Server Unit x86

o

o

o

System information and interfaces of the unit
Managing the IP configuration of the SU x86
Managing routing of the SU x86

Managing the DNS configuration of the SU x86
Configuring Net-Storage on the SU x86
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® Managing Application Units
© Configuring an Application Unit
© Displaying hardware information of the Application Unit

© Managing the IP configuration of the Application Unit
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10.1.1 Units - Information, powering on/off, etc.

> Select Hardware -> Units, Units tab.
The Units tab displays information on all Management Units, Server Units, HNCs, and Application Units of the
SE server configuration.

Units. Update avervaw

= Linits
HW mods| Sarvar Fower stats System sHEts HW status Status summary ~
Fiter Al - Al - A - Al - AN -
SuT10 I) abgeez > ON > RUNNHG £ NORMAL & ) HORMAL V]
W3 I} abgse? > ON 1. WARNING I & HORMAL B b WARNING ]
(T |} abgsez * ON » RUNKHG & HORMAL ® ) HoRMAL o
HHE M3 I} abgse? > ON B RUNHRG & HORMAL & (& HORMAL ]
HMEG M2 |} abgesz = ON B RUNNNG &3 NORMAL B 5 NORMAL ]
HMC M 1) abgeez = ON B RUNRRG S NORMAL w5 HORMAL V]
sutomM1 | abgee? = ON B RUNNRG & RORMAL B NORMAL ]
SUrn 1) SE-Servard > DN P RUNRMNG S RORMAL O NORMAL &
MUM4 X 3 e ON B RUNNMG 4 NORMAL B NORMAL ]
U M4 L b ON L WARMING I S RORMAL ¥ 1 WARNING &
HNC W4 i3 ON B RUNRNG 4 RORMAL B O NORMAL (v ]
HNC M4 i} SE-Serverd = ON B RUNNNG £ RORMAL B € NORMAL V]
HNC M4 1) SE-Serverd = ON b RUNRNG o NORMAL » q HORMAL &
SU310 MY I} SE-Serverd = ON b RUNNRIG L'\)Ii-.’.‘:'{l.'m & ) NORMAL (o JP

Toteh 17

i Notes:

® If at least one AU PQ is available, the column HW model is followed by an additional Chassis column.
In the case of AU PQ, the chassis of the AU and the partitions are each displayed as single units.
Actions are only possible for partitions.

® For a configuration, as in the example, consisting of two or more SE servers in a Management Cluster:

© The Units menu does not contain a model name (it is displayed in the submenu of the respective SE
server instead).

© The table contains the additional Server column. This column contains the name of the SE server to
which the respective unit belongs.

Hardware details for unit

By clicking the Hardware details (“# ) icon in the HW status column, you can view details about the status of the
single hardware components of a unit.

Actions: Power on, reboot, shut down or power off immediately a unit

Depending on the status, you use the Units tab to power a unit on or off or reboot it. Depending on the unit type, the
following actions are possible:
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Unit type Power on | Reboot @ Shutdown | Power off

immediately
MU X X X X
SU /390 X X
SU x86 X X X X
HNC X X X X
AU X (X) X X

i On an SU /390 without connection to the hardware interface for switching on / off, the Power on or Power
off icon is not active and a tool tip displays the cause.

An AU PY can be rebooted. Restriction: Rebooting an AU PY with VMware ESXi is not possible.

Powering on the unit

Depending on the situation and the status, the action may not be available. A tool tip then informs about the reason.
> Click the Power on icon by the required unit and confirm the action with Execute in the subsequent dialog box.

The powered-off unit is powered on. You will receive a message when the operation has been completed.

Rebooting a unit (MU, SU x86, HNC and AU PY only)

Depending on the situation and the status, the action may not be available. A tool tip then informs about the reason.

i When you reboot the local MU, the connection in the SE Manager is cleared down. You must log in again
after the rebooting of the MU.

> Click the Power off icon by the required unit.

> In the subsequent dialog box, select Reboot and confirm the action with
Execute.

The unit is rebooted. You will receive a message when the operation has been completed.
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Shutting down the unit or immediately powering it off

Depending on the situation and the status, the action may not be available. A tool tip then informs about the reason.

> Click the Power off icon by the required unit.

> In the subsequent dialog box, select the option Shut down or Power off immediately and confirm the action
with Execute.

i Only Power off immediately is available for the SU /390.

The unit is shut down or powered off immediately. You will receive a message when the operation has been
completed.
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10.1.2 Overview of the software versions of the units

> Select Hardware -> Units, Update overview tab.

The Update overview tab displays information about add-on packs installed on Management Units of the SE
server configuration in the first table and information about the basic software and updates installed on the
x86-based units of the SE server configuration in the second table.

Links allow easy navigation to the individual add-ons, to the update windows of the individual units and to the

units overview in the HW inventory.

Units | Update overview

= Installed add-on packs

Add-on - M Unit  Server Version Status

All - bem - ANl ~ |Filter All -
GPENSMZ bern SE1-Suisse 21.0.5-01 » RUNNING

STORMAN bern SE1-Suisse 10.3.0-0  RUNNING
o 2 Total: 2 from 6
w

+ Units x86: Installed basis software and updates ?

EI Hardware overview

Unit HW model Server SW version Updates

Filter Filter All ~ |VE.5A0302 Filter

basel MU M4 SE1-Suisse M2000 VE.5A0302

bern MU M3 SE1-Suisse M2000 VE.5A0302

gold Su33o0 M1 SE1-Suisse X2000 VB 540302

konstanz MU M4 SE4-Germany SW M2000 VE.5A0302

ulm Su33om1 SE4-Germany SW X2000 V8.5A0302
M = Total 5 from 20
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10.1.3 Managing the SE servers of the Management Cluster

If you have a Management Cluster, you can view specific information on each of the SE servers in that cluster.

>  Select Hardware -> Units -> <se server> (SE<model>), Information tab.

Information

~ Server SE6-Svizzera (SE730): Information

Name SE6-Svizzera
Model SE730

SE index B

Location RZ Ticino

Customer Support configures the displayed data in consultation with the customer.
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10.1.4 Managing the Server Unit /390

The administration of an SU /390 is described in the following sections:

®* Name, system information and interfaces of the SU /390

® Displaying the IP configuration of the SU /390
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10.1.4.1 Name, system information and interfaces of the SU /390

You obtain the system information and interfaces of the SU /390 using the associated Information menu.

You may change the name of the SU /390.

Displaying system information of the SU /390

> Select Hardware -> Units -> [<se server> (SE<model>) ->] <unit> (SU</390>) -> Information, System tab.

System | FCinterfaces

+ Server Unit EM3: System information

Name EM3 ’
HW model SE SERVER SU740

B52000 mode| 5U740-70

Serial number 00029003

HCP EB6L01G-01M+035

Main memory 63.0 GB

CPUs

Changing the name of the SU /390

FUJITSU SU740 CPU (11)

In the System tab for the SU /390 you may change the name of this SU.

> Click the Change icon in the line containing the name and enter the desired nhame in the dialog that opens.

Displaying FC interfaces of the SU /390

> Select Hardware -> Units -> [<se server> (SE<model>) ->] <unit> (SU</390>) -> Information, FC interfaces tab.

Syglem FCinterfaces

- Swrunr Unit EMZ FOinwriaces

CHRID = CHE Box Slot) port Ghivs  WWPN Status
------- drr £ Fifter e Al
™ n 2 pt [ i 9 ue
[ 4 0 QU
ook 2 from 4
= ServerUnit EMY; FC pashe
5 e stoage aota
o Storage
CHPID = CHE box Slot! port WWRH Mame Port nasme WNPH
e Flr o Fiter [ Wer

08 (] = pf 208 FREQ
o o g2 i FFEQ
4 4 s4pl M FEEQ
40 4 g2 E
4 B = pf 208 FREQ
ca L

AL OO
000

000
A0.00

1258

s Al bo G E L

1288
12

o Ch
orct

i The column Gbit/s of the FC interfaces table showing the configured maximum transmission rate is only

displayed for an SU740.
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10.1.4.2 Displaying the IP configuration of the SU /390

The IP configuration of the SU /390 is displayed using the associated Management menu. The IP configuration tab

displays information on SVP networks and connections:

> Select Hardware -> Units -> [<se server> (SE<model>) ->] <unit> (SU</390>) -> Management, IP

configuration tab.

IP configuration

Server Unit EM1: IP configuration (SVP networks)

)

SVP network IP address. Management Unit Usage Status

MSNPRO 10.0.1.44 abgsedmul-1 PASSIVE Q) NORMAL
MSNPRO 10.0.1.45 abgsedmu2-1 ACTIVE {H NORMAL
MSNPR1 1002 44 abgsedmui-1 PASSIVE \) NORMAL
MSNPR1 1002 45 abgsedmu2-1 PASSIVE u NORMAL

J &

Server Unit EM1: Management Unit connections

SVP network Status
MSNPRO o NORMAL
MSNPR1 o NORMAL

B E

Total: 2

Total: 4
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10.1.5 Managing the Management Unit

The administration of a Management Unit is described in the following sections:

Displaying system information and interfaces of an MU
Managing the IP configuration

Managing routing of the Management Unit

Managing the DNS configuration

Managing SNMP

Setting the system time (time synchronization or local)

Entering CLI commands
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10.1.5.1 Displaying system information and interfaces of an MU

You obtain the system information and interfaces of a Management Unit using the associated Information menu.
Options provided in this menu:

® Displaying system information of the MU

® Displaying and changing IP interfaces of the MU

® Displaying and resetting FC interfaces of the MU

¢ Displaying multipath disks of the MU

® Displaying CRD disks of the MU

® Displaying and managing EMDISC files of the MU

Displaying system information of the MU

> Select Hardware -> Units -> [<se server> (SE<model>) ->] <unit> (MU) -> Information, System tab:

System | |Pinterfaces | FCinterfaces | Multipath disks CRD disks | EMDISC files
~ Management Unit abgse7mui: System information (7

Name abgse7mul

HW model SE SERVER MU M&

Serial number EWCD004178

SW version M2000 VB .6A007

Updates MVE BA0107U020

System start 2024-09-26 14.29:49

Main memory 128 GB

CPUs INTEL(R) XEON(R) GOLD 5520+, 2200 MHz (2 Sockets)

System disks MNormal

iRMC address 172 E21

In the case of System disks, Normal means that the mirror disk is decoupled. In maintenance means that the mirror
is active for the system disks, and the data is being synchronized (in preparation for a software update).

Displaying and changing IP interfaces of the MU

> Select Hardware -> Units -> [<se server> (SE<model>) ->] <unit> (MU) -> Information, IP interfaces tab:

System | IP interfaces FC interfaces Multipath disks . CRDdisks | EMDISC files
+ Management Unit abgse7mu1: IP interfaces @ 3'
Slot/ port ~ MTU  Type MAC address Usage Status
Filter Filter Fiiter Filter Fiiter All pot
- 1500 - 0A0 YFF LOGLAN - k4
50 p0 onboard 1500 Intel Corporation 1210 Gigabit Network Connection (rev... C4:7 18 RMC2 oDOWN
s0 p0 ocpt 1500 Intel Corpaoration 1350 Gigabit Network Connection (rev... FO:E 44E 8YS1 ‘:jUF
s0 p1ocpl 1500 Intel Corporation 1350 Gigabit Network Connection (rev... FOE 44E 8Ys2 OUP
s0 p2 ocpl 1500 Intel Corporation 1350 Gigabit Network Connection (rev... FO:E 4:50 - eDOWN -
s0 p3 ocpl 1500 Intel Corporation 1350 Gigabit Network Connection (rev... FOE 4:51 - eDOWN #
o B Total: 6
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Changing the packet length in the case of LOCLAN and PCI interfaces

In the IP interfaces tab of the Management Unit you can change the packet length. In the case of a PCl interface,
normal operation is required for this purpose, i.e. the Status UP is displayed.

> Click the Change icon in the row with the required IP interface, and in the subsequent dialog box select the
required packet length.

Displaying and resetting FC interfaces of the MU

> Select Hardware -> Units -> [<se server> (SE<model>) ->] <unit> (MU) -> Information, FC interfaces tab:

System IPintefaces | FC interfaces Multipath disks | CRD disks EMDISC files

v Unit abgseTmui: FC inter 7
HC  Ssiot/port ~ Type WWPN CHPID  Status
Filter Fiter Fiter Filter Al -
00 s1p0pci Emulex LPe31002-M8 10:00:00.62.08:43 F3.93 40 Qup
s1plpci Emulex LPe31002-M6 10:00:0062:08:43-F3:84 - o e 2
52 pl0 pei Emulex LPe31002-M6 10:00:00:62:08:43 F3.C8 - O pown
s2plpei Emulex LPe31002-M6 10:00.00.62 0843 F3.C7 - our -
Total 4
+ Managsment Unit abgse7mut: FC paths 0]
5] Update storage data
Unit Storage
Slot | port ~ WWPN Port address HName Port name WWPN Part address
Fiter Fiter Fiter Filter Fiter Fiter Filter
s1p1 pei 10:00:00:62:08:43:F3.94 D427 00 DX8900-54-1 FCP_CEQZCMOOCAQIPO1 50.00:00 EO:DC 454E:25 D2 0D .00
s1p1pei 10:00:0062-08:43 F3 64 D427 00 DX900-85-1 FCP_CE01CMO0CAOSPD1  50-00:00 E0 DC 425E:1D GE 07 00
s1p1 pei 10.00:00.6208:43F3:94 D427 00 DX600-S6-1 FCP_CMOOCAO1P00 50:00:00:E0 DD'40:44:24 CE1C 00

Total 3

The FC interfaces tab displays three groups with information on the FC interfaces:

® FC interfaces provides information for each FC interface of the MU on the host controller used, the plug-in
position (slot and port), the Type (firmware and revision status), the local WWPN (World Wide Port Number) of
the FC interface, and the connection channel to the Server Unit /390 (Channel Path ID - CHPID). The hardware
status of the FC interface is also displayed (UP / DOWN). For MUs without SKP functionality the columns HC
and CHPID are not displayed.

® FC targets contains the WWPNs of the FC interfaces on the accessible FC controllers (targets). The WWPN
identifies a port unambiguously worldwide.

® FC paths contains information on the connections between the units and the accessible FC controllers. Address
information on the end points of the various connections is displayed.

Resetting the FC interface

On the FC interfaces tab of the management unit, you can reset the individual single FC interfaces. The devices
connected to the FC interface are rescanned. After this action, the displayed number of connected devices to this
interface can change.

Displaying multipath disks of the MU

For the FC disks the Multipath disks tab displays the status of the paths from the unit to the storage system and the
end points of the paths, i.e. the interfaces on the storage system and on the unit. The columns Name and Serial
number of the storage system are supplied only, if STORMAN is properly configured and the storage data is
updated. For this, the Update storage data dialog in the Hardware -> Storage menu must be called.
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> Select Hardware -> Units -> [ <se server> (SE<model>) ->] <unit> (MU) -> Information, Multipath disks tab:

Displaying CRD disks of the MU

The CRD disks tab in the Information menu displays the status of the internal and, if existing, the external CRD
disks (configuration disks) of the Management Unit.

Purpose and operation of CRD disks are described in section "External CRD disks".

> Select Hardware -> Units -> [<se server> (SE<model>) ->] <unit> (MU) -> Information, CRD disks tab:

System | [Pinterfaces | FCinterfaces | Mulipathdisks | CRDdisks | EMDISC files
* Management UnitabgseTmuf: CRD disks E @

2] Update storage data
Index~ Device Storage name Storage serfal number  Volume number  Status
Fiter  Fier Fiter Filter Filter At ~ Filter

1 [devidiskiby-partuuidifScaTed-bifd. - 3 g €2 NORMAL intem

2 DX000E21025C-Disk1E8 DX900-85-1 4652005001 488 » NORMAL SE_CRD_Server?

DXO000E31026C-Disk1ES DX900-55-1 4652005001 486 ¢) NORMAL  SE_GRD_Serverd

| e

Total 3

The table lists the CRD disks with the current status. The internal CRD disk is listed before any possibly existing
external CRD disks. The Description column can contain additional information on the use of the CRD disk.

Displaying and managing EMDISC files of the MU

The EMDISC files tab in the Information menu provides information about the unit's EMDISC filesystems and the
EMDISC files contained in them.

Authorized users can add, extend and delete EMDISC files of external filesystems.

The displayed data can be updated by clicking on Update EMDISC filesystems. The Repair EMDISC filesystem
action is available for individual EMDISC filesystems for authorized users and only if the EMDISC filesystem is not
already in the ACTIVE state.
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> Select Hardware -> Units -> [<se server> (SE<model>) ->] <unit> (MU) -> Information, EMDISC files tab

System | IPinterfaces | FCinterfaces Multipath disks CRD disks EMDISC files

» Management Unit abgseTmu1: EMDISC files

(=)

 Add new EMDISC Tile 5] Disks

Name ~ Size [MB] [EMDISC filesystem MN HC Unit 1D Status

Filter Filter Fiiter Filter Filter Filter All -

BS20_CDFO 16000 internal CDFO a0 30 5 WACTVE

BS2D_CDF1 16000 internal COF1 o0 3 € mACTIVE

BS2D_hanm 80000  xempDXO00E2A0761d309 - - = & macTve 7 9

BS20_roo! 1024 xempOXO00E2AO761d309 - @ nacTiVE )

e Total 4
= Management Unit lugano. EMDISC filesystems j‘

_ Updale EMDISC flesystems Last update of the EMDISC filesystems: 2025-01.20 08,4222

Filter Filter Filter Filter All hd

internal 32768 768 2 ACTVE

xempDXO00E2A0761d309 93184 1935 2 @ AcTVE

xempDX000EZAOTS1d30A 93184 93178 0 ) ACTVE

o Totat 3
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10.1.5.2 Managing the IP configuration

You manage the IP configuration of the Management Unit using the associated Management menu, IP configuration

tab.

> Select Hardware -> Units -> [<se server> (SE<model>) ->] <unit> (MU) -> Management, IP configuration tab.

IP configuration | Routing &DNS | SNMP | Systemtime | CUI

Management Unit geneve: Host name

geneve example net

+ Management Unit geneve: Network properties

Network ~ Properties

?

Filter

MANPU [ pHepva IPVE Autoconf [ oHerve 4

MCHLO [ oHceva IPVE Autoconf [ oHeeve

MCNPR [ pHepya IPv6 [ Autoconf [ oHerve

MONPRO1T  [[] DHCPv4 IPVE Autoconf ] oHePve #

MSNPRO [ pHepva 1PV Autoconf [ pHerve

MSNPR1 [] DHCPv4 IPV6 Autoconf [] DHCPv6

e Total 6
» Management Unit geneve: Network IP addresses

[ Add new P address |

Network « IP address Mask  Name Conf.

Filter Filter Fiter  Filter Fiiter

LOCLAN 102.168.138.12 5 L

MANPU 172. 79 22 static %

MANPU fd11:1d52: feed:422c /64 - dynamic

MANPU fe80::921b: 422¢ 164 static 7

The IP configuration tab displays information on the host name, network properties, and addresses of the MU in

three groups.
The following options are available to you:

Changing the host name and domain of the MU

> In the Host name group click the Change icon and change the host name and domain in the subsequent

dialog box.

Changing network properties of the MU

> In the Network properties group click the Change icon by the required network. In the subsequent dialog box

you can enable or disable the required pro

Adding a new IP address

perties.

> In the Network IP addresses group click Add new IP address.

In the Add IP address wizard you can specify the required properties of the IP address step by step.

Deleting the IP address

)

=)
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> In the Network IP addresses group click the Delete icon by the required IP address and confirm the action.
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10.1.5.3 Managing routing of the Management Unit

You manage routing of the Management Unit using the associated Management menu, Routing & DNS tab.

> Select Hardware -> Units -> [<se server> (SE<model>) ->] <unit> (MU) -> Management, Routing & DNS tab.

IP configuration Routing & DNS | SNMP | System time cl
~ Management Unit abgseZmu1: Routing )

Add new route

Target - Gateway Usage

Fiiter Fiiter Fiiter

10.0.1.0024 10.0.1.45 MSNPRO

10.0.2.0/24 10.0.245 MSNPR1

10.10.1.0/24 10.10.1.5 MONPRO1

127.0.0.0/3 -

17 22 17 5.104 MANPU ]
182.165.11.024 182.168.11.2 MCNLO

192.166.130.024 162.168.139.12 |

default 17 34.1 MANPU b g

rrTs B - - pi - 4D

You use the Routing & DNS tab with the Routing, DNS name servers and DNS domains groups to manage the
routing and DNS configuration of the unit. The routing is displayed in the Routing group above.

The following options are available to you:

Adding a new route to the MU (only for MANPU or MONPU networks)

> In the Routing group click Add new route (above the table). Make the required entries in the subsequent
dialog box and confirm the action.

Deleting a route on MU (only for MANPU or MONPU networks)

> In the Routing group click the Delete icon by the required route and confirm the action.
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10.1.5.4 Managing the DNS configuration

You manage the DNS configuration of the Management Unit using the associated Management menu, Routing &

DNS tab.

> Select Hardware -> Units -> [<se server> (SE<model>) ->] <unit> (MU) -> Management, Routing & DNS tab.

IPconfiguration | Routing&DNS | SNMP | Systemtime | CL

» Management Unit abgse2mu1: Routing

= Management Unit abgse2mu1: DNS name servers (DNS configuration: Static)
i-Ehange DNS name server |

DNS name server

Total 17 (7)

1 fd5e: 600::101
2 qr2d 317
3 1722 249

» Management Unit abgse2mu1: DNS domains (DNS configuration: Static)
i- Change DNS domains |

DNS domains

1 abg example net

2 mch.example.net

3 osdabgexample net
4 g€ local

The DNS configuration is displayed in the two groups DNS name servers and DNS domains. The title bar of the

v e N e

group shows whether DNS is configured and whether static or dynamic DNS configuration is involved. The following

options are available to you:

Changing the DNS name server configuration of the MU

Up to two external DNS name servers can be configured.

> To enter or change the entry for an external DNS name server, click Change DNS name servers, and after

changing the DNS name server configuration confirm the action.

> Toremove an external DNS name server, click the Remove icon in the row with the required DNS name

server and confirm the action.

The MU is preconfigured as a DNS server for the internal domain "senet" via the internal LAN (IPv6

address fd5e:5e5e:600::<nnn>). This entry cannot be removed.
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Changing the DNS domains and DNS search sequence of the MU or removing a domain
> In the DNS domains group select one of the following procedures:

> To change DNS domains or the DNS search sequence, click Change DNS domains, and confirm the
action after the change.

> Toremove a DNS domain from the DNS configuration, click the Remove icon in the row with the
required DNS domain and confirm the action.
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10.1.5.5 Managing SNMP

SNMP integration of the SE Server

SNMP (Simple Network Management Protocol) is a communication protocol for network, system and application
management and enables the SE server to be monitored over a LAN. From a management station (customer's own
computer), a system monitoring application can communicate with the SNMP agent present on the MU.

You administer central SNMP integration of the SE server using the SE Manager on the Management Unit. In the
case of an SE server configuration with several MUs, redundant SNMP integration is recommended: The MUs must
be integrated independently of each other in order to be used for SNMP monitoring, with the same functionality for
the same SNMP integration.

The preconfiguration on MU, HNC and SU x86 is created in such a manner that you can also use SNMP to monitor
the other units of the SE server on the management stations, provided a configuration for SNMP integration exists
on the Management Unit (read access, trap receiver).

On AUs, on the other hand, you have to configure SNMP by yourself. The online help of SEM contains instructions.

The following monitoring functions are possible:

® Queries
© Queries regarding the Server Unit /390 are possible at the MU (see the MIBs provided for this purpose).

© Queries regarding the individual BS2000 systems and the applications running there are possible (see
BS2000's own MIBs and the measures and prerequisites required for SNMP communication in the
corresponding BS2000 documentation).

© Management stations cannot address the SNMP agent on the SU x86 or HNC directly, but only via the MU.
The SNMP agent on MU, HNC and SU x86 supports MIB-Il and private MIBs for queries.

© The host name of the system or the SENET name of the unit must be used for the query - see the examples
below.

®* Traps

© In defined error situations (e.g. status changes) the SNMP agent on the Server Unit x86 or HNC sends traps
via the Management Unit to the external management stations.

© The traps generated by applications in the individual BS2000 systems are also forwarded via the MU to the
external management stations.

© The sender of the trap is always the Management Unit.

© In the case of two MUs (integrated in SNMP) in an SE server, traps are sent twice.

MIB files (MIBs) must be used to read and interpret the output.
The traps usually contain neither the trap weight nor the message text. This information can only be read from the
MIB.

Therefore at least the following MIBs should be imported at the management station:

® /usr/share/ snnp/ m bs/ FUJI TSU- SESERVER- M B. t xt
® /usr/share/ snnp/ m bs/ FUJI TSU- SU390- M B. t xt
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® /usr/share/ snnp/ m bs/ FSC- RAI D- M B. t xt
At the Management Units and Server Units x86, ServerView RAID periodically checks hardware components.
These events are reported by trap, even in good case with the weight NOTI FI CATI ON. Text example of such a
successful test: "Patrol Read started" and "Patrol Read finished".
In order for ServerView RAID's traps to be correctly represented by the management station, this MIB must be
imported to the management station.

® /usr/share/snnp/ m bs/ SRVMAGT- | NVENT. TXT and
[ usr/ share/ snnp/ m bs/ SRVYMAGT- SC2. TXT
In order for the traps from ServerView and get requests to be interpreted correctly by the management station,
these MIBs must be imported at the management station.

® /usr/share/snnp/ m bs/| NTEL- WM M B. m b
In order for general hardware-related traps and get requests to be interpreted correctly by the management
station, this MIB must be imported at the management station.

® Access to the above MIBs is possible on the Management Unit, e.g. with scp (secure copy) under any
administrator ID.

® The corresponding MIBs from BS2000 should be used to interpret the SNMP data from the BS2000 systems.
Details can be found in the manual "SNMP Management" for BS2000.

The following examples with standard SNMP commands are intended to illustrate the addressing of the units or
systems and the use of the MIBs. In a system monitoring application this is to be done analogously.
® Determining the SE server-specific data:

© adm n@bgsilver(M: snnpwal k -v 2c -m +FUJI TSU- SU390- M B: FUJI TSU- SESERVER-M B -c
seserver abgbl ack. abg.fsc.net 1.3.6.1.4.1.fujitsu.product. se-server

FUJI TSU- SU390- M B: : Mbdel = STRING " SU710- 20"

© The read community (in this case "seserver") must be configured on the MU to be queried (in this case on
abgblack) and allowed for the requesting side (in this case abgsilver).

© The MIBs must be accessible on the requesting side (in this case on abgsilver).
© The OIDs are usually documented in the MIBs.
® Determination of data from an SU x86:

© adm n@bgsilver(M: snnpget -v 2c -c sul-sel.seserver abgbl ack. abg. fsc. net
sysNane. 0
SNVPv2- M B: : sysNane. 0 = STRING abgafrica

© As read community <senet-name>.<read-community> has to be specified, “sul- sel. seser ver " in this case.
® Determination of openSM2 data from a BS2000 system:

© adm n@bgsilver(M: snmpwal k -v 2c -m FJ- OPENSM2-M B - ¢ DO20ZEOl. seserver
abgbl ack. abg.fsc.net .1.3.6.1.4.1.231
FJ- OPENSM2- M B: : snRStatus. 0 = | NTEGER: runni ng(1)
FJ- OPENSM2- M B: : sm2Version. 0 = STRING "V20. 0A04"

© As read community <hostname>.<read-community> has to be specified, “D020ZEQ1. seser ver " in this case.

SNMP integration of the SE server via SEM
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> Select Hardware -> Units -> [<se server> (SE<model>) ->] <unit> (MU) -> Management, SNMP tab:

IP configuration | Routing &DNS | SNMP | Systemtime | CLI

» Management Unit lugano: Configuration of local system data @ f
SYSLOCATION RZ Mch E2 4
SYSCONTACT Tel 1111 &

SNMP Engine ID 8000118804436862726e3032542b6T4C

« Management Unit lugano: Allowed read accesses @ ?)

| Add new read access |

'Read community Restricted to

seserver management station.net :
o B Total: 1

» Management Unit lugano: Trap receiver 7)

| Add new frap receiver |

Trap receiver - SNMP version Trap community User

Filter Al - |Fifter Filter

icinga.fsc net SNMPv3 - sesnmpva 7y 9 >

management station net SNMPv3 - sesrv] E 4 -

abgsgs03.fujitsu.local SNMPvZc sesenver - 7y 9 >

Total: 3

uh: $

Example of an SNMP configuration

The SNMP tab displays information for the selected MU on the configuration of the local system data, allowed read
accesses, and trap receivers.

The following functions are available in the SNMP tab:

® Changing local system data for SNMP

Click on the Change icon in the Configuration of local system data group and make the changes to the
system file in the following dialog.

Hints:

© The SE Manager displays the SYSLOCATION in the header line.
In a management cluster, SYSLOCATION should match the location of the SE server of the unit.

© The specific persistent SNMP Engine ID of the MU is displayed and can be used at SNMP management
stations to identify the MU.

® Adding or removing allowed read accesses

In the Allowed read accesses group select one of the following procedures:
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> To add a new read access, click Add new read access, and confirm the action after entering the
necessary information.

You can restrict the read access to a management station by specifying its host name or IP address.
> To remove a read access, click the Remove icon by the required read access and confirm the action.

® Adding, changing or removing trap receivers

In the Trap receiver group select one of the following procedures:

> To add a trap receiver, click Add new trap receiver, and confirm the action after entering the necessary
information.

> To change a trap receiver, click the Change icon by the required trap receiver and confirm the action
after entering the desired changes.

> To remove a trap receiver, click the Remove icon by the required trap receiver and confirm the action.

® Sending a test trap

> To send a test trap, click the Send test trap icon by the required trap receiver and confirm the action.

i Traps of the Alarm management cannot be configured here. To be able to receive these, trap receivers
must be configured under Logging/Alarm management, see Alarm management.
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10.1.5.6 Setting the system time (time synchronization or local)

To ensure high time accuracy, you can also configure automatic time leveling with a so-called NTP server, e.g. one
which supplies a time which is as accurate as a radio clock, using NTP (Network Time Protocol).

The Management Units are available as NTP servers for all units of the server via the private management network
MCNPR. SU x86 and HNC are preconfigured with respect to NTP; AU configuration must be performed as required
by the administrator responsible.

Effect on the time setting of the systems on the SE server

The time settings of the other systems are synchronized with the system time of the Management Unit. The
Management Unit is the basic timer. Refer to section "Time synchronization".

When changes are made to the time management which affect the Server Unit, bear in mind that the time settings
in BS2000 systems that are started later are also affected. Here you should in particular avoid large leaps in time
which are caused by setting the time manually.

Details on BS2000 are provided in the "Synchronization of the system time" section of the "BS2000 OS DX
Introduction to System Administration" manual [10].

> Select Hardware -> Units -> [<se server> (SE<model>) ->] <unit> (MU) -> Management, System time tab:
IP configuration Routing & DNS SNMP System time CLI

)

Management Unit abgsedmu1-1: Time synchronization with NTP server

Add NTP server

Hest name ~ IP address Stratum  Time difference Status

abgseZmul_senet fdbe: 10::102 - 0000171 - »
ns1.ts.fujitsu.com 80. 2154 - - , 4
ns2 ts fujitsu.com ML 4T 2 0.000650  Active »

D § Total: 3

Management Unit abgsedmui-1: Local configuration

4

Date 2020-08-17

Time 11:01:32

Time zone CEST (UTC +02:00 )
Stratum 8

The System time tab displays the NTP servers which are configured for automatic time synchronization and the
local time of the MU.

Adding or removing an NTP server

> To add an NTP server, click Add NTP server in the Time synchronization with NTP server group, and after
making the necessary entries confirm the action.

> Toremove an NTP server from the NTP configuration, click the Remove icon by the required NTP server in
the Time synchronization with NTP server group and confirm the action.
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Changing the local time

You can only change the local time if no NTP server is active.

i Changes to the time can also have an effect on productive operation. See also section "Effect on the time
setting of the systems on the SE server".

> In the Local configuration group click the Change icon, and after making the necessary entries confirm the
action.
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10.1.5.7 Entering CLI commands

Access to the CLI (Command Line Interface) of the MU is possible via the SE Manager or using e.g. the ssh client
PUTTY.
No CLI is available on the HNC or SU x86 units.

Access to the CLI is graduated:

® SEM and PuTTY
Administrators have execution rights for a restricted set of CLI commands.

® SEMand PuTTY
Non-administrators with the auxiliary role Shell access have access to the cronjob configuration under their own
ID and to some general display commands of the base system.

® PuTTY
Non-administrators with the BS2000 administrator role have execution rights for the special BS2000 access
commands bs2Consol e, bs2Di al og und svpConsol e.
However, these are only execution rights as ssh follow-up commands, a shell login is not possible.

® PuTTY
Non-administrators with the BS2000 operator role have execution rights for the special BS2000 access
commands bs2Consol e, bs2Di al og and svpConsol e according to the individual authorizations granted.
However, these are only execution rights as ssh follow-up commands, a shell login is not possible.

SE Manager

The SE Manager offers the administrator access to the CLI on the Management Unit.
> Select Hardware -> Units -> [<se server> (SE<model>) ->] <unit> (MU) -> Management, CLI tab.

On the CLI tab you can open a Linux shell in a terminal window and use the CLI for textbased administration by
means of commands.
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> Click Open.

A terminal window opens, and you are automatically logged in to M2000.

Information on the terminal window is provided in section "Terminal window".

Management Unit: bern

Administrator: leiadm

List administrator commands -»> cli_info
leiadm@bern(mu2-sel): []

[ Dispaykeypoara | [ Display settings

Connected

The available administrator commands can be displayed using command cl i _i nf o.

PuTTY

The use of PUTTY for BS2000 operation is described in the appendix Operating BS2000 with PUuTTY.

CLI general

The detailed description of the commands permitted for the administrator, including the BS2000 access commands
bs2Consol e, bs2Di al og and svpConsol e, can be found in the online help under General information -> CLI

commands.
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10.1.6 Managing the HNC

The administration of an HNC is described in the following sections:

® Displaying system information and interfaces of the HNC
® Managing the IP configuration of the HNC

® Managing routing of the HNC

® Managing the DNS configuration of the HNC

® Configuring Net-Storage on the HNC
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10.1.6.1 Displaying system information and interfaces of the HNC

The Information menu provides you with information about the HNC and its interfaces.

¢ Displaying system information of the HNC
® Displaying IP interfaces of the HNC

® Displaying FC interfaces of the HNC

® Displaying CRD disks of the HNC

Displaying system information of the HNC

> Select Hardware -> Units -> [<se server> (SE<model>) ->] <unit> (HNC) -> Information, System tab:

System | [Pinterfaces | FGinterfaces | CRD disks

= HNC hnci-sed: System information )

Name hnc1-sed

HW model SE SERVER HNC M4

Serial number EWWABO03851

SW version HNC VE 540201

Updates

System start 2023-02-09 18:54.06

Main memory 84 GB

CPUs Intel(R) Xeon(R) Silver 4309 CPU @ 2 80GHz, 2600 MHz (2 Sockets)
System disks Normal

Displaying IP interfaces of the HNC

> Select Hardware -> Units -> [<se server> (SE<model>) ->] <unit> (HNC) -> Information, IP interfaces tab:

System ' IPinterfaces | FCinterfaces | CRD disks
* HNC hnei-sed: IP interfaces (7)

Slot/ port ~ MTU  Type MAC address Usage Status

Filter Filter Filter Filter Filter All -

- 9000 - DA il LOCLAN - *
s0 plocp 1500 Intel Corporation 1350 Gigabit 880 50 5Y51 GUP

s0 p2 ocp 1500 Intel Corporation [350 Gigabit 68:( :50 Sysz2 l.:)UF’

s0plocp 1500 Intel Corporation 1350 Gigabit B8:( 52 8Ys3 ODOWN

50 pd ocp 1500 Intel Corporation [350 Gigabit 68:( =53 SYS4 @DOWN

52 p0 pci 1500 Intel Corporation X710 for 10GBASE-T (rev 02) B8:( A8 ZASLAN OUF’ s
s2 pl pel 9000 Intel Corporation X710 for 10GBASE-T (rev 02) 880 A9 ZASLAN, Net-Storage {,)UF’ s
s2 p2 pei 1500 Intel Corporation X710 for 10GBASE-T (rev 02) 8810 AA ZASLAN QUF‘ ’
52 pa pel 1500 Intel Corporation X710 for 10GBASE-T (rev 02) 68:( :AB ZASLAN OUP L
53 p0 pei 1500 Intel Corporation X710 far 10GhE SFP+ (rev 02) 404 18 ZASLAN QUF’ L4

The IP interfaces tab provides information about the HNC's LAN interfaces.
The following function is available:
Changing the packet length in the case of LOCLAN and PCI interfaces

In the case of a PCI interface you can only change the packet length in normal operation, i.e. when Status UP is
displayed for the interface.
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> Click the Change icon by the required IP interface, select the required packet length in the subsequent dialog
box, and confirm the action.

Displaying FC interfaces of the HNC
> Select Hardware -> Units -> [<se server> (SE<model>) ->] <unit> (HNC) -> Information, FC interfaces tab:

System ' IP interfaces : FC interfaces ' CRD disks

» HNC hnct-ses: FCinterfaces

HC ~ Slot/port Type WWPN CHPID Status
Filter  Fifter Fiter Filter All hd
oo s1 p0pci Emulex LPe31002-M5 10:00:00:10:8B:AT:F2:3C 08 U up
0 s1 pt pei Emulex LPe31002-M& 10:00:00:10:9B:AT:F2:3D - @ uP

‘o E Total: 2

The FC interfaces tab provides information on the Fibre Channel interface of the HNC to the SU /390.

The host controller used, the plug-in position (slot and port) and the local WWPN (World Wide Port Number) are
displayed for each FC interface. The hardware status of the FC interface is also displayed (UP / DOWN).

Displaying CRD disks of the HNC

The CRD disks tab displays the status of the unit's internal CRD disks (configuration disks).

> Select Hardware -> Units -> [<se server> (SE<model>) ->] <unit> (HNC) -> Information, CRD disks tab:

The structure of the tab is the same as that for the MU (see "Displaying CRD disks of the MU").
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10.1.6.2 Managing the IP configuration of the HNC

You manage the IP configuration of the HNC using the associated Management menu, IP configuration tab.

> Select Hardware -> Units -> [<se server> (SE<model>) ->] <unit> (HNC) -> Management, IP configuration

tab.

IP configuration Routing & DNS

HNC hne1-se4: Host name

Net-Storage

hnc1-sed senet g
* HNC hnci-sed: Network properties

Network - Properties

Filter

MCNLO ] pHePw IPv6 Autoconf | bHePve

MCNPR [[] pHePv4 IPv6 Autoconf [[] bHePve

o E Total 2
¥ HNC hnci-sed: Network IP addresses

Lozl &

Network ~ IPaddress Mask Name Conf.

Fifter Filter Filter Filter Filter

LOCLAN 1921 & 2 =

MCNLO fe80: 22b:739 164 static

MCNPR fdbe:E 4e52 62fffe2b:739 /a4 hnc1-se4.senet dynamic

MCNPR feB0: +2b 739 64 static

“:3 l?' Total: 4

The IP configuration tab displays the host name, network properties, and network IP addresses of the HNC in three

groups.

Changing the host name and domain of the HNC

> In the Host name group click the Change icon, in the subsequent dialog box change the host name and

domain, and confirm the action.

(=)

()
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10.1.6.3 Managing routing of the HNC
You manage routing of the HNC using the associated Management menu, Routing & DNS tab.

> Select Hardware -> Units -> [<se server> (SE<model>) ->] <unit> (HNC) -> Management, Routing & DNS

tab.

IP configuration | Routing & DNS

+ HNC hnc1-sed4: Routing

\7 Add new route. 7!

Target

| Net-Storage

~ Gateway Usage
Filter Filter Filter
172, W22 172 ".151 NETSTORO1
192 1.0/24 182 51.%2 -
fd11 #34:c5b0::/64 NETSTORO1
fdt1 ¥34:c5b3:/64 -
fd5e 500::/64 MCNPR

e 1 L':.'i

¢ HNC hnci-sed: DNS configuration: Static

The Routing & DNS tab displays the routing in the upper group Routing.

Total 5

()

The functionality of the tab is the same as that for the MU (see section "Managing routing of the Management Unit")

with the following restriction:

i The MANPU and MONPU networks are not available on the HNC.

The Add new route and Delete route actions are only available for Net-Storage connections.
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10.1.6.4 Managing the DNS configuration of the HNC

You can inquire information about the DNS configuration of the HNC using the associated Management menu,
Routing & DNS tab.

> Select Hardware -> Units -> [<se server> (SE<model>) ->] <unit> (HNC) -> Management, Routing & DNS
tab.
IP configuration | Routing & DNS | Net-Storage

» HNC abgviolet: Routing Total: 5 (7)

= HNC abgviclet: DNS name servers (DNS configuration: Static) ()

| Change DNS name server |

DNS name server

1 fdSe: 102
210 dhe 202
3 fdSe:s 201
» HNC abgviolet: DNS domains (DNS configuration: Static) 2

i- Change DNE domains |

DNS domains

1 senet

The DNS configuration is displayed in the two groups DNS name servers and DNS domains. The title bar of the
group shows whether DNS is configured and whether static or dynamic DNS configuration is involved.
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10.1.6.5 Configuring Net-Storage on the HNC
Access to Net-Storage (storage access via NFS) is possible for BS2000 systems (for Native BS2000 and the

BS2000 VMs) of the SU /390 provided the prerequisites are fulfilled in the HNC.

® For administrative access to the Net-Storage server that provides the Net-Storage, the administrator of the Net-
Storage server must create an account that is the owner of the directory released via NFS. In the case of
Eternus-CS HE NAS, the account must be the owner of the file group of the NAS share. The user ID and group
ID must be obtained from the administrator of the Net-Storage server.

The NFSv4 domain must correspond to the domain name set on the Net-Storage server.

i The HNC always tries to connect to the Net-Storage via NFSv4. If the mounting via NFSv4 fails,
NFSv3 is used as protocol.

® Each Net-Storage connection must be configured in the network.

You configure Net-Storage in the HNC using the Management menu, Net-Storage tab.

> Select Hardware -> Units -> [<se server> (SE<model>) ->] <unit> (HNC) -> Management, Net-Storage tab.

IP configuration | Routing&DNS |  Net-Storage

« HNC purple: Net-Storage permissions w?
Access authorization - User ID 7013
Access autherization - Group 1D 2003 4
NFSv4 domain localdomain

» HNC purple: Net-Storage client ?)

| Restart Net-Storage client |

Status Active (since 2023-10-25 15:26:28)
NFS mounts
w HNC purple: Net-Storage conngction properties f?
[ Add connection |
Connection Slot ! port VLAN Properties
NETSTORC01  s0 p2 ocpl g || DHCPv4 ] IPvB [T Autoconf [C] DHCPvE s 3
B Total- 1
w HNC purple: Net-Storage connection addresses { 'P
| AddIP address |
Connection  IP address Mask VLAN MAC address Conf.
LOCLAN 19 2 - - 0f FF

f B Total: 1

The Net-Storage tab displays the Net-Storage permissions, Net-Storage client, Net-Storage connection properties,
and Net-Storage connection addresses groups.

The following functions are available to you:
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Changing access right for the HNC

In the Net-Storage permissions group, the current user and group ID that can be used to administrate the Net-
Storage access are specified in the form of userid/groupid. The IDs must be obtained from the system administrator
of the Net-Storage server. The default value for both is 0.

> In the Net-Storage permissions group click the Change icon by Access authorization - User ID or Group ID. In
the subsequent dialog box change the user and/or group ID and confirm the action.

If the default value is not changed, the access is attempted with root rights, which is not recommended for
reasons of data protection.

i Please note that as a result of this action, all mounted Net-Storage devices in the BS2000 will be
unmounted. You will therefore have to re-mount them afterwards.

Entering or changing configuration data for the NFSv4 domain

> In the Net-Storage permissions group, click on the Change icon by NFSv4 domain and enter the domain
name in the subsequent dialog. Confirm the action.

i Please note that as a result of this action, all mounted Net-Storage devices in the BS2000 will be
unmounted. You will therefore have to re-mount them afterwards.

Restarting the Net-Storage client

The Net-Storage client group displays the current status of the Net-Storage client and the mounted directories.

> In the Net-Storage client group, click on Restart Net-Storage client and confirm the action.

i Please note that as a result of this action, all mounted Net-Storage devices in the BS2000 will be
unmounted. You will therefore have to re-mount them afterwards.

Adding and changing a Net-Storage connection to the HNC

> In the Net-Storage connection properties group click Add connection. Make the required entries in the
subsequent dialog box and confirm the action.

> In the Net-Storage connection properties group click the Change icon by the required Net Storage connection
and enter your changes in the subsequent dialog. Confirm the action.

For further information, see the "Description Paper Net-Storage Guide" [15].
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Deleting a Net-Storage connection

> In the Net-Storage connection properties group click the Delete icon by the required Net-Storage connection
and confirm the action.

Adding a Net-Storage connection address (HNC)

> In the Net-Storage connection addresses group click Add IP address. Make the required entries in the
subsequent dialog box and confirm the action.

Deleting a Net-Storage connection address

> In the Net-Storage connection addresses group click the Delete icon by the required Net-Storage connection
and confirm the action.
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10.1.7 Managing the Server Unit x86

The administration of an SU x86 is described in the following sections:

System information and interfaces of the unit
Managing the IP configuration of the SU x86
Managing routing of the SU x86

Managing the DNS configuration of the SU x86
Configuring Net-Storage on the SU x86
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10.1.7.1 System information and interfaces of the unit

You obtain the system information and interfaces of the Server Unit using the associated Information menu. Options
provided in this menu:

® Displaying system information of the SU x86

® Displaying and changing IP interfaces of the SU x86
¢ Displaying and resetting FC interfaces of the SU x86
¢ Displaying multipath disks of the SU x86

¢ Displaying CRD disks of the SU x86

® Displaying and managing EMDISC files of the SU x86

Displaying system information of the SU x86

> Select Hardware -> Units -> [<se server> (SE<model>) ->] <unit> (SU<x86>) -> Information, System tab.

System | |Finterfaces FC imerfaces Multipath disks | CRD disks EMDISC files

= Server Unit rinat: System information 0
Mame rinat
HW model SE SERVER 5U330 M1
B52000 model SU330-40F '
Performance quota 100 ’
Serial number YLVNGO1017
SW version X2000 VE.8AD201
Updates -
System start 2025-01-27 05:06:49
Main memory 64 GB
CPUs Intel(R) Xeon(R} CPU E7-8857 v2 @ 3.00GHz, 3000 MHz (2 Sockets, 24 Cores)
System disks in maintenance

=

i Performance quota is displayed and can be changed only when a license for dynamic performance
control (a so-called performance quota key) is installed on the unit.
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Displaying and changing IP interfaces of the SU x86

> Select Hardware -> Units -> [<se server> (SE<model>) ->] <unit> (SU<x86>) -> Information, IP interfaces tab.

System | IPinterfaces | FCintefaces | Multipathdisks | CRDdisks | EMDISC files
 Server Unit rinat: IP interfaces EG
Slot/ port ~ MTU  Type MAC address Usage Status
Filter Filter Filter Filter Fiter All -
- 9000 - 0AC ‘FF LOCLAN - #
50 p0 bmc 1500 Intel Corporation Controller 10-Gigabit X540-AT2 (rev 0. . C4:% 2FA SYSH \q}UF‘
s0 p1 bme 1500 Intel Corporation Controller 10-Gigabit X540-AT2 (rev 0. C4:f 2FA SYSs2 F;JUP
51 p0 pei 1500 Intel Corporation 1350 Gigabit Network Connection (rev... A0 178 ZASLAN QDOWN #
51 p1 pel 1500 Intel Corporation 1350 Gigabit Network Connection (rev... A02 179 ZASLAN ODOWN #
51 p2 pei 1500  Intel Corporation 1350 Gigabit Network Connection (rev... A02 A = w.:gUF' #
s1 p3 pei 1500 Intel Corporation 1350 Gigabit Network Connection (rev... AQ0:2 7B - \{;UF' 4
52p0 pei 1500 Intel Corporation 1350 Gigabit Network Connection (rev... AQ:2 75C ZASLAN eDOWN o
52 p1 pci 1500 Intel Corporation 1350 Gigabit Network Connection (rev. . A0:2 75D ZASLAN, Net-Storage QDOWN #
52 p2 pci 1500 Intel Corporation 1350 Gigabit Network Connection (rev... A2 T:5E - w.‘:;UF' #
52 p3 pel 1500 Intel Corporation [350 Gigabit Network Connection (rev... A0:2 T5F - "QUP 7
DE Total: 11

The IP interfaces tab provides information about the unit's LAN interfaces. The following function is available to you:

Changing the packet length in the case of LOCLAN and PCI interfaces

In the case of a PCI interface you can only change the packet length in normal operation, i.e. the Status UP is
displayed for the interface.

> Click on the Change icon by the required IP interface and select the required package length in the
subsequent dialog box.

Displaying and resetting FC interfaces of the SU x86

The FC interfaces tab provides information about the unit's Fibre Channel interfaces.

> Select Hardware -> Units -> [<se server> (SE<model>) ->] <unit> (SU<x86>) -> Information, FC interfaces
tab.

Detailed information on the tab is provided in the section "Displaying and resetting FC interfaces of the MU".

Displaying multipath disks of the SU x86

For the FC disks of the SU x86 you can view the status of the paths between the SU x86 and the storage system
and also of their end points on the storage system and the SU x86.

> Select Hardware -> Units -> [<se server> (SE<model>) ->] <unit> (SU<x86>) -> Information, Multipath disks
tab:

Detailed information on the output is provided in the section "Displaying multipath disks of the MU".
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Displaying CRD disks of the SU x86

The CRD disks tab in the Information menu displays the status of the internal and, if existing, the external CRD
disks (configuration disks) of the SU x86.

Purpose and operation of configuration disks are described in section "External CRD disks".

> Select Hardware -> Units -> [<se server> (SE<model>) ->] <unit> (SU<x86>) -> Information, CRD disks tab

Displaying and managing EMDISC files of the SU x86

The EMDISC files tab in the Information menu provides information about the unit's EMDISC filesystems and the
EMDISC files contained in them.

Authorized users can add, extend and delete EMDISC files of external filesystems.

The displayed data can be updated by clicking on Update EMDISC filesystems. The Repair EMDISC filesystem
action is available for individual EMDISC filesystems for authorized users and only if the EMDISC filesystem is not
already in the ACTIVE state.

> Select Hardware -> Units -> [<se server> (SE<model>) ->] <unit> (SU<x86>) -> Information, EMDISC files tab

System IP intertaces | FC interfaces Multipath disks CRD disks EMDISC files

+ Server Unit rinat: EMDISC files

Add niew EMDISC file &) Disks
Name - Size [MB] EMDISC MN He Unit ID Status
Filler Filter Fiter Fifter Filler Filler All -
BS2D_4711_lddri-of_4400 20467  xempDXO00E2AOTB1AZE] - - - O macTve L
BS2D_DO00 8204  internal = =} 5 & INACTIVE
BS20_emd1 4098  xempDXDDOEZAD7R1d2E2 - - - © NAcTIVE ’ 9
BS2D_roo1 1024 xempDXDDOE2AD7E1d2E2 1000 10 00 © AcTve
BS20_V60d 2048  intemnal 000 60 00 & ACTIVE
@ e Total &
> Server Unit rinat: EMDISC filesystems )
Update EMDISC filesystems Last update of the EMDISC filesystems: 2025-01-20 09.45 11
Name ~ Size [MB] [Free (MB] No. files Status
Filter Filter Fiter Filter All o
interrial 32788 22516 2 @ ACTVE
xempDX000E2ADTE142E1 20480 4 1 @ ACTIVE
xempDX000EZAD7A1d2E2 20480 16372 1 @ ACTVE

DE Total 3
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10.1.7.2 Managing the IP configuration of the SU x86
You manage the IP configuration of the SU x86 using the associated Management menu, IP configuration tab.

> Select Hardware -> Units -> [<se server> (SE<model>) ->] <unit> (SU<x86>) -> Management, IP
configuration tab.

Using the IP configuration tab you can change the host name and network properties and add network addresses.

The functionality of the tab is the same as that for the MU (see section "Managing the IP configuration™) with the
following restriction:

i If only the standard networks LOCLAN, MCNLO, and MCNPR are assigned on the SU x86, the buttons
for changes are not enabled.
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10.1.7.3 Managing routing of the SU x86
You manage routing of the SU x86 using the associated Management menu, Routing & DNS tab.

> Select Hardware -> Units -> [<se server> (SE<model>) ->] <unit> (SU<x86>) -> Management, Routing &
DNS tab.
The routing is displayed in the upper Routing group on the tab.
The functionality of the tab is the same as that for the MU (see section "Managing routing of the Management Unit")
with the following restriction:
i The MANPU and MONPU networks are not available on an SU x86.

The Add new route and Delete route actions are only available for Net-Storage connections.
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10.1.7.4 Managing the DNS configuration of the SU x86

You can inquire information about the DNS configuration of the SU x86 using the associated Management menu,
Routing & DNS tab.

> Select Hardware -> Units -> [<se server> (SE<model>) ->] <unit> (SU<x86>) -> Management, Routing &
DNS tab.

IP configuration Routing & DNS Net-Storage

» Server Unit gold: Routing Total 6 ‘E:'

» Server Unit gold: DNS name servers (DNS configuration: Static)

| Change DNS name servers |

DNS name server
1 fd5e =101
2  idge 201

w Server Unit gold: DNS domains (DNS configuration: Static)

(=)

|_éhange DNS domains |

DNS domain

1 senet ]

The DNS configuration is displayed in the two groups DNS name servers and DNS domains. The title bar of the
group shows whether DNS is configured and whether static or dynamic DNS configuration is involved.

The structure of the tab is basically the same as that for the MU (see section "Managing the DNS configuration”).
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10.1.7.5 Configuring Net-Storage on the SU x86

Access to Net-Storage (storage access via NFS) is possible for BS2000 systems (for Native BS2000 and the
BS2000 VMs) of the SU x86 provided the following prerequisites are fulfilled in X2000:

® For administrative access to the Net-Storage server that provides the Net-Storage, the administrator of the Net-
Storage server must create an account that is the owner of the directory released via NFS. In the case of
Eternus-CS HE NAS, the account must be the owner of the file group of the NAS share. The user ID and group
ID must be obtained from the administrator of the Net-Storage server.

The NFSv4 domain must correspond to the domain name set on the Net-Storage server.

i X2000 always tries to connect to the Net-Storage via NFSv4. If the mounting via NFSv4 fails, NFSv3 is
used as protocol.

® Each Net-Storage connection must be configured in the network.
You configure Net-Storage in X2000 of the SU x86 using the Management menu, Net-Storage tab.

> Select Hardware -> Units -> [<se server> (SE<model>) ->] <unit> (SU<x86>) -> Management, Net-Storage
tab.

IP configuration | Routing & DNS | Net-Storage

~ Server Unit gold: Net-Storage permissions (7)
Access authorization - User ID 7013 4
Access authorization - Group 1D 2003 ’
NFSv4 domain localdomain ' 4

- Server Unit gold: Net-Storage client

{~)

| Restart Net-Storage ciient |

Status Active (since 2023-10-256 19:30:45)
NFS mounts

« Server Unit gold: Net-Storage connection properties

()

| Add connection |

C i Slot/ port VLAN Properties

NETSTORC1  s0 p2 ocpl - 7] DHGPv4 ] IPvG ] Autoconf [ ] DHCPv6 7 9

o B Total: 1
« Server Unit gold: Net-Storage connection addresses 2

| Add P address |

Connection  IP address Mask VLAN MAC address Conf.

LOCLAN 19 12 - - Qs FF

0@ E Total: 1

The Net-Storage tab displays the Net-Storage permissions, Net-Storage client, Net-Storage connection properties,
and Net-Storage connection addresses groups. The following functions are available:
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Changing access for the SU x86

In the Net-Storage permissions group, the current user and group ID that can be used to administrate the Net-
Storage access are specified in the form of userid/groupid. The IDs must be obtained from the system administrator
of the Net-Storage server. The default value for both is 0.

> In the Net-Storage permissions group click the Change icon by Access authorization - User ID or Group ID. In
the subsequent dialog box change the user and/or group ID and confirm the action.

If the default value is not changed, the access is attempted with root rights, which is not recommended for
reasons of data protection.

i Please note that as a result of this action, all mounted Net-Storage devices in the BS2000 will be
unmounted. You will therefore have to re-mount them afterwards.

Entering or changing configuration data for the NFSv4 domain

> In the Net-Storage permissions group, click the Change icon by NFSv4 domain and enter the domain name in
the subsequent dialog. Confirm the action.

i Please note that as a result of this action, all mounted Net-Storage devices in the BS2000 will be
unmounted. You will therefore have to re-mount them afterwards.

Restarting the Net-Storage client
The Net-Storage client group displays the current status of the Net-Storage client and the mounted directories.

> In the Net-Storage client group, click on Restart Net-Storage client and confirm the action.

i Please note that as a result of this action, all mounted Net-Storage devices in the BS2000 will be
unmounted. You will therefore have to re-mount them afterwards.

Adding and changing a Net-Storage connection to the SU x86

> In the Net-Storage connection properties group click Add connection, make the required entries in the
subsequent dialog box, and confirm the action.

> In the Net-Storage connection properties group click the Change icon by the required Net-Storage connection
and enter your changes in the subsequent dialog. Confirm the action.

For further information, see the "Description Paper Net-Storage Guide" [15].

Deleting a Net-Storage connection

> In the Net-Storage connection properties group click the Delete icon by the required Net-Storage connection
and confirm the action.

Adding a Net-Storage connection address (SU x86)
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> In the Net-Storage connection addresses group click Add IP address, make the required entries in the
subsequent dialog box, and confirm the action.

Deleting a Net-Storage connection address

> In the Net-Storage connection addresses group click the Delete icon by the required Net-Storage connection
and confirm the action.
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10.1.8 Managing Application Units

An SE server can optionally contain autonomous high-end x86-64 servers, so-called Application Units (AUs).

The Application Units are integrated into the rack of the SE server (and into additional racks, if needed) when it is
supplied, the internal network is preconfigured, and if requested the operating system is also installed. The
Application Units are incorporated in the status display of the SE Manager and in the remote service procedure for
SE servers.

As administrator (or AU administrator) you install your own software (e.g. Networker StorageNode) on the
Application Units and perform other administration and configuration tasks. You add installed applications with web
interfaces to the list of applications in the SE Manager, which enables you to call these applications directly from the
SE Manager.

Many roles are entitled to access the applications. Only as administrator or AU administrator, however, the
administration functions for modifying the data for accessing Application Units are available to you.
Remote access to the console of the Application Unit

For Application Units PY (e.g. AU25 and AU47), the iRMC function Video Redirection enables remote access to the
console of the Application Unit. The console has the same functions as the local console.

The web interface of the Management Board can be opened in the same way for partitions of AU PQ (e.g. AUQ38E
/DBU3BE). The access to the console of the Application Unit is also available there.

The iRMC/Management Board is also linked in the system operation of the AU or AU partition.
The following sections describe the management of an AU in more detail:

® Configuring an Application Unit
® Displaying hardware information of the Application Unit

® Managing the IP configuration of the Application Unit
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10.1.8.1 Configuring an Application Unit

Application Units are integrated into the status monitoring and display of the SE Manager and the remote service
procedure of the SE server. The connection to these procedures is established via basic mechanisms of the
operating system on the Application Unit (SNMP query). No further software is required on the Application Units for
the connection.

You check and modify the configuration of the Application Unit in the following cases:

® You (re)install the Application Unit.
® You change the IP address space of MANPU.
® You change the IP address of the MU in MANPU.

i Further information is provided in the appendix of the online help under "Configuration on the Application
Unit."

Change LAN configuration of the Application Unit

If your Application Unit is connected or is to be connected via MANPU, you must change or set the IP addresses of
the Application Unit for MANPU in the following cases:

® You (re)install the Application Unit.

® You change the IP address space of MANPU.

You must perform the following steps to do this:
1. Use operating system resources on the Application Unit to change or set the LAN configuration of the LAN
interface for the MANPU.

2. On the Application Unit, use the Linux and Windows operating systems to change or set the SNMP
configuration according to the (new) IP address space of the MANPU.

3. Only when you are modifying the IP address space of the MANPU:
Modify the LAN configuration of the MU using the SE Manager.
Integrating an Application Unit into status monitoring

The hardware status of the Application Unit is determined by means of an SNMP query from the Management Unit
to the ServerView agent on the Application Unit via the management LAN. To permit this the ServerView agents
must be installed and SNMP must be configured on the Application Unit.

Detailed and operating system-specific information about the SNMP configuration is available in the appendix of the
online help (see "Further information”, "Configuration on the Application Unit").

> Check the implemented configuration.
The configuration is correct when the following conditions are satisfied:

® The Application Unit in the SE server overview on the Management Unit is displayed with the system
status Running.

® The hardware information of the Application Unit is displayed in the information for the Application Unit.
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i It is possible to integrate an AU only at hardware level.
In this case, systems resp. VMs are not enquired and therefore not displayed, NOT_MONITORED is
displayed as the system status of the AU, and the hardware displays are subject to certain restrictions.
For more information, see the online help.
For details, please contact Customer Support.

Integrating an Application Unit into the remote service procedure

An Application Unit is integrated into the remote service procedure with reporting of hardware errors to the Service
Center (teleservice call) by forwarding hardware error messages to the Management Unit. For Application Units

with the Linux and Windows operating systems, ServerView agents must also be installed for the purpose of
hardware monitoring.

On the Management Unit the messages forwarded from the Application Units are filtered further and sent to the
Service Center using the remote service procedure AIS Connect.

The Application Unit thus reports on hardware errors to the Management Unit in two ways:

® Trap forwarding from the iRMC

® Trap forwarding from the Management Board
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10.1.8.2 Displaying hardware information of the Application Unit

> Select Hardware -> Units -> [<se server> (SE<model>) ->] <unit> (AU<model>) -> Information, Overview tab.

Overview

w Application Unit arosa: Hardware information (7

Chassis.

Name arosa

HW model AlUZ25 PRIMERGY RX2530 M4
Serial number  YMBQOO1538

FW version JA47P

BIOS version V5.0.0.12 R1.58.0 for D3383-Alx

System start 2024-02-23 12:18:12

Main memory 256.0 GB

CPUs Intel(R) Xeon(R) Silver 4110 CPU @ 2.10GHz, 2100 MHz (2 Sockets)
iRMC address 17 246

The Overview tab displays hardware information on the selected unit.

For an AU PQ , information about the chassis, Management Boards, System Boards, 10 Units, and Disk Units is
displayed. When a partition is selected, information is displayed about the partition, the assigned System Board,
and the 10 Unit. Example for a DBU87 (only in extracts):

Overview
Application Unit auc8-se1: Hardware information Q)
Chassis

Name aucd-sel

HW model DBUS7 (PRIMEQUEST 2300E2)

Serial number 1541517004

‘Management Board 0

FW version 3033

Serial number PP1514036R

Management Board 1

FW version 30.33

Serial number PP1411015K

System Board 0

Serial number PP160502CV

BIOS version 187

BMC version 2.18F

Board revision CAD7777-DO10 B3

Main memory 123.0GB

CPUs Intel(R) ¥eon(R) E7-8867V3, 2500 MHz (2 Sockets)
System Board 1

Serial number PP151601YU

__BIOS version _ 167 . . - —
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10.1.8.3 Managing the IP configuration of the Application Unit
When managing the IP configuration, there are differences between Application Units PY and PQ.
Managing IP configuration of an Application Unit PY

You manage the IP configuration of an AU PY using the associated Management menu, IP configuration tab.

> Select Hardware -> Units -> [<se server> (SE<model>) ->] <unit> (AU<model>) -> Management, IP
configuration tab.

IP configuration

Application Unit au5-se2: Host name (?)
Host name aus-ge2
Application Unit au5-se2: IP network @)
IP address Mask IP interface VLAN Network
fd5e:5e5e:601.0:250: 561 fe62:5162 /I 64 vmi1 601 MONPRO1 s
Application Unit au5-se2: Access data @
Account Status
root & vaALD 7
Application Unit au5-se2: iIRMC Access data ©)
IP address iRMC Account Status
17 }.28 semuser &) VALID " 4

The IP configuration tab displays the groups Host name, IP network, Access data (only for AU with the VMware
vSphere ESXi or Microsoft HyperV operating system), and iRMC Access data.

The following functions are available:

Updating network data

You can cause the current data to be determined again and the display to be updated.
> Inthe IP network group click the Update network data icon and confirm the action.
A dialog with the Automatic update option is opened:
> If the AU is connected via MONPROL1 IPv6, select Yes and confirm the action.
> If the AU is connected via MANPU or MONPROL1 IPv4, select No and enter the IP address.

Changing access data of the Application Unit

You can change the access data of the Application Unit only if the Application Unit is operated with the VMware
vSphere ESXi or Microsoft HyperV operating system.

> In the Access data group, click the Change AU password icon for the required account, change the account /
password in the subsequent dialog box, and confirm the action.
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Changing access data of the Application Unit's iRMC access

The hardware status is determined for all Application Units using the iRMC. When the password on the iRMC has
been changed (outside of the SE Manager), you must also change the password here in SEM.

> In the iIRMC Access data group, click the Change IP address and password icon by the required IP address
iIRMC, change the IP address iRMC or the Password and confirm the action.

i semuser is permanently assigned as account. An account with this name must be created in the iIRMC of
the AU. The account must have the LAN Channel Privilege Administrator and Serial Channel Privilege
User rights.

Also see "Status monitoring via the iRMC of the Application Unit" in the appendix of the online help.

Managing IP configuration of an Application Unit PQ
IP configuration of an AU PQ is distributed to the Chassis and Partition levels.
At chassis level, access to the Management Board is configured centrally:
> Select Hardware -> Units -> [<se server> (SE<model>) ->] <unit> (<AU PQ model>) -> Management, IP
configuration tab.

In the Management Board access data area you can change the IP address and password.

i The account semuser is permanently assigned. The account must be configured in the web Ul of the
Management Board and have the admin privilege for the Remote Server Management.

At partition level access to the particular partition's system is configured:

> Select Hardware -> Units -> [<se server> (SE<model>) ->] <unit> (<AU PQ model>) -> <partition> ->
Management, IP configuration tab.

In the IP network area you can update network data analogously to AU PY (see "Updating network data").
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10.2 Managing IP networks

You manage the IP networks of the SE server using the tree structure Hardware -> IP networks. All IP networks are
listed in this menu.

The following description refers to the internal Net Unit and the networks realized with it. If the optional add-on NUX

(Net Unit eXtension) is installed on your Management Unit, SEM's menu structure will be adapted to the extended

connectivity of the SE server.
For more details on NUX, please contact the customer service.

The following sections describe the management of IP networks:

® Displaying information on networks and switches

o

o

o

o

o

Overview of IP networks and switches
Configuring SENET

Information on switches

Graphical display of the SE topology

Overview of the performance and utilization of the Net Unit ports

® Managing a Data Network Public

o

o

Configuring the ACL settings of the DANPU network

Information on the performance and utilization of the DANPU ports

® Managing a Data Network Private

o

o

o

o

o

Add network

Activate RADVD / DNS / NTP server

Managing members of a DANPR network
Configuring the ACL settings of the DANPR network

Information on the performance and utilization of the DANPR ports

® Managing a Management Network Public

O

o

Configuring the ACL settings of the MANPU network

Information on the performance and utilization of the MANPU ports

® Managing a Management Network Private

o

o

o

o

Overview over the status of all private management networks
Performance of the ports of the private management networks
Managing members of optional MONPR networks

Configuring ACL settings of optional MONPR networks
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10.2.1 Displaying information on networks and switches

You can display the following information on IP networks and switches:

Overview of IP networks

Configuring SENET

Information on switches

Graphical display of the internal IP network topology

Overview of the performance and utilization of the Net Unit ports
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10.2.1.1 Overview of IP networks and switches
You obtain the overview of the public and private IP networks and switches using the associated Overview tab.

>  Select Hardware -> IP networks, Overview tab.

Overview SENET | Switches | Topology Performance
» IP networks: Overview @ (7}

Perpage |32 ~

Network: Server Status Description

Filter abgsed NORMAL ~ Filter

DANPLUOY abgsed ) NORMAL Data network for systems on Server Unit SU1SE4
DANPUOT abgse4 ) NORMAL Data Network Public 07

DANPUOS abgse4 4 NORMAL Public data network 08

MONPU abgsed 4 NORMAL Management Optional Network Public

MSNFR abgsed o) NORMAL Management SVP Network Private
;(}: =] Tatal: & from 40

 IP networks: Overviaw switches

{ma}

Switch > Unit  Type Status.

Filter x Filter All -
nswal-se2 1 Stackable ICXG450-24 L NORMAL
nswal-sed 1 ex3400-48t ) NORMAL
nswhi-se2 1 Stackable ICXT750-48F 4 NORMAL

o Total: 3 from 8

The Overview tab displays information on all public and private data and management networks of the SE server
configuration as well as information on the switches in the second table.

If you manage a configuration of two SE servers in a Management Cluster, an additional Server column is displayed
in the first table. The column contains the name of the SE server to which the network belongs. For non-server-
specific networks (DANPR<nn>, MCNPR and MONPR<nn>), - (global) is displayed.
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10.2.1.2 Configuring SENET

SENET contains the internal DNS configuration of the SE server or the SE servers of a Management Cluster. The
IP network SENET is displayed on the SENET tab.

> Select Hardware -> IP networks, SENET tab.

Crvenaew SENET Switches Topalogy | Pedformance
IP netwark SENET (DNS) (7)
Add DNS enlry
SENEThostname + SENET name P address R N T
Filter Filter Filter Filter Filter
sud-set senet fdbe Hefe B0 Shab: Zaff fefif f4d1 MCNPR GAABIAGFFAD1
Idoe 0. SGab Jall febiIS1b DCANFRDT  S4ABIABFFS1B8-¢01 ’ 9
auTirme sel senet 172 245 MANFLI aufimcsel v
mutarnc-se ] senet 1411 Chb0 B210 el leat 8251 - mulirmese]
nswal-sel senet fdSe:Se5e-600: a:101 MCNPR nswalsel
sudirme sel senet fitfie- frebe G0N 0 Siak 3aff fefif £GTR MCHPR sufimicset
abggabil senel aui-sel.senel 172 245 MANPL O0S056ACAFEG 4
ABGSEA11 senet sudvmilset senst fodbe-Gehe GO0 092 1h eff fah? 1412 MCHPR B01ROERZ141A
ABGSETH senel Suvimlo-set senel Tdbe Bebe 800 0.921h el leb2 1414 MOHPH HOTHOEEZ21414
abgsemi1.senet mul-sel senet fd5e Se5e600:101 MCNPR S01BOCSAS93C
AUTvm3 senet fdbeGehe B01D! *feaa Taed DANPRDM  DOSDSEAATBEZ # 9
DANFROTwn IS serel - Id5e Bebe BOT.0. lebZ 142d DANFHRDT  901BOEBZ 14204017 F A
miZsel senst 172 39 MANPL! S01BOESBATAT ¥ 9

Total 13

The SENET tab displays all DNS entries of the SENET. In addition to the fixed internal entries, you can add or
remove additional DNS entries and change the host name:

Adding a new DNS entry to the SENET
> Inthe SENET tab, click the Add DNS entry button and follow the instructions of the wizard.

In the first step of the dialog, you choose between the IPv6 Discovery mode or Manual input of the IP address.

In case of IPv6 Discovery, select a private management or data network. After that, all IPv6 addresses of this
network that are not yet registered in the DNS are displayed. In the Ports selection list, select the required address.
The registration name is assigned automatically. You can assign the host name.

In case of Manual input of the IP address, in the following steps of the dialog, you can assign the IP address, the
registration name and the host name.

Changing the host name of a DNS entry

> Click on the Change icon next to the DNS entry and change the host name in the subsequent dialog.

Deleting a DNS entry

> Click the Remove icon by the DNS entry you wish to remove.
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10.2.1.3 Information on switches

The information on switches is displayed in the Switches tab.

>

Select Hardware -> IP networks, Switches tab.

Overview |

SENET |}

= IP switch status

Switches ‘ Topology ‘

Performance

Switch ~ Unit Type Temp. [°C] | HW status ISL status

sed Filter Filter Filter Al - Al -

nswal-sef 0 ex3400-48t 480 i) ) NORMAL 4 NORMAL

nswai-sef 1 ex3400-48t 420 ) CINORMAL ) NORMAL
o E Total: 2 from 8

w |P switch port information

1 to 32 from 41 | | L Page 1 from 2 \IHE‘ Go to page ! \I| Per page | 32
Switch ~ Port (of tio Purpose Type  Gbits Link Status VLAN
seb Filter Filter Filfer Filter  Filter All - | Al

nswat-sef 0/0/14  HNC152P0 Other RJ45 1.00 {}UF -;';.iNORMAL o
nswai-sef 0/0/16  HNC1S2P1 Other RJ45 1.00 QUP L NORMAL L}
nswat-sef 0/0/33  HNCZRMC1 Other RJ45 1.00 OUF L NORMAL L
nswat-sef 0/0/43  MU25YS1 System RJ45 1.00 QUF L NORMAL L
nswal-sed 0/0/45 nswal-seZ 1/1/23 ISL-E RJ45 1.00 C‘}UP \)NORMAL L
nswail-sef 0/0/47  AROMA-AZ Other RJ45 1.00 l() UP L NORMAL L}
nswal-sef 0/1/0 nswal-seg 1/1/0 ISL-8 LC 40 C,\UP & NORMAL L
nswal-sef 07141 nswal-ses 1/1/1 ISL-§ LG 40 (—)UP L NORMAL a

The Switches tab displays the status of the switches and information on the ports.

>

If you drag the mouse over the ' icon next to the temperature value in the IP switch status group, a tool tip

displays the temperature thresholds for warning and power-off.

In the IP switch port information group, click the Display/Details icon (“®) in the entry for a switch port; The

VLAN connections for this switch port are displayed in a dialog box.
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10.2.1.4 Graphical display of the SE topology

A graphical display of the network topology with all the network components and connections is displayed in the

Topology tab.

> Select Hardware -> IP networks, Topology tab.

Fﬁ s I.l
| Al |
| I X ]

z L7 4
AT 22807 230 13

12 IES 406112 =7 A IR T

H-II e
! II | l.

-4

You can influence the display:

® In the display of the topology you can have a selected network highlighted, i.e. this network is displayed normally

and the components of all other IP networks are grayed out.

® For a Management Cluster, you can select the SE server for which you want to display the topology, from the

Server list. The default is the SE server of the local MU.

i When you drag the mouse cursor over a network component, a tool tip displays detailed information on it

(if available).

To view the relevant parts of the graphic, left-click and hold the graphic to drag it into the desired position.

In the case of AU PQ the chassis and system components IO Unit and Management Board are displayed

together as one unit.

Further information can be found in the online help.
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10.2.1.5 Overview of the performance and utilization of the Net Unit ports

An overview of the performance and utilization of the switches in the Net Unit is supplied by the Performance tab.
The maximum and current data throughput rate (in MB/s) and the utilization (in %) are displayed for each Net Unit
port (for each of the Net Unit's active connections). A distinction is made between the send and receive directions
for data throughput and utilization.

>  Select Hardware -> IP networks, Performance tab.

Overview SENET Switches Topology Performance

IP switch port performance view @
F'erpage
Switch Port Gbit/s Sending Receiving Connection ~
- MB/s Utilization  MBis Utilization
Filter Filter  Filter Filter
nswal-se 112 0.01 0.00 0.00 % 0.00 0.00 % MSNPRO
nswal-se 1113 1.00 0.06 0.05 % 0.04 0.03 % | MANPU
nswal-sel 114 = = = = - MONPU
nswal-se 115 1.00 0.00 0.00 % 0.00 0.00 % DAMPUOA
nswal-sel A7 1.00 0.00 0.00 % 0.00 0.00 %  MUA1SYSA
nswal-sel 118 1.00 0.20 017 % 017 0.14 % | MU2SYS1
nswal-sel 1119 1.00 0.00 0.00 % 0.00 0.00 % | SU1SYS1
nswal-sel 1MH0 1.00 0.00 0.00 % 0.00 0.00 % | SU28YS1
nswal-sel 1M1 1.00 0.00 0.00 % 0.00 0.00 % HNC1S5YS1
nswal-sel MMz 1.00 0.00 0.00 % 0.00 0.00 % | HNC25YS1
nswal-sel 1MH3 - - - - - 8U1S7P1
nswal-sel 1MH4 1.00 0.00 0.00 % 0.00 0.00 % | SU251P0
nswal-sel 1MH5 1.00 0.00 0.00 % 0.00 0.00 % HNC1S3PD
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10.2.2 Managing a Data Network Public

You manage the public data networks (Data Network Public, DANPU) using the menu item Data Network Public in
the IP networks menu. Up to eight DANPUSs can exist per SE server. These are named DANPUO1, DANPUOQ2, etc.

i DANPUOL is pre-configured, further DANPU networks are configured by the Customer Support staff.

Overview of all DANPUs

>  Select Hardware -> IP networks -> Data Network Public, Overview tab.

Overview

Overview Data Network Public EE @
Networl Status Description
Filter All ~| Fifter
DANPUD1 L NORMAL Data Network Public 01
DANPUD3 W NORMAL Data Network Public 03
DANPUDE s/ NORMAL Data Network Public 08

o & Total: 3

The tab displays information on all existing DANPUs of the SE server configuration.

If managing a Management Cluster, an additional Server column is displayed. It lists the SE servers and the
DANPUSs that belong to it.

All DANPU networks are listed in the tree structure, under the Hardware - > IP networks - > Data Network Public
menu entry. If a Management Cluster is configured, each SE server has a <se server> (SE<model>) submenu
containing its DANPUSs. You can use these DANPU entries to obtain detailed information on the various public data
networks and manage them.
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Overview of the various DANPUs

> Select Hardware -> IP networks -> Data Network Public -> [<se server> (SE<model>) ->] DANPU<no>,
Overview tab.

Overview | ACL ! Performance
IP network DANPUO1: General information 7]
Property Value

VLAN ID (NetUnit) 4

Status & NORMAL

Description #

= [P network DANPUOD1: IP switch uplinks

()

Switch ~ Port Mode Link Status

Filter Filter Filter All | AN >
nswal-set 1115 untagged @UP 4 NORMAL
nswal-set 2115 untagged Q}UP &2 NORMAL

o E Total: 2

w IP network DANPUO1: IP switch ISL

()

Switch ~ Port Purpose Link Status
Filter Filter Filter All ~ | AN i
nswal-sei 11211 ISL-S QP # NORMAL
1/2/3 upP o NORMAL
nswal-se1 21211 ISL-3 Qup ) NORMAL
21213 Qe 4 NORMAL
‘D E Total: 2

w |P network DANPUO1: NetUnit information

(=)

~ Add ports |
SENET hostname SENETname Portname Port Mode Link Status Details
su3-sel SU351P1 1/1/31  dual @UP @NORMAL @
5U352P1 211131 dual @UP &) NORMAL

The Overview tab displays all information on the selected DANPU. The table in the NetUnit information group
contains the additional Switch column with the name of the switch, if more than one logical switch exists.

The following functions are available:
Modifying the description

> In the General information group click the Change icon (‘.'-'?) in row Description.

The subsequent dialog box Change description allows to enter resp. modify the description of the
network.

Displaying the MAC address

> In the NetUnit information group click the MAC addresses icon (“®) by the required unit.

The subsequent dialog box Display MAC addresses displays the unit's active MAC addresses.
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Adding ports

> In the NetUnit information group click Add ports, follow the instructions of the wizard, and select the
required port.

Removing a port

> In the NetUnit information group click the Delete ( # ) icon by the required unit and confirm the action.
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10.2.2.1 Configuring the ACL settings of the DANPU network

The ACL (Access Control List) defines the access settings for the DANPU<no>. You can add and delete ACL
entries for the DANPU<no>.

> Select Hardware -> IP networks -> Data Network Public -> [<se server> (SE<model>) ->] DANPU<no>, ACL
tab.

Overview ACL | Performance

= |P network DANPUO1: ACL settings

(~)

Network ACL Mode
IPv4 active # deny
IPvE inactive P -
* |P network DANPUO1: ACL IPv4 rules (7)

| Denysemwice |

TCP / UDP port TCP | UDP service
49888 "

‘D = Total: 1

The ACL tab displays a list of the ACL settings.

Changing an ACL setting

You can:

© enable or disable an ACL and associated network access control on a network-specific basis (for IPv4 and
IPv6 separately),

© select the ACL mode (permit or deny). In permit (whitelist) mode only the ports/services contained in the ACL
are permitted network access. All other services are locked. In deny (blacklist) mode only the ports/services
contained in the ACL are locked.

> |Inthe ACL settings group click the Change icon by the required entry and enter the new settings in the
subsequent dialog box.

If you set permit mode and enable ACL without entering services in the list, network access is locked
for all services.

Adding a service to the ACL

> Inthe ACL IPv4 rules or ACL IPv6 rules group click Deny service (in the case of ACL mode deny) or
Grant service (in the case of ACL mode permit) and select the ports and the services associated with
them which are to be added to the ACL.

Removing a service from the ACL

> Inthe ACL IPv4 rules or ACL IPv6 rules group click the Remove icon by the required entry and confirm
the action.
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10.2.2.2 Information on the performance and utilization of the DANPU ports

An overview of the performance and utilization of the ports belonging to the network is provided by the Performance

tab.

Performance tab.

QOverview ACL Performance

+ |P network DANPUO01: Uplink performance view

> Select Hardware -> IP networks -> Data Network Public -> [<se server> (SE<model>) ->] DANPU<no>,

®

Switch Port Ghit/s Sending Receiving
MB/s Utili MB/s Utilization
nswal-sel 11/58 1.00 0.18 0.16 % 0.00 0.00 %
2115 1.00 0.00 0.00 % 0.00 0.00 %
D & Total: 1
+ |P network DANPUO1: ISL performance view @
Switch Port Gbit/s Sending Receiving
- MB/s Utili: MB/s Utilization
Filter Filter Filter
nswal-sel 1121 10.00 0.01 0.00 % 0.10 0.01 %
11213 10.00 0.04 0.00 % 0.03 0.00 %
nswal-sel 2721 10.00 0.10 0.01 % 0.01 0.00 %
21213 10.00 0.03 0.00 % 0.04 0.00 %
D Total: 2
= |P network DANPUOD1: Unit performance view Q)
SENET host name SENET name  Switch Port name Port Ghit/s Sending Receiving
MB/s Utilization MB/s Utilization
- sud-set nswal-sel SU3S1P1 171131 1.00 0.00 0.00 % 0.19 0.16 %
SU3s2P1 2113 1.00 0.00 0.00 % 0.00 0.00 %

Three views are displayed on the Performance tab:

The maximum and the current data throughput rate (in MB/s) and the utilization (in %) are displayed for each port
(for each connection) listed in the various views. A distinction is made between the send and receive directions for

data throughput and utilization.

In the case of redundant networks the two ports used for the redundant connections and their performance are
displayed one after the other in a table row.

Total: 1

The Uplink performance view provides information relating to the performance and utilization of the connection
ports to customer networks.

The ISL performance view provides information relating to the performance and utilization of the network's ISL
ports (ISL = Inter Switch Link).

The Unit performance view provides information relating to the performance and utilization of the network's units
(members).
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10.2.3 Managing a Data Network Private

You manage a Data Network Private (DANPR) using the menu item Data Network Private in the IP networks menu.
Up to 99 DANPRSs can exist. These are named DANPRO01, DANPRO02, etc.

Overview of all DANPRs

> Select Hardware -> IP networks -> Data Network Private, Overview tab. The Overview tab with all information
on the existing DANPRs opens.

Overview
Overview Data Network Private E] (2)
| Add network |

1t032/99 114 [*][m] Page 1 [+] Perpage[32 |

Network Status Description Lok

Filter All ~ | Filter

DANPRO1 ) NORMAL Data Network Private 01

DANPROZ ) NORMAL Data Network Private 02

DANPRO3 ) NORMAL Data Network Private 03

DANPRO4 () NORMAL Data Network Private 04

DANPROS L NORMAL Data Network Private 05

DANPROG @NORMAL Data Network Private 06

DANPRO7 LANORMAL Data Network Private 07 v
o F Total: 99

i The administrator can create another private network by clicking the Add network button.

All existing DANPR networks are listed in the tree structure, under the Hardware -> IP networks -> Data Network
Private menu entry. You can use these DANPR entries to obtain detailed information on the various private data
networks and manage them.
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Overview of the various DANPRs

> Select Hardware -> IP networks -> Data Network Private -> DANPR<no>, Overview tab.
The Overview tab with all information on the selected DANPR opens.

Overview = ACL | Performance

IP network DANPROD2: General information

Property Value
VLAN ID (NetUnit) 802
Status £ NORMAL
Description E 4
IPv6 autoconf. prefix fdbe:d 64
~ IP network DANPROZ2: RADVD / DNS | NTP server Q)
SENET host name ~ IP address
Filter Filter
abgsem11 fd5e: 10:921beff-fefa.693c i  d
abgsem11 fdbe hete o0 - 101 v 9
o8 Total: 2
¢ IP network DANPROZ: IP switch ISL Total 2 -.i:‘,"
+ |P network DANPROZ: NetUnit information 7]
| Add ports |
SENET host name ~ SENET name Port name Port Mode Link Status Details
Filter Filier Filter Filter Filter All ~| Al ~
- sud-set SU3S1P1 1/1/31  tagged @UP o NORMAL @ 4
SU3S2P1 2/1/31  tagged [+ 10 4 NORMAL
su3-set SU3sS1P3 1/1/35  tagged QDOWN 1. WARNING E
SU3s2P3 2/1/35  tagged ODOWN A, WARNING

The Overview tab displays all information on the selected DANPR. The table in the NetUnit information group
contains the additional Switch column with the name of the switch, if more than one logical switch exists.

The following functions are available:

Modifying the description

> In the General information group click the Change icon (‘.'-'?) in row Description.

The subsequent dialog box Change description allows to enter resp. modify the description of the
network.
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Activating the RADVD/DNS/NTP server

> Inthe RADVD / DNS / NTP server group click the Activate RADVD / DNS / NTP server button.

A dialog box opens in which you can enable the RADVD/DNS/NTP server on the MU resp. the desired
MUs of the SE administration area.

Only those MUs can be selected which are connected to the network and on which the RADVD/DNS
INTP server is not yet activated.

Deactivating the RADVD/DNS/NTP server

> Inthe RADVD / DNS / NTP server group click the icon Deactivate RADVD / DNS / NTP server ( #) by
an IP address of the local MU.

After confirmation, disables the RADVD/DNS/NTP server. The function is available only for the local MU.

Displaying the MAC address

> |n the NetUnit information group click the MAC addresses icon () by the required unit.

The subsequent dialog box Display MAC addresses displays the unit's active MAC addresses.

Adding ports

> In the NetUnit information group click Add ports, follow the instructions of the wizard, and select the
required port.

Removing a port

> In the NetUnit information group click the Delete icon ( *# ) by the required unit and confirm the action.
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10.2.3.1 Add network

> Select Hardware -> |IP networks -> Data Network Private -> Overview tab. The Overview tab with all
information on the existing DANPRs opens.

> Click Add network.

The Add network dialog box opens and the first free network name is preselected.

> Follow the instructions of the wizard and enter the network data. Detailed information is provided in the SE
Manager help.

i In the wizard, the available ports of the units (MU, SU x86, HNC) are only offered in the selection list
subject to the selected mode (tagged, untagged or dual). The ports of the MUs are only offered for
selection in the tagged mode. If another mode was selected, the ports of the MUs can be added
afterwards at the respective DANPR<nn> via Add ports (see "Overview of the various DANPRs").
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10.2.3.2 Activate RADVD / DNS / NTP server

For each DANPR, you can activate the RADVD / DNS / NTP server on the MUs of the SE administration area
connected to the network:

> Select Hardware -> IP networks -> Data Network Private -> DANPR<no>, Overview tab.
> Click Activate RADVD / DNS / NTP server.
> The Activate RADVD / DNS / NTP server dialog box opens.

Select the desired MUs, if necessary, and click Activate.

i For reasons of redundancy we recommend to activate the RADVD / DNS / NTP server on all MUs of the
SE administration area.

Note: At least one port of the respective MU must be assigned to the network.
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10.2.3.3 Managing members of a DANPR network

You can display the active MAC addresses and add or remove ports (members of the network) for each DANPR.

Proceed as described in section "Managing a Data Network Public".

i Caution:

After assigning a port of a unit in the untagged mode to a network, that port cannot be assigned to an
additional network.
In dual mode, assigning the port for other networks is only possible as tagged.
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10.2.3.4 Configuring the ACL settings of the DANPR network
You can add and delete ACL entries for each DANPR.

> Select Hardware -> I[P networks -> Data Network Private -> DANPR<no>, ACL tab.

Proceed as described in section "Configuring the ACL settings of the DANPU network".
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10.2.3.5 Information on the performance and utilization of the DANPR ports

An overview of the performance and utilization of the ports belonging to the network is provided by the Performance
tab.

> Select Hardware -> IP networks -> Data Network Private -> DANPR<no>, Performance tab.

The Performance tab displays the ISL performance view and Unit performance view tables.

Detailed information is provided in section "Information on the performance and utilization of the DANPU ports".
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10.2.4 Managing a Management Network Public

Each SE server has a public management network, the so-called Management Network Public (MANPU). There
can also be a second optional network (Management Optional Network Public, MONPU for short).

You manage the public management networks (MANPU and MONPU) using the menu item Management Network

Public in the IP networks menu.

Overview over the status of the management networks MANPU and MONPU

>  Select Hardware -> IP networks -> Management Network Public, Overview tab.

Overview
Overview Management Network Public [ @
Network Status Server Description
Filter All ~ | Filter Fiiter
MANPU L NORMAL SE1-Schweiz Network MANPU of SE1-Schweiz
MANPU QNORMAL SE2-Svizzera Network MANPU of SE2-Svizzera
MANPU (I NORMAL SE3-Suisse Management Network Public of SE3-Suisse
MANPU (I NORMAL SET-silver Management Administration Network Public
MANPU L NORMAL SE8&-blue-and-white Management Administration Network Public

i-r

Total: 5

In Management Cluster configurations, the Overview tab displays the status of the public management networks of
both SE servers of the Management Cluster. The Server column lists the name of the corresponding SE server with

each MANPU/MONPU.
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Overview over the network MANPU of an SE server

> Select Hardware -> IP networks -> Management Network Public -> [<se server> (SE<model>) ->] MANPU,
Overview tab.

Overview | ACL | Performance
Server SE3-Suisse IP network MANPU: General information @
Property Value
VLAN 1D (NetUnit) 2
Status 9 NORMAL
Description Management Nefwork Public of SE3-Suisse ' 4
IPv4 gateway 172 1
IPv4 network 172 0522
IPvG autoconf. prefix fd11:1d52: b0:./64
~ Server SE3-Suisse IP network MANPU: IP switch Uplinks )
Switch ~ Port Mode Link Status
Filter Filter  Filter All | Al s
nswal-se3 1/1/3  untagged Qur (2 NORMAL
nswail-se3 2/1/3  untagged Qe ) NORMAL
o E Total: 2
« Server SE3-5uisse IP network MANPU: [P switch ISL @
Switch ~ Port  Purpose Link Status
Filter Filter  Fitter All | Al b
nswal-se3 121 ISL-S Qe CANORMAL
1123 e ) NORMAL
nswal-se3 2121 ISL-8 0 upP v NORMAL
21213 Q) up I NORMAL
o B Total. 2
~» Server SE3-Suisse IP network MANPU: NetUnit information f?_)
Addports |
SENET host name- SENETname Portname  Port  Mode _Link Status Details
Filter Filter Filter Filter  Filter Al ~ | Al o
- hnci-se3 HNC153P0 1113 dual @UP (I NORMAL & £
- hnc2-se3 HNC253P0 2/113  dual e',:;UP LI NORMAL a ]

The Overview tab displays all information on the MANPU. Information on a MONPU network is displayed in the
same way.

For a Management Cluster, this overview also contains the IP switch ISL group.

The following functions are available:
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Displaying the MAC addresses

> |n the NetUnit information group click the MAC addresses icon (“#) by the required unit.

The subsequent dialog box Display MAC addresses displays the unit's active MAC addresses.
Adding ports
> In the NetUnit information group click Add ports, follow the instructions of the wizard, and select the ports.
Removing a port

> In the NetUnit information group click the Delete icon by the required unit and confirm the action.
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10.2.4.1 Configuring the ACL settings of the MANPU network
You can add and delete ACL entries for each MANPU.

> Select Hardware -> IP networks -> Management Network Public -> [<se server> (SE<model>) ->] MANPU,
ACL tab.

If you set permit mode and enable ACL without entering services in the list, network access is
locked for all services. For the MANPU network this means that you, as administrator, "lock yourself
out".

Proceed as described in section "Configuring the ACL settings of the DANPU network".
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10.2.4.2 Information on the performance and utilization of the MANPU ports

An overview of the performance and utilization of the ports belonging to the public management network is provided
by the Performance tab.

> Select Hardware -> IP networks -> Management Network Public -> [<se server> (SE<model>) ->] MANPU,
Performance tab.

The Performance tab displays the Uplink performance view, ISL performance view and Unit performance view
tables.

Detailed information is provided in section "Information on the performance and utilization of the DANPU ports".
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10.2.5 Managing a Management Network Private

An SE server can have the following private management networks:

® MCNLO: Management Control Network Local

®* MCNPR: Management Control Network Private

* MONPRO1 to up to MONPRO08: Management Optional Network Private, optional
* MSNPR: Management SVP Control Network Private, optional

You manage the private management networks via the IP networks -> Management Network Private menu. The
existing private management networks are listed below Management Network Private. You use these menu entries
to manage the network and obtain detailed information.

In a Management Cluster configuration, only the globally available private management networks MCNPR and
MONPRO1 to MONPROS are listed directly under IP networks -> Management Network Private. The server specific
MSNPR and MCNLO networks are each listed in the SE server-specific <se server> (SE<model>) menu.

Example:

= Management Network Private
MCNPR
MONPRO1
MONPRO2
= SE-Server-1 (SE700B)
MSNPR
= SE-Server-2 (SE700)
MCNLO
MSNPR
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10.2.5.1 Overview over the status of all private management networks

The Overview tab offers an overview over the current status of all private management networks existing in the
current configuration.

> Select Hardware -> IP networks -> Management Network Private, Overview tab.

Overview
Overview Management Network Private E] 2)
[ Add network |
Metwork Status Server Description
PR NORMAL ~ | Filter Filter
MCNPR L NORMAL - (global) Management Control Network Private
MONPRO2 I NORMAL - (global) Management Optional Network Private 02
MONPRO4 L NORMAL - (global) Management Optional Network Private 04
MONPROS (& NORMAL - (global) Management Optional Network Private 05
MONPRO7 \;)NORMAL - (global) Management Optional Network Private 07
MONPRO8 ) NORMAL - (global) Management Optional Network Private 08
MSNPR L NORMAL abgse2 Management SVP Network Private
MSNPR 2 NORMAL abgsed Management SVP Network Private
o F Total: 8 of 14

The Server column is only displayed for Management Cluster configurations. For each SE server-specific network,
this column contains the name of the SE server to which the network belongs. For each private cross-SE server
management network, the Server column displays value - (global).

Add network

An SE server configuration can contain up to 8 Management Optional Network Privates (MONPRO1 ... MONPRO8).
As long as there are fewer than 8 MONPR networks, you can add additional MONPRSs:

> Click Add network.
The Add network dialog box opens and the first free network name is preselected.
> Follow the instructions of the wizard and enter the network data. Detailed information is provided in the SE

Manager help.

Overview over a single private management network

The overview is similar for all Management Networks Private. Consequently only the MONPRO1 is shown here. You
can display the MAC addresses for all Management Networks Private. Detailed information on tabs and the
subsequent dialog boxes is provided in the SE Manager help.

> Select Hardware -> IP networks -> Management Network Private -> MONPRO1, Overview tab.

The Overview tab with all information on the MONPRO1 opens.

252



SE Server - Administration and Operation - User Guide

Overview ACL Performance

IP network MONPRO01: General information

(=)

Property Value
VLAN ID (NetUnit) 601
Status & NORMAL
Description 7
IPv4 network 10. 0/24
IPvE autoconf. prefix fd5e:! 501::/64
» |P network MOMPRO1: RADVD / DNS /| NTP server
[ Activaie RADVD | DNS./ NTP semver |
SENET host name  IP address
abgsem11 fdbe: 1101 i
‘o =# Total: 1
w |P network MOMNPRO1: IP switch ISL
Switch ~ Port Purpose Link Status
Filter 12 Filter All | Al b
nswail-sel 11211 ISL-S @UP 4 NORMAL
11213 up ) NORMAL
o= Total: 1 of 2
» IP network MOMPRDO1: NetUnit information
| Add ports
SENET host name ~ SENET name Port name Port Mode Link Status Details.
abg Filter Filter Filter Filter All ~ | Al
abgsem11 mul-set MU1SYS1 1117 tagged @UP ) NORMAL &
MU1SYS2 217 tagged @UP L NORMAL

Displaying the MAC addresses

>

In the NetUnit information group search for the required unit and click the MAC addresses (“® ) icon.

The subsequent dialog box Display MAC addresses displays the unit's active MAC addresses.

253



SE Server - Administration and Operation - User Guide

10.2.5.2 Performance of the ports of the private management networks

An overview of the performance and utilization of the ports belonging to the selected private management network
is provided by the Performance tab.

> For the MCNPR or MONPR<nn> networks: Select Hardware -> IP networks -> Management Network Private

-> <network>, Performance tab. Here <network> specifies the private management network MCNPR or
MONPR<nn>.

> For the MCNLO or MSNPR networks: Select Hardware -> IP network -> Management Network Private -> [<se
server> (SE<model>) ->] <network>, Performance tab. Here <network> specifies the private management
network MCNLO or MSNPR. Since these networks are server-specific, they are always assigned to a <se
server> (SE<model>) menu if they are part of a Management Cluster.

The Performance tab is similar for all Management Networks Private. The ISL performance view and Unit

performance view tables are displayed. Detailed information is provided in section "Information on the performance
and utilization of the DANPU ports".
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10.2.5.3 Managing members of optional MONPR networks
You can add or remove ports for each optional MONPR (MONPRO1, MONPRO2, etc.):

> Select Hardware -> IP networks -> Management Network Private -> MONPR<no>, Overview tab.

Adding ports

> Select the NetUnit information group and click Add ports.

The Add ports dialog box opens. Follow the instructions of the wizard and select the ports.

> Confirm the action in the last step with Add.

Removing a port

> In the NetUnit information group, click the Delete icon by the required unit and confirm the action.
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10.2.5.4 Configuring ACL settings of optional MONPR networks
You can add and delete ACL entries for each optional MONPR.

> Select Hardware -> I[P networks -> Data Network Private -> MONPR<no>, ACL tab.

Proceed as described in section "Configuring the ACL settings of the DANPU network".
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10.3 Managing FC networks

You manage the Fibre Channel networks of the SE server using the tree structure Hardware -> FC networks.

Information about all FC networks and switches is accessible via this menu.

The Overview tab provides a summary overview of the connections per FC network (fabric) and of the switches.

>

Select Hardware -> FC networks, Overview tab.

Overview Connections Fabrics/Switches Topology Performance Settings
» FC natworks: Overview (2)
Network Number of connections in status: Status
-~ NORMAL WARNING ERROR INFO UNKNOWN
Filter Filfer Fifter Filter Filter Filfer All -
fabric1 267 0 0 131 355 e NORMAL
fabric? 263 0 0 121 339 ) NORMAL
‘fm E Total. 2
+ FC networks: Overview switches (7}
Name ~ Model ‘Serial number Status
Filter Brocade G620 ~ | Filter All b
fesw106 Brocade G620 EWY1908N001 ) NORMAL
fcsw109 Brocade G820 EWY1921Q061 ) NORMAL
o Total- 2 from 17

The following options for information and settings are available to you:

Displaying topology

Configuring settings

Displaying connections

Displaying fabrics and switches

Displaying performance
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10.3.1 Displaying connections

The Connections tab provides an overview of all connections. Three different tables of connections are shown:

Between server and storage, storage and storage, and between two switches (ISL).

> Select Hardware -> FC networks, Connections tab.
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You can obtain the details for a connection as follows:

> Click on the Display icon (“®) for the required connection in the Details column. The Connection details
dialog displays details of the connection as an overview (in the example a connection of the SU su390-se4):

Connetfon bt

Servar sulilasd

Fabrie: fabrie

Model  SE SERVER SUTH
Ser, Mo,  (OOPRO0G

[ Switch A: foswet 05—
Maodel Brocade G520
FabriciD 124
DomainiD 105 e £31)

. —Part: 8 (e 8- 1 Port: 36 (hex 23] -
WWPN 2042100 17 42 DE FC 68 | Portagdr, G0 Portagde  0EZIO0
WWPN 2008.C4 F5TC 3 06 CC | WWPN 230021 F8 88 AR50
| | ur.speed 12 G0 | Curr. spesd I Gotis

= Switch B: feaw il
Model Brocade 8520
FabrielD 177
DoemalntD 104 {rex 88}

Zone 1 SEN_43 _dvbs3_01_cmO_eal pd

Starage: ETERNUS SERIAL-NR 240047 —

Model
Ser, Mo
SystemiD

- Port
WWPN  S00000 EDDA BN 4T 23

| Ciase
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10.3.2 Displaying fabrics and switches
In the Fabrics/Switches tab all configured switches are shown.

> Select Hardware -> FC networks, Fabrics/Switches tab.
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The FC switch hardware info table displays the hardware switches with their properties. Virtual switches will not be
shown.

The Fabrics table displays the fabrics with their associated switches.

The Virtual switches table displays the virtual switches with the corresponding hardware switches. If no virtual
switch is configured, the table will not be shown.
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10.3.3 Displaying topology

The Topology tab displays all connections of the FC networks of the SE administration area in graphical form.
When you drag the mouse cursor over a hetwork component, a tool tip displays detailed information on it.

> Select Hardware -> FC networks, Topology tab.

Overview Connections ’ Fabrics/Switches |  Topology ' Performance Settings
Topology
View compact v | Zone |All w  System All v

ik " £
AF650-52-1 JDX500 S3-02 JDX500 S4-1

~

m DX8700-S3-01

RN ACE

DX900-55-1

View

The view can be switched between detailed and compact. In the compact mode, only the main components like
fabrics, servers and storage systems are visible.

Zone

List of the zones. The default is All, i.e. all zones are displayed. When you select a zone, all other components apart
from the selected zone are grayed out.

System

List of the storage systems and servers. The default is All, i.e. all systems are displayed. When you select a system,
all switches and systems which have no connection to this system are grayed out.
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10.3.4 Displaying performance

The Performance tab displays the performance values of the FC switches.

> Select Hardware -> FC networks, Performance tab.

Overdew | Connections | Fabrics/Switches Topalagy Performance | Seffings

 FC networks: Performance
1o 16 from 1242 Page 1 lrom 78 '__;; Gt page 1 _;' Ferpage 16w
Suitch. Sending. c Cennect
Name ~ Port  Gbitls MBis Uil Name Port
All - |Fller v | Faler Futer Faiter Falter Al * Filter
feswiid o 16.00 8.8 0.468% 54 82 2B leswils B4
feswild 1 16.00 0.00 0.00% e 1.66% foswils &5
feswiid 2 B.U0 o0 0.00% 0.0u 0.00% - =
foswi0d 4 8.00 1821 1.70% 5590 072% -
fesw104 & a0a aoo 0 00% noa 0.00%
lesw104 g 18.00 a0 00U iR ] 000% -
foswild T 800 0.00 0.00% 0.00 0.00% - =
feswild 8 16 00 aoa 0 0¥ om 000%
feswind a2 B.Ooo 014 001% o.or 001% - =
frwiid 10 400 nng 000 (L] 000%
Tesw104 n .00 .00 0.00%: oo 0.00% - -
feswild 12 16.00 0.00 0.00% 0.00 0.00% -
feswiod 13 16 0 L] 00 000 1 00%
lesw104 15 300 uoo 0.00%, o.oo 0.00% -
feswild 16 B.00 0.00 0.00% 0.00 0.00% - C
fesw104 1" 800 B0.48 B34% nog 001% ETERNUS SERIAL-NR 280054 -

Total: 1242
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10.3.5 Configuring settings

In the Settings tab you configure the access data for the FC switches to be monitored. Prerequisite for this are the
settings mentioned below.

Required settings at the FC switches

FC switches of the manufacturer Broadcom® (Brocade®) are supported. Details concerning the supported switch
models and fabric OS versions are described in the support matrix (see https://bs2manuals.ts.fujitsu.com/ > Fujitsu
Server BS2000 > Server Connectivity > FC-Switch).

Details of the settings can be found in the manufacturer's documentation ,Brocade® Fabric OS® Administration
Guide".

® The discovery of the properties and states of switches, fabrics and ports is carried out encrypted via the Brocade
REST API.

® To fulfill the requirement of access via https, SSL must be configured in the switches. In addition, the REST API
must be enabled.

® To configure a switch in SEM, a user with one of the following roles is required in the switch: admin, user,
switchadmin, operator, zoneadmin, fabricadmin, basicswitchadmin, securityadmin.

i Actions for changing the configuration are only available to an administrator resp. FC network
administrator.

> Select Hardware -> FC networks, Settings tab.
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Settings

In the Settings group, you can configure the data update regarding the registered switches (switch discovery) and
the therefore necessary access data.

Actions:

> Activating/deactivating the automatic status update including performance data (ﬂf)
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> Updating the complete FC network data including the FC network configuration ( - )
This action is required after configuration changes like e.g. adding or removing a switch, configuration of disks
or changes on the zoning.

Registered FC switches
In the Registered FC switches group, you can specify which FC switches are to be registered in SEM.

Actions:

> To add a switch to the list of registered FC switches, click Add FC switch. In the Add FC switch wizard, you
can make the required entries step by step.

> To change the settings for a switch, click the Change (;‘-'?) icon by the desired switch, follow the instructions
of the following wizard, and confirm your changes.

> To discover and add additional virtual or fabric switches for a registered FC switch, click the Discover (=)
icon by the desired switch.

> To remove a switch from the list of registered FC switches, click the Remove ( # ) icon by the desired switch.
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10.4 Managing storage systems

You manage the storage systems of the SE server in the tree structure Hardware -> Storage.

The Storage menu provides an overview of the storage available and enables the management of the storage. The
prerequisite for this is that the add-on pack STORMAN is installed and running.

For STORMAN versions V10.3 and higher on the local MU, the Storage Manager is directly integrated into the SE
Manager. The STORMAN user interface is accessible immediately below the Storage menu.

For STORMAN versions older than V10.3 on the local MU the following applies:

If the SE server has more than one MU or if more than one SE server form a Management Cluster, the Storage
menu provides an overview of the storage available in the complete configuration.

If you have an SE server configuration with multiple MUs, a submenu is displayed in the tree structure below
Storage, which has an entry Storage (<mu-name>) for each MU on which the STORMAN add-on pack is installed.

These entries give you an MU specific overview over the available storage and the direct access to the Storage
Manager on the respective MU.

® QOverview of the storage systems of the SE server configuration

® Qverview over the storage systems of an MU

® Storage Manager
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10.4.1 Overview of the storage systems of the SE server configuration

Depending on the version of the Storage Manager on the local MU, the navigation in the SE Manager differs:
For STORMAN V10.3 and higher, the Storage Manager is fully integrated in SEM. In this case, the STORMAN user
interface is directly accessible in the navigation below the Storage menu with the Overview tab.

For older versions, STORMAN can be called from SEM. The Storage Manager tab provides access to its user
interface.

>  Select Hardware -> Storage, Overview tab.

Overview
~ Update storage data @)

| Update storage data | Last update of the storage data: 2023-03-08 13:01:16

(=)

v Disk storage

Name ~ Vendor Model Serial number Status

Filter Filter Filter Filter All *
DX500 S4-1 FUJITSU ETERNUS DX500 S4 4621347002 & OK

DX500-S5-1 FUJITSU ETERNUS DX500 S5 4641951002 \) OK

dx5000s31 FUJITSU ETERNUS DX500 S3 4621632001 ) WARNING

dx5000s32 FUJITSU ETERNUS DX500 S3 4621631008 1, WARNING
DX900-S5-1 FUJITSU ETERNUS DX900 S5 4652005001 & OK

D¢ Total: &

4
()

Tape storage

Name Vendor Model Serial number Status

Phoenix FUJITSU ETERNUS CS8000 YABCO00007 & 0K

‘o8 Total: 1
v Management software (7)

Name Management Unit Description

ETERNUS SF bern

Y, '! :: Total: 1

In a single-MU configuration, the Overview tab displays information on the storage systems of the SE server. This
information is the same as in the information overview which the Storage Manager displays for storage systems.

In an SE server configuration with multiple MUs, the Overview tab informs of the storage systems as well as the
management software that the Storage Manager manages on all MUs. Storage systems which are found on more
than one MU are displayed only once, namely with the worst status. A tool tip displays the status of the storage
systems on the various MUs if you move the mouse over the icon in column Status.
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10.4.2 Overview over the storage systems of an MU

This tab is only displayed, if the STORMAN version on the local MU is older than V10.3.

In this case, information on the storage systems of an individual MU of a Management cluster or an SE server with
redundant MU can be obtained as follows:

>  Select Hardware -> Storage -> Storage (<mu-name>), Storage tab.

Storage Storage Manager
w Update storage data

| Update storage data |

&

Last update of the storage data: 2023-03-13 12:20:10

> Management Unit abgseSmu1: Disk storage 7
Name « Vendor Model ‘Serial number Status
Filter Filter Filter Filter All b
AFBE0-52-1 FUTSU ETERMUS AFG50 52 4521637022 Q0K
DX500 53-02 FUITSU ETERMUS DX500 53 4521349005 & OK
DX500 541 FUJITSU ETERMUS DX500 54 4621347002 1 WARNING
DX500-55-1 FUITSU ETERMUS DX500 55 4541951002 2 oK
DX8700-53-01 FUJITSU ETERMUS DXB700.53 4531528004 & OK
DXB8900-54-1 FUJITSU ETERMNUS DX8900 54 4652214004 @ OK
DX800-55-1 FUTSU ETERMUS DX800 S5 4652005001 2 0K
Total: 7
~ Management Unit abagseSmu1: Tape storage Q)
HName = Vendor Model ‘Serial number Status
Filter Filter Filter Filter All -
Atama FUIITSU ETERNUS C58000 YLWS001008 LI0K
Phaoenix FUITSU ETERMUS C58000 YABCO00007 &2 0K
‘o B Total: 2
v 1ent Unit wt; M @
HName Description
Mo data available
o E Total: 0

The Storage tab provides information about the storage systems and the management software which the Storage

Manager manages on this MU.

You obtain direct access to the Storage Manager via the Storage Manager tab.
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10.4.3 Storage Manager

This tab is only displayed, if the STORMAN version on the local MU is older than V10.3.

In this case, you call the Storage Manager from the SE Manager as follows:

> In a configuration with a single MU: Select Hardware -> Storage, Storage Manager tab.

> In an SE server configuration with multiple MUs (MU redundancy on an SE server or Management Cluster):
Select Hardware -> Storage -> Storage (<mu-name>), Storage Manager tab.

The Storage Manager's homepage opens.

If the current account was not entered in the Storage Manager as authorized, the call is rejected.

I
In configurations with multiple MUs, switch to the GUI of the Storage Manager instance on the MU <mu-name>.
Ménagém_ent Uﬁit'_(,a_h_éseﬁ:r_nlii'u_]- _

(<) SEManager

$ Sstorace >

E Configuration b3
a Authorizations 5

& Berechtigung

Further details on using the Storage Manager are provided in the online help and documentation for the Storage
Manager.

When you click SE Manager, you return to the SE Manager.
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10.5 HW inventory

In the Hardware -> HW inventory menu you can have the hardware configuration of your SE server displayed on
the screen in graphic form and also in various tables:

® Rack view

® Displaying units

® Displaying components

® Administration

In the case of a Management Cluster, the following is added:
® The main window Hardware -> HW inventory -> Units provides an overview of all units of the entire configuration
(details in the server-specific Units window).

® Below Hardware -> HW inventory a submenu <se server> (SE<model>) with the hardware equipment of this SE
server is displayed for each SE server.
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10.5.1 Rack view

The rack view displays all integrated components on the screen in graphical form.

> Select Hardware -> HW inventory [-> <se server> (SE<model>) ], Rack view tab.

The Rack view tab opens, here with an SE710 with two racks as an example.

Rackview | Units

SE-Server-3 (SE710) at Abg TestCenter

| Name

hnc2-se3
hncl-se3
mul-se3

muz2-sed

50310

5u390-5e3 (CHE-Box 6)

nswal-sel (basic-ry
nswai-sel (basic)
C 1

5u390-se3 (CHE-Box 2)
5u390-5e3 (CHE-Box 5)
5u300-5e3 (CHE-Box 1)
su390-5e3 (CHE-Box 4)
5u300-5e3 (CHE-Box 0)
Shelf1

Su300-se3 (CPU-Box)

Components

Type

HNC
HNC
My
My

SUxB6

50U /390

Switch
Switch
RC

SU/390
5U /390
51 /390
541390
sU /390
Shelf

S5U /390

GG @ s o ¢ e

LI < < B I <

Administration

& 6 8 6 @

€ 68 0 @

Name
naxos

fcews2
feswi1

lesbos

DX600-3303
DX600-83 32
DX6E00-33 22
DX600-53 12
Dxe00-s3 02
DXG00-83 31
DXx600-53 21
DX600-33 11
DX600-53 01
DX600-83 30
DXx600-53 20
DXE00-53 10
DX600-83 00

Rack 2 (DX600 S3 Rack)

Type
SU x86

Switch
Switch

SU x86

DriveEnclosure
DriveEnclosure
DriveEnclosure
DriveEnclosure
DriveEnclosure
DriveEnclosure
DriveEnclosure
DriveEnclosure
DriveEnclosure
DriveEnclosure
DriveEnclosure
DriveEnclosure

DriveEnclosure

DX600 53-PE02 Storage (disk)

The “® jcon allows you to view detailed hardware information about a unit.
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10.5.2 Displaying units
The Units view displays all integrated units in tabular form.

> Select Hardware -> HW inventory [-> <se server> (SE<model>)], Units tab.

The Units tab opens, here with an SE730 as an example.

Faoh Uity Compinents Adrmwsrgton

Barver $E0-Trizters (SET20): Unite

Hame = Model Firmwara (iRMC | HCP)  BIOS. Powear status. HW statun Invantory information

Fiter ar - Filer Fater A - Al = Fiar

B HNG WM 5P V1,00 0R1 230 for DISR0-A1Y O & HORMAL .
Incarmn WL A TGP V000 R 230 for DIEH0A1x > oN & HORNAL w
Hagioy WU WS 2415 00051 7.0 for D3I AL > O &) NORIN w
e HNC M5 2315 V1000 R T 0o DAGE2Me » ON &) NORMAL .
SUTHRSEN [CHE bay 0) Sy & POWER_ON w
SUTI0-5E6 (GHE boa 4} sSurin . & POWER_ON -
SUTH-SED (5P box) SuTIn ESOLOTG-D40+08T = oM o NORMAL L

Tatal 7

| In the case of a Management cluster, the central server-spanning main window Hardware -> HW
inventory -> Units provides an overview of all units of the entire configuration. That main window has the
same structure as the server-specific Units main window and contains the additional Server column.

270



SE Server - Administration and Operation - User Guide

10.5.3 Displaying components

In the components view all integrated add-on components, e.g. switches and storage systems, are displayed in
tabular form. A separate group is displayed for each component type.

> Select Hardware -> HW inventory [-> <se server> (SE<model>) ], Components tab.

The Components tab opens, here with an SE server with an SU /390 as an example.

Hack view Unts | Components Adminssraton

v Smruar abgeed (SETME] IP switchas

Name = Unle Ml Serlal number Freeporis  PW version HW status Inventory Informatian
Fller Flust Fitor Fltesr Pl Fiter A - Fiter
ol -5t (s o 3400467 HXIEZIIE0N05 8 from 48 231R18 A NORMAL
osowal 1o ed (basic .o} 1 40046 M2 TI0065E 9 from &6 23R8 CINORMAL
Tokal 2

+ Sarver abgved [SETIIB); FG switthes

Hama - Tres Modal Swrial numbar Frempores P varsian Statun Invenisey infarmation
Fltire GERD Filter Filtar Faitias ay = Filfer

Tesw 108 FC walich édernpl - Brocade G20 EWY 1808001 34 Fom &4 UCR R CINORMAL

Teww 108 FC woaich enderrnl - Brocade GB20 EWY19210061 A2 from €4 Va2 08 .:}MDRMN

Total & fom 21

= Smruer abgeed (SETIE): Disk storage companents ki)

Fiter Fiter Al = sy Fier Filter Fifter ax - Fiter

CIRNE 541 ICE) FLUITSLL ETERNUS DX500 54 AEZ1A4T002 VIGLBO-4000 Abg DCBA. |68 SWEUST GOk

P Tonal 1 fhoen 54
* Sarver sbgeed (SETME) Tape storage Total: | (7}
= Zarvur sogeed |EETI0E): Dther compenams A

Hame = Type Motdel - Serial number. Inventory Information

Filter Fier Filtor Filfer Fiker

RG w28 senice
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10.5.4 Administration

In the administration view all racks and hardware components are displayed in tabular form. One group is displayed
for each racks and other hardware components.

> Select Hardware -> HW inventory [-> <se server> (SE<model>) ], Administration tab.

The Administration tab opens, here with an SE710 as an example.

Rack view Linits Componems Administration
= Server SE-Server (SET10): Racks ki
Fller Filter Fiter
1 GIC4 A2 DIXATOO
PR a2 SEf10
AcicE 42 DXB00
E Total 3
= Server 3E-3erver-3 {SE710) Units and campanents 7
Name Tipe = Model |Rack Position  Height Serial nlimber
Filter Filter Filier Fller Fillie Frlter Fiteer Filler
hnicl sad HNE SE SERVER HNC M3 CI1CH A 1 YMLLIG01122 friae HNC
nnc2-2ed HNC SE SLRVER HNG M4 LGS 4 | EVVAEDDID4S
captain MU SE SERVER ML M3 1ch M 1 YMILLID0A DS mam ML
caplang MU SE SERVER MU M4 ¥ EWABDDSS8E
RC 1 RC re-25 cics 3 | SErvice
Shelf 1 Shelf CICH 1" 2 service
UE00 53-PEG2 (LE) Storage (desk) ETERNUS DXaU0 53 CIEE z 3 a621416010
DXGO0 53 PEO? (DF 0x00) Stofage (disk) ETERNLIS DXG00 53 CiCs & 7 IWKTP14Y50063

> In the Inventory information column you can directly enter a comment or change the existing comment.
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10.6 Managing energy settings

You manage the energy settings of the SE server using the tree structure Hardware -> Energy.

In a Management Cluster, a submenu <se server> (SE<model>) for each SE server is displayed below Hardware ->
Energy, which contains the energy settings of the respective SE server.

The following options for information and settings are available to you:

® Monitoring energy consumption of the units of the SE server

® Scheduled power on/off of units of the SE server
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10.6.1 Monitoring energy consumption of the units of the SE server

The Monitoring tab displays the current energy consumption, the hardware-specific maximum performance, and the

power status for all units of the SE server (SU, MU, HNC, and AU).

> Select Hardware -> Energy [-> <se server> (SE<model>) ], Monitoring tab.

Monitoring | Scheduled power on/off

« Server SE-Server-4 (SET30): Energy Monitoring of units (7]

Name ~ HW model Current power consumption Power status

Filter All

ABGSE111 (CHE-Box D) SUT30 188 W (from 267 W) B ON

ABGSE111 (CHE-Box 4) SU730 171 W (fram 267 W) B ON

ABGSE111 (CPU-Box) SUT30 311 W (from 817 Wi = ON

abgse4mul-1 MU M4 190 W (from 960 W) P ON

abgsedmu2-1 MU M4 200 W (from 360 W) > ON

hnc1-se4 HNC M4 180 W (fram 960 W) B ON

hnc2-sed HNC M4 190 W (from 960 W) B ON

hnc3-sed HNC M4 180 WV (fram 960 W) > ON

su310sed SU310 M1 490 W {from 1020 W) B ON
mE Total: 9

Using the L= icon in the group header you switch between a relative and absolute consumption display. The
image above is an example for the absolute display.
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10.6.2 Scheduled power on/off of units of the SE server

> Select Hardware -> Energy [-> <se server> (SE<model>) ], Scheduled power on/off tab.

Manitoring Scheduled power onlaff

» Server abgsed (SETI0B): Scheduled power onfoff of units o)
Name HWmodsl Monday  Tussday  Wednesday day [ Friday. | (Saturday | Sonday, - Pouesstahix
- On  Off On off On off On Ooff On Ooff On off On off
e o e T B N e N = (R TTS o .
ATE WG || D500, ey e iy e s i e IRHE e ] sl i RO o
1 MUMS S e REY  SED e e e el RO ShEel R e owker ks RON F.
1 MU M4 —— - - - - s iy e = o o e = o B ON Py <
UGS o W e dtah D ool ol RS SmL WL L m g wa (el # e
HHNC M5 ses e e sl s sl mslm sl s sle men slen omsle s B ON
HNEIRL i o e e e aaR b el Sl m ale oede e ks PPOR #
hiricd:se4 REGMAl S Sa T B e e e e e e N e e oh # 4
Tatal T

A list is displayed containing all the units of the SE server which can be powered on and off on a scheduled basis.

The power on/off times currently set and the current power status are displayed for each unit of the type MU, HNC,
SU x86, and AU PY. You can define, change, and reset new power on/off times for each day of the week.

i The functionality is not supported for SU /390 and AU PQ.
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11 Managing a cluster

A cluster is configured by Customer Support as per the customer's request.

The Cluster main menu is displayed in the tree structure if you manage at least one cluster in your SE server
configuration via the SE Manager.

Two or more SE servers are always managed in a Management cluster. Depending on the configuration, there can
be one or more additional SU clusters.

The Cluster -> Overview tab displays all clusters in the server configuration and their status.
In the Dashboard main menu, the Cluster -> Overview tile displays the status of the clusters in accumulated form,
and the link branches to the Cluster -> Overview tab.

i In the case of a Management cluster, the displays in SEM become correspondingly more complex.
Examples:
® The dashboard contains another tile called Cluster (also in case of an SU cluster only).

®* Where necessary, tables contain a further column called Server, e.g. the central overviews for systems
and units.

®* Where necessary, menus are split into server-specific menus, e.g. for systems and units.

A detailed description of the cluster functionality is provided in the "Cluster Solutions for SE Servers”
whitepaper [8].

In this chapter the following further topics are briefly presented:

® Status of the Management cluster

® Managing an SU cluster

276


https://edsys.g02.fujitsu.local:8443/pages/viewpage.action?pageId=42570106

SE Server - Administration and Operation - User Guide

11.1 Status of the Management cluster

If an SE server configuration consists of two or more SE servers, the SE servers are managed together in a shared
Management cluster. The main window provides information on the central resources of the Management cluster

and their status, as well as on the overall status of the Management cluster.

> Select Cluster -> Management cluster, Management cluster tab.

Management cluster

~ Management cluster summary

Status summary
IP networks ISL-E
Master MU

abgsedmu2-1

» Management cluster overview

£ NORMAL
) NORMAL
& NORMAL

=)

Management Unit  Server ~ Power status CRD disks Network heartbeat

Filter Filter All > Al - Al -
abgse2mu? abgse2 = ON a‘) NORMAL ) NORMAL

abgse2mu?2 abgse2 b ON &9 NORMAL &9 NORMAL

abgsedmui-1 SE-Server-4 = ON & NORMAL & NORMAL

abgse4mu2-1 SE-Server-4 P ON &9 NORMAL & NORMAL

B

Total 4
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11.2 Managing an SU cluster
An SU cluster combines SUs of the same type (SU /390 or SU x86), which enable the Live Migration (LM) of
BS2000 systems from one SU to another.

If an LM is currently possible (calling the wizard in the Operation main window of the respective BS2000 system),
depends on the current status of the SU cluster.

In order to avoid unwanted fault indications and events over long periods when maintenance takes place (e.g. SU
switched off or in error status), the SU cluster can be temporarily deactivated. You can use the icon ¥ to activate
or deactivate an SU cluster.

>  Select Cluster -> <cluster-name>, SU cluster tab.

SU eluster

= SU cluster Im380: Status

Cluster name Im3ad v

Function Live igration

Slalus summary I NORMAL
 5U cluster md80: Units

Unit Model  Server Qperation mode Power status CRD disks Hetwork heartbeat

E2 SuT0 abgsel &9 VM2000 B ON C3 NORMAL CINORMAL
abgse2muz B ON & HORMA, CHHORMAL
abgse2mut B ON & HORMA EANORMAL

EM1 SUT30 SE-Sefver-4 £ VIMZ000 = ON L4 NORM CANORMAL
ahgsedmut-1 » ON @ HoRNAL CINORMAL
abgsedmuz-1 » ON ) HoRMAL EIHORMAL

In the example, the SU cluster tab shows the current state of an SU cluster with SU /390.

A detailed description of the cluster functionality is provided in the "Cluster Solutions for SE Servers" whitepaper [8].
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12 Managing authorizations

For information on managing authorizations, see the following sections:

® Users
© Managing accounts
© Managing passwords
© Managing multi-factor authentication
© Managing operator rights
© Managing sessions
® Roles
® Configuration
© Access to an LDAP server
© |P-based access restriction to the MUs
® Certificates
O SSL certificate
®  Confirming/importing a certificate in the web browser
© Managing certificates
® Using the standard certificate
® Creating and enabling a new self-signed SSL certificate

® Requesting an SSL certificate

Uploading and activating a customer-specific certificate
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12.1 Users

You use the Authorizations -> Users menu to manage the local user accounts of all MUs of the SE server
configuration and the attributes of the accounts (exception: service account). Accounts are MU-global, i.e. every
account exists on every MU of the SE server configuration and always has the same attributes.

In addition to local accounts, you can also release or lock LDAP accounts for usage on the MUs of the SE server
configuration, which are centrally managed on a connected LDAP server (see section "Managing accounts"). The
prerequisite for this is that access to an LDAP server has been configured (see section "Access to an LDAP server”

).

For the administration and operation of the SE server, an administrator or security administrator can assign the
following basic roles to the accounts. In addition, user-defined roles can be configured by combining basic roles
(except Administrator and Service).

¢ Administrator

® BS2000 administrator

® BS2000 operator

* AU administrator

® Read-only administrator

® Security administrator

® Hardware administrator

® Storage administrator

® Power operator

® [P network administrator

® FC network administrator

® Shadow terminal operator

®* Remote service administrator

® Shell access

® OPENSM2 administrator and OPENSM2 information

® OPENUTM administrator, OPENUTM operator and OPENUTM information
® ROBAR administrator and ROBAR operator

® STORMAN administrator and STORMAN information

® Service
The SE Manager only displays this role or the user accounts with this role. A service account cannot be
administered in the SE Manager.

Detailed information on the various roles is provided in section "Role and user strategy".

®* Managing accounts

® Managing passwords

® Managing multi-factor authentication
® Managing operator rights

® Managing sessions
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12.1.1 Managing accounts

The administrator resp. security administrator manages all accounts on the SE server or the SE servers of a
Management Cluster, with the exception of the service accounts. They create new accounts and change or delete
existing accounts. There are local accounts and LDAP accounts:

® Alocal account is created on the MUs of the SE server configuration and is completely managed in the SE
Manager.

® An LDAP account is created on an LDAP server and is also managed from there. For an LDAP account, "Add
new account" means that the account is released for usage on the SE server and enables access to the SE
Manager just like a local account. "Remove account" means the account is no longer available for use on the SE
server.

The local accounts admin for the administrator and service for Customer Support are predefined and cannot be
deleted.

As administrator resp. security administrator you can create, modify and delete further accounts with a basic role or
a user-defined role. You cannot administer the service account (Service role).

You can also manage passwords and password attributes (e.g. validity time) for the local accounts, see section
"Managing passwords".

Users who are not an administrator or security administrator are only authorized to manage their own account, i.e.
they can change the access password for their local account themselves, see section "Managing passwords".

BS2000 operators obtain access to BS2000 systems and the corresponding BS2000 devices only in accordance
with their individual authorizations which are assigned by the administrator resp. security administrator, see section
"Managing access to the BS2000 console and dialog".

On the Accounts tab you can create, delete and manage accounts:

i For users who are not an administrator or security administrator, the functionality is limited to displaying
their own account and changing the name and comment.
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Displaying and managing accounts

> Select Authorizations -> Users, Accounts tab.

Accounts | Password management Muttifactor authentication | Operator rights Sessions
+ Accounts

[Fveaeat]

Type Account « Role Name Comment

All « | Filter All « | Filter Filter
-] doejohn Administrator Doe_John r 9
o leiadm Administrator Stefan 4
& leiaua AU administrator s’ 9
e leibs2a BS2000 administrator StefanBS2Adm bs2a (admin) ’ 3
® leifcadm FC network administrator .
o leiopr BS2000 operator Stefan - BS2 Operator s 9
| leiroadm Read-only administratar Stefan read-only read-only admin s 9
o leisecur Security administrator 4
o | leishado Shadow terminal aperator K
hi leiutmad OPENUTM administrator s 9

Add new account

> Select Add new account.

>

> Enter all required information for the new account.

The following is required to release an LDAP account:

® On the SE server on which the LDAP account is to be released, access to the LDAP server is
configured and active (see section "Access to an LDAP server").

® |f you have activated the check in the LDAP directory tree, the account is only created if it exists in the
LDAP. If you have not activated the check, you can also add an account that does not exist in the

LDAP (yet).

® There must be no local account with the same name.

An administrator or security administrator can use the Accounts tab to view all accounts in the server
configuration. Every account is available on every MU of the managed SE server configuration. Users with
another role see only their own account.

Local accounts and LDAP accounts can be distinguished via the icon in the Type tab.

The Customer Support account service (Service role) is only displayed, you cannot administer it.

In the following dialog, select whether you want to create a local account or release an LDAP account. You
only have this option if an LDAP server is configured.
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i You can create an account for the AU administrator role only if at least one AU exists in the SE server
configuration.

Change an account

You can change the Name and Comment properties of an account.

i For users who are not an administrator or security administrator, the functionality is restricted to their own
account.

> In the row of the required account click the Change (fp) icon and change the required account properties.

Remove an account

i Every user with the Administrator or Security administrator role can remove any other user. Only the
predefined accounts admin and service cannot be deleted.

> Click the Remove () icon by the required account and confirm the action.

The removed account is no longer displayed in the Accounts tab. An LDAP account is locked for use on the
SE server but still exists on the LDAP server.
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12.1.2 Managing passwords

In the Password management tab you manage the passwords of all defined local accounts.

i The passwords of LDAP accounts are only managed on the LDAP server.

The passwords of the local accounts have the attributes Validity time, Warning time, Minimum time, and Inactivity
time:

During the Validity time, which applies from the last time the password was set, it is possible to log in without
restriction.

You can enter a maximum of 365 days as the value for the Validity time.

During the Minimum time which is defined by the administrator or security administrator, users with another role
cannot change their own password.

During the Warning time, a warning is issued that the password will soon no longer be valid. However, it is
possible to log in without restrictions.

During the Inactivity time, the password is no longer valid, but it is still possible to log in. Directly after a user has
logged in, a request to change the password is issued.

After the Inactivity time has elapsed, the account is locked. It can be opened again from an(other) administrator
resp. security administrator account or, if necessary, by Customer Support.

The value -1 for the Inactivity time results in the inactivity time not elapsing.

The figure below shows the relationship between these times.

Login possible Account locked
=
Validity time
:
Minimum Warning Inactivity
time i fime
» time =
-
Time
Last Password
change expired
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When the SE server is supplied, the following values are predefined for the Validity time, Warning time, Minimum
time, and Inactivity time for the standard account admin:

Account  Minimum | Validity = Warning  Inactivity | Comment

time time time time

admin 0 60 7 -1 The account is never locked, it is always possible to
log in with the old password.
The value -1 for the inactivity time means that it
never expires.

When you create another local account using the SE Manager, the passwords you specify are initially assigned the
following attributes:

Account | Minimum | Validity = Warning | Inactivity
time time time time

<name> 7 60 7 7

The minimum time is not relevant for an administrator resp. security administrator account and the value 0 is
therefore displayed for it.

As administrator or security administrator you can disable an account in the password management. You can only
log in under this account again if you activate the account.

You can also force a change of password. When you force a change of password for an account which is locked by
the system, you permit a one-off login using the previous password.

Displaying password attributes

> In the tree structure select Authorizations -> Users, Password management tab.

Accounts | Password management | Mubluctor suthersestion | Opetator tights | Sessions

- Passward management &l

Accotm - Rals alidiey time  Warning ime Misimum time inactivity time | Stamis Login

Fiter Ar - Foitur Filter Fitar Filter Filer AN - " -
levesad Remate senace aominsraior 6 1 ] 1200213 & MINIMUM ¢ @ vn
levaecad Securty admndror 60 7 a T 2260213 & WD ¢ YD
(e Shados terminal opestar 60 1 T 20260293 & MINIML s & v
v Starage admanstrain L] T 7 1 20280243 &) MINIMUM # G v
(-] Adnunestrator ;5 o T 20250710 & LD ¢ G
malte Ausminestraton L] 7 o 7 20250206 ) vALID Ll R
FibradTn Ao 4 f o T 20250204 & VAL ¢ @ v
nbiroge BE2000 cperates ] 7 7 T 20250240 €3 MINIMUM # &
seryice Seryice n 7 o 1 20250208 & wwin & VLD
WA Adiministratoe (i) T o T H0Rh-00 £ VaLID £ QvAam

Tedal 27

The Password management tab displays the defined local accounts with their password attributes.
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Changing passwords or password attributes

| = For users who are not an administrator or security administrator, the functionality is restricted to their

own account:
They can change their own password if it has not yet expired and the minimum time between two

changes has been reached.
Only an administrator or security administrator can change password attributes.

® The service account service is only displayed; only the service itself can manage its password and
password attributes under the account service.

> Click the Change icon for the required account and change the password and the attributes as required.
In configurations with multiple MUs, the password and the password attributes of the account are changed on

all MUs.
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12.1.3 Managing multi-factor authentication

The Multi-factor authentication tab shows for which accounts multi-factor authentication (MFA) is configured and
allows to activate and deactivate MFA in general and for individual accounts.

> | Select Authorizations -> Users, Multi-factor authenticaton tab.

Accounts | Password management Multi-factor authentication Operator rights Sessions

» Multi-factor authentication

| Deactivate muiti-facior authentication

Account = Role Type Activation Initialization ”
Filter All hd Filter ~ |Filier hd

lejadm Administrator TOTP Na No -
leiopr BS2000 operator TOTP Yes No ' Aat -
lodamz2 Administrator TOTP Na Nao -
lodte1 Administrater TOTP Na No F 2

The Multi-factor authentication tab displays - only if MFA is activated generally - all accounts with their respective
MFA configuration.

For users who are not an administrator or security administrator, the functionality is restricted to their own account.

Activate/Deactivate multi-factor authentication generally

> Administrator or Security administrator only: Click the Activate/Deactivate multi-factor authentication button
above the table and confirm the action to activate resp. deactivate MFA in general.

i After the general activation of MFA, it is initially inactive for all accounts and must then be activated for the
desired accounts.
e)activate or an accoun
D tivate MFA f t

> Administrator or Security administrator only: Click the Activate/Deactivate MFA icon (.“f#) at the desired
account and confirm the action in order to activate resp. deactivate MFA for the account.

Renew MFA secret

> Only for accounts with MFA initialized: Click the Renew MFA secret icon ( < ) at the desired account and
confirm the action in order to create a new MFA secret for the account.
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12.1.4 Managing operator rights

The Operator rights tab displays all BS2000 operator accounts (local accounts and LDAP accounts with the BS2000
operator role) and their current individual rights.

The tab is not available to users who are not an administrator, security administrator or BS2000 operator.
For BS2000 operators the functionality is restricted to their own account. They only see their own rights. Only an

administrator or security administrator can make changes.

> Select Authorizations -> Users, Operator rights tab.

Accounts

| Password management |

+ Individual rights for operators

Account

~ Unit

Multi-factor authentication

System

Operator rights

Host name

i Sessions

Persistence Console

Dialog

Filter

demoopr

leiopr

wrooopr

J ¥

Filter

ulm
ulm
ulm

gold
gold

gold

Fiter

ULMO1
ULMOG
uLmor

GOLDO1
GOLD02

GOLDO03

Filter

uLmot
ULMO0E
uLmo7

GOLDO1
GOLD02

GOLDO03

Filter

No
Yes
Yes

No
Yes

Yes

Filter

co
co
C1,G2

co
co

Co

All

Granted
Granted
Denied

Granted
Granted

Denied

#

Total: 3

The Operator rights tab lists all BS2000 operator accounts, including accounts whose user-defined role includes the
BS2000 operator role, together with their individual rights.

Changing operator rights

i Only an administrator or security administrator can make changes.

> Click on the Change operator rights icon by the desired account. Assign the desired rights for the BS2000

operator in the following dialog.

i Note regarding non-persistent BS2000-systems

Console and dialog access for non-persistent BS2000 systems (VMs) lose their validity when the SU is

restarted and must be assigned again.

Managing access to the BS2000 console and dialog

A BS2000 operator can access the console of a BS2000 system solely by means of individual rights.

BS2000 communicates with KVPs using the mnemonic names of the KVP devices concerned. In addition, consoles

to be used by operators and administrators in BS2000 must be configured with a mnemonic console name and
assigned rights must be configured in the OPR parameter record of the parameter service (see the manual
“Introduction to System Administration”, /DEFINE-CONSOLE and /SET-CODE instructions). When a KVP is
configured, the mnemonic console names CO and C1 which are by default configured in BS2000 are automatically
assigned. These console names can be changed in BS2000. However, changes become effective only after the
BS2000 system has been started up again.
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An administrator resp. BS2000 administrator can always access the BS2000 consoles and the BS2000 dialog.
BS2000 operators can only access BS2000 consoles and BS2000 dialogs for which they have an individual right.
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12.1.5 Managing sessions

The Sessions tab informs the administrator resp. security administrator about all sessions of users who are
currently logged in on the SE Manager of a Management Unit of the SE server or Management Cluster.

> Select Authorizations -> Users, Sessions tab.

Aceoums Fassword managemeant Musts-tactar authents: ation Cperstor nghts Sasnions.

- Seasions 7

Account = Hame. Role 1P addreas Langusge Autom, upd. Timeout  Starting time
Filter Fiiter Filter .ﬁll- - Faar A _-_.T Filer Fater Filter
- {ploba) admin System Administrator Admniziratar 17 7 English E - 23023142953 #
« (gt} acrpavel Adrrun Pavel Adrrenestrator 17 sl Englsh 10s - A2302-1309 2113 *
{gobal) jdoe John Doe Adrmvristrator 17 1% Gerrnan 20min 20230214 072240 »
~ (gl Iosadem Stefanddm Aderinisratar 1T 23 Enghsh B B0 min 2023-02-14 075550
{ighaabal) ‘wiobadim Wh Adrrirustrator 17 8 German 105 20030215 184218 »

The Sessions tab provides information on the sessions of the users currently logged in. The local session is
highlighted.

In addition to the information on the user and IP address of the PC, the current individual settings for the session
are also displayed.

The Management Unit column is only displayed for multi-MU configurations. It informs on the scope of the session:

® For a global session, which is valid for all MUs of the SE server configuration, - (global) is displayed. No new
login is required for switching to one of the other MUs.

® In alocal session, the name of the MU for which the session is valid, is displayed. You must log in again when
you switch to another MU. When logging in on the SE Manager, a local session is only created if the MU is
addressed via the IP address or if it has not been entered in the DNS.

Delete session

i Deleting your own session is not possible.

> Click the Delete icon by the required session and confirm the action.
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12.2 Roles

An administrator or security administrator can create and manage user-defined roles in the Authorizations -> Roles
menu.

A user-defined role is a combination of predefined basic roles under a freely definable name.
The following basic roles are available for the configuration of a user-defined role:

® BS2000 administrator

® BS2000 operator

® AU administrator

® Read-only administrator

® Security administrator

® Hardware administrator

® Storage administrator

® Power operator

® [P network administrator

® FC network administrator

® Shadow terminal operator

® Remote service administrator

® Shell access

® Add-on-specific roles
© OPENSM2 administrator and OPENSM2 information
© OPENUTM administrator, OPENUTM operator and OPENUTM information
© ROBAR administrator and ROBAR operator
© STORMAN administrator and STORMAN information

Detailed information on the various roles is provided in section "Role and user strategy".
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> Select Authorizations -> Roles, Roles tab.

Roles

+ Roles

| Add new role

Role

~ Basic roles

Description

()

Filter

Admin4AllAddons

CHSfcnet

OldBs20000perator

StorageAndNetworkAdm

The Roles table displays all configured user-defined roles.

Filter

OPENSM2 administrator
OPENUTM administrator
ROBAR administrator

STORMAN administrator

) FC network administrator

BS2000 operator

Power operator

Shadow terminal operator
OPENSM2 information
OPENUTM information
ROBAR operator
STORMAN information

Storage administrator
IP network administrator
FC network administrator

The following actions are available:

Add new role

> Select Add new role.

> In the following dialog, provide a name and optionally a description for the new role and select the basic roles
it shall comprise.

i The role Shell access is an auxiliary role which can be used only in combination with another basic role.

Change arole

You can change the Basic roles and the Description of a role.

i If the role is currently assigned to an account, its basic roles cannot be changed.

> In the row of the required role click the Change icon (.‘-'?) and change the role's properties in the following

dialog.

Remove a role

> Click the Remove icon ( # ) by the required role and confirm the action.

Filter

Administrator for all add-ons

Operator rights as in V6.4

Total: 4
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12.3 Configuration
The Authorizations -> Configuration menu is used to manage the access to an LDAP server, which provides
centrally managed accounts for use on an SE server, as well as IP based access restrictions to the MUs.

® Access to an LDAP server

® |P-based access restriction to the MUs
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12.3.1 Access to an LDAP server

The LDAP tab enables you to configure and edit the access to an LDAP server on which the LDAP accounts are
managed that can be released for the MUs of the SE server.

i In a Management Cluster, you can configure one LDAP server per SE server. Two redundant MUs in one
SE server share the same LDAP server.

The LDAP server and the MU(s) must synchronize their time via the same NTP server.

The explicitly configured port for the LDAP protocol (default 389 resp. in case of communication secured
by LDAPS 636) as well as ports 88 and 750 for the Kerberos protocol must be open in the firewall to allow
communication with the LDAP server.

> In the tree structure select Authorizations -> Configuration, LDAP tab.

LDAP | IP-based access rights
LDAP configuration @
v # 9

IP address | host name 1 743

Port 330

Server type ActiveDirectory

Domain example nat

Communication Secured (SSL)

Base DN OU=DE-Munich,DC=example, DC=net

Account mchdemacenter

Status Active

On the LDAP tab, the configuration data of the currently configured LDAP server are displayed. The Status
field informs you whether the LDAP configuration was activated or only created.

i In a Management Cluster, the configurations for each SE server are displayed in individual groups. The
LDAP configuration is SE server-specific, but in the default mode it is configured for all SE servers
together (i.e. all get the same configuration). For more information on the LDAP configuration in the
Management Cluster, see the "Cluster Solutions for SE Servers" whitepaper [8].

The following options are available to you:

Configuring access to the LDAP server

To access the LDAP server, you need a valid account on an LDAP server (Bind DN) with a password.
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> Click on the Change LDAP configuration button, in the subsequent dialog enter the access data for the LDAP
server or change the existing data.

This button is only available if there is no LDAP configuration (yet) or the LDAP configuration is the same for
all SE servers.

You can test the new setting (Test button) before you confirm the configuration. By selecting the Active option,
you can specify whether the LDAP configuration should be activated directly after creation.

Testing the LDAP configuration

> In the displayed LDAP configuration of the SE server, click the corresponding Test LDAP configuration icon.
The test commences immediately and is followed by a dialog that informs you whether the LDAP
configuration was successfully tested. You can only work with LDAP accounts if the test was successful.

Changing the access data of LDAP configurations

You can change individual parameters of the displayed LDAP configuration, e.g. activate or deactivate the access
to the LDAP server:

> In the displayed LDAP configuration of the SE server, click the corresponding Change LDAP configuration
icon and change the data of the currently entered access as you require. To activate or deactivate the access
to the LDAP server, activate or deactivate the Active option. Confirm the action.

If the access is activated and a connection to the LDAP server is established, you can use the released LDAP
accounts to log in to the SE server.

Delete LDAP configuration

> In the displayed LDAP configuration of the SE server, click the corresponding Delete LDAP configuration icon
and confirm the action. On the LDAP tab, no configuration data are displayed (in the group) anymore.
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12.3.2 IP-based access restriction to the MUs

An administrator or security administrator can configure the access to the MUs (applies for access via SE Manager

and CLI) of the SE server in such a manner that it is possible only for explicitly configured IP addresses or for IP

addresses from an explicitly configured IP network.

By default the list for access restrictions is empty, and access is permitted without restriction for all IP addresses

and networks:

LDAP | IP-based access rights
Allowed IP addresses El @
| AllowIPaddress | | RemovealllPaddresses | | Setconfiguration status
Server IP addresses Description Status
All IP addresses are allowed.

Configuration status for server SE1-Schweiz: Inactive.

Configuration status for server SE2-Svizzera: Inactive.

Configuration status for server SE3-Suisse: Inactive.
@ Total: 0

i The access restriction is server-specific. In case of MU redundancy, the access restriction is valid for both
MUs of the SE server.

In a Management Cluster, you can specify different IP-based access restrictions for each SE server.

> In the tree structure select Authorizations -> Configuration, IP-based access rights tab.

LDAP IP-based access rights

Allowed IP addresses E (7)
Allow [P address Remave all IP addresses Set configuration status
Server IP addresses Description Status
Filter Filter Filter Filter
SE3-Sulsse 19 a5 Computers of deparment A Active 2y 9
SE3-Sulsse 17 19.08 Branch B Active s 9
SE3-Sulsse e 16 Network of subsidiary C Active r 9

Total: 3

The IP-based access rights tab displays the IP addresses and networks for which access to the MUs of the SE

server is allowed.

If two SE servers form a Management Cluster, the additional Server column indicates for which SE server the

access authorization is defined.

The following options are available to you:
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Allow IP address or network

> Click Allow IP address and enter the IP address or network in the subsequent dialog box.
Syntax: <ip address>[/<network mask>]

You also have the option of entering a description for the allowed access, such as usage or the contact
details of the responsible administrator.

For a Management Cluster, you also have to determine whether the access restriction is valid for all SE
servers or only for a single SE server. The default is All.

i With the first entry (IP address or IP network) you enable IP-based access restriction to the MUs of
the SE server. Access is then only possible for IP addresses which are entered either explicitly or
via an IP network. Because of that, the IP address of your administration PC, from which you have
logged on to the SE Manager, should be part of the first entry.

Remove all IP addresses

> Click Remove all IP addresses and in the subsequent dialog box select either an SE server, for which all IP
addresses are to be removed, or choose All to remove the IP addresses for all SE servers. Thereby
unrestricted access to all associated Management Units is possible.

Set configuration status

> Click Set configuration status and in the subsequent dialog box determine for each SE server, whether the IP-
based access rights should be active or inactive. Only with active IP-based access rights, access to the
associated Management Units will be restricted.

Modify the description for the allowed IP address

> By the required IP address or network, click the Change icon and enter a description, such as usage or the
contact details of the responsible administrator.

Remove IP address or network

> By the required IP address or network, click the Remove icon and confirm the action.

i As soon as you delete the last entry from the list for access restrictions, access to the MUs of the
SE server is once again possible for all IP addresses without restriction. You should delete the entry
that contains the address of your administration PC last.
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12.4 Certificates

The handling of certificates is described in the following sections:

® SSL certificate
© Confirming/importing a certificate in the web browser
® Managing certificates
© Using the standard certificate
© Creating and enabling a new self-signed SSL certificate
© Requesting an SSL certificate

© Uploading and activating a customer-specific certificate
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12.4.1 SSL certificate

To use HTTPS/SSL, not only an SSL key pair is required on the system, but also a (digital) SSL certificate. This
server certificate performs the following two tasks:

® The certificate is always system-specific (contains the FQDN) and proves the online identity of the system
concerned for the browser on the administration PC.

®* The certificate provides the public key with which the browser encrypts its messages to the server on the
administration PC.

A self-signed, system-specific certificate which was generated on the system is preinstalled as the standard
certificate on each of the systems.

You can also use other certificates on your SE server instead of the preinstalled self-signed certificate. The
following options are available:

® Use of a self-signed certificate
A certificate of this type is preinstalled on the system as the standard certificate. It must be explicitly confirmed or
imported on any browser with which the SE Manager operates.

® Use of a customer-specific certificate (signed by a customer CA)
If the customer-specific policy specifies the use of such a certificate, it can simply be installed.
The certificate is as a rule derived from a customer-specific root certificate. Such a certificate is known to the
browsers the customer uses and is accepted without an inquiry (i.e. without being confirmed or imported).

® Use of a commercial certificate (signed by a root CA)
A certificate of this type is created for a fee by a trusted root certification authority (CA) and is therefore known to
all browsers. Consequently every browser accepts such certificates without an inquiry.
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12.4.1.1 Confirming/importing a certificate in the web browser

If the web interface called uses a self-signed certificate (i.e., for example, the preinstalled standard certificate), web
browsers reject the call for the page because, from their viewpoint, the certificate is not trusted. To permit pages of
the SE Manager to be loaded in the browser at all, you must either temporarily accept the certificate error or import
the certificate permanently in the browser.

The procedure described in principle below is based on Internet Explorer Version 11 or higher and differs according
to the browser used and the version. You will find details of the specific procedure in your browser's online help.

> Open your web browser.

> In the browser window call the SE Manager of the required system.
@) There is a problem with this website's security certificate.

The security certificate presented by this website was not issued by a trusted certificate

rity certificate presented by this website was issued for a different website's address.

ertificate problems may indicate an attempt to fool you or intercept any data you
send to the server

We recommend that you close this webpage and do not continue to this website,

@ Click here to close this webpage

& Continue to this website (not recommended),

= More information

The web browser reports a certificate error.

> Confirm that the website should be loaded.

You are shown the login page. The browser's address bar displays Certificate error as a warning.

=] hitps: ,fmwin.m_mn_mﬁ_gm? TR iFeg O 7 @ Certificate error & |

The certificate has now been temporarily accepted for this session, and you can now work with the SE
Manager of this system.

To prevent this browser message from being displayed in future, you can also import the certificate.

> Click Certificate error in the browser's address bar.

bs: Untrusted Certificate

|

|
The security certificate presented by thin
webisite was not izsued by a trusted

‘ certificate authority.

|

|

|

|

|

|

This problem might indicate an attempt to
fool you or intercept any data you send to
the server,

We recommend that you close this webpage,

About certificate errors

View certificates

You are shown information about the potential security risk, and About certificate errors enables you to view
more detailed information in the browser’s online help.
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> Click View certificates.
Certificate |

| General | Detais, | Certfication Path|

4§y Certificate Information

| This CA Root certificate is not trusted. To enable trust,
install this certificate in the Trusted Root Certification
Authorities store.

Issued to: Fujitsu SE Server CA 7494684

Issued by: Fujitsu SE Server CA e74%4e84

valid from 10f 20/ 2017 to 10f 20/ 2027

Irﬁtaltertﬁ:ate...] [ssuer Srat emen

Learn more about Zertificated

Check the certificate (further details are provided on the Details and Certification Path tabs).
Continue only if no doubts exist about the certificate.

> Click Install Certificate.

The certificate import wizard starts and guides you through installation of the certificate step by step.
i You have to explicitly select "Trusted root certification authorities" as certificate memory (for details,

see "Security Manual" [7]).

Alternatively or for other browsers, you can also download and install the CA certificate, see "Uploading and
activating a customer-specific certificate".
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12.4.2 Managing certificates

The Certificates menu option enables you to create and manage SSL certificates. In the case of HTTPS

communication a server identifies itself to its client with an SSL certificate. An SSL certificate is only ever issued for
a server, an organization and a particular period. This information is contained in the certificate and can be viewed
in a certificate viewer (e.g. browser). The validity of this information is confirmed by a trusted certification authority

(CA) by means of the authority's digital signature.

The Certificates menu option provides the following functions for managing certificates:

Using the standard certificate

© Displaying the current SSL certificate

© Displaying details of the current SSL certificate
Creating and enabling a new self-signed SSL certificate
Requesting an SSL certificate

© Displaying details of the current SSL certificate request
© Downloading the SSL certificate request

Uploading and activating a customer-specific certificate

Downloading a CA certificate and installing it in the browser

Detailed information on the option is provided in the SE Manager help.

i Digital certificates are system-specific, i.e. they are managed MU-specifically. In an SE server

configuration with multiple MUs (MU redundancy on an SE server or Management Cluster with two SE
servers) there is a submenu for each MU beneath Certificates in the tree structure, named <mu-name>
(MU).
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12.4.2.1 Using the standard certificate

A self-signed, system-specific certificate is preinstalled for each MU on the SE server. This is not known directly by
the web browsers, nor is it derived from a known root certificate.

A standard certificate is automatically generated and activated each time the system is renamed (the FQDN is
changed). The new standard certificate must then of course be accepted by or imported to the browsers.

The main features of this certificate are:

® The Common name (CN) is identical to the fully qualified domain name (FQDN) of the base operating system.
® The validity time is 10 years.

® The fingerprint which unambiguously identifies the certificate is generated using the SHA-1 algorithm and RSA
encryption.

As the browser does not know the self-signed certificate, when the SE Manager is called it requests the user to
accept the certificate temporarily for the current session or to import it permanently.

If you call the SE Manager on the local console, you must also confirm or import the standard certificate, because
the browser used there does not know the certificate, either.

You are granted access to the SE Manager of the system only if the certificate is temporarily accepted or
permanently imported.

If in doubt, you should first read and cross-check the certificate before accepting it temporarily or importing it
permanently.

Displaying the current SSL certificate
> In the tree structure select Authorizations -> Certificates [-> <mu-name> (MU)].

The Certificates tab with the Current SSL certificate and Current request for an SSL certificate groups opens.
Certificates

Management Unit abgsilver: Current SSL certificate @
Create and enable new SSL cerificate

Upload ang snable SSL cenificats

Certificate Standard certificate
Issued for (CN) abose2mu.abgfscnst, abgse2mu2, 1 B7.111, localhost
Issued by (CN) Fujitsu SE Server CA Be2e6505 r
Valid from 2017-08-10
valid to 2027-08-10
Validity period in days 3652
Management Unit abpse2mu?; Current request for an S5L centificate 7

Create new request

The information displayed is described in the SE Manager help.




SE Server - Administration and Operation - User Guide

Displaying details of the current SSL certificate

> In the tree structure select Authorizations -> Certificates [-> <mu-name> (MU)].
The Certificates tab opens.

> To display further details, click the Details icon (“# ) in the Current SSL certificate group.

The Detailed display of the current SSL certificate dialog box opens. The information displayed is described in
the SE Manager help.
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12.4.2.2 Creating and enabling a new self-signed SSL certificate

The preinstalled standard certificate contains data which is of course not customer-specific.
If you want to work with a certificate with customer-specific data, you can at any time create and use such a
certificate. This action can also be necessary when you want to renew a certificate.

i Notes:

®* When a certificate is activated, the web server is also automatically rebooted.

® As the web browser does not know how trustworthy the new certificate is, like the standard certificate it
must be explicitly accepted or imported (see the section "Confirming/importing a certificate in the web
browser").

> In the tree structure select Authorizations -> Certificates [-> <mu-name> (MU)].

> In the Current SSL certificate group, click Create and enable new SSL certificate.

The Create and enable SSL certificate dialog box opens.
> Make the necessary entries. Detailed information on the entries is provided in the SE Manager help.

> Click Create and enable.

The certificate is created, activated immediately and displayed as the current certificate.
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12.4.2.3 Requesting an SSL certificate

i Any existing request is overwritten.

For the following reasons you should not perform reinstallation or change the host name between
requesting an SSL certificate (creation of the certificate signing request) and entering the signed
certificate into the system:

® When the certificate signing request is created, it is linked to the system’s standard SSL key. If this key
is changed in the system in the time between the certificate signing request being created and the
signed certificate being entered in the system, the certificate cannot be used.

®* A new standard SSL key is created when reinstallation takes place or when the host name is changed.

> In the tree structure select Authorizations -> Certificates [-> <mu-name> (MU)].

> In the Current request for an SSL certificate group, click Create new request.

The Create SSL certificate request dialog box opens.
> Make the necessary entries. Detailed information on the entries is provided in the SE Manager help.

> Click Create.

The request is created and displayed as the current request. To send the request to the certification authority
by email, first download the request to your administration PC, see section "Downloading the SSL certificate
request".

When the signed certificate is returned to you, enter the certificate in the system: see the "Uploading and
activating a customer-specific certificate” and "Using the standard certificate" sections.

Displaying details of the current SSL certificate request

> In the tree structure select Authorizations -> Certificates [-> <mu-name> (MU)].

> In the Current request for an SSL certificate group, click the Details icon (“#).

The Detailed display of the current SSL certificate request dialog box opens. The information displayed is
described in the SE Manager help.

Downloading the SSL certificate request

> In the tree structure select Authorizations -> Certificates [-> <mu-name> (MU)].

> In the Current request for an SSL certificate group, click the Download request icon.

The file with the current request for the SSL certificate is downloaded in the browser.
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12.4.2.4 Uploading and activating a customer-specific certificate

Instead of a self-signed certificate generated in the system (standard certificate or user-defined certificate), you can
use a certificate of your own to access the system’s SE Manager.

Requirement

A certificate signing request was generated in the system for the certificate (see section "Requesting an SSL
certificate") and sent to a certification authority.

Procedure

As soon as the certificate signed by the CA (certification authority) is available to you, you can upload and activate it.

i Notes:

® When a certificate is activated on the target system, the web server is also automatically rebooted with
the new certificate. A brief interruption of the SE Manager‘s connection to the system can occur.

* |f the web browser used (on the administration PC or local console) knows that the new certificate is
trusted or knows its root certificate, no further action is required.

® If the web browser does not know that a certificate is trusted, the certificate must be explicitly
confirmed or imported (see the section "Confirming/importing a certificate in the web browser").

> In the tree structure select Authorizations -> Certificates [-> <mu-name> (MU)].
> In the Current SSL certificate group, click Create and enable new SSL certificate.
The Create and enable SSL certificate dialog box opens.

> Make the necessary entries: certificate and optionally key and CA certificate. Detailed information on the
entries is provided in the SE Manager help.

> Click Upload.

The files specified are uploaded into the target system, activated immediately and displayed as the current
SSL certificate.

Downloading a CA certificate and installing it in the browser

To prevent a certificate error, you can download the CA certificate currently installed on the Management Unit and
install it in the browser.

> Select Authorizations -> Certificates [-> <mu-name> (MU)], Certificates tab. The table displays the current
certificate.

> In the Issued by (CN) row click the Download CA certificate icon.

After the download, you can install the certificate in your browser.
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> Open the certificate file and click Install Certificate.

The browser's certificate import wizard takes you through certificate installation step by step.
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13 Managing the logging

The Logging menu comprises the functions for central management of the audit logging and event logging and the
configuration of the alarm management of the SE server configuration.

¢ Displaying audit logging

® Displaying event logging

® Alarm management

i In a multi-MU configuration, the following must be observed when displaying audit logging records and
events on an MU:

In normal operation, the displayed entries are the same at each MU.

However, if an MU is not available during the generation of an entry (e.g. switched off), the entry cannot
be propagated to that MU. Because of that, the displayed entries and the date of the oldest entries can
differ between the MUs. Especially the MUs in a Management Cluster will always show differences.
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13.1 Displaying audit logging

The logging records from the audit logging are displayed in the Audit logging tab.

Audit logging logs every action that is executed on a unit (MU, SU, HNC) of the SE server configuration via the SE
Manager, an add-on or a CLI command. This enables you as administrator, security administrator or read-only
administrator to trace at all times who performed which action and when.

> Select Logging -> Audit logging, Audit logging tab.

Audit logging
w hutiit lagylng sntries
Period: 70739008 07 1502
Perpige 512° w
Datn = Linig Aesount Gompanem  Type Mestage

Bctiten SEM o Actions Dencisvass UEA fnr account. Ascourtsvesee - The midti-fctor outherte sion fof
£ e ewstuly deacivmioy

= Th rudidicior mhesticmion (e sccoum

Upetme cyshe=0, Sesson
seltmigs N docal ey s Pave: béen chimged

firgs, Typesiocal Accoumt=vasaam; Upame tycin=l; Sesson

The Audit logging tab lists the logging entries sorted according to their time stamps (newest action first).
You can use the Period: field to filter for entries from a certain time.
A log entry contains the following information:

* Time stamp with date and time at which the action was executed

i In order for the time stamp to be consistent, it is assumed that all units (MU, SU x86, HNC, etc.) are
synchronized with an NTP server.

®* Name of the unit on which the action was executed
® Account under which the action was executed

® Component on which the action was started: SEM (SE Manager), <add-on name> or CLI (Command Line
Interface)

® Type of the log entry or executed action, e.g. login or start

® Message with details on the action, e.g. parameter values, result message
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13.2 Displaying event logging

The Event logging function displays the logged events in the Current events and All events tabs.

i The dashboard of the SE Manager contains the Events tile, on which the number of currently not yet
acknowledged events is displayed, depending on their weights (NOTICE, WARNING, ERROR etc.). The
tile is linked to the Current events tab of the Event logging.

Current events

> Select Logging -> Event logging, Current events tab.

Curunt svents A ety

- Currant dvane

Aekstimisstipe Ciirtest evenm Highust message wasght () FRRCE Last acknewledgemant 0071000 15 1553
1663 b 258 Trom 3407 "o Page 4 frimn 55 O i page 4 " Pit page BY w0
it = Weight. Uniit] Dl Component  Message

AP - Ar iy

A0 205678 NOTCE X000 i
AP0 205238 NOTICE Sys-Mgmi
FEIALAD 205238 HNOTCE Sy Mg T
HRINTAN A2 3] NOTGE sufss Sis-Higmi VM WMOOS on Siorver L 501 se5 eactiiiod
DOEIN10 20 52 37 HOTCE st Sys-tgme 5 dnactivaled
ZINAVEDAGY) L WARMING dtpetimd| Chistes P NORUAL (o PeCiT, ACCESSIRLE
FT-I0 2044 s EERACH abgsedrmet-1 X000 ged from NORMAL 1o ERROR

The Current events tab contains a list of all events that occurred since events have been acknowledged the
last time. You can only acknowledge the events of the whole table:

>  Click on the Acknowledge current events button and confirm the action.

All currently displayed events are removed from the table and are now only visible in the All events tab.
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All events

> Select Logging -> Event logging, All events tab.

rent evens Al wvents
- Al e
Petiod:  2023.10.00 08.57 24
T4 32 from 3744 . Page 1 hom 1T b Ba o page 1 3 Perpige 33 v
- e i ’
- ~ Fitet A - Filnr
023116 V0645 HWOMCE sul.sed 2000 20 ik

HOTIGE sufsed Sys-Mpmi VI MEPTOR on Servet Urit 554 mctvated
MancE sutsed Lys-ligrmi VN MO on Sonver Und sul-sed

NOTICE uit-sad Sy gl VM VRS0
HomaE wuf Spblgmi T

HLT115 V704 10 HOTKE atgsedmid-1 = Conligurate anged trom NOT_ACCESSIELE 1o oL
AR ATE NOTIZE abgsedmid| X2000 Stte of und su't-sed thmnged from ERROR lo HORIMAL

In this group, all occurred events are listed.

Default sorting and scope of the listed results

In both tabs, the default sorting is by the date of the events, with the newest event listed first.
In the All events tab you can use the Period: field to filter for entries from a certain time.

i To ensure that the dates are consistent, it is required that all units (MU, SU x86, HNC etc.) are
synchronized with an NTP server.
See also section "NTP server".

To restrict the number of displayed results, you can filter by the following criteria:

® Weight of the event (e.g. WARNING, ERROR or CRITICAL)
* Name of the unit on which the message was issued

® Component that issued the warning (e.g. M2000, HNC, X2000, ResMon, Sys-Mgmt, TsCall, Cluster, RemSrv or
the name of an installed add-on)

® Message text

i The currently possible events with messages are listed in the online help of the SE Manager under
"General information”.

i Generally all events with weight >=WARNING generate a teleservice call. The following exceptions from
this rule apply:
Events of the add-on packs OPENSM2, ROBAR, SEHAMONITOR and STORMAN do not generate
teleservice calls. The add-on pack OPENUTM at present doesn't create events.
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13.3 Alarm management

As administrator or security administrator, you can use the Alarm management tab to configure rules for the

automatic messaging in case of events on the units of the SE server configuration. There are two possible types of
messages:

®* A management station can be informed via SNMP trap. Traps are unsolicited messages of the SNMP agent.

® A user can be informed via e-mail.

You decide which servers are informed via SNMP trap and which users are informed via e-mail. You decide for
each receiver, which weight an event must have to trigger a message.

> Select Logging -> Alarm management, Alarm management tab.

Alarm management

~ SHMP Engins IDs @
Management Unit SNMP Engine ID
abgsa7 Fiiter
abgse7mut BPEB1TEEE44368087258454555436851
abgse7muz - BB8B1F388443686775645786d45687 84
omE Total: 2from 7
~ SNMP trap receivers .'iw
| Add new trap receiver
Trap receiver ~ SNMPversion Trap i User Ci Weight Active
Filter Al ~ | Filter Filter M2000, ResMo..= |LAll hatl V4|
104 SMNMPvZe community_01 = SE Server == WARNING Yes . T
abg su.local SNMPv3 - auto_noauth SE Server AMY Yes ’3 $ >
abg sulocal SMNMPVE - auto_authno SecMon ANY Yes s 9 »
abg su local SNMPvV3 - auto_authSHA . Cluster ANY Yes F 9 >
o F Total: 4 from 8
~ Wail configuration @
r =
SMTP server Return address
imt u.com MU@EM2.g02 fujitsu.local # 9
« Mail receivers 7
| Add new mail receiver
Mail receiver ~ Component \Weight Active
Auser Al v Al TAl -
useri@example.com SE Server == WARNING Yes A
user2@example.com SechMon ANY Yes > 9 P
oE Total: 2from 5

The Alarm management tab contains information on the receivers of messages via SNMP trap, the e-mail
configuration and the receivers of messages via e-mail.

A message via e-mail has the following properties:

® Sender: Contains the return address as configured in the Mail configuration group and the name of the reporting
Management Unit

® Subject: SE server alarm management notification (<weight>)

® The content of the mail shows the event or a list of the events of the last minute in the following format:
<ti mest anp>; <wei ght >; <nanagenent - uni t >; <conponent >; <nessage>

For a list of possible events, see General information - > List of possible events in the online help.
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The following functions are available in the Alarm management tab:

SNMP Engine IDs

> In this group, the specific persistent SNMP Engine IDs of the MUs are
displayed.
They can be used at SNMP management stations to identify the MUs.

Add a new SNMP trap receiver

> In the SNMP trap receivers group, click the Add new trap receiver button and in the subsequent dialog, enter
the required information for the trap receiver.
Select the SNMP version, specify the component for which a notification should be sent, the weight of the
events from which a notification should be sent for this component and whether the trap receiver should be
active, i.e. whether traps should currently be sent to the trap receiver.
If the SNMP version SNMPv3 has been selected, you can resp. have to define further parameters. Then
confirm the action.
If a receiver is to receive notifications for several components, several entries may have to be created for
them.

Change the properties of an SNMP trap receiver

> In the SNMP trap receivers group click the Change icon by the required trap receiver. Then modify the
properties of the receiver as needed, decide whether the trap receiver should be active and confirm the action.

Remove an SNMP trap receiver from the list

> In the SNMP trap receivers group click the Delete icon by the required receiver and confirm the action.

Test the messages for an SNMP trap receiver

You can send a test trap to a receiver. If the test trap is successfully received, the properties of the receiver are ok.

> In the SNMP trap receivers group click the Test icon by the required receiver and confirm the action.

Create mail configuration
For messaging via e-mail, you need an SMTP server that sends the e-mails. There should also be a return address

entered in the sent e-mails. If there is no e-mail configuration configured yet, proceed as follows:

> In the Mail configuration group, click the Create mail configuration button and in the subsequent dialog, enter
the required information. Then confirm the action.
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Change mail configuration

If you want to change the data of an existing e-mail configuration, proceed as follows:

> In the Mail configuration group, click the Change icon. Modify the required properties and confirm the action.

Delete mail configuration

> In the Mail configuration group click the Remove icon by the entered SMTP server and confirm the action.

Add a new e-mail receiver

> In the Mail receivers group, click the Add new mail receiver button and in the subsequent dialog enter the e-
mail address of the receiver.
Specify the component for which a notification should be sent, the weight of the events from which a
notification should be sent for this component and whether the mail recipient should be active, i.e. e-malils
should currently be sent to the recipient. Then confirm the action.
If a receiver is to receive notifications for several components, several entries may have to be created for
them.

Change the properties of an e-mail receiver

> In the Mail receivers group click the Change icon by the required receiver. Then modify the weight and/or the
Active property and confirm the action.

Remove an e-mail receiver from the list

> In the Mail receivers group click the Delete icon by the required receiver and confirm the action.

Test the messages for an e-mail receiver

You can send a test mail to a receiver. If the e-mail is successfully received, the mail configuration and the e-mail
address of the receiver are in order.

> In the Mail receivers group click the Test icon by the required receiver and confirm the action.
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14 Managing service-related functions

The Service main menu comprises the menus Information, Configuration, Remote service sessions and Units.

The Information menu contains displays and functions that the customer needs when communicating with the
Service Center for configuration changes, maintenance, or troubleshooting. Furthermore, the SE operation state
can be changed and an information to be displayed in the SE Manager's header area can be configured here.

The Configuration menu allows to configure the remote access for service technicians on the Remote service
access tab.

The Remote Service Sessions menu displays on the Sessions and files tab the current AIS Connect sessions and
existing AlIS Connect logging files and allows to delete and download logging files.

The Units menu provides you for each Management Unit, HNC and Server Unit x86 of the SE server configuration
in a unit-specific menu with diagnostics and maintenance functions as well as functions for the administration of
updates and (MU only) of the remote maintenance via AlS Connect.
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14.1 Information

The Information tab displays data that the customer needs when communicating with the Service Center.
In addition, the SE operation state and an information to be displayed in the SE Manager's header area can be
configured here.

Customer ID

The SE Server: Customer ID group displays the customer ID or in case of a Management cluster the customer IDs.
Using the customer ID, the customer data - configurations and contracts - can be quickly and uniquely identified in
the Service Center..

SE operation state / Maintenance state

In the SE operating state group, an administrator can configure the operating state and an information that is
displayed in the header area of the SE Manager of all main windows.
This way, all users are informed about current conditions or warned about special conditions.

Particularly noteworthy here is the so-called maintenance state:

This can and should be used during the execution of maintenance work to make all users aware of the current
special situation:

® The maintenance state is displayed in red in the header of each main window, dialog, wizard, etc.

® In SEMVT, before the actual functionality is called, "Be aware of the SE operation state! State maintenance ..." is
displayed for a few seconds.

i Service consultation

The timing of setting or leaving/resetting the maintenance state should be agreed in consultation with the
Customer Service performing this work.

i Events and teleservice calls

Each time the operating state is changed, an event is generated which can be forwarded to all registered
users via alarm.
Setting or leaving/resetting the maintenance state is also reported to the service center.
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14.2 Remote service access

On the Remote service access tab the status of the AIS configuration is displayed and the customer can configure if
service technicians have to identify themselves when establishing a remote connection, and which customer-
specific information is displayed to a service technician after login.

> In the tree structure select Service -> Configuration.

Remote service access

~ Remote service status

Management Unit Remote service status Shadow status
abgseBmu2 AlS Connect not configured
abgsetmul AIS Connect configured Access allowed, shadow possible
~ Remeote service access ()
| Change remote service access
Identification at login Yes
Customer information Please contact the system administration

The Remote service access tab opens. It contains the two groups Remote service status and Remote service
access.

The Remote service status group displays in a table the status of the AIS configuration for each MU.

The Remote service access group displays the current configuration: Identification at login with the possible
values Yes or No and the configured Customer information.

If identification at login is required, service technicians have to specify their name as well as a disruption
number and a description when establishing a remote connection, otherwise access will be denied.

A customer information, e.g. names and telephone numbers of administrators or other persons responsible at
the customer, is optional and is displayed to the service technician after login.

The Change remote service access button opens a dialog box which allows to change the configuration.
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14.3 Remote service sessions

The Sessions and files tab in the Remote service sessions menu displays the currently active AlIS Connect sessions
and in a second table the existing AlIS Connect logging files. The information displayed is cross-MU, i.e. it concerns

all Management Units of the SE administration area.

The first table is displayed only if at least one direct connection to AIS Connect exists.

> In the tree structure select Service -> Remote service sessions.

Sessions and files

» AIS Connect sessions (7

Creation date - Asset Mu Type  SessioniD Aecount
Filter Filter Filter Al = Frller Fulter
20231116 0840048 5e300_a_se300001050_konstanz e 18367 aldabadm ]
20231116 08 3848 54300 a se300001050_konstanz ssh 78365 aktabadm ¥
Totak 2

= AlS Connsct logging files (7)
Last change a Creation date Size [WB] MU Type  Session ID Account
Filter Filter Fiter Fiter Al = Fdlter Filter
20234116 095822  2023-11-16 054233 ssh - {nane) -(uninown) A3 %
2023-1-16 09.57.23  2023-11-16 09:40.55 e 1361 akdabadm N »
223118095722 20231118 00.39.13 ssh 78385 akdabadm A »
2023-11-1809.40.18 20251116 09.39 64 e 18368 alahadm A »
2025113114857 2023-11-13 110200 5 - (nore) -{unknown) 3 @
20234107 11:40:42 20231107 11.36:26 ssh (nane) (unknown) 0 9
20231102 1004101 2023-11-03 1004041 ssh 71787 aklatiadm N 9
2023-1-03 1003427 2023-11-03 1034 11 0 konstanz ssh 77785 aidabadm AN »

Tatal B

The Sessions and files tab opens. The AIS Connect sessions table displays the currently active sessions.

As an administrator or security administrator you can delete a session by clicking the Delete ( b ) icon for the
required session.

The AIS Connect logging files table displays the existing logging files.

By clicking Delete all logging files you as an administrator can delete all logging files at once.
Clicking the Download (5 ) icon by the required logging file downloads it to the local PC.
Clicking the Delete ( b2 ) icon by the required logging file deletes it after confirmation.

Both functions are also only available to an administrator.

Reading logs

AIS Connect writes the Customer Support activities to logging files. The files have different formats depending on
the type of session:

® SSH sessions: logging files in text format

® VNC sessions: logging files with *.flv suffix
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Alternatively to using the SE Manager, you can also list and delete the logging files using the ai sLog command.
You can also view the logging files of SSH sessions with ai sLog. You may enter the command on the shadow
terminal, and as administrator you can also enter it in the terminal window of the Management Unit using the CLI
tab, see section "Entering CLI commands".

i The administrator should delete the logging files at regular intervals, to prevent the file system from
overflowing.

You can only read the logging files of VNC sessions on a PC. Transfer the required logging file to your PC (e.g. with
scp under an administrator account). The tool VLC media player can be used for viewing.
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14.4 Units

The Units menu provides you for each Management Unit, HNC and Server Unit x86 of the SE server configuration
in a unit-specific menu with diagnostics and maintenance functions as well as functions for the administration of
updates and (MU only) of the remote maintenance via AIS Connect.

In the case of a single SE server, the menu is displayed as Units (SE<model>).

When multiple SE servers are operated in a Management Cluster, a server-specific menu <server-name>
(SE<model>), which ranks above the unit-specific menus of the associated units, exists in the Units menu for each
SE server.
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14.4.1 Managing updates

Fundamental information on updates is provided in section "Customer Support and maintenance”.

The administrator uses the Update tab to manage updates for the unit (MU, SU x86 or HNC).

Updates extend the system or the M2000 basic software of the MU:

® Add-on packs enhance the basic software and are functional software components which have their own version
schema. Add-on packs exist only for Management Units.

® Updates solve customer-specific problems.

Updates (for an MU also add-on packs) or their installation sources can be integrated into the system in various

ways, with the customer and Customer Support as a rule sharing the tasks (see section "Tasks of Customer

Support" and section "Tasks of the customer"):

® Updates can be supplied by Fujitsu on CD/DVD.

® Updates can be uploaded from PC to the MU. Before this is done, they must, for example, be downloaded from a

Fujitsu download server to a PC.

® Updates can be prepared in advance and installed by Customer Support.

The Update tab provides you with information on the current status of the updates:

> Select Service -> Units -> [<se server> (SE<model>) ->] <unit> (<unit-type>), Update tab.

Update CSR | Diagnostics Remote Service

» Management Unit abgsedmui-1: SW version V6.5A0201

| Transfer update from CD/DVD fo system |

» Management Unit abgse4mui-1: Add-on packs

| Upload add-on pack |

(=)

Add-on pack ~ Installation type Status

Fifter All All - Al

SEFW-1.0801-1.0 Online Installed ® O 9%
STORMAN-10.1.0-0 Online Installed » RUNNING 2 O "E

o aE Total: 2

+ Management Unit abgsedmui-1: Updates

| Upload update |

Update Installation type

Installation

Mo data available

‘@ E

Total 0

{=a)

When the group is collapsed, the group header of each update type contains a general overview of the
information. To obtain detailed information or to execute actions, expand the group concerned.

The Update tab offers the following functions:

® Transfer update from CD/DVD to system

All updates contained on the CD/DVD are transferred to the system. They are then displayed in the relevant

group and can be used further.
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® Add-on packs group (for Management Units only)
Administrators can upload, install, and uninstall add-on packs or delete add-on packs which have not been
installed. They can view the readme file for the available add-on packs.
Installation and uninstallation of add-on packs have an immediate effect on the SE Manager (e.g. adjustment of
the tree structure). The add-on is started automatically after the installation.
If the add-on supports that functionality, the administrator can manually change the status of the add-on pack via
the Change add-on status icon ({-IJ) (e.g. Start, Stop, Restart, Reload).

® Updates group
An administrator can upload updates.

They can delete updates which have not been installed or their installation sources. Only Customer Support can
install updates (see section "Tasks of Customer Support” and section "Tasks of the customer").
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14.4.2 Managing configuration data (CSR) of the MU

You use a CSR backup (CSR = Configuration Save and Restore) to back up the configuration data of the unit in an
archive. A CSR backup allows the configuration of the unit at the time of the backup to be restored later. Each
backup archive has a creation date and an archive name.

The backup archive contains the complete configuration of the basic system, e.g. the devices and for SU x86 and
HNC the Net-Storage configuration, as well as for an MU all other configuration data that are managed via the SE
Manager. For an MU the backup archive contains MU-specific data (e.g. BS2000 devices or host name) and MU-
global data (e.g. accounts). When restoring the data from the backup archive, this distinction must be taken into
account.

i Recommendation: Perform a CSR backup after every configuration change. In a single-MU
configuration, you can use a CSR backup to recreate the configuration of the unit as of the time of the
backup. In a multi-MU configuration, for a Management Unit there is a difference between MU-specific
and MU-global data (see the Important information under "Restoring configuration data from a file
archive").

You manage the configuration data of the unit using the associated unit menu, CSR tab.

> Select Service -> Units -> [<se server> (SE<model>) ->] <unit> (<unit-type>), CSR tab.

Update | CSR Diagnostics | Remote Service

()

» Management Unit lugano: Configuration data backup

| ‘Execute configuration data backup (CSR) | | Upload configuration data backup (CSR) |

Date created « Archive name

Fifter Filter

2023-01-26 13:1547 MU-M2_MVE.5A0201 lugana_hartm
2023-01-18 15:17.30 MU-M2_MVE.5A0201_lugano_hartm
2023-01-1807 4323 MU-M2_MVE 540200 _lugano_hartm
20221215 13:36:01  MU-M2_MVE SA0200_lugano_151222_p2
2022412-14 10:04°54  MU-M2_MVE 5A0104_lugano_141222
2022-10-27 17:13:46 MU-M2_WMVE.5A0103_lugano_hartm

L) o —~ -
e e

Y B & B
i - e
P05
& N e

o= Total 6

The following options are available to you:

Executing configuration data backup for the unit

> Click Execute configuration data backup (CSR) and confirm the action after selecting a file archive for
configuration data backup.

Uploading configuration data backup to the unit

> Click Upload configuration data backup (CSR), select a backup file, and confirm the action.

i Ensure to only upload the configuration data backups of the associated unit!
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Downloading configuration data backup for the unit

> To download the file archive, click the Download icon (J,‘I ) in the row with the required file archive, if
necessary select whether you wish to open or save the file archive, and confirm the action.

i Do not change the file names of CSR backups after you have downloaded them, otherwise they will
not be accepted when they are uploaded.

Deleting configuration data backup for the unit

> To delete the file archive, click the Delete icon ( *# ) in the row with the required file archive and confirm the
action.

Restoring configuration data from an archive file

> Click the Restore icon ((EI‘}) in the row with the required archive file and confirm the action. If the Customer
Support staff has already prepared restoration, the action is rejected with a message to this effect.

Restoration leads to the unit being rebooted immediately.

i Important information (for Management Units)

®* For MU-specific data:
The current MU-specific data are replaced by the old data.

®* For MU-global data:
The current MU-global data are not changed, only missing MU-global data available in the CSR
backup are restored.
The MU-global data are the configured authorizations (accounts, LDAP configuration, IP based access
rights), the configuration of the alarm management, the configured Application Units, the configured
applications, the configuration of the FC networks, the configured SU clusters.
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14.4.3 Generating diagnostic data

To support error diagnosis by Customer Support, an administrator, BS2000 administrator or BS2000 operator can
generate diagnostic data when an error situation occurs and send this to the Support Center.

> Select Service -> Units -> [<se server> (SE<model>) ->] <unit> (<unit-type>), Diagnostics tab.

Update = CSR Diagnostics  Remote Service

+ Management Unit lugano: Diagnostics

=)

[ create new diagnostic data |

File name

DIAGtarM6_5A lugano.20230130.153300.tar.bz2 9

An already existing diagnostic data file is displayed. You can generate new diagnostic data, in which case an
existing diagnostic data file is overwritten. The file name shows the basic software for which and when the
diagnostic data was generated. For an MU the name has the following format:

DI AG ar . Mcsof t war e- ver si on><uni t - nane>. <dat e>. <ti ne>. gz

For SU x86, the name starts with the prefix DI AG ar . X, for HNC with DI AG ar . H. Otherwise, the format is the
same as for MU.

As administrator, BS2000 administrator or BS2000 operator, you can download the diagnostic data file on the local
MU as a compressed archive file in order to send it to the Support Center if necessary.
i Note

When communicating with the Support Center please specify the customer ID of your SE server. See for
this also chapter "Tasks of the customer".
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14.4.4 Managing service access

Remote Service

Customer Support activities on the SE server are monitored with the help of the shadow terminal. Configuration can
be implemented in such a manner that you as administrator, for instance, observe all the Customer Support
activities (mandatory use of a so-called shadow terminal).

Remote service ensures that a teleservice call is sent to the Support Center when a problem occurs (outgoing
connection).

Customer Support can establish the connection to the SE server itself (incoming connection) if it wants to correct
the problem or take preventive measures (changes, updates, diagnostics, etc.).

If it is absolutely essential, as an administrator (and to a lesser extent as an operator) you can change the remote
service configuration or intervene in a service operation which is currently running.

1 |

I Important!
Please discuss every change to the remote service configuration with the Support Center, otherwise you
will put the serviceability of your SE server at risk. Aspects of remote service which are relevant to
security are described in the Security Manual.

External assets

AIS Connect enables Customer Support connections to be configured via the Management Unit to selected storage
systems which in this context are referred to as external assets. These connections are configured by Customer
Support in agreement with the customer. As administrator you can at all times modify the Customer Support access
to specific external assets (allow or not allow).

i External assets are only possible when the MU is connected directly, but not for connection via a gateway.

Service accounts

To perform its work, Customer Support logs in (remotely via Teleservice or locally) under the service account
provided for this purpose. On the units the protected account service is available to Customer Support in the
operating system.

Remote Service tab

Service access is managed via the Management Unit. The Remote Service tab is provided in the Service menu for
this purpose:
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> Select Service -> Units -> [<se server> (SE<model>) ->] <unit> (MU), Remote Service tab.

The Remote Service tab displays the groups Service access, Service access external assets (if at least one
service access to an external assets is configured), AIS Connect proxy configuration (only for a directly
connected MU), AIS Connect gateway (only for connection via a gateway) and AlS Connect service agent.

Update | CSR ' Diagnostics ' Remote Service
» Management Unit konstanz: Service access

Ly
2| Remote senvice access

)]

Asset name Shadow status
5e330_a_se330001050_konstanz_mch Access allowed, shadow possible "
Shadow terminal for leiadm | Open |
+ Management Unit kenstanz: Service access external assets 7
Asset name Description IP address Access status
se330_konstanz_mch_ext_moniulm External Asset MONTULM 17 (5] Access allowed #

imE

* Management Unit kenstanz: AlS Connect proxy configuration

IP address Port Account

1 G 81

~ Management Unit kanstanz; AlS Connect service agent

Status

B RUNNING

Changing the service access

> In the Service access Management Unit or Service access external assets group, click on the Change icon
next to the required asset. In the subsequent dialog box select one of the available access settings and

confirm the action.

Opening a shadow terminal

The functionality is restricted for users without administrator rights:

® For AU- and Add-on administrators, the whole main window is not displayed.

® BS2000 administrators can operate the shadow terminal.

® QOperators can only operate the shadow terminal if they have an individual authorization.
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> Click the Open button after Shadow terminal for <account> in order to open a terminal window.

The account tele is switched to automatically and a shadow is opened. You can follow the activities of
Customer Support in this window.

Depending on the current setting of the Customer Support access (see Access status), you have the following
options:

® With the Allow access, shadow mandatory setting Customer Support is blocked until you have opened the
shadow terminal. Only then can Customer Support work. You can now follow every step taken by
Customer Support on the opened shadow terminal and can intervene actively yourself, i.e. enter
commands yourself.

® With the Allow access, shadow possible setting Customer Support can work independently of the
customer. When Customer Support is active, the process ID (pid) of the AIS Connect session is displayed
for you in the format <pid, >.<pid,>.<pid,> after you have logged in on the shadow terminal.

> Enterthe screen —x <pi d1>. <pi d2>. <pi d3> command to establish a connection to this AIS
Connect session.

> Enter screen —I| s to display open sessions.

Entering/changing or deleting a proxy configuration

> To enter or change a proxy configuration, in the AlIS Connect Proxy configuration group click the Change icon
by the required proxy server for AlS. Define the properties of the proxy configuration and confirm the action.

> To delete a proxy configuration, in the AIS Connect Proxy configuration group click the Delete icon by the
required proxy server for AIS and confirm the action.

AIS Connect gateway

The group displays - only if the AIS Connect access is carried out via a gateway - the IP address of the gateway
and in case given the name of the AIS Connect box.

Rebooting a service agent

> In the AIS Connect Service agent group click the Restart icon and confirm the action.
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15 Appendix

The sections below describe the alternative BS2000 operation using PuTTY.

® Operating BS2000 with PUTTY
© BS2000 console on MU or SU /390
© BS2000 dialog on MU or SU /390
© SVP console on MU or SU /390
© BS2000 console on SU x86
© BS2000 dialog on SU x86

© Information on the user strategy
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15.1 Operating BS2000 with PuTTY

Users with the roles Administrator, BS2000 administrator or BS2000 operator have access to the CLI commands
bs2Consol e, bs2Di al og and svpConsol e on the Management Unit (MU). Upon entering the correct
parameters, these commands open the correct operation instance (BS2000 console, BS2000 terminal or SVP
console) on the specified Server Unit.

Below, we will use a few examples to quickly outline how you can use these commands for the alternate BS2000
operation under PUTTY.

In general:

® A prerequisite for this is a valid account with the role Administrator, BS2000 administrator or BS2000 operator on
the Management Unit.
Both local accounts and LDAP accounts can be used.

® The respective command is specified in PUTTY as follow-up command.

i An administrator has access to the CLI and can therefore use the commands directly in the shell.

© Some special settings are required for an ideal display and the use of specific shortcuts.

An administrator can also open a Linux shell on the Management Unit and can use this to call CLI commands.
The cl i _i nf o command lists the M2000-specific commands which are available.

A detailed syntax description of the CLI commands is provided in the CLI command reference, see the online
help under General information - > PDF documents.

Notes on PUTTY

© Access to the Management Unit is only possible with the most recent PUTTY versions (from version 0.63
onwards).

© You can find the most recent version on the PuTTY download page: http://www.chiark.greenend.org.uk
/~sgtatham/putty/download.html

The following sections describe the BS2000 operation with PUTTY in more detail. Some screenshots still show
M2000 version V6.2A. The described procedure, however, also applies to newer M2000 versions.

¢ BS2000 console on MU or SU /390

® BS2000 dialog on MU or SU /390

® SVP console on MU or SU /390

® BS2000 console on SU x86

® BS2000 dialog on SU x86

® Information on the user strategy
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15.1.1 BS2000 console on MU or SU /390

> Address the MU via hostname or IP address.

ﬁ PuTTY Configuration

Category:

B s-sior)

' - Logging
= Terminal
Keyboard
Bell
Features
=-Window
- Appearance
- Behaviour
- Translation
[+-Selection
- Colours
=-Connection
-Data
- Proxy
- Telnet
Rlogin
[H-SSH
- Serial

About Help

> Optional: Save the session under a meaningful name (Session menu).

> Optional: Set a meaningful name for the title bar (Window -> Behaviour menu).

Basic options for your PuT TY session
Specify the destination you want to connectto

Host Name (or IP address) Port

I‘abgsesmu‘l I ‘ |22

Connection type:

ORaw  (OTelnet ()Rlogin @3sSH () Serial

Load, save or delete a stored session
Saved Sessions
|ldemoadm_se6_Konsole | ‘

Default Settings Load

demoadm_seb_Konsole =
Save
Delete

Close window on exit
O Always (O Never (@ Only on clean exit

> Enter your own account (Connection -> Data menu):

@ PuTTY Configuration

Category:

[=-Session

f ‘- Logging
- Terminal
Keyboard
Bell
Features
E-Window

- Appearance
- Behaviour
- Translation
- Selection
- Colours
- Connection

- Proxy

- Telnet

- Rlogin
#-35H

- Serial

About Help

Data to send to the server

Login details

Auto-login usemame ||Ie\adm |

When usemame is not specified
(@ Prompt () Use system username (stefan leisner)

Terminal details

Terminal-type string |xterm

Terminal speeds [38400.38400

Environment variables

Variable | || Add

Value |

| Remove
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> Enter the bs2Consol e follow-up command (Connection -> SSH menu) with the following parameters:

®* a BS2000 system of the local or explicitly addressed MU (system name, SE name or host name)

® only as administrator or BS2000 administrator: with specification of a console

ﬁ PUTTY Configuration ? X
Category:
—--Sfession Options controlling SSH connections
P Lo.ggmg Data to send to the server
- Terminal
-Keyboard Remote command:
- Bell |b5200n50|e -s ABGSEB04 -m CO
- Features
—-Window Protocol options
Appea.rarlce [JDon't start a shell or command atall
- Behaviour M
- Translation Enable compression
4-Selection SSH protocol version:
| Colours @2 (01 (INSECURE)
—J-Connection
-Data Sharing an S§H connection between PuTTY tools
- Proxy [[1Share SSH connections if possible
Telngt Permitted roles in a shared connection
"'m Upstream (connecting to the real server)
! Serial Downstream (connecting to the upstream PuTTY)
About Help Cancel

One or two consoles are predefined for a BS2000 operator in the individual rights.

If two consoles are specified, the BS2000 operator must explicitly specify a valid console; if only one console is
specified, this can be determined.

> Click Open, and in the console window, enter the password for the specified account:

@ leiadm-Console - O X

Using username "leiadm".

Pre-authentication banner message from server:
| Buthorized uses only. R11 activity may be monitored and reported.
|
g End of banner message from server

Eeyboard-interactive authentication prompts from server:
| Password: I

After successful login, the connection to the console of the specified BS2000 system is opened:
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‘@ leiadm-Console

ID: SYSWSAR, TASK
%5NJ4-000.074635
%5NJ4-000.074635
ID: SYSWSAR, TASK
%5NJ5-000.075010
%5NJ5-000.075010
ID: SYSWSAR, TASK
%5NJ6-000.075010
%5NJ6-000.075010
ID: SYSWSR, TASK
%5NJX-000.143720
%SNEQ-000.143720

ARLLER 'TSN SNJX'.

%5NEQ-000.154035
%5NEQ-000.154035
e tasks present

%£5NEQ-000.154035
ID: SYSWSR, TASK

5Ys VM4 LEIRDM

> Choose an alternative setting for the window size (the default size is 80 x 24). To avoid line breaks, we
recommend using 132 columns. To do this, right-click on the header of the console window and select

I

I

I

I

@ o D o a® I o o@D

a? o I

00010068, JOB NAME: REWPING

5VTS004 Service SREWPING: Service task terminated

EXC0420 /LOGOFF PROCESSED. CPU TIME USED: 1.379%7 SEC, USER
0001006C, JCOB NAME: REWPING

SVT3004 Service SREWPING: Service task terminated

EXC0420 /LOGOFF PROCESSED. CPU TIME USED: 0.9%872 SEC, USER
00010070, JOB NRAME: REWPING

SVTS004 Service SREWPING: Service task terminated

EXC0420 /LOGOFF PROCESSED. CPU TIME USED: 0.9%083 SEC, USER
00010079, JCOB NRME: REWPING

SVTS001 Service SREWSERV02317323: started

JMS0154 '"SYSWSA' LOGGED ON FOR 'SUB'. JOB NAME 'REWSERV'. C

TID 000500D7

ol

ol

2
=3

ID:
ICDOBES IOTO1 DEVICE
ICDOB6Y RKFOS DEVICE
I0D086Y IOTO01l DEVICE
I0D086Y RKF05 DEVICE

co sul-seé

SVTC011 Command processing aborted due to time out
SVTS003 Service SREWSERV02317323 terminated: no more servic

EXC0420 /LOGOFF PROCESSED. CPU TIME USED: 0.2657 SEC, USER
000500D7, JOB NAME: REWSERV

MN=R047 DERCTIVATED (0)

MN=R047 ACTIVATED (0)

MN=R047 DERCTIVATED (0)

MN=R047 RCTIVRTED (0)

2023-02-17 07:34

Change Settings... from the context menu:

#® PUTTY Reconfiguration ? X
Category:
Et S:ession Options controlling PuTTY's window
L Logging Setthe size of the window
=] T:ermma\
- Keyboard Columns Rows
-~ Bell [132 | 24
- Features
. When window is resized
= arance @Change the number of rows and columns
BZEaviour (_) Change the size ofthe font %
Translation (_) Change font size only when maximised
Selection () Forbid resizing completely %+
-~ Colours Confrol the scrollback in the window
[=-Connection _
- S5H Lines of scrollback 2000

[v] Display scrollbar

[ Display scrollbar in full screen mode
[JResetscrollback on keypress
Reset scrollback on display activity
Push erased text into scrollback

When operating the BS2000 console, you can change the size by dragging; the number of columns and lines
is automatically adapted, based on the settings. Some other potentially useful settings for the window size are:

® Changing the font size together with the window size: Change the size of the font (see above)

Apply Cancel

® Set a fixed window size: Forbid resizing completely (see above)

The console window with 132 columns:
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@ leiadm-Console

%5NJ4-000.
%3NJ4-000.

%5NJ5-000.
%SNJS-000.

%5NJ6-000.
%3NJ6-000.

%5NIX-000.
%5NKQ-000.

%SNKQ-000.
%5NKQ-000.

%5NKQ-000.

IOD08€ES IOTO1 DEVICE
IOD0B€ES RKFO5 DEVICE
I0D0869 IOTO1 DEVICE
I0D08€9 RKF05 DEVICE

SYs VM4

074635
074635

075010
075010

075010
075010

143720
143720

154035
154035

154035

LEIADM

e oo

ae

e

e oo

a0 ap

a0 oo

%

SVTS004 Service SREWPING: Service task terminated

EXC0420 /LOGOFF PROCESSED. CPU TIME USED: 1.379%7 SEC, USER ID: SYSWSA, TASK ID:
SVTS004 Service SREWPING: Service task terminated

EXC0420 /LOGOFF PROCESSED. CPU TIME USED: 0.9872 SEC, USER ID: SYSWSA, TASK ID:
SVTS004 Service SREWPING: Service task terminated

EXC0420 /LOGOFF PROCESSED. CPU TIME USED: 0.%083 SEC, USER ID: SYSWSA, TASK ID:
SVTS001 Service SREWSERV02317323: started

JMs0154 'SYSWSA' LOGGED ON FOR 'SUB'. JOB NAME 'REWSERV'. CALLER 'TSN 5NJX'. TID 0003500D7
SVTC011l Command processing aborted due to time out

SVTS003 Service SREWSERV02317323 terminated: no more service tasks present
EXC0420 /LOGOFF PROCESSED. CPU TIME USED: 0.2657 SEC, USER ID: SYSWSAZ, TASK ID:
MN=R047 DEACTIVATED (0)

MN=R047 ACTIVATED (0)

MN=A047 DEACTIVATED (0)

MN=A047 RCTIVATED (0)

co sul-seé 2023-02-17 07:4¢

0001006c,

oool10070,

00010079,

000500D7,

JOB NAME :

JOB NAME:

JOB NAME:

JOB NAME :

REWPING

REWPING

REWPING

REWSERV
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15.1.2 BS2000 dialog on MU or SU /390

> Enter the bs2Di al og follow-up command with the following parameters:

®* a BS2000 system of the local or explicitly addressed MU (system name, SE name or host name)

® a LOCLAN connection (only if there is more than one LOCLAN assigned to the BS2000 system)

| ﬁ PuTTY Configuration

Category:

[=-Session

‘ Logging

= Terminal

‘ Keyboard
Bell
Features

> Window

Behaviour
Translation
[+ Selection
L Colours
= Connection
Data
Proxy
o EE
~ Serial
Telnet
Rlogin
SUPDUP

About

Appearance

Options controlling SSH connections

Data to send to the server

X

Remote command:
bs2Dialog -s ABGSEGD4

Help

Protocol options

[) Don't start a shell or command at all

[_)Enable compression

SSH protocol version:

[ }] (O 1(INSECURE)
Sharing an SSH connection between PuTTY tools
[T Share SSH connections if possible

Permitted roles in a shared connection

Upstream (connecting to the real server)
Downstream (connecting to the upstream PuTTY)

Open | Cancel

> Make sure to use the default character set UTF-8 that supports the display and the keyboard shortcuts
required in the BS2000 dialog (Window -> Translation menu):

ﬁ PUTTY Configuration

Category:

= Session
‘ Logging
= Terminal
‘ Keyboard
Bell
Features
=-Window
: Appearance
Behaviour
[+ Selection
" Colours
=) Connection
Data
Proxy
& SSH
" Serial
Telnet
Rlogin
SUPDUP

About

Help

Options controlling character settranslation

Character settranslation

X

Remote character set

|UTF-8

)

(Codepages supported by Windows but notlisted here,

such as CP866 on many systems, can be entered manually)

|_] Caps Lock acts as Cyrillic switch

| Treat CJK ambiguous characters as wide

Adjust how PuTTY handles line drawing characters

Handling of line drawing characters:

© Use Unicode line drawing code points

(") Poorman's line drawing (+. - and |}

(C) Fonthas XWindows encoding

'f:) Use fontin both ANSI and OEM modes

() Use fontin OEM mode only

lj Copy and paste line drawing characters as lgqgk

[_) Enable VT 100 line drawing even in UTF-8 mode

Open Cancel
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> Make sure to set the window size to 80 columns and 25 rows.

% PUTTY Configuration ? X
Category:
[=-Session Options controlling PuTTY's window
Lo.ggmg Setthe size of the window
= Terminal
| | Keyboard Columns Rows
Bell 80 25
1 res When window is resized:
1 e (_) Change the number of rows and columns
E‘Zgaviour © Change the size of the font
Titubtas \f:) Change font size only when maximised
61 Salaction (_) Forbid resizing completely <
Colours Control the scrollback in the window
(=} Connection
Data Lines of scrollback 2000
gg’;ﬁ' B Display scrollbar
o Sarial [ Display scrollbar in full screen mode
L Talnat [JResetscrollback on keypress
Rlegin Reset scrollback on display activity
SUPDUP Push grased text into scrollback
About Help | Open ‘ Cancel

The number of columns and lines may not change when the dialog window is dragged, as this would disrupt
the display. Therefore, select one of the following settings for window size:

® Changing the font size together with the window size: Change the size of the font (see above)

® Set a fixed window size: Forbid resizing completely (see above)

In the dialog window, enter the password for the specified account:

@ leiadm_se6_Dialog — O x
login as: leiadm
Pre-authentication banner message from server:

| Ruthorized uses only. ARll activity may be monitored and reported.

Kevboard-interactive authentication prompts from server:

g End of banner message from server

Password: []

After successful login, the connection to the BS2000 dialog is opened and you can login to BS2000. Important keys:

Kl | F5
K2 | F6
EM | F11
DUE  F12
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Ef demoadm-SU390-Dialog — O X
CN04 CONNECTED WITH MANL06$DIRLOG,' B S LI I R R
% JMS0150 INSTALLATION '3%0s5U- 700-20', BS2000 VERSION 'v210', HOST 'DO21EZEOG'

PLERSE ENTER I/SET—LOGON—PAR.AMETERSI OR I"_;I ..................................
/ .demoadm logon tSOSI ...........................................................
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15.1.3 SVP console on MU or SU /390

> Enter the svpConsol e follow-up command:

-I- Session Options controling SSH connections
. Lo;;gmg Data to send to the server
T %am Remote command:
Bell svpConsole
Features -
= Window &P‘owm
Appearance || Don' start a shell or command at all
Behaviour || Enable compression
Translation Prefemed SSH protocol version:
Selection ) Tonly 1 @2 () 2only
Colours . ,
=I- Connection Erionpeon cotone
Data Encryption cipher selection policy:
~ Proxy AES (SSH-2 only)
:’“e‘ 3DES LY |
“ FOgn ~wam below here - ]
Gl SSH) Arcfour (SSH-2 only) | Down, |
Senal DES
[ Enable legacy use of single-DES in SSH-2
[ Aot |[ Hep | [ open J[ Corce |

Options controfing PuTTYs window
Set the size of the window

Calumns Hows
| 80 25
Wndow 1S resized.
@ Change the number of rows and columns
Change the size of the fort
(_: Change font size only when m#@

() Forbid resizing completely ‘

Control the scroflback in the window
Lines of scrofiback 2000

[] Display scrofibar

|| Display scrolbar in full screen mode
|| Reset scrollback on keypress

[] Reset scrollback on display activity
[¥] Push erased text into scrolback

The number of columns and lines may not change when the dialog window is dragged, as this would disrupt
the display. Therefore, select one of the following settings for window size:

® Changing the font size together with the window size: Change the size of the font (see above)

® Set a fixed window size: Forbid resizing completely (see above)
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> Specify a character set (Window - > Translation menu) and a keyboard (Terminal -> Keyboard menu) that

support the display and keys required on the SVP console:

Cpliors coriralng dhoracle adt brarsision Optans cortrolirg tha Facts of kays
Charmcter amd ereiato Crarge the sagercey werd by
Flamote chamcter se- The Backspace ey
1508855151995 (Labred, “eurc’) - CortreiH & Cortrol-7 127
Codacages sppotad by Wirdows but not lied hare This Home and End ks
wuch s CPBEE on memy sytems. Can be erteed ¥ Serdonl R,
marualy) Tha Rundior keye ard kaypad
EsCh- e 1.!!!!!'
1| Tremt CIK ambrpuous characiers oa wele I NTA0 VT 100- 0 50
[71Caps Lock acts a5 Cymkc smtch
Foclcaton kevoed wetiros.
Adust how FuTTY hendies Ine demng charecien ol state of cumorkeys:
Haehng of kns ey sz B Noswel Aodbzon
& U Ureids e dawing code ponts Vil dale of numans baynad
71 Poer man's bne drmng b ond ) L C Apiewon Pt Pt
Fort hes XWirdows encodng
d 1 ANSH ard GEM mode el Erat sara waybowd Nt
L fat bn CHEM mescc oy i 35H | MG wcte 22 Compose by
[7]Copy and porete e demwing charschens 2akygyde = L 7| Cortrel A I forert from AeGe
mon [ e | [ opn Carcel et o | [ oo =

> In the console window, enter the password for the specified account:

Using username "demoadm".
Welcome to M2000 VE6.2A
jUsing keyboard-interactive authentication.
Password:

After successful login, the connection to the SVP console is opened. Important keys:

PF3

| NDEX

ESC + F3 | (in this order)

ESC + F2  (in this order)

*CH
*CM
*GE
*ID
*LD
*MA
*ME
*MF
*ML
*MS
*PA
*PC
*PM
*RM

FRAME ID =>

ALTER DISPLAY FRAME
AUXILIARY FRAME
CHANNEL/SUBCHANNEL FRAME
CONCURRENT MAINTENANCE FRAME
GENERATION FRAME

INDEX FRAME

PROGRAM LOAD FRAME

MANUAL OPERATICN FRAME
MESSAGE FRAME

MAINTENANCE SUPPORT FACILITY
MODE SELECTION FRAME
MAINTENANCE DISPLAY FRAME
PERFORMANCE ANALYZER FRAME
POWER CONTRCL FRAME

PATCH MANAGEMENT FRAME
REMCTE MAINTENANCE FRAME

CL-0 CPU-0 IOP-0
X0XB4 READ POWER CONSUMPTION ACCEPTED

i
2

s ESOLO1G-03C+030 =

*5Q SEQUENCE FRAME
*5T STATUS DISPLAY FRAME
*UT SVP UTILITY FRAME

m

RUN
CE HD TEST
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15.1.4 BS2000 console on SU x86

> Address the MU via hostname or IP address.

> Optional: Save the session under a meaningful name (Session menu).

#® PUTTY Configuration ? X
Category:
|_T_|--Session Basic options for your PuTTY session
... Logging
= Terminal Specify the destination you wantto connectto
. Keyboard Host Name (or IP address) Port
Bell IabgseSmu1| I | |22 |
[—j--V\}.ianeoE\Lures Connection type:
- Appearance (ORaw (O Telnet (JRlogin @SSH () Serial
- Behaviour Load, save or delete a stored session
Translation
- Selection Saved Sessions
.. Colours | demoadm-SUxg6-Konsole| |
B--Ccrgletctlon Default Settings Load
- Data demoadm_seb_Konsole
- Proxy demoadm_se6_dialog S
- Telnet leiadm_dialog
Rlogin Delete
[#-SSH
- Serial
Close window on exit
(O Always (O Never (@) Only on clean exit

About Help Cancel

> Optional: Set a meaningful name for the title bar (Window -> Behaviour menu).

> Enter your own account (Connection -> Data menu):

#R PUTTY Configuration ? X
Category:
[=-Session Data to send to the server
i Logging . )
& Terminal Login details
-~ Keyboard Auto-login usemame | [leiadm | |
E:!tures When usemame is not specified:
& Window (@ Prompt (O Use system usemame (stefan leisner)
~Appearance Terminal details
- Behaviour
- Translation Terminal-type string |xterm |
El-Selection Terminal speeds |38-4-DD‘38-4-DD |
- Colours
B-Connection Environment variables
- Proxy Variable | || Add
- Telnet
- Rlogin Value | | Remove
H#-SSH
- Serial

About Help Cancel
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> Enter the bs2Consol e follow-up command with the following parameters:

® the unit: external or internal name of the SU x86
® the system specified by its system name or SE name or hostname

® only as administrator or BS2000 administrator: the console MN

ﬁ PUTTY Configuration

Category:

[=-Session

| i.Logging
= Terminal

- Keyboard
- Features
[=-Window
- Appearance
- Behaviour
- Translation
[+-Selection
- Colours
[=l-Connection
Dala
- Proxy

- Telnet
- Rlogin

34 SSH|

Serial

Options controlling SSH connections

Datato send to the server

Remote command:

X

‘szConsoIe -u sul-seb -s ABGSEG4 -m CO

About

As BS2000 operator, you may not enter the console (-m CO in the example)! It is defined and will be determined.

Help

Protocol options

["|Don't start a shell or command at all
["|Enable compression

SSH protacol version:

@2 (O1(INSECURE)

Sharing an SSH connection between PuTTY tools
[|share SSH connections if possible

Permitted roles in a shared connection:
Upstream (connecting to the real server)

Downstream (connecting to the upstream PuTTY)
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> In the console window, enter the password for the specified account:

22 demoadm-SUx86-Konsole - |

Using username "leiadm".
Pre—-authentication banner message from server:
| Buthorized uses only. All activity may be monitored and reported.

End of banner message from server
Keyboard-interactive authentication prompts from server:

| Password: I

After successful login, the connection to the console of the BS2000 system is opened:

FO.0.0:0.0:0.0.04
%ON3I-000.095147

%SN2W-000.110218
F5N2W-000.110218
ID: SYSWSAR, TASK
%5N2V-000.110223
%oN2V-000.110223
ID: SYSWSR, TASK
%SN2U-000.110223
%5N2U-000.110223
ID: SYSWSR, TASK
%5NZT-000.110223
%ON2T-000.110223
ID: SYSWSR, TASK

S5¥YS VM4 LEIADM

ID: T303, TRSK ID:

2

c]

o ol

o o O

e o O

o o O

2

EXC0420 /LOGOFF PROCESSED. CPU TIME USED: 0.7311 SEC,

0001008C, JOB NAME: *NO

SVTS004 Service SREWPING: Service task terminated
EXC0420 /LOGCFF PRCCESSED. CPU TIME USED: 4.1le4 SEC,
00010078, JOB NEME: REWPING

SVTS004 Service SREWPING: Service task terminated
EXC0420 /LOGOFF PROCESSED. CPU TIME USED: 3.4085 SEC,
00010078, JOB NAME: REWPING

SVTS004 Service SREWPING: Service task terminated
EXC0420 /LOGOFF PRCOCESSED. CPU TIME USED: 3.1809 SEC,
0001007%, JOB NEME: REWPING

SVTS004 Service SREWPING: Service task terminated
EXC0420 /LOGOFF PROCESSED. CPU TIME USED: 3.5037 SEC,
00010078, JOB NAME: REWPING

co sul-se¢ 2023-03-10 08:09

22 demoadm-SUx86-Konsole - O X
%5SN3I-000.005147 X»> LI1#MCNPR ABGSET04 VLLN IPVE VALI FDSE:3ESE:600:0:921B:E
FF:FEB2:13C3/64

%5N3I-000.095147 X>»> L1#MCNPR ABGSET04 VLLN IPVE VALI FEES0:0:0:0:921B:EFF:FE
B2:13C3/10

%5SN3I-000.095147 X> L2#DPUOL *any VLLN LAN VALI 890:1B:0E:B2:13:DC
$SN3I-000.095147 X»> L2#DPUOL1 ABGSET04 VLLN IF VALI 1.1.64.36/22

FON3I-000.005147 XXM KRR KR RO XK XK KK KKK KKK KKK AKX

USER

USER

USER

USER

USER
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> Choose an alternative setting for the window size (the default size is 80 x 24). To avoid line breaks, we
recommend using 132 columns:

@ PuTTY Reconfiguration ? >

Category:

[=I-Session
: i Logging
(=) Terminal
Keyboard Columns Rows

Bell

Features
& vindov/]
Appearance
Behaviour
Translation
-Selection
Colours
[=-Connection
[-55H

Options controlling PuTTY's window

Setthe size of the window

[132 | [2+

VWhenwindow is resized:
(@) Change the number of rows and columns
(") Change the size of the font -
(") Change font size only when maximised
(O Forbid resizing completely <%

Control the scrollback in the window

Lines of scrollback 2000

D\sp\ay scrollbar
[ Display scrollbarin full screen mode

["Resetscrollback on keypress
Resetscro\lback on display activity
[]Push erased textinto scrollback

Apply Cancel

When operating the BS2000 console, you can change the size by dragging; the number of columns and lines
is automatically adapted, based on the settings. Some other potentially useful settings for the window size are:

® Changing the font size together with the window size: Change size of the font (see above)

® Set a fixed window size: Forbid resizing completely (see above)

The console window with 132 columns:

£ demoadm-SUx86-Konsole - O X
%5N3I-000.095147 X> LI1#MCNPR ABGSE704 VLLN IPVE VALI FDSE:S5ESE:600:0:921B:EFF:FEB2:13C3/64

%5N3I-000.095147 ¥> LI1#MCNPR RBGSE704 VLLN IPV6 VALI FEB0:0:0:0:921B:EFF:FEB2:13C3/10

%5N3I-000.095147 X> L2#DPUOLl *any VLLN LAN VALI %0:1B:0E:B2:13:DC

%5N3I-000.095147 X> L2#DPUOLl ABGSE704 VLLN Ip VALL 1.1.64.36/22

%5N3I-000.095147 XEXXXXXKXKAKKKXKXKKXKE KX KK KKK KKK KH KK KKK KKK KKK KK KR KKK KK XK KL KK KK

%5N3I-000.085147 % EXC0420 /LOGOFF PROCESSED. CPU TIME USED: 0.7311 SEC, USER ID: TS0S, TASK ID: 0001008C, JOB NAME: *NO
%SN2W-000.110218 % SVTS004 Service SREWPING: Service task terminated

%5N2W-000.110218 % EXC0420 /LOGOFF PROCESSED. CPU TIME USED: 4.1164 SEC, USER ID: SYSWSA, TASK ID: 0001007B, JOB NAME: REWPING
%5N2V-000.110223 % S3VTS004 Service SREWPING: Service task terminated

%5N2vV-000.110223 % EXC0420 /LOGOFF PROCESSED. CPU TIME USED: 3.4085 SEC, USER ID: SYSWSA, TASK ID: 0001007Z&, JOB NAME: REWPING
%5N2U-000.110223 % SVTS004 Service SREWPING: Service task terminated

%5N2U-000.110223 % EXC0420 /LOGOFF PROCESSED. CPU TIME USED: 3.1809 SEC, USER ID: SYSWSA, TASK ID: 00010079, JOB NAME: REWPING
%5N2T-000.110223 % SVTS004 Service SREWPING: Service task terminated

%5N2T-000.110223 % EXC0420 /LOGOFF PROCESSED. CPU TIME USED: 3.5037 SEC, USER ID: SYSWSA, TASK ID: 00010078, JOB NAME: REWPING
SYS VM4 LEIRDM co sul-seé 2023-03-10 06:24
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15.1.5 BS2000 dialog on SU x86

> Enter the bs2Di al og follow-up command with the following parameters:

® the unit: external or internal name of the SU x86

® the system specified by its system name or SE name or hostname

ﬁ PuTTY Configuration ? X
Category:
| - Session Options controlling SSH connections
! Logging Data to send to the server
= Terminal
I Keyboard Remote command:
Bell bs2Dialog -u sul-se6 -s ABGSE604
Features
— Window Protocol options
ggﬁ:j_?u"rce [) Don't start a shell or command at all
1 <
Transtation |_JEnable compression
4 Selection SSH protocol version:
" Colours 02 ()1 (INSECURE)
= Connection % ;
Data Sharing an SSH connection between PuTTY tools
Proxy [T) Share SSH connections if possible
8} SSH Permitted roles in a shared connection
?e:'alt B Upstream (connecting to the real server)
elne
Rlogin Qownstream (connecting to the upstream PuTTY)
SUPDUP

About Help l Open Cancel

> Make sure to use the default character set UTF-8 that supports the display and the keyboard shortcuts
required in the BS2000 dialog (Window -> Translation menu):

B2 PUTTY Configuration ? X
Category:
(=] Session Options controlling character settranslation
I Logging Characler settranslation
(= Terminal
] Keyboard Remote character set E
Bell |UTF-8 v|
ok medeDa\:’ures (Codepages supported by Windows but notlisted here,
5 such as CP866 on many systems, can be entered manually)
Appearance
Behaviour — . %
[_] Treat CJK ambiguous characters as wide
4 Selection [) Caps Lock acls as Cyrillic switch
! Colours . 3
&} Connection Adjusthow PuTTY handles line drawing characters
Data Handling of line drawing characters:
Proxy © Use Unicode line drawing code points
#-SSH (_) Poorman's line drawing (+. - and [)
" Serial () Fonthas XWindows encoding
Telnet () Use fontin both ANSI and OEM modes
Rlogin () Use fontin OEM made only
SUPDUP

D Copy and paste line drawing characters as lgqgk
[_) Enable VT 100 line drawing even in UTF-8 mode

About Help Open Cancel
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> Make sure to set the window size to 80 columns and 25 rows.

& PuTTY Configuration ? X
Category.
[=-Session Options controlling PuT TY's window
. Logging Setthe size of the window
= Terminal
! | Keyboard Columns Rows
Bell 80 25
E = . — :
AE res When window is resized:
1 rpAAiAReS () Change the number of rows and columns
Ezgaviour © Change the size ofthe font <&
T ranslation L':,‘- Change font size only when maximised
i’ Selection (_) Forbid resizing completely -«
Colours Control the scrollback in the window
= Connection
Data Lines of scrollback 2000
- Proxy B Display scrolibar
i 22:.; [ Display scrollbar in full screen mode
Telnet L:I Reset scrollback on keypress
Rlogin Reset scrollback on display activity
SUPDUP Push erased textinto scrollback
About Help ‘ Open ‘ Cancel

The number of columns and lines may not change when the dialog window is dragged, as this would disrupt
the display. Therefore, select one of the following settings for window size:

® Changing the font size together with the window size: Change the size of the font (see above)

® Set a fixed window size: Forbid resizing completely (see above

> In the dialog window, enter the password for the specified account:

P demoadm-SUx86-Dialog - O X

Using username "leiadm".
Pre—authentication banner message from server:
| Authorized uses only. All activity may be monitored and reported.

Keyboard-interactive authentication prompts from server:

|
g End of banner message from server
| Password: [

After successful login, the connection to the BS2000 dialog is opened and you can login to BS2000. Important keys:

Kl | F5
K2 ' F6
EM | F11
DUE | F12
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@ demoadm-5Ux86-Dialog

% JMS0150 INSTRALLATION 'X865U- 300B-1e0F', BS2Z2000 VERSICON 'Vv200', HOST 'RBGSETO
4 1 - PLEASE ENTER 1 /SET_LOGON_PARAMETERSI OR 1 2 L T T T T T T T R T T T T R
/.demoadm logon tSOSI ...........................................................
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15.1.6 Information on the user strategy

For administrators and BS2000 administrators, the accesses described are unrestricted. For other roles except
BS2000 operator none of the accesses is possible.

For BS2000 operators, their individual rights apply, as specified by an administrator or security administrator (also
see the following example):

® BS2000 console rights:
Access to the defined systems of the individual SUs is only possible with fixed consoles.

® BS2000 dialog rights:
The access to the BS2000 dialog is possible for the BS2000 systems allowed by the individual rights.

® SVP console (SU /390):
Access is possible according to the individual rights.

Example for a BS2000 operator with individual rights (Authorizations -> Users menu):

Accounts Password management Multi-factor authentication Operator rights Sessions

()

w Individual rights for operators L

Account ~ Unit System Host name Console Dialog SVP
demoopr Filter Filter Filter Filter All - |All -
demoopr SUT10-SEB M4IVE D020ZE01 Cc0 Granted Granted ‘¢
SU710-SEB G4lvVa D020ZE02 co Denied
SUT730-SE5 M4IVE D021ZE01 C1 Denied Granted
o E Total: 1 from 21

The authorizations are tested, the call is rejected:

‘@ demoopr-SU390-Dialog - O X

login as: demoopr
g Pre-authentication banner message from server:
| Ruthorized uses only. All activity may be monitored and reported.
|
End of banner message from server
Kevboard-interactive authentication prompts from server:
| Password:
f End of keyboard-interactive prompts from server
Access to B52000 dialog not granted on system ABGSE604

i Information on logging in with an ssh key:
For a more comfortable access, the user may generate an ssh key pair and store the public key in their
account.
When storing the public key, it is important to note that the file authorized_keys may already contain ssh
keys, which are used internally by the SE Manager. These keys must remain as is under all
circumstances!
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16 Glossary

Application Unit
AU, AU PY, AU PQ

Optional component of the SE server.

An AU permits operation of applications under Linux, Windows, VMware or other hypervisors.

Application Unit PY (AU PY) refers to all PRIMERGY based AUs (e.g. the AU20 or AU47 hardware models).
Application Unit PQ (AU PQ) refers to all PRIMEQUEST based AUs (e.g. the AUQ38E or DBU38E hardware
models).

Configuration Save and Restore
CSR

Saves the configuration data of the Management Unit in an archive. The backup archive contains all
configuration data that the customer manages himself using the SE Manager.

CRD disk
Configuration disk

Internally mirrored disk of the Unit (MU, SU x86, HNC) where the data of the SE server configuration are
locally stored. In addition to the internal CRD disk, up to two external CRD disks can be configured on external
FC RAID systems, to which all MUs and SU x86 have access via a redundant connection.

Customer ID

The customer ID is defined by the service and serves to uniquely identify the customer data in the Support
Center. It is displayed in the SE Manager and must be specified for each communication with the Support
Center.

Data Network Private
DANPR

Private data network for use as SE server-internal private customer network. When required, you can
configure up to 99 networks DANPR<n> (with <n>= 01..99).

Data Network Public
DANPU

Public data network for connecting applications to the public customer network. You can configure up to 8
networks DANPU<n> (with <n>= 01..08).

FDDRL

FDDRL (Fast Disk Dump and ReLoad) is a BS2000 software product for saving the contents of BS2000 disks
and pubsets. FDDRL supports both public and private disks. The pubsets can be either single-feature (SF) or
system-managed (SM).

FDDRL job

For each FDDRL function statement, one FDDRL job is defined per single or pubset disk. Another FDDRL job
is defined per disk set. Each FDDRL job can be handled either under the calling task (FDDRL maintask) or
under a separate task (FDDRL subtask).
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FDDRL subtask

FDDRL jobs can be processed by a subtask generated by FDDRL.
Hardware Abstraction Layer
HAL

Firmware component on SU x86 for mapping privileged /390 interfaces to the basic machine code. This
mapping is required, for example, when handling exceptions, managing memory and also for system
diagnostics.

High-speed Net Connect
HNC

HNC implements the connection from an SU /390 to a LAN. HNC designates both the Linux-based basic
software which is integrated into the SE Manager and the hardware unit on which this basic software runs. As
a hardware unit, the HNC is a component part of the Net Unit on SE servers which have an SU /390.

HSMS
HSMS (Hierarchical Storage Management System) is a BS2000 software product for data backup which
supports data management on external storage devices in a BS2000 system.

Initial Program Load

IPL
First phase of system initialization after booting. IPL reads in the CLASS1-EXEC, system parameters, and
REPs.

IO Configuration File / Input/Output Resource File

IOCF / IORSF

Contains information on the configuration of the input/output devices of an SU /390.
An IORSF contains a BS2000 device configuration, which is required to start up an SU /390.
The IOCF must be installed in the service processor SVP in order to be used.

IOGEN

BS2000 utility routine to generate an IORSF configuration (IOCF)

KVP

Console distribution program
Access to a BS2000 console window takes place via a KVP (console distribution program).
The KVP performs the following tasks, among others:

©  Authorization checks

© Distribution of the BS2000 tasks to multiple console windows

© Short- and long-term storage of the console communication logs (KVP logging)

BS2000 sees a KVP as two (emulated) KVP devices (or a device pair) which are identified by their mnemonic
names.
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Management Admin Network Public
MANPU

Public management network for the administrative access to MU, BS2000 systems and AUs.

Management Control Network Local

MCNLO
Private management network for the local SE server communication

Management Control Network Private

MCNPR
Private management network for the SE server communication

Management Optional Network Private

MONPR
Private management network for the SE server communication. When required, you can configure up to 8
additive networks MONPR<n> (with <n>= 01..08).

Management Optional Network Public

MONPU
Public management network, which can be configured as the additive administration network when required (e.
g. when AIS Connect is not to be operated via MANPU but over a separate network).

Management SVP Network Private

MSNPR
Private management network, which enables the SVP communication to the SU /390 on SE servers with SU
1390.

Management Unit

MU
Component of the SE server; with the help of the SE Manager, enables central, web-based management of all
units of an SE server.

Multi-factor authentication

MFA
Login procedure (at the SE Manager) in which the access authorization is checked by several (here: two)
independent characteristics (factors).

Net-Storage

The storage space provided by a server in the computer network and released for use by foreign servers. Net-
Storage can be a file system or also just a node in the Net-Storage server's file system.
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Net-Storage client

Implements access to Net-Storage for the operating system using it.
In BS2000 the Net-Storage client, together with the BS2000 subsystem ONETSTOR, transforms the BS2000
file accesses to corresponding UNIX file accesses and executes these using NFS on the Net-Storage server.

Net-Storage server

File server in the worldwide computer network which provides storage space (Network Attached Storage,
NAS) for use by other servers and offers corresponding file server services.

Net Unit
NU

Component of the SE server; enables an SE server to be connected to customer networks (LAN/SAN). The
Net Unit incorporates High-speed Net Connect (HNC).

Net Unit Extension
NUX

The optional add-on pack NUX serves to connect the SE server to the customer networks by means of
additive Cisco switches outside the SE server.

In a broader sense, NUX refers to the entirety of these Cisco switches, their configuration and integration into
SEM using the NUX add-on pack.

Parallel Access Volume
PAV

Multiple I/O requests can be executed simultaneously to a logical volume. A logical PAV volume is represented
by a basic device and up to seven alias devices.

SE Manager
SEM

Web-based user interface for SE servers. The SE Manager runs on the Management Unit and permits central
operation and administration of Server Units (SU /390 and SU x86), Application Units (x86), Net Unit (including
HNC), and the storage. Frequently used abbreviation: SEM.

SENET
senet

A DNS server for the "senet" domain which provides name resolution for communication (especially for the
internal communication within MCNPR) runs on every MU. The DNS server is configured in such a manner
that it performs name resolutions for "senet" itself and forwards other name resolutions to external DNS
servers which must be configured in addition.

Server line, Server type
SE /390, SE x86

® SE /390: A server of this line resp. of this type contains one SU /390 and optional one or several SU x86.

® SE x86: A server of this line resp. of this type contains one or several SU x86 and contains no SU /390.
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Server Unit
SuU

Component of the SE server that supports the operation of BS2000 (Native-BS2000 or VM2000). SU types are
SU /390 and SU x86 - see below. The models and the abbreviations used for them can be found, for example,
in the Basic Operating Manual [1].

Server Unit /390
SU /390

Component of the SE server; Server Unit with /390 architecture. A /390-based Server Unit (SU /390) enables
operation of BS2000 (Native BS2000 or VM2000).

Server Unit x86
SU x86

Component of the SE server; Server Unit with x86 architecture. An x86-based Server Unit (SU x86) enables
operation of BS2000 (Native BS2000 or VM2000).

Service and console processor
SKP

An SKP enables servers with /390 architecture to be operated, the connected devices to be managed, and
remote service to be supported.
The term SKP is used in the three views hardware functionality, software functionality, and device type:

® Hardware functionality
To operate, S servers require an SKP as a hardware unit which has a local console, a Host Controller, and
various ports for LAN connection and supporting remote service.
On the SE server the Management Unit (MU) provides this hardware functionality for operating SU /390.

® Software functionality
On an SKP hardware unit the SKP Manager provides the SKP functionality for operating the S server and
managing the devices and remote service.
On the SE server the SKP functionality is integrated into the SE Manager.

® Device type
In BS2000 an SKP device type is used (e.g. SKP2).

SVP

Service processor of the SU /390.
With SU x86 there is an emulated SVP functionality in the X2000, as faras necessary.

SVP clock

Autonomous clock which supplies the TODR (Time of Day Register) with the real time at system startup. In SU
/390 the SVP clock is part of the SVP. In SU x86 the SVP clock is emulated via the basic software X2000.

Unit x86

Component of the SE server with x86 architecture: Server Unit x86, Management Unit or HNC
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17 Related publications

You can find the following BS2000 manuals on the manual server with the BS2000 documentation at

https://bs2manuals.ts.fujitsu.com.

Other manuals, for example descriptions of the Fujitsu PRIMERGY and PRIMEQUEST servers, can be found on
the general Fujitsu support pages at https://support.ts.fujitsu.com/.

[1]

(2]

3]

[4]

[5]

[6]

[7]

(8]

[9]

Fujitsu Server BS2000 SE Series
Basic Operating Manual

Fujitsu Server BS2000 SE Series
Server Unit /390
Operating Manual

Fujitsu Server BS2000 SE Series
Server Unit x86
Operating Manual

Fujitsu Server BS2000 SE Series
Additive Components
Operating Manual

Fujitsu Server BS2000 SE Series
Administration and Operation
User Guide

Fujitsu Server BS2000 SE Series
Quick Guide
User Guide

Fujitsu Server BS2000 SE Series
Security Manual
User Guide

Fujitsu Server BS2000 SE Series
Cluster Solutions for SE Servers
Whitepaper

BS2000 OS DX
System Installation
User Guide
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[10]

[11]

[12]

[13]

[14]

[15]

[16]

[17]

[18]

[19]

[20]

[21]

BS2000 OS DX
Introduction to System Administration
User Guide

BS2000 OS DX
Utility Routines
User Guide

VM2000 (BS2000)
Virtual Machine System
User Guide

openNet Server
BCAM
User Guide

openSM2
Software Monitor
User Guide

Net-Storage Guide
Description Paper

You can find this product on the BS2000 product page under Net-Storage Guide.

ServerView Suite
iRMC S<n>

User Guide (Documentation for the current version)

ServerView Suite
ServerView Operations Manager

Installation for Linux / Installation for Windows (one Installation Guide for each)

ServerView Suite
ServerView Operations Manager

Installation of the ServerView agents for Linux / Installation of the ServerView agents for Windows (one

Installation Guide for each)

LS| MegaRAID
SAS Software
User Guide

LSI Controllers
Modular RAID Controller
Installation Guide

Fujitsu Software
openUTM WebAdmin
User Guide
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[22]

[23]

ROBAR
Controlling MTC Archive Systems
User Guide

Storage Manager (StorMan)
Managing virtualized storage resources
Administrator and User Guide
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